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About This Guide

About This Guide

This user guide is intended to supplement Find it EZ website resources (FAQ, Knowledge Base, Video Tutorials, and Corporate
Documents) by providing step-by-step procedures to help you make the most of your Find it EZ product.

If we can improve this reference in any way, please feel free to send us your feedback and suggestions to support@finditez.com

Visit https://www.finditez.com/support/#overview for Find it EZ website resources.

This guide uses the following document conventions:

Program windows or dialog box titles are shown in bold text like this: Bold Title
Program menus are shown like this: 'File -> Open

Program buttons are shown like this:[Cancel |

Keyboard keys are shown like this:

Program labels, radial buttons and drop down list options are shown in mixed case bold mono-type textlike this: Labels

Thisis a hyperlink: http://www.finditez.com/

' Note: Thisisa note. j
Tip: Thisis a tip.
' Alert: Thisisan alert. J

' Example: Thisis an example.

See Also:

* Thisisacross-reference

About Find it EZ

Find it EZ Software Corp. is a global leader in developing and delivering productivity improvement tools for software developers. Our
award winning software developer tools provide instant, comprehensive and pin-point accurate where-used results all in one place.
These productivity tools offer a new solution for crystal reports designers, database developers and software vendors to better man-
age release changes through every phase, from more accurate estimating, to optimal design selection, rapid development,
improved code quality for smoother end-user roll out and expedited critical production support.

Tools developed by Find it EZ Software Corp. support all major programming languages, reports and databases across an entire n-
tier enterprise application with a single integrated package.

Productivity software tools with vendor certified support to search and document all major business intelligence reporting tools, under-
lying databases, programs, application logs, data files, office documents plus more for complete change impact analysis. Database
developers can take advantage of a full software stack impact analysis tool that identifies all interrelated components whenever
changes are planned or made in an underlying database.

By using our change impact analysis tools, software developers benefit from:

©2010-2019Find it EZ Software Corp. 1
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About Find it EZ

» Saving time and money by quickly searching all reports, application source code, and/or databases with just one integrated
software tool.

* More accurate and efficient source code change management.
» Ability to determine the exact scope and impact of planned changes.
« Easily estimate the time required to complete a change and ensure better quality code releases.

» Effective Risk Management, Resource Management and Cost Management.

2 © 1998 - 2019 Find it EZ Software Corp.



Installation, Activation, and Updates

Installation, Activation, and Updates

This section describes the steps required to download, register, install, configure, update, and manage your Find it EZ license and to
understand the benefits and limitations of product trials.

Download Find it EZ

Visit https://www.finditez.com/members/#downloads.

1

2. Ifyou have not done so already, register for a free Find it EZ account.
3. Oncelogged in, click to view the Software Downloads tab.
4

Refer to the following documents to select the product that best meets your needs:

a. https://lwww.finditez.com/resellers/salesaids/FinditEZ_compare_editions.pdf

b. https://lwww.finditez.com/resellers/salesaids/Product%20Selection.pdf

5. Clickon the (latest) Version hyperlink next to the Product you are interested in to begin downloading the corresponding
product setup file.

6. Once the setup file has been successfully downloaded, double click or open the file to run the installation process on the tar-
get workstation(s).

See Also:

» "My Account" on page 246

Download Connectors

Source items that require a connector will appear with a small warning icon preceding the name. See example below:

Note: Some connectors are required (e.g. '.net') but others are optional (depending on whether or not you want to search a par-
ticular document type that then needs a corresponding vendor supplied connector). After product install on first run configuration
wizard for setting up your environment, if you select one or more source items that require connectors, the wizard will prompt you
to auto-download and install them. If you do not do so, or later add a source item, you will note that it has a yellow alert triangle icon
next to it in the left (Source) panel. If you attempt to include such a source item in a project, you will be prompted to auto download
and install the required connector.

©2010-2019Find it EZ Software Corp. 3
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Download Connectors

@ Find it EZ - My Sample Project

File  Projects Compare Replace Reports  Tools  Help
| Search Assistant Find: Enter Boolean Expression ...
Source = Results
Statistics | Errars (0)
[ Databases See more
[ DB2 Linwo/UnibeWindows To begin a search, use the search assistant or:
[] mysaL (1) select and configure settings for one or more source ite
[] Orack (2) set your search options on the right
[] PostgreSaL {3) enter your search terms or use the Advanced wizard to
[ & SAP HANA
[] 5GL Server

Click on the source item / warning to download the associated connector.

If you try to initiate a search that includes a selected source lacking a required connector, an error message willbe generated. See

example below:

@

The connectar for SAP HAMA is not installed.

pos

You can download a compatible version from our website using the button below.

You will not be able to use this search module urtil the connector is installed.

Download Cancel

From the Program:

' Note: Downloading and installing a connector will require local administrative rights on your system.

1. Fromthe Find it EZ menu, select Tools -> Connector Manager .

© 1998 - 2019 Find it EZ Software Corp.



Download Connectors

&) Find it EZ - My Sample Project
File  Projects Replace Document | Tools | Help
| Wizards | Customize »
View Session Log -
Source = . .
Clear Expression History
Prowy Settings
] File Systems y 9
Connector Manager |
Local or Metwork Folders -
License Management »
[] Databases Index & Search Management
[T (3} sef Uptions 1o optimize search res
A Connector Manager dialog willappear.
@) Connector Manager X
Show Al ~
Name Installed 32-bit Version Other Available 32-bit Versions Release Date
‘T‘._‘; Find it EZ Git Runtime 21201 Feb 25, 2017
@ SAP HANA Database Client 1.00.102.06.1461042750 1.00.097.00.1434028111 Jul 02, 2015
‘D |IBM Data Server Driver Package 11.1.0.1527 Help me decide
'D SAP Business Objects Bl platform .MET Runtime (32-bit} 1424 2464 Help me decide
‘ ‘ | Open Downloads Folder ‘

2. Optionally select one of the Show drop down options to filter the list. For example, selecting the optonMi s sing will dis-

play a list of required connectors that have not yet been installed based on the source items you have configured using the
Configuration Wizard.

Note: Items with a check-markicon o next to them indicate you have the minimum or newer connector version detec-
ted as already installed on your system.

e

=
3. Click on any one of the items with an install icon g then click the| Install / Update |button. The connector will begin down-
loading.

Downloading SAP Crystal Reports runtime engine for MNET (32-bit)

Progress:  18.8 MiB/74 1 MiB (25% complete)

==
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Download Connectors

Once downloaded, a Find it EZInstallShield Wizard willappear.
Click on the[Next|button.

Read and follow the instructions provided.

When complete, click on the[Finish |button.

& o T D

4. OR, clickon any one of the items with a download compatible version icon i , then click the[Help me decide |button or
hyperlink for that item. T his will launch your browser and open a page on the Find it EZ Software Corp. website to help you
select the correct version of the connector based on other related software installed on your workstation. For example, click-
ing on the "IBM Data Server Driver Package" for the required DB2 connector will take you to this page, see below:

Q Finditez Products Solutions Customers Quotes Shop Support Resources Blog Q LogIn

home / support / connectors / DB2

DB2 Integration

Find it EZ ires the IBM Server Driver Package client installed in order to connect to and search DB2 databases.

Plea he appropriat it connector below.

Download Free Trial

Code Search Pro Desktop, Pro Server or Dev Surge 365 Enterprise
Find it EZ v18 or later

DB2 runtime 9, 10 and 11 are certified compatible. Choose the one that most closely matches your DB2 database server or your workstation
DB2 client tools version installed. NOTE: All versions are backwards compatible.

» IBM Data Server Driver v11.1 - Download Here (52mib), Alternatively this is available directly from IBM Here
» IBM Data Server Driver v10.5 - Download Here (75mb)

» IBM Data Server Driver v9.7 - Download Here (26mb)

5. Follow the instructions on the website page to select, then download and chose to either save or run the corresponding
setup package depending on your browser and network security permissions.

Note: If you chose to save the setup package to your local system, you will then need to locate and run it with admin-
istrative rights once the download completes successfully.

Tip: The[Open Downloads Folder|button will contain all downloaded Find it EZ setup packages within this default path:
C:\ProgramData\Bits n Bytes Software Inc\Installers . To keep all related downloads organized for re-use, it is recom-
mended that you save these "version compatible" connector setup packages to this specific folder location as well.

On the Website:
1. Logintoyour Find it EZ Member Account.

2. Clickto selectthe Software Downloads tab. Alist of product releases and optional connectors willappear.

6 © 1998 - 2019 Find it EZ Software Corp.



Download Connectors

Q Finditez Products  Solutions  Customers  Quotes  Shop  Support  Resources Blog Q
home / members
My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets Feedback
My Products :
Download Release Optional Connectors
Product Version Date Notes .net| HANA  Crystal Reports DB2 Access SAP BI Git
Code Search Pro - Desktop 2018 18041 20180911 B 45 |1 Helpme decide |~ Helpme decide |~ 2016
Code Search Pra - Server 2018 18.042 20181026 B 45 |1 Help me decide
Dev Surge 365 - Enterprise 2018 18041 20180911 B 45 Helpme decide  Helpmedecide 2016 | Help me decide = 2.12.0

3. Locate the product release for which you want to download a connector.

4. Inthe Optional Connectors section of the table, click on the corresponding hyperlink in the desired connector column. For
allhyperlinks that do not contain the text Help me decide,aConnector Details dialog box willappear. See
example below:

SAP Crystal Reports runtime engine for NET (32-bit)
CONNECTOR DETAILS

¥ Installs the SAP Crystal Reports runtime engine for NET Framework (32-bit) version 13.0.17

REQUIRED FOR SCANNING or UPDATING CRYSTAL REPORTS
(RPT files)

¥ Download a compatible 32-bit version from our server (75MB)

¥ Alternatively download the 32-bit edition direci

T

To download the selected version from the Find it EZ server, click on the[ Download Now |button. OR,

Where applicable, to download the selected version directly from Microsoft (i.e. Access) or directly from SAP (i.e. Crystal
Reports), click on the directly from Microsoft or directly from SAP link, respectively. See example above.

from SAP. Click on the "32bit.msi" link beside support pack 17 or later

7. The connector will begin downloading.
Once downloaded, a Find it EZ InstallShield Wizard will appear.
Click on the[Next|button.

Read and follow the instructions provided.

When complete, click on the[Finish [button.

8. Toclose the Connector Details dialog box, click on the Close or[X]button.

e o T 9

9. OR,inthe Optional Connectors section of the table, if you chose any connector with the hyperlinktext Help me
decide, awebsite page will display with instructions to guide you through selecting a compatible version depending on
related software that may be installed on your workstation or network environment. See example below:

©2010-2019Find it EZ Software Corp. 7



View or Edit Proxy Settings

Q Finditez Products  Solutions ~ Customers  Quotes  Shop  Support  Resources  Blog

SAP Business Objects and Crystal Reports Integration

uires a compatible .NET runtime installed in order to work wi Reports and/or to connect and search SAP Bl platforms.

appropriaf

Dev Surge 365

Dev surge supports three types of connectors depending on the repository you have enabled. None (Local Files Only). BOE BI XI 3.1 or earlier. or SAP 81 4.X.

hich version of the Crystal Reports designer you have installed (if applicable) and your SAP Business Intelligence server version (if applicable)

Crystal Reports SAP Repository
None / Not installed || None / Local or Network files only v <:|

Find it EZ v18 or later

Allversions above service pack 2 ( 13.0.2 ) of the connector are supported

ommend always using the latest version from SAP.

» SAP Crystal Reports runtime engine for NET (32-bit) SP23 - D

98mb). Alternatively the latest version can be downloaded directly from SAP Here

10. Follow the instructions on the web page to filter the recommended compatible version of the connector to be installed.

11. Once the recommended connector download link is displayed, click to download and chose to either save or run the cor-
responding setup package depending on your browser and network security permissions.

<
Note: If you chose to save the setup package to your local system, you will then need to locate and run it with admin-
istrative rights once the download completes successfully.
J
N\
See Also:
» "Checkfor Updates" on page 38
* "Download Release Version" on page 257
* "Download .NET Framework" on page 263
J

View or Edit Proxy Settings

If your corporate network uses a proxy server firewall to manage allincoming and outgoing (Internet) traffic, you will need to con-
figure settings within a running Find it EZ program to enable automated “check for updates on start-up” as well as automated down-
load and install of optional connectors or upgrades.

Note: The proxy server itself will also need to be configured to permitinbound / outbound traffic over secure port 443 to the fol-
lowing two Find it EZ Software Corp. website addresses:

.

activation.finditez.net ( for update checks and automated product activation )

cdn.finditez.com ( for integrated product and connector setup file downloads )

Please contact your Network Administrator to ensure these website address' are white-listed in your proxy server.

There are three ways you can enter proxy settings. In all cases, the settings are saved between sessions. Note that saved pass-
words, if required for your proxy, are automatically encrypted for security.

From the Program Activation Dialog Window:

© 1998 - 2019 Find it EZ Software Corp.



View or Edit Proxy Settings

@ Activate

Email Address: ||

First Name: |

Last Name: |

Serial Number: |

| Activate || Manual Activation |

/

k/

Proxy Settings ‘ ‘ Lookup Serial Number ‘ | Buy Now ‘ | Contact Us ‘

Cancel

1. Before clicking on the[ Activatelbutton, check your Proxy Settings.

2. Clickon the[Proxy Settings |button. The Proxy Settings dialog box will appear.

Prowy Settings

netwaork administrataor.

(® Mo Proxy
() System Default
() Custom Proxy Seftings

|Isemame:

Password:

Address: Part:

Enter your prosgy credentials. f vou do not know them please contact your

0K

Cancel

3. Choose System DefaultandorenterCustom Proxy Settings,asrequiredforyournetwork.

' Note: If you don't know your proxy settings, please contact your Network Administrator.

4. Tosave your changes and close the Proxy Settings dialog box, click on the[OK |button.

From the Program Main Menu:

File  Projects Replace Document Toocls Help

©2010-2019Find it EZ Software Corp.



View or Edit Proxy Settings

1. Select Tools -> Proxy Settings .

Tools | Help

Customize 3

Configuration Wizard
View Session Log

Clear Search History

Proxy Settings .
Download Connectors . 3
License Management 2

Index & Search Management

The Proxy Settings dialog box willappear, as below:

Prowy Settings

Enter your proogy credentials. f you do not know them please contact your
network administrator.

(® Mo Proxy
() System Default
() Custom Proxy Settings

=)

Address: Port: | 80

|semame:

Password:

ok ||

Cancel

2. Choose System DefaultandiorenterCustom Proxy Settings,asrequiredforyour network.

. Note: If you don't know your proxy settings, please contact your Network Administrator. j

3. Tosave your changes and close the Proxy Settings dialog box, click on thebutton.

From any Download Dialog Window:

10
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View or Edit Proxy Settings

Download Connector pod

Connector: SAP Business Objects Bl platform .NET Rurtime
Latest Version: 14.1.7.1898

Last Updated: 20151217 Mot working 7 Download from our website

Mote: Downloading and installing this connector will require local admin rights on your system.

o

| Praxy Settings | | Download & Install || Close

1. Before clicking on the[ Download & Install |button, check your Proxy Settings.
2. Clickon the[Proxy Settings |button. The Proxy Settings dialog box will appear.

Prowy Settings

Enter your proogy credentials. f you do not know them please contact your
network administrator.

(® Mo Proxy
() System Default
() Custom Proxy Settings

Address: Port: | 80

|semame:

Password:

0K || Cancel

3. Choose System DefaultandiorenterCustom Proxy Settings,asrequiredforyour network.

' Note: If you don't know your proxy settings, please contact your Network Administrator. ]

4. Tosave your changes and close the Proxy Settings dialog box, click on thebutton.

©2010-2019Find it EZ Software Corp. 11



Installation and Configuration Wizard

Installation and Configuration Wizard

Install

Once the setup file has been successfully downloaded:
1. Locate and double-click on the *.exe file in the lower, left of your desktop or in your Downloads folder. The Preparing to
Install... dialog will appear, as below:

Preparing to Install...

Find it EZ - Code Search Pro Server Setup is preparing the
Installshield Wizard, which will guide you through the program
setup process. Please wait.

Extracting: Find it EZ - Code Search Pro Server.msi

Once the preparation is complete, the following dialog will appear:

12 © 1998 - 2019 Find it EZ Software Corp.



Install

Waelcome to the InstallShield Wizard for Find it
EZ - Code Search Pro Server

The Installshield(R) Wizard will install Find it EZ - Code Search
Pro Server on your computer, To continue, dick Mext,

WARNIMG: This program is protected by copyright law and
international treaties,

2. Clickon the[Next|button to continue. The License Agreement dialog will appear, as below:

©2010-2019 Find it EZ Software Corp.
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Install

i Find it EZ - Code Search Pro Server - InstallShield Wizard -
License Agreement ﬂ
Please read the following license agreement carefully. u

Find it EZ Software Corp. a
Software License Agreement

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT
("LICENSE") CAREFULLY BEFORE USING THE FIND IT EZ
SOFTWARE. BY USING THE FIND IT EZ SOFTWARE, YOU

ARE AGREEING TO BE BOUND BY THE TERMS OF THIS v

(_) I accept the terms in the license agreement

(®) I do not accept the terms in the license agreement

InstallShield

3. Read and accept the license agreement as follows:
a. Usethe vertical scroll bar to read the license agreement carefully and thoroughly.

b. To printthe license agreement, clickon thebutton. A Print dialog will appear. Configure print settings as desired and
click on the[Print|button.

c. Toacceptthe license agreement, click to choose the | accept the terms in the license agreement option.

4. Clickon the[Next]button to continue. The Destination Folder dialog wil appear, as below:

14 © 1998 - 2019 Find it EZ Software Corp.



Install

Destination Folder
Click Mext to install to this folder, or dick Change to install to a different fo

Install Find it EZ - Code Search Pro Server to:

C:\Program Files (x88)\Find it EZ Software Corp\FindItEz - Code
Search Prol,

InstallShield

©2010-2019 Find it EZ Software Corp. 15



Install

a. Tochange the destination folder, click on the[ Change... |button. The following dialog will appear:

Change Current Destination Folder
Browse to the destination folder,

Loak in:

£ FindItEz - Code Search Pro

Folder name:

Installshield

b. Make changes, as desired, and click on the[ 0K |button to close the dialog.
5. Clickon the[Next]button to continue. The Custom Setup dialog will appear, as below:

16 © 1998 - 2019 Find it EZ Software Corp.



Install

Custom Setup
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed,

Find it EZ - Code Search Pro Server
= ~ | Find it EZ - License Manager

Install to:

Feature Description

Find it EZ - Code Search Pro
Server

This feature requires 1760KE an
your hard drive,

C:\Program Files (x36)\Find it EZ Software Corp\FindItEz - Code Search Prol,

InstallShield

| e || space

a. Tochange how afeature is installed or to exclude a feature, click on the icon preceding the feature name and select the

desired option from the context menu. For more information, click on the[Help |button. See below:

©2010-2019 Find it EZ Software Corp.
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Custom Setup Tips 44
Custom Setup allows you to selectively install program features. Q

i Find it EZ - Code Search Pro Server - InstallShield Wizard

'~ The icon next to the feature name indicates the install state of the feature. Click
the icon to drop down the install state menu for each feature.

This inztall state means the feature...
Will be completely installed to the local hard drive.

Will have some subfeatures installed to the local hard drive. (Available only if the
feature has subfeatures.)

Will not be installed.

Will be installed on first use. (Available anly if the feature supports this option. )

il

Will be installed to run from the netwark. (Available only if the feature supports this
option.)

Installshield

Tip: Toinstallonly the Code Search Pro Server host, without the license manager, clickon the Find it EZ - License
Manager and chose the option "This feature will not be available" as follows:
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i Find it EZ - Code Search Pro Server - InstallShield Wizard -

Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature D ipti
(=~ | Find it EZ - Code Search Pro Server SR EesALLL

m Find it EZ - License Manager Find it EZ - License Manager

=3 This feature will be installed on local hard drive,

=18 This feature, and all subfeatures, will be installed on local hard drive.

=0 This feature will be installed when required.

This feature will not be available.

Install to:

Change...

Installshield

Space < Back ” Mext = | | Cancel

Note: For ease of management, itisrecommended that you only install a single Find it EZ Pro Server license manager on
your network. You may however, install the Pro Server host/index on multiple physical or virtual servers, all pointing to the
single license manager on your network. If you plan on ghosting / cloning a base image to multiple server hosts for bal-
ancing the workload as well as minimizing RDP client access licensing costs ( normally restricted to 2 client connectionsin
Windows by default ), it is recommended that you install the license manager on a separate server without the Pro Server
product itself installed on this host. The license manager can not be cloned or hosted on multiple serversin a network.

b. Toclose the Custom Setup Tips dialog, click on the[ OK |button.
c. Toview available disk space, clickon thebutton. The Disk Space Requirements dialog willappear, as below:
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Disk Space Requirements
The disk space required for the installation of the selected features,

Volume Disk Size Available Reguired
= 127GE T3GE 95MEB

< m |

The highlighted volumes do not have enough disk space available for the currently selected
features. You can remove files from the highlighted volumes, choose to install fewer features onto
local drives, or select different destination drives.

Installshield

[ o ]

d. Toclosethe Disk Space Requirements dialog, click on the[OK |button.
6. Clickon the[Next]|button to continue. The installation will begin and the following dialog will appear:
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Installing Find it EZ - Code Search Pro Server
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs Find it EZ - Code Search
Pro Server, This may take several minutes,

Status:

Installshield

Mext = | |

7. Wheninstalling the Find it EZ - Code Search Pro Server, you willbe prompted to select the location of the Find it EZ -
License Manager on your network. The following dialog will appear:
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4 Find it EZ - Code Search Pro Server - InstallShield Wizarcl| - | a | X |

Installing Find it EZ - Code Search Pro Server 44

The program { @Y Find it EZ - License Manager Setup - g

arch
® License Manager is installed on the local machine
e Port: 4565
. () Licensze Manager is installed on ancther machine
localhost
4565
Test Apply

InstallShield

< Back Mext = Cancel

a. Clickon the radial button corresponding to the location of the Find it EZ - License Manager on your network. It can be
installed on the same ( local ) machine, or on another machine ( remote server ). If you select another machine, you must enter
the remote server host name or IP address. See figures below for possible network installation design alternatives to consider:

i. Single Windows Server with license manager installed on same host (end user client connections via RDP)
ii. Multiple Windows Servers with license manager installed on one host (end user client connections via RDP)

ii. Multiple Windows Servers with license manager installed on separate host (end user client connections via
RDP)

iv. Citrix VDI client network with license manager installed on separate host (recommended configuration)
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Windows Server w/ Remote Desktop Access

Find it EZ License Manager

FigUI'e Find it EZ Pro Address:
i 4 Server XOOUXOCXKHXK

A

| ‘ | Port: 4565
[ ] ]
User 1 RDP Session User 2 RDP Session User n RDP Session
User 1 Index User 2 Index User n Index

| RDP Client | RDP Client | RDP Client

¢ . C

User 1 User 2 Usern
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Windows Server w/ Remote Desktop Access

_ Windows Server w/ Remote Desktop Access

Find it EZ Pro

Server

Find it EZ License Manager

HOLXOCXKANXX
- Port: 4565

User 1 RDP Session

S

User 1 Index

User 2 RDP Session

O

User 2 Index

User 3 RDP Session

S

User 3 Index

RDP Client

User 1

RDP Client

User 2

RDP Client

User 3

—

Find it EZ Pro
Server

,J

User 4 RDP Session

S

User 4 Index

User 5 RDP Session

S

User 5 Index

User n RDP Session

S

User n Index

RDP Client

User 4

RDP Client

User 5

RDP Client

User n
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‘Windows Server (Virtual or Physical)

Find it EZ License Manager

Address: XXOLXKX0LKK
Port: 4565

Windows Server w/ Remote Desktop Access

_ _ Windows Server w/ Remote Desktop Access

———— |

Find it EZ Pro
Server

_J

User 1 RDP Session

S

User 1Index

User 2 RDP Session

S

User 2 Index

User 3 RDP Session

S

User 3 Index

RDP Client

User 1

RDP Client

User 2

RDP Client

User 3

—

Find it EZ Pro
Server

,J

User 4 RDP Session

S

User 4 Index

User 5 RDP Session

S|

User 5 Index

User n RDP Session

S

User n Index

RDP Client

User 4

RDP Client

User 5

RDP Client

User n
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Windows Server (Virtual or Physical) NOTE: Only one License manager
installed per site. DO NQOT CLONE the
Find it E2 License Manager server running the single license manager.
Address: XXX XXX d
Port: 4565
Citrix Server — Windows image _ _ Citrix Server — Windows image

XenApp XenApp
@ Find it EZ Pro @ Find it EZ Pro
- Server - Server

User 1 4 User 2 User 3 User 4 d User 5 User n
vee
User 1Index User 2 Index User 3 Index User 4 Index User 5 Index User n Index
/

Citrix Client Citrix Client Citrix Client Citrix Client Citrix Client Citrix Client

iv

e User n

Figure

User 1 User 2 User 3 User 4 User5

26




Install

The default port is 4565, you may change this port when necessary. Note your network and server firewall rules must be set
up to allow communication via IP protocol if the license manager is installed on another machine.

c. Ifyou have selected a remote server, click on the[Test button to ensure that the Find it EZ license manager can be contacted. If
thisis the initial install and you have selected to install the license manager on the local machine, this step is not applicable.

d. Ifyoureceive the following alert, ensure that the license manager is running, accessible and listening on the port provided.

44 Find it EZ - Code Search Pro Server - InstallShield Wizarcl| - | a | X |

Installing Find it EZ - Code Search Pro Server -

|
The program { @ Find it EZ - License Manager Setup |L| g

arch

# license Manageris installed on the local machine

Unable to connect to the license manager, ensure that the service is started and
listening on the given port

oK

I TEPTF I

Installshield

< Back Mext = Cancel

e. Clickon theutton to close the alert and try again after making configuration changes and/or ensuring the remote service
is enabled and both incoming and outgoing traffic over IP to that port is allowed on your network firewall settings.
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f. Click on the[Apply putton to accept and save your settings. The following dialog will appear. Click on the[OK putton to continue.

4 Find it EZ - Code Search Pro Server - InstallShield Wizard| - | o | - |

Installing Find it EZ - Code Search Pro Server
The program{ @ Find it EZ - License Manager Setup | X

Ples arch
Prol

(®) Llicense Manager is installed on the local machine

- — =
. () Licenss ihine :l

Configuration saved

oK

Test Apply

Installshield

8. Once complete, click on the[Next|button to continue. The following dialog will appear:
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i, Find it EZ - Code Search Pro Server - InstallShield Wizard -

InstallShield Wizard Completed

The Installshield Wizard has successfully installed Find it EZ -
Code Search Pro Server, Click Finish to exit the wizard,

Launch the program

< Back Cancel

To launch the program after installation, click to select Launch the program (selected by default).

9. Tocomplete the installation, click on the[Finish |button. If selected, the program willlaunch.

Custom Configuration

After you download and install Find it EZ and run it for the first time, a Configuration Wizard opens to walk you through the initial
setup and configuration process. This wizard can also be run at any time from the Tools -> Configuration Wizard menu, as below:

[ Tools | Help

Customize 3

| Configuration Wizard

[
View Session Log B

Clear Search History

Prowy Settings
Download Connectors 3
License Management 3

Index & Search Management
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@ Find it EZ - Configuration Wizard *

Thank you for choosing Find it EZ!

This wizard will help configure your environment based on the programming languages,
reporting tools and databases you use.

|| het> || camce ]

1. Clickon the[Next >> |button to continue through the steps (click on the[ <<Previous |button to go back at any point during the
wizard).

Once complete, click on the[ OK |button to save all changes and close the Configuration Wizard.

3. Toexitand discard all changes at any point during the wizard, click on the[ Cancel |button. This will apply and use your exist-
ing configuration settings.

See Also:

* "Download Find it EZ" on page 3
» "Configuration Wizard" on page 72

* "License Manager" below

License Manager

License manager is a product license authorization check on start-up (e.g. a trial period or SaaS annual renewal period check to see
if it is valid before running the program). The license manager has to be running (as a Windows Service).

Note: The license manager runs within (behind) the firewall so is secure and US Health Insurance Portability & Accountability Act
(HIPAA) compliant.

During install, a warning that it is going to be listening on a TCP/IP port may be issued by Windows during setup.

If the service is not running or does not start automatically (by default), or the license manager can not be contacted due to firewall
restrictions on your network, you will receive an "Unable to connect to the license manager..." dialog preventing the Find it EZ pro-
gram from running.

30 © 1998 - 2019 Find it EZ Software Corp.



License Manager

Unable to connect

be running oris being blocked by a firewall,

Would you like to atternpt to restart the service?

Yes

Unable to connect to the license manager at localhost:45365, The service may not

Mo

If you receive this alert, try the following solutions to resolve this issue:

1. Clickon the[No button to close the alert. Log onto the Server running the Find it EZCode Search Pro Server and launch the
License Manager configuration utility. Use the Windows Start -> Programs -> Find it EZ Code Search Pro Server ->

Setup License Manager menu. The following dialog window will appear:

@ Find it EZ - License Manager Setup -

(® Licenze Manager iz installed on the local machine

Port: 4565

() license Manageris installed on another machine

localhost

(]
(=5
£n

Test Apply

2. Confirm and test the host name and port. Ensure that the service is running and accessible. This may require firewall
changes on either the Code Search Pro Server host machine and/or the server running the Find it EZ license manager. If

necessary, contact your network administrator for assistance in configuring these settings.

3. Logonto the host server that is running the Find it EZ license manager. Use the Windows Task Manager to attempt to

restart the Find it EZ license manager services.

4. Rebootthe server thatis hosting the license manager.

5. Ifnone of the above work, contact your local technical support or contact Find it EZ and provide log files using the Help ->

Send Logs to Supportmenu.

©2010-2019Find it EZ Software Corp.
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See Also:

« "Serial Numbers" on page 269

» "Installation and Configuration Wizard" on page 12

Activate License

To activate your license:

1. Once the productis downloaded and installed, launch the program. The Activate dialog box willappear, as below:

@) Activate bl
Email Address: || |+
First Name: | |+
Last Name: [ |+
Serial Number: | =

| Activate | | Manual Activation |

Proxy Settings ‘ ‘ Lookup Serial Number H Buy MNow H Contact Us ‘ | Cancel ‘

2. Enter your account Email Address, First/Last Name, and product Serial Number.

Note: If access to the Internet is protected by a proxy firewall within your network, click on the[ Proxy Settings|button and
enter the required credentials before clicking the[Activatelbutton. For more information, see "View or Edit Proxy Settings"
on page 8

Note: To find your serial number, click on the| Lookup Serial Number |button. The member website will openin a
browser window. Log in and the Serial Numbers tab will open. Locate and copy the product serial number.

3. Clickon the[Activate |button. If successful (see message below), the program will be activated for use.

*

Thank you for activating. Your application will now be re-started to fully unlock
its functionality

To close the message, click on the[ 0K |button.

Note: If you receive an error message (e.g. "Entered information is incorrect. Please check the serial number and try
again"), try again. Ensure there are no extra characters or spaces in the serial number. If you feel you are receiving this
message in error and continue to experience difficulty attempting to activate your product, please contact sup-
port@finditez.com.
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Activate License Manually

See Also:

» "Enter New Serial Number" on page 271

» "View or Transfer Current License" on page 269
* "Download Find it EZ" on page 3

» "Download Release Version" on page 257

» "GetaNew Trial License" on page 272

* "View or Edit Proxy Settings" on page 8

Activate License Manually

If you have a corporate security policy that does not allow the workstation on which you are installing Find it EZ to be connected dir-
ectly to the Internet, use manual activation.

This is quite common in large corporations where outbound internet connections are locked down (on certain ports) or not available
to go to a given website domain, etc. Our automated activation system is a web service on domain activation.finditez.net, on SSL port
443. A corporate security policy may prevent an application from attempting to "call out," or may not allow a connection to this specific
secure domain address. However, they could often still use a web browser to go to our website on www.finditez.com as the most
corporate internet use security policies typically allow normal internet access to trusted websites.

In cases where no Internet access is allowed even from a web browser, the end user would have to find a workstation (home com-
puter other office computer that is permitted web browsing) from where they can perform the manual activation by sending the files
back and forth between a computer with Internet access and the computer upon which the Find it EZ application is installed.

Note: Pending receipt of payment, manually activated licenses will automatically expire within 30 days. Once expired, manual
activation will be required upon receipt of payment.

From the Program:

1. Once the productis downloaded and installed, launch the program. The Activate dialog box willappear.

Note: You can also access the Activate dialog box from the menu; select Tools -> License Management -> Enter New
Serial Number .

@ Activate X
Email Address: || =
First Name: | |+
Last Name: | |+
Serial Number: | =
| Activate | | Manual Activation |
‘ Proxy Setiings ‘ ‘ Lookup Serial Number ‘ Buy Now ‘ ‘ Contact Us ‘ | Cancel

2. Enter your account Email Address, First/Last Name, and product Serial Number.

Note: To find your serial number, click on the[ Lookup Serial Number |button. The member website will open in a
browser window. Log in and the Serial Numbers tab will open. Locate and copy the product serial number.
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Activate License Manually

3. Clickonthe button. The Manual Activation dialog box willappear, as below:

@ Manual Activation *

Step 1) Click on "Save Activation Request” below and save the file to a location you are familiar with. Then once saved
upload it to our website.

| Save Activation Request

Step 2) Log in to our website, in the members area under the Serial Numbers tab click on "Manual Activation”.

Step 3) After downloading the response file from our website, click on “Load Repsonse File" below. This will complete the
activation request.

| Load Response File

Note: Manually activated licenses expire in the lesser of 30 days from now or the original expiry date. Once expired manual

activation will be required again.

4. Follow the instructionsin Step 1); to create an activation request file. Save it to a folder or location such as your desktop that
you will be able to access for uploading this temporary file to our website.

5. InStep 2), click on the[ Open Website |button to launch your default browser with our website log in page.
a. Logintothe Find it EZ member website.
b. Clickonthe Serial Numbers tab.

Search Website

My Account Software Downloads Serial Numbers. Quotes. Orders My Support Tickets Feedback

Get a New Trial License | Manual Activation *

5 o q # # Buy
License Type Serial Number UpgradeProtection | 00 Uged More

Code Search Pro - Desktop 2016 - Single Named Active until 2017-07- 2 1 Details =
User 01 L
Dev Surge 365 - Enterprise 2016 - Single Named Active until 2016-11- 1 Details | S
User 26 e

c. Clickonthe|Manual Activation [button. The Manual Activation dialog box willappear, as below:

Manual Activation

Step 1) Click on "Browse" or "Choose File" below and select the activation file from your
system.

Choose File | No file chosen

Step 2) Click on "Next" and we will process the request

Note: Manually activated licenses expire in the lesser of 30 days from now or the original
expiry date. Once expired manual activation will be required again.

34
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d. Clickon the[Choose File |button to load the FinditEZ_request.datfile you saved it in step 4 above.

Manual Activation

Step 1) Click on "Browse" or "Choose File" below and select the activation file from your
system.

FinditEZ_request.dat

Step 2) Click on "Next" and we will process the request

Note: Manually activated licenses expire in the lesser of 30 days from now or the original
expiry date. Once expired manual activation will be required again.

Next

e. Clickon the[Next]button. A response file will be generated. See example below:

Manual Activation

Step 3) Activate Find it EZ

Click on "Download" below to download your response file. Please save this in a place
you will remember and then load it into the application as prompted.

wnload

Thank you for using our manual activation service.
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f. Clickonthe button to download and save the finditez_response.datfile.

Opening finditez_response.dat >

You have chosen to open:
| | finditez_response.dat
which is: dat File (1.9 KB)

from: https:/fwww finditez.com

What should Firefox do with this file?

) Open with Erowse...

(®):5ave File

[ ] Do this automatically for files like this from now on,

6]4 Cancel

g. Returntothe Find it EZ program.

@ Manual Activation X

Step 1) Click on "Save Activation Request” below and save the file to a location you are familiar with. Then once saved
upload it to our website.

| Save Activation Reguest

Step 2) Log in to our website, in the members area underthe Serial Mumbers tab click on "Manual Activation”.

Step 3) After downloading the responze file from our website, click on "Load Repsonse File” below. This will complete the
activation request.

| Load Response File

Note: Manually activated licenses expire in the lesser of 30 days from now or the original expiry date. Once expired manual

activation will be required again.
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6. Clickonthe[Load Response File |button to locate and select ( click to highlight ) the saved response file.

@ open

«

~ 4 s ThisPC > Desktop

Organize +

New folder

PDF source files

MName

<]

Press Releases temp convert test

[7] finditez_projects_2018-10-19_21_58 45
|| Findi#tEZ_request.dat

@ OneDrive

I This PC

J 30 Objects b ]
I Desktop

[ Documents

4 Downloads

D Music

&) Pictures

B videos

‘e Windows (C)

= FinditezWebsite (1\192.168.5.237\Output) (Z:)

|| finditez_response.dat

¥ Network v <

Date modified

Search Desktop
Type

File folder
File

DAT File
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
DAT File

X
r)
o @

Size

File name: [finditez.response.dat

Cancel

Click on the[Open|button. The program will be activated for use.

its functionality

Thank you for activating. Your application will now be re-started to fully unlock

Product Trials and Limits

Product trails are subject to the following limitations:

Time limited

Features (# of documents processed and contained in exported reports or conversion wizards) capped

Ability to create projects is restricted

Number of trial licenses issued per customer capped (by unique company email domain)

Allabove get auto-reset whenever we release a new minor or major build. Release numbering is : major.minor.build. Customers can
request a new trial whenever we announce / post a new major or minor release after their past trial with an earlier version has
expired.

While in trial mode, creating projects is restricted:

Code Search Pro (Desktop & Server): you can only create one additional project; just the single "Default" project plus one

custom user-defined project is allowed.

Dev Surge 365: you can create only one additional (i.e. a maximum of 2) projects. This is required to permit easier eval-
uation of the "Compare" wizard (i.e. compare the default project to a "new" second project).

The Default project can not be deleted. However, the one additional project permitted in a Dev Surge 365 trial could be

deleted if desired to test this feature.

©2010-
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» Usersalso have full access to document filtering and managing their index so that they can bring in and check functionality
against various subsets of documents.

Number of licenses per customer:
» Equalto the number of registered login accounts linked to the customer account (+ 1 when the trial key is requested).
» Acustomer (user) can request a trial for each product edition. They are separate, unique keys and trials.
* Wecan, at our discretion, grant extensions or additional trial licenses upon request.

* Feature limits are indicated in the table below.

Number of documents processed feature limits in trial mode:

Code Search Pro Desktop 50 50
Code Search Pro Server 100 100
Dev Surge 365 Enterprise 100 100 100

Note: Both in trial and fully unlocked mode, all products allow indexing, searching and comparing (Dev Surge 365 feature only),
an unlimited number of database objects, reports, programming source code, data and log files or office documents.

The product trial time limits are:
» Code Search Pro Desktop: 15 days
» Code Search Pro Server: 30 days
» Dev Surge 365 Enterprise: 30 days

Check for Updates

From the Program:
On start-up, an updates available check is performed provided:

A. You are connected to the Internet, and your proxy or firewall is not preventing traffic to our web service on https://activ-
ation.finditez.net.

B. Your account profile is not set to skip the updates available check. Note, this setting may be used by and administrator to pre-

vent all end-users from receiving this message and attempting to upgrade independently rather then by a more controlled
corporate roll-out.

Note: If your system is connected to the Internet on start-up of Find it EZ, by default you will automatically receive this
Update Available notice. This on-start-up check can be disabled for all Find it EZ users in your company by logging into
your online company profile and disabling this default setting at any time. This will affect all users linked to the company
profile. See below:
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Finditez Q O B = e
SOFTWARE PRODUCTS  CUSTOMERS QUOTES SHOP  SUPPORT

home » members Welcome

My Account Software Downloads Serial Numbers. Quotes Orders My Support Tickets Feedback

Email Address: ]

First Name: .

Last Name: .
Phone Number:
Company Name:

Update alerts on

tartup? ¥ Alert all users when a newer release is available *
program start-up?

Subscribe to m"".‘“:% @ New Release Announcements
ists?
) Quarterly Newsletter

Special Offers

= [*

RESOURCES  CHAT

| My Account | Log out

Search Website

Alternatively, you may disable on start-up checks for your individual workstation by changing your custom profile using

the Tools -> Customize -> User Options menu.

1. Fromthe Find it EZ menu, select | Help -> Check for Updates .

click on the[ OK |button.

3. Ifupdatesare available, an Update Available dialog willappear as in the example below:

@ Update Available

Anewer version of Find it EZis available, do you wish to download it?

X

Wersion 16 35, Released 20160807

Release Notes:

16.3.5

BI REFORTS

[] Do nat show me when updates are available. Dovinload & Install | | Visit Website | |

Close

4. Use the vertical scrollbar to view all release notes.

If no updates are available, you will receive a message that reads "No updates available at this time." To close this message,

©2010-2019 Find it EZ Software Corp.
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5. Todownload and install the update, click on the[Download & Install |button. ADownload Update dialog will appear.

@ Jpdate Avallable

Release N Latest Version:

Version 16 Download Update

Anewer version of Find it EZis available, do you wish to download it?

Dev Surge Enterprise v16.1.12

Mot working? Download from our website

| Download & Install || Close

[] Do nat show me when updates are available.

| Download & Install | | Visitwebsite | |

Close |

a. Toenter proxy settings, click on the| Proxy Settings [button.
b. Todownload and install the update, click on the button. The download will begin.

Once completed, the InstallShield Wizard will appear to walk you through the installation process.

Follow the screen instructions and click on the[Next|button to proceed through the steps.

On the Website:

1. Logintoyour Find it EZ Member Account. Click on the Software Downloads tab.

Product

Code Search Pro - Desktop 2017
Code Search Pro - Server 2017
Dev Surge 365 - Enterprise 2017
Code Search Community

Eclipse Plugin

Version

17.1.2
17.1.2
17.1.2
17.0.5
116

Download Release

Date
2016-12-20
2016-12-20
2016-12-20
2016-09-28
2011-07-1%

[y I

Notes Specs

[ 23

e e e e

My Account  ([EETSTSNISsWNRSNERNl|  SerialNumbers | Quotes | Orders | MySupport Tickets | Feedback

Download Connectors

.net HANA  CrystalReports DB2 Access Bl41 X131 Git

45 00.097 13.0.17 10.5 2007
45 100097 13.0.17 10.5 2007
45 | 1.00097 13.0.17 10.5 2007
22

1417 | 127 271

2. LaunchFind it EZ; from the main menu, select Help -> About .

40
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About

Code Search Pro Desldop 17.1.2 Dec 22, 2016

This product is licensed to :

Serial #:

License Type: MNamed User Perpetual
License Effective Date : May 24, 2016
Software Assurance Expiry Date: Jul 01, 2017

Installed Cannectors:

" Crystal Reports
\/ Microsoft Access
v DB2

Find it EZ =2001-2017 Find it EZ Software Corp. All Rights Reserved.

https:/Awww finditez. com./

Close

3. Compare the latest posted release number under the Version column (on the website) corresponding to your product edi-
tion (on the About dialog). If the version posted on the website is newer, an update is available.

' Note: Provided your software assurance plan is active, you may download and install the latest upgrade for free. ]

Via Email from Find it EZ Software Corp.:

Allusers on an active software assurance plan will receive email notification of new (optional / recommended / required) upgrades,
releases, updates, patches, and offers.

N
Note: You may disable automatic notifications by logging into your profile and changing your email notice preferences (as above),
or by clicking on the “unsubscribe” hyperlink on any update notice received.

J

l Note: If your support plan has lapsed or you have not yet decided, you may request a free trial key to see what's new.

Note: If your software assurance plan has lapsed, the latest version available to your for download would be posted under the
"Older Versions" table, below the current product releases.

Index Reset on Upgrades

After upgrading to a newer version of the application where there is an a index structure change or model change, you will see the fol-
lowing message:

x

Due to changes made in the last update your index has been reset,

oK

In these circumstances, the index needed to be cleared in order to make the new information available.
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To clear this message, click on the[ OK |button.

See Also:

» "Download Release Version" on page 257
» "Download .NET Framework" on page 263
» "Download Connectors" on page 264

» "View or Edit Proxy Settings" on page 8
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Product Overview

Product Overview

This section provides an introduction to Find it EZ user interface layout, navigation methods, Tools menu customization options,

File and Document menu options.

User Interface Layout

Refer to the image and table below for a description of the key components of the Find it EZ user interface:

@ Find it EZ - Default Project — [u] X
File Projects Replace Document Tools Help
‘W\zards \ Find: {OrderlD} or {Customer} = ‘ Options “ Ermm BT
Source < Results
‘Search Resut History: |~ Select a search result ~ ~ [0 search within selected Documents
) e Results (displaying 190f 19)  Statistics  Emors (1)
[ae= DL T FEEE E+ Locaton Type Host Fil: Path or Database Document Matches  ~
O SQL Server Table Defintion 3 014 I lesOrderDetail 6
[J Databases O SQL Server Table Deim:nn brbdatabasel AdventursWorks2014 Sales Customer 1
[ Access O SaL Server Table Defintion  brbdatabase3 Adventure\Works2014 Production WorkOnder 3
[ DB2 Linuwx/Unix/Windows O SQL Server Table Definttion brbdatabase3 AdventureWorks2014 Production WorkOrderRou... 6
O SQL Server Table Definttion brbdatabase3 AdventureWorks2014 Sales SalesOrderHeaderS. [3
[ Goagle Cloud SQL for MySQL O SQL Server Table Defintion brbdatabased  AdventursWorks2014 Production Transactonkis. 3
[ InterSystems Caché O QL Server Table Defintion  brbdatabase3 AdventureWorks2014 Sales SalesCrderHeader 11
O mysaL O SQL Server Trigger bnbdatabase3 AdventureWorks2014 Purchasing uPurchaseOrd. 2
] Oracie O QL Server Trigger brbdatabased  AdvertureWorks2014 Purchasing uPurchaseOrd... 10
O SGL Server Trigger 3 014 lesiduSalesOrderDetal 20
0] PostgesaL O Trigger brbdaiabased  AdventureWorks2014 Production WerkOrder 2
SQL Server O e brbdatabase3 AdventureWorks2014 Purchasing iPurchaseOrde... &
[ SQL Server Agent Jobs O SQL Server 3 014 Production uWorkOrder 2
O SQL Server Trigger 3 014 ! esOrderHeader 2
Advanced Search Filters O SQL Server User Defined Fu. 3 014 dbo.ufnGeiC 2
O SQL Server View brbdatabase3 AdventureWorks2014 Sales vindividualCustomer 2
Crystal Reports @
Details [ Show matches only
First | Next | Previous | Last | Match1of8 Find in File: -w
BEGIN TRY "
INSERT INTO [Production].[TransactionHistory]
([ProductID]
, [ReferenceRmam
; [ReferenceOrderLinelD] v
< >
‘Trigger
108 matches found.
# Name Description
Menu Click on a menu item to view and navigate projects and settings, initiate a task, export or print results, access
user options, reports, help, and more.
Search Quickly initiate a search.
Source This panel allows you to select and configure settings for the source files (File Locations, Databases, Bl
Reports, Programs, and Documents) within which you want to search. Show or hide the panel by using the
p and - buttons. Expand or collapse a source category by using the a0y buttons (note that a cat-
egory cannot be collapsed if an item has been selected). In the desired category, click to check the desired
source items. To select allitems in a category, click to check the uppermost check-box located in the cat-
egory header.
Results Once a search is complete, results can be viewed or edited via this window. Select a tab to view Results,
Statistics, and Errors.
Details When aresultis selected in the Results window, details willappear in this window.
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See Also:

* "Wizards Overview" on page 124

» "Perform a Regular Search" on page 150
« "Use the Expression Builder" on page 156
* "Work With Search Results" on page 166

» "View Search Result Details" on page 181

Navigation

Navigation in Find it EZ is accomplished in two main ways:

1. Byusing the Wizards (for new users).

@ Wizards X

Iwantto ..
SEARCH

® Search for a specific database object, code snippet, or a variable to find any
references throughout all of my source code (including within reports and databases )

DOCUMENT
() Exiract database objects (tables. stored procedures. views. etc. ) used in my reports
() Generate detailed content documentation for my reports
(O Estract all SOL code used in my reports
() Create a database column crosseference for my reports
() Create a list of all my reports, including printer, and update information
REPLACE

(O) Replace Crystal Report data source connections, or qualified table names

[[] Show on Startup | | | Next == | | Cancel ‘

Note: Many of the items included in the Wizards can also be accessed directly via the main menu. Refer to the table
below.

2. Byperforming a Regular Search from the main screen (for intermediate or advanced users).

Navigation
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Navigation

Wizard Option Menu Navigation Sample
Documents
Search for a specific database object, code snippet, or a variable to find any references See links at end of List XLSX
throughout all of my source code (including within reports and databases) topic. List HTML
Detail
XLSX
Detail
HTML
Extract database objects (tables, stored procedures, views, etc.) used in my reports Document -> Business  XL_.SX
Intelligence -> Data-
base Cross-Reference
Generate detailed content documentation for my reports Document -> Busi- HTML
ness Intelligence ->
Report Definition TXT
Extract all SQL code used in my reports Document -> Busi- HTML
ness Intelligence ->
Show SQL Queries TXT
Create a database column cross-reference for my reports Document -> Busi- XLSX
ness Intelligence ->
Column Cross-
Reference
Create a list of all my reports, including printer and update information Document -> Busi- XLSX
ness Intelligence ->
Report Listing
Replace Crystal Report data source connections or qualified table names Replace -> Crystal
Reports -> Data source
connections or qual-
ified table names
Set my Crystal Reports to "No Printer" Replace -> Crystal
Reports -> Set Reports
to "No Printer”
<
See Also:
» "Perform a Regular Search" on page 150
« "Launch the Wizards" on page 124
» "Use the Expression Builder" on page 156

©2010-2019Find it EZ Software Corp. 45


https://www.finditez.com/solutions/report_examples/Search_Results_List.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_List.html
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.xlsx
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.html
https://www.finditez.com/solutions/report_examples/Search_Results_Detail.html
https://www.finditez.com/solutions/report_examples/SQLCodeExtract.xlsx
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.html
https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.txt
https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.html
https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.txt
https://www.finditez.com/solutions/report_examples/databasecrossref.xlsx
https://www.finditez.com/solutions/report_examples/reportlisting.xlsx

Customize Find it EZ Program Settings

Customize Find it EZ Program Settings

Tools | Help

| Customize

[~
Configuration Wizard b
View Session Log

Clear Search History

Proxy Settings
Download Connectors
License Management

Index & Search Management

User Options
Result List Columns
Source ltems
File Locations

Viewer/Editor Settings

The view of the main Find it EZ screen can be customized as follows:

» Toshow or hide the Source panel on the left, see "Product Overview" on page 43

» Toexpand or collapse Source items, see "Product Overview" on page 43

+ Toaddor remove Source items, see "Configuration Wizard" on page 72 or "Show or Hide Source ltems" on page 66

» Toshow or hide Project Settings each time you select a source item, see "File Locations and Source Settings" on page 86

» To customize file type processing by extension or select a custom source item "opens with" viewer / editor, see "Viewer /

Editor Settings" on page 69

» Tocustomize Results list columns, see "Show or Hide Result List Columns" on page 66

* Toshow or hide the Wizards on start-up, see "Show Wizards on Start-up" on page 128

File Menu Options

This section describes the various options available via the | File menu. Follow the steps to save or open saved search results, save
project settings, export or print search results, and to exit Find it EZ.

Save Search Results

1. Performasearch.

2. Fromthe Find it EZ menu, select File -> Save .

46
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Save Search Results

@ Find it EZ - My Sample Project

File | Projects Replace Document Tools  Help

Open Find: Enter Boolean
= Save
o Export — » ree =
-} ~
Print »
Exit
olders To begin
S0L Server Reporting Services (1) =elg
3. ASave Search Results dialog box willappear, as below:
@ Save Search Results oo

Mame: ||

* MOTE: Database table data seanch results will not be saved

Save

Cancel

4. Inthe Name text box, enter a descriptive name for the results.

5. Clickon the[Save |button.

Note: Once you save search results, every subsequent change to the search results elements are automatically re-
saved. Also, If any search results have annotations or have been marked complete and you attempt the exit/close the pro-
gram without first saving your results, you will be prompted to save your search results, continue without saving, or keep

the program open.
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Open Saved Search Results

Open Saved Search Results

1. Fromthe Find it EZ menu, select  File -> Open .

@ Find it EZ - My Sample Project
File | Projects Replace Document Tools  Help
|y | Find: [T
= Save E
| Export y [urce < Search Result
_ s
Print »
Exit Results (
- [~ Locy
2. AnOpen Search Results dialog box willappear.
@ Open Search Results X
Search: | —select - ~
Cpen | | Cancel

3. Fromthe Search drop-down list, select the name of the saved search results.

Note: Once saved results are opened, all further changes to them are automatically saved (this is reset when you exit the\
program OR if you run another search to replace the "SAVED / re-Opened" search results that you had been working
with. Also, when you open a previously saved search result, this also auto-switches to the saved Project settings. The
saved results listed include the following identifiers: Date, Time, [File] Name, Project Name, Search Type, and Search
text.

4. Clickon the[Open |button. The selected search results willappear in the Results window.

See Also:

* "Wizards Overview" on page 124
» "Perform a Regular Search" on page 150

« "Add or Edit Annotations" on page 189

» "Mark Item(s) Complete or Incomplete" on page 185

Save Project Settings

If you have only one project (the Default project) and can have more than one project, you will be prompted to save your current set-
tings as a New Project upon closing the program. Click on thebutton to save your settings.

See Also:

* "Product Trials and Limits" on page 37
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Export Search Results

Export Search Results

Follow these instructions to export data following a search using the File -> Export menu:
* Search Results List
* Search Results Detail
* Search Results Line Matches
* MS Project Tasks

¢ Error List

When you generate any of these reports with the exception of the Error List, a Select the items to include dialog appears so that
you can filter which search items are to be included in the file contents generated. For the Error List, all search errors are included.
Select your content filter preference for any of the other reports and click theutton, a Save As dialog appears. Browse to the
folder location where you would like to save the file, select the output file type, entera File nameandclickon thebutton.
The report s created and a Save Complete alert dialog window appears. To view the saved report, click on the[View Now|button.

Export Search Results List

An exported search results list will create a spreadsheet containing all or a subset of your search results. This saved .xslx file can then
be redistributed, changed, or printed using your default spreadsheet editor (e.g. Excel ).

1. Open a previously saved search result using the | File -> Open menu or perform a search.

2. Fromthe Find it EZ menu, select File -> Export -> Search Results List .

File | Projects B
| Open Fir
a Save T
-| Bxport  » | Search Results List

Exit Search Results Detail
Search Results Line Matches
M5 Project Tasks
Error List
ETTET e
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Export Search Results List

3. ASelect the items to include dialog willappear.

@ Select the termns to include
i@ Al results (239)
() Curmrently displayed resufts (239)

() Checked results only (5)

Save asfiletype: | Excel 2007 {(d=x)

Mext Cancel

a.
b. Chose afile type from the options available.
c. Clickonthe[Next|button. A Save As dialog box will appear.

Click to choose one of the options; All results, Currently displayed results, or Checked results only.

@ Save As

*
A <« FinditEZ » Content ~ O Search Content el
Organize * MNew folder = 0
I This PC ~  Name Date modified Type "
[ Desktop A_Intreduction Topics 2016-0 File folder
| Decuments BE_Links and Lists 2016-07-07 File folder
& Dawnloads C_Conditions Motes Tables 2016 File folder
J'! Musi D_lmages 2016-07-07 &:39PM  Filefolder
usic
_ w £ >
File name: | | ~
Save as type: | XLSX Files (*xlsx) ~
A Hide Folders Cancel

Navigate to the destination folder.

Enter the desired File name.

Click on the[Save |button.

50

© 1998 - 2019 Find it EZ Software Corp.



Export Search Results Detail

d. ASave Complete dialog willappear (see below).

i. Toview the saved file, click on the[View Now|button. The file will open in the selected viewer (see below).

@ Save Complete

Save complete

Would you like to view the saved file 7

[] Mways view, do not show again.

>

View Now

Close

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

i. Toclosethe Save Complete dialog, click on the[Close |button.

4. Exported search results will contain the following data columns:

» Source Location

* File Type

* HostName

» File Path or Database
* Document Name

* Number of Matches

* Annotations

Export Search Results Detail

An exported search results details will create a spreadsheet containing all or a subset of your search results. This saved .xslx file can

then be redistributed, changed, or printed using your default spreadsheet editor (e.g. Excel ).
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Export Search Results Detail

1. Open a previously saved search result using the | File -> Open menu or perform a search.

2. Toexportselected details only:

In the Results window, click on a result row. Details willappear in the Details window.

File

Projects

| wizards |

@ Find it EZ - My Sample Project

Replace Document Tools Help

Find: productid

[m) x

- (XS | expression Buider

Source << | Search Result History: - Select a search resuft —

[] File Locations

Local or Network Folders

Resu[_] Search within selected Documents

Resuits ( displaying 6of 6) | Statistics | Errors (2)

[ Databases

[] DB2 Linww/Unoo/Windows
[ mysaL

[ Oracle

[ PostareSGL

[] 5AP Sybase ASE

[ QL Server

SQL Senver Stored Procedure

SQL Server Stored Procedure
SQL Server User Defined Fu.
SQL Server User Defined Fu.
SQL Server User Defined Fu.

Seemore fit

ooooodn

[ Report Lhilities
Crystal Reports

[ Gracle Reports <
SGL Server Reports

Ses more

Details

~  Location Type Host

[] Show matches only

File Path o|
Adventure]
Adventure]

Adventure]

Adverture|
Adverture|

>

¥ Options

[] Programming Langua. ..

[] SGL (DBA Scripts)
[] Website Development

Seemore | First | Next | Previous | Last |

- »

WHERE p.[ProductID] = @ProductID

[0 Documents

[] Microsoft Excel
[ Microsoft Word

Seemore fit

<
User Defined Function

CREATE FUNCTION [dbo].[ufnGetStock] (Griasey [int) A

Content Filters:

[ Exact Match

[] Case Sensitive
[ Include Comments
[ Commerts Only

Code

Search

PRO desktop

27 matches found

Left click the check-box next to each item you wish to include from the results list.

Resylts ( displaying 239 of 239)

Location

OR, left-click on the check-box in the results title bar for a drop down list of actions available.

You may use the menu of choicesto select allorselect none, etc

Select
all
none
items marked completed
iterns with annotations
Mark all selected as cornplete
Mark all selected as incomplete
Add selected files to project exclusion list
Remove all selected

Search for all selected Documents

c. OR, right- click for a context menu to appear. You may use this contextmenuto select all orselect none,

etc.

3. FromtheFindit EZ menu, select | File -> Export -> Search Results Detail .
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Export Search Results Detail

File | Projects [
| Open Fir
= Save T
-| Export  » | Search Results List

Exit Search Results Detail
Search Results Line Matches
M5 Project Tasks
Error List
M | — e

4. ASelect the items to include dialog will appear.

@ Select the terns to include =

() All results (180)
() Currently displayed results (130)
(® Checked results anly (68)

Save asfiletyper | HTML (html) w
Print? [ ]

et Cancel

a. Clickto choose one of the options, select Checked results only to export the subset of checked search result items if applic-
able per step 2 above.
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Export Search Results Detail

b. Optionally checkthe Pxrint check-boxto bring up the print dialog.

E.E;I Print

General  Options

Select Printer

M Adobe POF
& Brother MFC-L2700DW
= Fax

£

Status:
Location:
Comment:

Ready
MFC-L2700DW series LAN

Page Range

® Al

Selection Cumert Page

Enter either a single page number or a single
page range. For example, 512

Prirt

M Microsoft Print to PDF
= Microsoft KPS Documen
= Samsung C430W

>

Prirt to file Preferences

Find Printer...

MNumber of copies: |1 =

Collate
111 2120 33

Cancel Apply

c. Clickonthe[Next|button. A Save As dialog box will appear.

@ savehs

4 MM > ThisPC > Desktop

Organize = New folder

Technology A Neme

@ OneDrive € SearchResultDetails. html

[ This PC
B 3D Objects
I Deskiop
| Documents
& Downloads
b Music
=] Pictures
B videos
iy Windows (C)

== Finditez.Website (\\192.168.5.23}
v

Date modified

2018-11-08 257 PM  Chrome HTML Do...

v & | SearchDeskiop P

Type
3IKB

[ZICLED N SearchResult Details.html|

Save astype: | HTML Files (*.html)

A Hide Folders

Cancel
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Export Search Results Line Matches

i. Navigate to the destination folder.

i. Enterthe desired File name.

iii. Clickon the[Save |button.

d. ASave Complete dialog willappear.

i. Toview the saved file, click on the[View Now|button. The file will open in the selected viewer (see below).

E’l Save Complete >

Save complete

Would you like to view the saved file ?

[ Aways view, do not show again. | View Now | ‘ Close

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

i. Toclosethe Save Complete dialog, click on the[Close |button.

5. Exported search results detail will contain a copy of all highlighted search matches in full context. A single HTML file will be
created, with each search result source item having a title and page break to separate documents included. It is essentially a
copy of the search "Detail" panel contents for all selected search results items.

Export Search Results Line Matches

An exported search results details will create a spreadsheet containing all or a subset of your search results. This saved .xslx file can
then be redistributed, changed, or printed using your default spreadsheet editor (e.g. Excel ).

1. Open a previously saved search result using the | File -> Open menu or perform a search.
2. Fromthe Find it EZ menu, select File -> Export -> Search Results Line Matches .

a.3.ASelect the items to include dialog willappear.

@ Select the iterns to include ol

(® Al results (739)
() Cumently displayed results (235)
() Checked results only (5)

Save as file type: | Excel 2007 {x=x) -

Mext Cancel
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Export Search Results Line Matches

i. Clickto choose one of the options; All results, Currently displayed results, or Checked results only.
ii. Clickonthe[Next|button. A Save As dialog box will appear.

Search Content

Date medified

201 PM
2016- PM

Type

File folder
File folder
File folder
File folder

@ Save As
1 « FinditEZ » Content
Organize « MNew folder
A
I This PC Mame
[ Desktop A_Introduction Topics
[ Documents B_Links and Lists
l’ Downloads C_Conditions Motes Tables
. D_Images
J’! Music
. LU 4
File name: | |
Save as type: | XLSX Files (*.xlsx)
» Hide Folders

Save

Cancel

i. Navigate to the destination folder.

i. Enterthe desired File name.

iii. Click on the[Save |button.

ii. ASave Complete dialog willappear (see below).

i. Toview the saved file, click on the [View Now button. The file will open in the selected viewer (see below).

l@l Save Complete

Save complete

Would you like to view the saved file?

*

[] Mways view, do not show again. |

Wiew Now

| | Close

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

i. Toclosethe Save Complete dialog, click on the[Close |button.

4. Exported search results detail will contain the following data columns:

* Source Location

* File Type

* HostName

+ File Path or Database
* Document Name

» Section

+ Search Terms Matched
* Matches Found

* Original Line
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Export MS Project Tasks

Export MS Project Tasks

An exported MS Project task list will create a spreadsheet containing all or a subset of your search results. This saved .xslx file can
then be imported directly into MS Project as a set of tasks to be assigned to resources.

1. Open a previously saved search result using the | File -> Open menu or perform a search.

2. Fromthe Find it EZ menu, select File -> Export -> MS Project Tasks .

File | Projects B
| Open Fir
a Save T
-| Bxport  » | Search Results List

Exit Search Results Detail
Search Results Line Matches
M5 Project Tasks
Error List
M | — e

3. ASelect the items to include dialog willappear.

(@) All results (130)

@ Select the items to include ot

() Currently displayed results (130}
() Checked results only (48]

Save as file type: | CSV (csw) W

Mext

Cancel
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Import Tasks to Microsoft Project

a. Clickto choose one of the options; All results, Currently displayed results, or Checked results only.

b. Clickon the[Next|button. A Save As dialog box will appear.
@ savehs

X
4 B > ThisPC > Desktop v &/ | Search Desktop »
Organize New folder - @
Technology A Name - Date modified Type Size
@ OneDrive Me items match your search.
[ This PC

¥ 30 Objects
I Desktop

| Documents
J Downloads
D Music

&/ Pictures
Videos

i Windows (C)

== Finditez Website (\\192.168.5.23
-

File name: | ESULENER XS

Save as type: | CSV Files (".csv)

A Hide Folders Cancel

i. Navigate to the destination folder.

i. Enterthe desired File name.

iii. Click on the[Save |button.

c. ASave Complete dialog will appear.
i. Toview the saved file, click on the[View Now |button. The file will open in the selected viewer (see below).

E‘j Save Complete

*

Save complete

Would you like to view the saved file?

[] Always view, do not show again. | View Now | ‘ Close

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

i. Toclosethe Save Complete dialog, click on the[Close |button.
4. Exported search results will contain the following data columns:
» Active-YesorNo
+ Task_Mode - Auto Scheduled or Manually Scheduled
» Task_Name - Search Source and Path

* Notes - Hostand Path

Import Tasks to Microsoft Project

1. Open Microsoft Project.

2. Fromthe File menu, select New.
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Export Error List

On the New page, click New from Excel workbook.
In the Open box, click the arrow next to XML Format, and pick Excel Workbook.

Locate and select the workbook you want to import, and click Open.

o o A W

In the Import Wizard, click Next to get started, and follow the steps to complete the import.
Export Error List

An exported errors list will create spreadsheet containing all errors from your most recent search results. If there are no errors to
export, an alert willindicate there is nothing to save. This saved .xslx file can then be sent to FinditEZ technical support or used to
review individual files that may be corrupt for further investigation or required repair / removal from your system.

1. Open a previously saved search result using the File -> Open menu or perform a search.

2. Ifanyerrorsare generated during the search, the Errors tab in the Results window will be selected automatically, the total
number of errors willbe shown on the tab label, and error details will be listed.

3. FromtheFind it EZ menu, select File -> Export -> Error List .

File | Projects k
| Bpen Fir
= Save
] [
-| Export  » | Search Results List
Exit Search Results Detail
Search Results Line Matches
M5 Project Tasks
Error List
“SETET |
4. ASave As dialog boxwillappear.
@ save s X
4 « FinditEZ » Content v 0 Search Content 2
Organize » Mew folder SEENA o
B This PC ~  Name Date modified Type "
[ Desktop A_Introduction Topics File folder
| Documents B_Links and Lists File folder
C_Conditions Motes Tables File folder
; Downloads
D_lmages 016-07- W File folder
J’! Music -mad v
. v < >
File name: | | -
Save as type: | XLSX Files (*xlsx) ~

~ Hide Folders Cancel
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Export Error List

a. Navigate to the destination folder.

b. Enterthe desired File name.

c. Clickon the[Save]button.

5. ASave Complete dialog will appear.
a. Toview the saved file, click on the[ View Now |button. The file will open in the selected viewer (see below).

@ Save Complete

Save complete

Would you like to view the saved file?

*

[] Aways view, do not show again. ‘

View Mow

Close

Tip: Click to check the Always view, do not show again check-box to always view the saved results file.

b. Toclose the Save Complete dialog, click on the[Close |button.

6. The exported error list will contain the following data columns:

Location

Type

Host

File Path or Database
Document

Error

Details

See Also:

» "File Menu Options" on page 46

» "Wizards Overview" on page 124

» "Perform a Regular Search" on page 150
» "Work With Search Results" on page 166
» "Viewer/ Editor Settings" on page 69
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Exit Find it EZ

Exit Find it EZ

1. Fromthe Find it EZ menu, select | File -> Exit .

File | Projects Replace Document T

| Open

5 Save

Export  » ree <

Exit

OR

2. Clickon the|z|button located in the upper, right corner of the screen.

@ Find it EZ - My Sample Project - m] X

File Projects  Replace Document Tools  Help /

3. Theprogram willclose.

Built-in Reports and Documentation

This section describes the steps required to access various Find it EZ reports included with the system.

For example, if you wanted to analyze a large number of reports in preparation for a possible upgrade to discover which ones are not
currently compliant with your corporate standards for recommended best practises involving table join syntax in the queries, you
could chose any on of the following:

Many Find it EZ built-in documentation extracts will give you precisely what you are looking for. One is the "Show SQL Queries" doc-
ument. This report extracts any joins used by the visual linking expert within the CR designer and recreates the SQL code based on
the join property options used by the visual linking tool. There is also the "Report Definition" and "Column Cross-Reference" which
actually has a column or section showing the type of join used when applicable via the visual linking expert. These reports are avail-
able under the Reports -> Business Intelligence menu.

For more details on each document type available, please see below.

Note: Our trial mode has the number of documents searched and output limited. However, a fully unlocked version is not limited.
This may affect your evaluation results if the limits are reached. See below for more information.

Business Intelligence Reports

Bl Reports can be generated and accessed as follows:
From the menu, select Document -> Business Intelligence -> [desired report] . See report options below:

« Database Cross-Reference - generates a single spreadsheet cross reference containing all database connections, tables, pro-
cedures, views, embedded SQL queries, database call statements, table joins, and optionally the underlying SQL code from
the source database used in each selected report. This information is a high level summary of database tables used within a
report and does not provide individual table column where-used detail ( see Column Cross-Reference ). Output spread-
sheet columns are customizable ( include / exclude as needed ). See a sample on our website: XSLX
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Business Intelligence Reports

Column Cross-Reference - generates a detailed where-used spreadsheet listing every location, formula, etc. that each and
every source database table column is used. Provides report field name and full context statement referenced. Does not con-
tain high level database connection information ( see Database Cross-Reference ). Output spreadsheet columns are cus-
tomizable (include / exclude as needed ). See a sample on our website: XSLX

Show SQL Queries - extracts allembedded SQL queries, database call statements, and drag-n-drop tables and fields used
in areport (in the form of a simulated SELECT statement ). Output can be to a single file for all selected reports, or individual
files for each source file. Output file type options include text and HMTL. See a sample on our website: HTML or TXT

Reports Definition - generates a common formatting and labelled layout of report content, including data source connection
information, SQL queries used within the report, database calls, report parameters, formulas, images, etc.. A formatted doc-
ument with relevant report design meta-data in a standard format re.g.ardless of source report type ( eg Crystal Reports,
SSRS, Oracle Reports or any other report type supported ). Output can be to a single file for all selected reports, or indi-
vidual files for each source file. Output file type options include text, HMTL and XML. See a sample on our website: HTML ,
XML or TXT

Report Listing - generates a spreadsheet listing your complete report library, including file location, author, last updated,
default printer and report title / description. Output spreadsheet columns are customizable ( include / exclude as needed ).
See a sample on our website: XSLX

See Also:

"Document Wizards" on page 137
"Export Search Results" on page 49

"Reporting Tools" on page 221

"Product Trials and Limits" on page 37
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User Settings and Customization

User Settings and Customization

This section describes the steps required to set user options, preferences, and settings for Find it EZ. These configuration settings
are permanently saved for each session, allowing each end-user to customize the software to their specific environment (source

items) and preferences.

Set User Options

1. Fromthe Find it EZ menu, select Tools -> Customize -> User Options .

Tools | Help

| Custormize

|

Configuration Wizard
View Session Log

Clear Search History

User Options M

Result List Cu:ulumnsw
Source [tems

Viewer/Editor Settings

Proxy Settings
Download Connectors
License Management

Index & Search Management

2. The User Options dialog box will appear, as below:

©2010-2019Find it EZ Software Corp.

63



Set User Options

@ User Options .

On Startup
(® Use application default seanch settings | Boolean, Entire Documert )

() Use last search settings
Show Wizards
Show me when updates are available

Performance

[ Runin reduced performance mode {Used for troubleshooting)
[] Enable Crystal Report locked file pre-checks (Local or network files only)

‘Wam me ff files are larger than : I:l ME

Results

Automatically expand details
[ Always view my exported report after saving

Limit the number of matches per object to
Tips and Hints
Show project settings whenever | select a source tem
Show an alert when | try to remove one or more search results
Show an alert before | attempt to search database or saved report data
Show an alert whenever | add an item to the project exclusions list
[] Enable detailed emor logging

QK Cancel

3. Choose, select, or enter settings as desired. Refer to the table below for details:

User Option Description

Use application Choose this option to apply the Find it EZ default search settings (i.e. Search Type =Boolean

default search set- Search, OR see next option...

tings (Boolean, Entire

Document)

Use last search set- Choose this option to apply the last-used search settings for the next search.

tings

Show Wizards Click to check this item if you want to launch the Search Wizard each time you start up Find it
EZ.

Show me when Click to check this item to receive a notification message when you start up Find it EZ when any

updates are available new updates are available for download.
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Set User Options

User Option

Description

Run in reduced per-
formance mode
(Used for
troubleshooting)

Enable Crystal
Report locked file
pre-checks (Local or
network files only)

Warn meif files are
largerthan: __ MB

Automatically expand
details

Always view my expor-
ted report after sav-
ing

Limit the number of
matches per object
to:

Show project settings
whenever | selecta
source item

Show an alertwhen |
try to remove one or
more search results

This option can be used if/ when you have limited memory (RAM) on your computer and Find it
EZ isfreezing, crashing, logging .net memory issues, or taking a VERY long time to complete a
search. The Find it EZ program will process the maximum number of documents simultaneously
using threads. By dropping this to reduced performance mode, only a single document is pro-
cessed at a time, reducing stress on a system with a limited amount of RAM. Default = Off ( for
optimal performance ).

Allows the Crystal Reports scanner to detect locked files during indexing and, if a file is currently
open or locked, to make a temporary copy of the file before allowing Crystal Reports to open it.
Note that this feature is disabled by default as it can affect performance.

When processing many documents in a folder & sub-folders (especially "text" type documents),
this option will allow you to skip individual large documents during the search process that are
found in a source folder; like error logs, etc. that may be in a file directory but do not need to be
searched (as they will either return too many false positives OR will slow down processing unne-
cessarily). This gives you an opportunity at search run time to skip certain very large files you
may not have wanted to be scanned but were in the folder and had a file type you do want to
search other (smaller) documents for matches. You can change this setting to customize for
your environment. Default =4 MB.

Click to check this item to expand selected result details in the Details window when a resultis
selected in the Results window. If unchecked, details will appear collapsed. Click on the "+" to
expand.

Click to check this item if you want exported reports to open immediately after saving.

Use this limit when too many matches are being returned in each individual document and you
really only care if one or more "hits" are discovered. This willimprove Find it EZ performance;
once the limit of matches per document is reached, the search engine moves on to the next doc-
ument and logs a "maximum hits reached" warning in the error log. Default = 1000.

Click to check this item to launch the Project Settings dialog box each time you select (check)
an item in the Source panel. These settings allow you to include / exclude the selected item, con-
figure and test connection settings and select folders (where applicable), apply filters, select the
viewer / editor with which to open results, set options, and add or remove file extensions.

Click to check this item if you want a confirmation message to appear (i.e. "Are you sure you
want to remove this item from the search results?" Yes/No) each time you right-click on a result
inthe Results window and select Remove.
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Show or Hide Result List Columns

User Option Description

Show an alertbefore  Everytime you are about to run a search that includes database table data, when this option is

| attempt to search checked, an alert is displayed. This warns you that the search time may be long, depending on

database data the size of the table. Find it EZ searches for matches in every column (field) of every row in the
table. For a table with a significant number of text columns and rows, this can really affect the
search performance and run time. Find it EZ allows for searching database table data, but thisis
intended for small "system" tables that are used in a dynamic table-driven software system.
Such tables contain references to screen names, report labels, or even code to perform actions.
This is also why we have the user explicitly choose a small subset of tables and do not offer a
"search all tables" option. Basically, this reminds the user they are about to search data and
gives them the option to cancel the search / disable data searching before proceeding. Ata min-
imum, it lets them know why the search is taking awhile. Default = On (to warn the user every
time they are about to search table data). Note also that database table data searching is "dis-
abled" by default.

Enable detailed error  This option is used to help identify the file on which a search may be getting stuck. Itis best if used

logging in combination with "reduced performance mode" enabled and will allow the system to log
search stepsin the "session log" in greater detail. This is often requested by tech support for
sending in logs and helps expedite problem resolution. Default = Off.

4. Clickon thebutton to save your settings. The User Options dialog box will close.
5. Todiscard any changes, click on the[Cancel |button.

Show or Hide Result List Columns

Note: There must be results listed in the Results window in order for the following menu option to be enabled for use. Column
names shown in grey cannot be hidden.

1. Fromthe Find it EZ menu, select| Tools -> Customize -> Result List Columns .

m Help
| Customize 4 | User Options |.||_Q, Search | | B
Cenfiguration Wizard | Result List Columns %L‘ Location
View Session Log Source ltems Type
Clear Search History Viewer/Editor Settings Haost
Proxy Settings File Path or Database
Download Connectors 3 Document
License Management » Matches
Index & Search Management | | Document Scope:

2. Alistof column names willappear on the right (as above).

3. Clickto show or hide columns, as desired. See note above.

Show or Hide Source Items

This section describes how you can add ( show ) source items to correspond to technologies, programming languages, databases
and reporting tools used in your work environment. Source items can be added in one of two ways.

1. While configuring project or wizard settings for source locations.

2. Usingthe Configuration Wizard.
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Show or Hide Source ltems

You can add ( show ) source file types while updating the advanced configuration settings on any of the file source location panels.
For example, right-clickonthe Local or Network Folders iteminthe mainFinditEZ window Source panel
to launch the advanced configuration settings:

@ Default Project Settings

Folders & Version Control
+ Local or Network Folders
Git / GitHub
Team Foundation Server
Business Inteligence
o Crystal Reports Server 2011
o Microsoft Reporting Services
v rePORTAL
Databases
InterSystems Caché
Postgre SQL
SQL Server Agent Jobs
Advanced Search Fiters
Crystal Reporis
SSRS Reports

Include Local or Network Folders
Options  Mask Fiters  File Filter

Search Path(s):

Directory

C:iUsers\ken*Documents' Test Cases'en‘\SamplestReports.
C:iUsers\ken Documents' Test Cases‘\Oracle-Reports'
C:iUsers\ken*Documents' Test Cases‘reportal®.
C:\Users\ken'\Documents ' Test Cases\S5RS

Include Sub Directories?

LGN QN

| Add ‘ | Edit | ‘ Remove
Include [ C Style [C.C+=CH) [ Configuration / Log Crystal Reports
[] Microsoft Excel [] Microsoft Ward [] Cracle Reports
[ PDF [] Per / PHP / Python  [] SQL (DBA Seripts)

[[] SSRS Reparts [ Text / ¥ml / CSV

Search within archive flee? (O Yes (® No

[[1 Do not show this window each time | select a scan source item.

[] Website Development

Close

Clickonthe See more hyperlink to view all supported document types for this location. The list will be expanded to allow you to
select additional source items currently hidden.
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Show or Hide Source Items

@ Default Project Settings

Folders & Version Control
+ Local or MNetwork Folders
Git / GitHub
Team Foundation Server
Business Intelligence
« Crystal Reports Server 2011
o Microsoft Reporting Services
+ rePORTAL
Databases
InterSystems Caché
PostgreSQL
SAL Server Agent Jobs
Advanced Search Fiters
Crystal Reports
SSRS Reports

Include Local or Network Folders
Options  Mask Fiters  File Filter

Search Path(s):

Directory Include Sub Directories?
Clgers\ken\Documents'. Test Cases'en\Samples'Reports" -/
C\Uzers‘\ken'\Documents'. Test Cases'Oracle-Reports’ -./
Clzers‘\ken'\Documents'. Test Cases'reportal®. -./
Clzers‘\ken'\Documents'. Test Cases'SSRSY v
Add ‘ | Edit | | Remove
Include: [ Ada [ C Style {CC++CH) [] cosoL
[ Configuration / Log Crystal Reports [ Java
[ Lua [] Microsoft Excel [] Microsoft Word
[] Oracle Forms [] Oracle Reports [[] Pascal (Delphi)
] POF [] Ped / PHP / Python  [] Ruby
___} [] SAP Dashboards [] SQL (DBA Scripts) [] 55RS Reports
[ Text / %ml / CSV [] Visual Basic [] Website Development
Search within archive files? (O Yes @ Mo

[] Do not show this window each time | select a scan source tem

Close

If you check any source item that was previously hidden, this new setting will automatically be saved so that the selected document
type willnow be visible in all configuration panels or wizards. The checked source setting(s) will be enabled under the Configuration
Wizard individual components taband wil automatically update and be saved to your custom program settings.

Source items visibility can also be set via the Configuration Wizard. Source items selected will be reflected in both the main applic-
ation (Source panel) and all Find it EZ wizards. In addtion to "showing" new source items, the Configuration Wizard allows

you to hide items that are not required. This allows you to customize and clean your Find it EZ workspace and minimize unnecessary
items from being displayed on the main Souxr ce panel or within any of the wizards.

To access the Configuration Wizard, from the Find it EZ menu, select Tools -> Customize -> Source .

Tools | Help

| Customize

r User Options

View Session Log

Clear Expression History

Result List Columns

Source

Proxy Settings
Connector Manager
License Management

Index & Search Management

Associate File Types

The Source Items dialog box willappear, as below:
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Viewer / Editor Settings

@ Customizing - Code Search Pro Desktop - 12.0.41 X
Software Flatfoms Used  Individual Components
A Summary
> SQL Server Agent Jobs

Vendor Technology Stacks (4)

Microsoft [} BTy SAP Analylics m] > Epic Softwars
Manage appiication changes using Microssft technlogies Mansge appiication changes using SAP analytics  Incivicual Componerts
include NET, SQL Server, Azure, Acess and MS Office. technologies including Crystal Reports, SAP Dashboands,

SAP Hana, Sybase |Q, Sybase ASE and SQL Anywhere

E Oracle O IBM O
Manage application changes using Oracle technologies Manage application changes using IBM technologies
including Java, MySQL and Oracle databases. including COBOL and DB2 database.

Web & Bundled Software Apps (4)

ASPNET and web development [m} Open source development [}
Manage changes using web development lanquages Manage changes in files using open source languages and
including C#, VB, ASP, JavaScript, HTML, XML, Ped, databases including MySQL, PostgreSQL, Java, Lua, Perd,
PHP, Python, SQL Scripts etc. PHP, Python, HTML, XML, Text, PDF etc.

M Epic Sofware s MIS software bundle O
Manage and implement Epic healthcare releass upgrades Manage changes to software components and databases
with ease, including support for all underlying technologies, used by iMIS, including SGL Server, Crystal Reports.

the whole analytics kit & caboodle!

Business Intelligence & Report Scheduling Services (1)

J#= SQL Server Agent.Jobs

Connectto a SGL Serverto extract agent job SGL
statements cortained within each job-step.

Select options and programming languages and tooks used in your envionment to customize your Find t EZ instal. Note that addional vendor

connectars may be required based on your selections. You wil be prompted ta download and install addtional companents  needed ‘ Apply ‘ | Cancel

Refer to the Configuration Wizard section of this user guide for more information.

See Also:

» "Configuration Wizard" on page 72

* "Viewer / Editor Settings" below

Viewer / Editor Settings

The File Association dialog settings allow you to select the viewer / editor used to open a search result listitem, as well as to add or
remove custom file extensions to be processed by available "search syntax" within the Find it EZ indexing engine. This ability to cus-
tomize how various file types are handled by the Find it EZ application is useful in situations where corporate naming standards
require use of a unique file extension such as".common" for shared JAVA program modules. The ".common" extension is not recog-
nized as a universal standard JAVA type file, but using this custom file type association within Find it EZ, you can configure the product
to treat all files with the ".common" extension as containing JAVA code and to include and process them the same as any other stand-

ard JAVA programming language file for example.

Note: The Windows Default Editor (referenced below) is set at the Windows operating system level by the end user when you
install a new program. Or, you can change the default editor settings in Windows 7 via Start -> Default Programs or in Windows

10 via Start -> Settings -> System -> Default Apps.
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Viewer / Editor Settings

1.

From the Find it EZ menu, select  Tools -> Customize -> Associate File Types.

Tools | Help

| Customize

» User Options

= View Session Log

Clear Expression History

Result List Columns

Source

141

Proxy Settings
Connector Manager
License Management

Index & Search Management

Associate File Types

The Associate File Types dialog box willappear, as below:

@ Association File Types kY
Assaciate a file type with a specfic Find it EZ Search syntax.
You can also use this feature to change which application Find t EZ will use to open search resuks
Add New
File Type Extension Search Syntax Opens Wih Application "
i ASCX Webste Development Find it EZ Code Viewer
W Asp Website Development Find it EZ Code Viewer
W ASPX Webste Development Find t EZ Code Viewer
& cFm Webste Development Find it EZ Code Viewer
W CONFIG Website Development Find it EZ Code Viewer
W css Webste Development Find t EZ Code Viewer
@ csv Text / ¥l / CSV Find it EZ Code Viewer
W DoL SQL (DBA Scripts} Find it EZ Code Viewer
4 Doc Microsoft Word Find t EZ Code Viewer
4 Docx Wicrosoft Word Find it EZ Code Viewer
& obar SQL {DBA Scripts) Find it EZ Code Viewer
4 DD Text / ¥l £ CSV Find it EZ Code Viewer
W HTM Website Development Find it EZ Code Viewer
W HTML Webste Development Find t EZ Code Viewer
o ar SQL (DBA Scripts) Find it EZ Code Viewer
WS Website Development Find it EZ Code Viewer
o ISP Webste Development Find t EZ Code Viewer
i MASTER Webste Development Find it EZ Code Viewer
W onc SQL (DBA Scripts} Find it EZ Code Viewer
4 POF POF Find t EZ Code Viewer
W PRC SQL (DBA Scripts) Find it EZ Code Viewer
W RDL SSRS Reports Defauk Windows Application Nicroscft SQL Server Report Buider .
4 denctes a buit in extension which cannct be removed.
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Viewer / Editor Settings

3. Toadd anew file type, click thebutton, the Associate File Type - Add / Edit dialog will appear as below:

Extension:
Search Syrtax:
Open With:

&) Add/Edit Association

EXAMPLE
Crystal Reports
(® Find it EZ Code Viewer

() Default Windows Spplication (Windows Open With (Pick an app))

() Custom Application

X

oK

Cancel

Note: TheDefault Windows Application radialbutton option will automatically reflect "known"
extensions on your system. For example, typing in the Extension "TXT" wil show (NotePad) by default unless you

have selected some other editor to open . TXT files.

Enter the custom file type you would like to add for processing by Find it EZ in the Extension field.

b. Selectone ofthe available FinditEZ Search Syntax modulesfrom the drop down list. This will direct the way in
which the contents of the files with this extension are to be parsed by our search engine.

Note: The list of search syntax options are limited based on the current set of document source types enabled within the
Customization Wizard. To add more search syntax options, you must first add one or more file types associated with that

syntax.

c. Choose one of the following viewer / editor Open Wi th options:

- Find it EZ Viewer

+ Default Windows Application

+ Custom Application
d. IFCustom Applicationischosen:

i. Clickon the corresponding folder icon to the right ofthe Cus tom Application textbox. An Open dialog box will

appear.
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Configuration Wizard

@ Open ¥
1 <« FinditEZ » Content v 0 Search Content 2
Organize » Mew falder =~ [ @
I Thic PC 2 Marne "
[ Desktop A_Introduction Topics
£ Documents B_Links and Lists
‘ Downloads C_Conditions Motes Tables
. D_Images
J’! Music ) .
Print Only Topics
&=/ Pictures R
£50UrCes w
m Videos oo |l <2 >
File name: || v| EXE files (*.exe) (*.exe) ~

cance'

ii. Navigate to the program application you want to use to open this type of file.
iii. Click on the[Open |button.
4. Tosave anychanges and close the Associate File Types - Add / Edit dialog box, click on thebutton.
5. Todiscard changes, click on the[ Cancel |button.
To change the Open Wi th program for an existing file type listed:
Click to select ( highlight ) a file type in the list.
Clickthe Change Settings button.
The Associate File Types Add / Edit dialog willappear.
Change the Open Wi th settings as desired. See above for Custom Application settingsinstructions.
Click on the[OK|button to save and close.

o kw0 Dd -~

Note: You can notchange the Search Syntax setting for any file types. To change this setting, simply add an additional
entry for the same extension using a different Search Syntax. For custom file types, delete any unwanted Search
Syntaxlistings.

To remove a custom file type:

1. Clickto select ( highlight ) any custom file type. You can not delete any built-in file types identified by a locked image -*=

2. Clickon the[Remove|button.
3. Clickon the[oK]button to save and close.

Alert: You can add duplicate file type extension entries, but each must be unique by Search Syntax. Duplicate entries
will process files with that extension using each unique Search Syntax selected. This may produce duplicate search res-
ults for the same file and is not recommended.

Configuration Wizard

The Configuration Wizard walks you through the steps required to set up your Find it EZ program so that it is customized to your envir-
onment. Itis recommended that you only select and display reports, databases, repositories, programs, version control systems and
other files in use within your organization. The configuration wizard is automatically launched after each install, including product
upgrades. These settings can also be changed at any time as your company adds or removes support for individual file types or tech-
nologiesin use.
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Configuration Wizard

Note: With each new technology supported by a Find it EZ release update, any new databases, programs, reports, or other
source items will appear in the left hand panel to bring these new features to your attention. It isrecommended that you use the
configuration wizard to disable any such source items that are not in use within your organization in order to remove clutter from

the Find it EZ interface.

From the Find it EZ menu, select  Tools ->Customize->Source .

Tools | Help

| Customize

View Session Log

Clear Expression History

Prowy Settings
Connector Manager

License Management

Index & Search Management

r User Options
Result List Columns
Source
Associate File Types
3

The Configuration Wizard willappear, as below:

@ Customizing - Code Search Pro Desktop - 18041

Seftware Platforns Used | individual Components

Vendor Technology Stacks (4)
O

Microsoft

s

Manage application changes using Microseft technologies
include NET, SQL Server, Azure, Acess and MS Office

O

Oracle

Manage applcation changes using Oracle technalogies
inclucing Java, MySQL and Oracle databases.

Web & Bundled Software Apps (4)

ASP.NET and web development [m}

Bl Varisge changes using web deuslopmert languages
inclucing C#, VB, ASP, JavaScript, HTML, XL, Pe,
PHP, Python, SQL Scrpts etc

||!I Epic Software

o] iMIs
Manage and implement Epic healthcare release upgrades

with case, including support for all undertying technologies.

the whole analytics kt & caboode!

Business Intelligence & Report Scheduling Services (1)

= SOLSewverAgent Jobs

Connect to a SGL Severto extract agent job SQL
statements contained within each jobrstep.

Select options and programming languages and tools used in your environment to customize your Find it EZinstall. Note that addtional vendor
Gonnectors may be required based on your selections. You wil be prompted to download and install addtional companents i needet

~  Summary

> SOL Server Agert Jobs
SAP Analytics m} » Epic Soltware
Manage application changes using SAP anatics ndvidual Component
technologies including Crystal Reporte, SAP Dashboards, R
SAF Hana, Sybase 10, Sybase ASE and SQL Anywhere
IBM m]
Manage application changes using IBM technologies
including COBOL and DE2 database.
Open source development [m]

Manage changes in fies using open source languages and
databases including MySQL, PosigreSQL, Java, Lue, Ped
PHP, Python, HTML, XML, Text, PDF eic

iMIS sofware bundle ]

Manage changes to software components and databases
used by iMIS, including SGL Server Crystal Reports.

Cancel ‘

Click all boxes that apply to the technologies and vendor software that your shop uses or supports. This will in turn enable

(select) allindividual source databases, programming languages and reporting tools bundled / provided in that vendors
product/ portfolio that Find it EZ supports.

Clickonthe Individual Components taband scrollthrough to see all checked items or expand all of the

Summary categories on the right to display the complete list of items selected.
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Clear Expressions History

@ Customizing - Code Search Pro Desktop - 18.0.41

Software Platforms U!94 Incividual Components

[AProgramming Languages
ia

[]Ad:

[C Style (CC+CH)
[coeoL

iava

Owa

[Oracle Forms

[JPascal (Defphi)

[IPed / PHP / Python
-CRuby

[41SaL (DBA Sciipts

[] Visual Basic:

[ Website Development
[CJDocuments

-[]Corfiguration / Log Files
[Microsoft Excel

[ Microsoft Word

CJPOF

[ Text / ml /CSV

Report Lilties

[A|Crystal Repotts

[J0racle Reparts

[] SAP Deshboards (Xcelsius)
[15SRS Reports

[Databases

DlAccess

[ Amazen RDS for MySQL

[ Amazon RDS for Oracke

[ Amazon RDS for PostareSQL
-[JAmazon RDS for SQL Server
[ D82 Linux/ Ui Windows
[A1Google Cloud SQL for MySQL

Summary
> SQL Server Agert Jobs

v Enic Softwars
Crystal Reports
InterSystems Caché
Cracle
5L (DBA Scrpts
SQL Server

Select options and programming languages and tools used in your environment:to custorize your Find it EZ install. Note that addiional vendor
connectors may be required based on your selections. You wil be prompted to download and instal addiional companens f needed

> Individual Componznts

[

Cancel ‘

5. FromtheIndividual Components tab, clickto selectany additional database types, programming lan-
guages, documents and report utilities used by your organization. Selecting a subset of these available technologies sup-
ported by Find it EZ allows you to fully customize the source panel on the main application window and wizards project
configuration panels to only display the items applicable to your work space.

a. Tosave your custom settings, click on the[Apply|button.
b. To discard any changes, click on the[Cancel |button.

Note: If one or more items selected is greyed out, this meansiitis included in a vendor bundle from the Sof tware
Platforms Usedtab. Youmustdeselect the corresponding bundle(s) to deselect the item(s) in the Indi -
vidual Components tab. Anindividualitem may be included in more then one software platform set ..
expand the Summa ry items to view allitems included within each software platform bundle.

Alert: Changing these selections may require Find it EZ to prompt for required vendor connectors upon first use and/or may

l restart the program to apply new settings.

See Also:

» "Download Connectors" on page 264
» "Show or Hide Source Items" on page 66

* "Viewer / Editor Settings" on page 69

Clear Expressions History

Each time you perform a search, the search expression is added to a the top of a history list that can be accessed by using the (drop-
down arrow ) to the right of the F'i nd text box within the search bar. A maximum of the most recent 25 expressions are saved, with
the oldest simply dropping off the bottom of this history list as new searches are performed. To access find expressions history for re-

running a previous search expression, simply click on the F'ind boxdrop down arrow.

74

© 1998 - 2019 Find it EZ Software Corp.



Index & Search Management
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To clear the search expressions history:

* FromtheFind it EZ menu, select Tools -> Clear Expression History .

Tools | Help

Custormize 3

View Session Log

| Clear Expression History

Proxy Settings
Connector Manager

License Management 3

Index & Search Management

» Allprevious search expressions will be deleted (except for the current search expression).

Index & Search Management

This section provides instructions to clear your current documents index or search history in order to recover disk space. You may
also create an index summary report to review the contents of your current or search history indexes.

Find it EZ stores an optimized, tokenized version of your documents, along with meta-data and a keyword dictionary in the following
default location:

» C:\ProgramData\Bits n Bytes Software Inc\Find it EZ\Data\username\lndex2\DataStore\
Saved search results meta-data and pointers default location is here:
+ C:\ProgramData\Bits n Bytes Software Inc\Find it EZ\Data\username\lndex2\SearchResults\

Aproprietary set of NoSQL key-value hash indexes are used to store information about all source documents, projects and search
results. These sets of indexfiles are loaded into RAM while the program is running and updated as part of each indexrefresh. Per-
sistent copies of these index files are located in these default locations:

» C:\ProgramData\Bits n Bytes Software Inc\Find it EZ\Data\username\Index2\DOCUMENTS.*
» C:\ProgramData\Bits n Bytes Software Inc\Find it EZ\Data\username\lndex2\PRJDOCUMENTS.*
» C:\ProgramData\Bits n Bytes Software Inc\Find it EZ\Data\username\Index2\SEARCH.*
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Change Index Storage Location

Alert: You should never add, remove or change files directly that are stored in the index folder as this will corrupt your index.
However, you can view and monitor the amount of physical disk space used by your Find it EZ indices within this folder.

In addition, Find it EZ uses a SQL.ite database to store your project configuration settings. This database is located here:

You can open this database using a SQL.ite query tool at your discretion. However, itis recommended that you use the packaged
Find it EZ utilities to Repair or Reset this database.

Alert: Manipulating data in this database directly will corrupt your Find it EZ project settings. You will lose your project settings and
be forced to Reset to factory defaults with our repair utility ( see below ).

Change Index Storage Location

1. Fromthe Find it EZ menu, select Tools -> Index & Search Management .

Tools | Help

Customize »

Configuration Wizard
View Session Log

Clear Search History

Proxy Settings
Download Connectors 3
License Management 3

Index & Search Management %

2. Thelndex & Search Management dialog box will appear, as in the example below:
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Clear Index or Subset

@ Index & Search Management X

Cument Documents (2) Search Results (0) Storage Location

Directory: |C:\ProgramData\Bits n Bytes Software Inc\Find it EZ\Data‘be\Index2\ =]

Reset to Default

Note: You can move your Find it EZ index storage location to an alternate drive for additional space or improved per-
formance on a faster (e.g. SSD ) drive.

3. Selectthe Storage Location tab. Click on the folder browser button “d Select the new desired index storage location
using the Windows file browser.

4. After changing the current storage location path, you will see anbutton appear at the bottom of the Storage Loca-
tion tab, to the left of the Close button. Click the Apply button. You will be prompted to move (keep) the existing indexed
documents or clear your index.

q X

You have selected a new folder for the index, would you like to Move the current contents or clear and start with a fresh index?

1 Clear I | Move | | Cancel ]

5. Clickthe Clear button to create a new, empty index or click the Move button to copy your currentindexed documents to the
new location. Click the Cancel button to abort.

Note: When you choose to clear or move your index, your old index folder is automatically deleted to release previously
used disk space.

Clear Index or Subset

Alert: When clearing the index or a subset from the Current Documents tab, any indexed documents that are contained in
saved search results are not deleted. To remove documents contained in saved search results, use the Saved Search Results
tab. Multiple copies of documents are stored in your index whenever an updated version of the same file are detected if they have
been saved within any search results. This preserves the state of the file contents at the time the search results were saved, while
also maintaining a “current” copy for subsequent search, compare, and documentation use.
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Clear Index or Subset

1. Fromthe Find it EZ menu, select Tools -> Index & Search Management .

Tools | Help

Customize 3

Configuration Wizard
View Session Log

Clear Search History

Proxy Settings
Download Connectors 3
License Management 2

Index & Search Management L\\s

2. Thelndex & Search Management dialog box will appear, as in the example below:

@ Index & Search Management b4

Cument Documerts {7} Search History (1)
® Clear all indexed documents
() Clear Selected Subset(s):

I'U'_Iy Sample
i Microsaft Word - Word - 7 documert(s)

Cument Size: 73.9 KiB

View Index Summary Report | Apply | | Close |

Note: The current size of your indexes are shown at the bottom of each Index & Search Management tab dialog box
(see above example). If you feel thisis too large (e.g. you are running out of hard drive space), you can shrink the data-
base to try and reclaim some of that space. The benefits can be significant as the underlying database is a "grow only"
type system. If, for example, you had 15,000 documents at one point and only have 200 now, you could reclaim a lot of
space.

3. Selectthe Current Documents or Search Results tab. Current documents are the latest versions of all files contained in
your index. Search results contain a list of all documents linked to any active session search results or previously saved
search results history.

4. Toclear the entire index:
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View Index Summary Report

a. Clickto choose the Clear the entire index option.
b. Clickon the[Apply |button.
OR

5. Toclear asubset(s) of the index:
a. Clicktochoose the Clear the following subset option. A check-box willappear before each project and subset.
b. Clickto checkthe project(s) or subset(s) you wantto clear.
c. Clickon the[Apply |button. The selected project(s) and or subset(s) will be cleared from the index.

View Index Summary Report

1. Fromthe Find it EZ menu, select Tools -> Index & Search Management .

Tools | Help

Customize 3

Configuration Wizard
View Session Log

Clear Search History

Prowy Settings
Download Connectors ]
License Management 3

Index & Search Management I}

2. Thelndex & Search Maintenance dialog box will appear.

@ Index & Search Management *

Cument Documents (7). Search History (1)
(® Clear all indsxed documents
(O Clear Selected Subset(s):

I'u'_ly Sample
i Microseft Ward - Word - 7 document(s)

Curent Size: 73.9 KB /
View Index Summary Report | Apply | | Close
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Repair Index or Reset to Factory Defaults

3. Atthe bottom of the dialog box, click on the View Index Summary Report link. The Index Summary report willopen in the

selected viewer.
4. The reportwillinclude the following data; one row per unique document:
» Location —original physical location of the source document
* Type —the type of document (e.g. Java, HTML, Crystal Report, Stored Procedure, etc. )
* Host - original local or network host name of the source document
* File Path or Database — original folder path or Database name of the source document
* Document—documentname
+ Last Updated — source document last updated timestamp (when available from the host system)
» Last Indexed — document last indexed timestamp

+ Size (KiB) —indexed document size in kilobytes

Repair Index or Reset to Factory Defaults

In rare cases, if your index and/or project configuration files become corrupt and prevent Find it EZ from starting or the program per-
formance degrades to an extremely slow condition, you will need to use the Index repair utility. The repair utility is a separate pro-

gram, automatically installed along with the main Find it EZ application and uninstall utility.

1. Tostart the repair tool, use the Windows Start menu to navigate to executables installed within the Find it EZ programs

folder.

2. Runthelndex Repair Tool.

® Index Repair Tool *

Welcome to the Find it EZ Index Repair Tool

| would like to :

(® Perform a repair of your database as well as optimize it for best performance.

e Factory reset the index.
This option will remove all projects and settings but will also repair ary major problems.

3. The utility dialogue window will prompt for one of two options:

a. The Repair Index option will clear your entire index and attempt to repair your project configuration settings database. This will

resolve most issues while preserving your saved project settings, and is the recommended first repair attempt.

b. The Factoryreset option will clear your entire index AND all of your project settings will be lost. This isrecommended as a last

resort, but may be necessary if your project settings database becomes corrupt and can not be recovered or repaired.
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Repair Index or Reset to Factory Defaults

4. Clickthe[Next >>|button to run the selected repair option. A Repair dialogue wil appear indicating progress.

Repair

! Stopping Code Search Pro Desktop

! Clearing the Index

Verifying user settings

Compacting, shrinking and optimizing the database

5. Ifthe Repair Index option does not work, try a Factory Reset. If this stilldoes not resolve the issue, contact Find it EZ tech-
nical support.
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Projects

Projects

This section provides step-by-step procedures to add, edit, switch, clone, rename, set active, delete, or save a project and its set-
tings.

Projects are used to configure and store paths and connection information for a collection of source code files. These settings are
retained for re-use between sessions, and can also be used to filter a small subset of items to be included in a project, compare or doc-
umentation run. Each project or collection is generally configured in relation to how your development process flows. For example, in
a waterfall development process, you would typically have planned releases, each with a corresponding set of individual unit and an
integration test environment. There is often also a staging environment for a frozen set of releases where final user acceptance test-

ing is performed, followed by a production environment. Each environment will have unique underlying database host, reports, pro-
gramming language files and so-on.

One common way to use Find it EZ projects is to set up a distinct collection of settings for each such environment or release. You can
then quickly switch between or compare files within these unique projects as you move through the design, development, migration,
and production support processes.

Projects are a key feature for organizing your work within Find it EZ, and the ability to configure each once, and then re-use settings
between indexing and search passes, is a huge time saving benefit.

Fromthe Find it EZ menu, select Projects -> Manage Projects . The Manage Projects dialog box willappear, as below:

@ Manage Projects >

:My Sample (actve)
Default

Edit

Clone

Rename

Set Active

Delete

Close
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Add a New Project

Add a New Project

1.

From the Manage Projects dialog box, click on the[Add |button. A dialog will appear.

@ Project Name

Enter a New Project Name

0K

||| comes |

2. Enter the name of the new project.
3. Clickon the[OK]button. The new project will be added to the list.
4. Toclose the Manage Projects dialog box, click on the[ Close |button.

Edit a Project

You may change the configuration settings to add a new file path, add a new database schema or owner to include that set of objects,
add file or database object filters and so on.

1.

From the Manage Projects dialog box, in the projects list, click to highlight the project you want to edit.

2. Clickon the[Edit|button. The Project Settings dialog box will appear. See example below:

® Default Project Settings

File Systems
+ Local or Network Folders
Databases
Access
DB2 Linwe/UnixAVindows
Google Cloud SQL for MySQL
InterSystems Caché
MySaL
Oracle
Postgre SQL
+ SQL Server
SQL Server Agent Jobs
Advanced Search Filters
Crystal Reports

Include Local or Network Folders
Options | Exclusions  File Fiter

Search Paths):

X

Directory

C:\Usershken'\Documents'. Test Cases'\UofSask’y

Include Sub Directories?

v

Add | ‘ Edit ‘ | Remave
Include Crystal Reports [ Microsoft Excel [ Microsoft Word
[] POF [] SQL{DBA Scripts) [1 S5RS Reports

[ Text / ¥ml /CSV

[] Website Development

Search within archive files? () Yes @ No

[] Do not show this window each time | select a scan source item.

Close
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Switch Between Projects

Switch Between Projects

1. The name of the currently viewed project is shown in the top, left corner of the main screen Title Bar. See below:

@ Finditez

| Wizards |

File  Projects Replace Document Tools  Help

Py Samplaprnject @

Source =

2. Toswitch to another project:

* Fromthe Find it EZ menu, select Projects -> [Project Name] .

File

@ Find it EZ - My Sample Project
Projects | Replace Document  Tools  Help

| Wizarg

Manage projects Find:

Settings

Default

My Other ﬁ

My Sample

[~] Lo

=

| I‘ Click to set as the active project.

* The selected project settings will be loaded for use.

Another way to select a saved project settings for use is to use the Project Management dialog box:

1. Fromthe Manage Projects dialog box, click to select the name of the project you want to set as the active project.

2. Clickon the[Set Active |button. The project will appear in the list followed by the word "(active)."
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Clone a Project

@ Manage Projects

My Sample (active) ‘ Add |

My Other

Default ‘ Edit |
Lo ]
| e ]
‘ Set Active |
L ove ]
‘ Close |

3. Toclose the Manage Projects dialog box, click on the[ Close |button.

Clone a Project

A quick way to set up a new project is to clone ( copy ) an existing one, then update individual source configuration settings as needed.

1. Fromthe Manage Projects dialog box, click to select the project you want to clone (i.e. copy all settings).

2. Clickon the[Clone|button. A dialog will appear.

@ Project Name

Enter a New Project Name

e

3. Enter adifferent name for the new, cloned project.
4. Clickon the[OK]button. The cloned project will be added to the list.
5. Toclose the Manage Projects dialog box, click on the[ Close |button.

Rename a Project

1. Fromthe Manage Projects dialog box, click to select the project of which you want to change the name.

2. Clickon the[Rename |button. A dialog will appear.

@ Project Name

Enter a New Project Name

oK |
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Delete a Project

3. Change the name, as desired.
4. Clickon the button. The renamed project will appear in the list.
5. Toclose the Manage Projects dialog box, click on the[ Close |button.

Delete a Project

1. Fromthe Manage Projects dialog box, click to select the name of the project you want to delete.

l Note: The active project cannot be deleted. J

2. Clickon the[Delete |button. The selected project will be immediately removed from the list.
3. Toclose the Manage Projects dialog box, click on the[ Close |button.

File Locations and Source Settings

This section provides detailed instructions to configure project settings for Source Location (local or network folders, databases)
and File Type (Programs, Documents, Bl Reports), including instructions on how to customize Find it EZ project settings.

Note: Some project configuration settings are used in combination with each-other. For example, in order to include any Pro-
gramming Language files, Reports or Other Documents, you must select and configure the physical “Location” of those files. This
could include a local or network folder.

There are three ways to access the Project Settings dialog box:

1. Fromthe Find it EZ menu, select Projects -> Settings to access the active project settings. See below:

@ Find it EZ - My Sample Project
File | Projects | Replace Document Tools Help

| Wizart Manage projects h Expre
! Settings .
L
Default
0 R My Other Edit the active project settings. fotatist
v | My Sample
Ll:.‘- : i Tooegin, use t
[1 80l Server Benodinn Services (1l gelect 3 A

2. Within the main program window, right-click on any location or source item within the expanded Source panel. The
advanced settings for the active project source item will appear (see sample below).

[] Databases ]
[] Acc

[ Fmaz::l Right click to change settings.
[ ] Amazon or Uracle

[ Amzzam BOS far Prctars SOl

3. Fromthe Manage Projects dialog box, click to highlight a project from the list, then click on thebutton to accessthe
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File Locations and Source Settings

selected project's settings.

@ Find it EZ - My Sample Project

N

Settings

File @ Replace Document Tools Help
| Wizar Manage projects E‘@ h Expres

*L%Iick here to add/remove/edit projects, h—

dLUit

My Other

My Sample

Statisti

[v] Lok

[ ] 5QL Server Reporting Services

oo

(1) select a Pr

n. use th

My Other
Default

My Sample (active)

@ Manage Projects

Close
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Location

@ My Sample Project Settings ®

- Location

- Local or Network Folders
- Repositories Options  File Fiter

>

[ Include Local or Netwaork Folders

~ SQL Server Reporting Service

- Databases

- Access

- Amazon RDS for MySQL . . A .

- Amazon RDS for Oracle C:A\Users'wmooman'\Desktop'Misc Files v

- Amazon RDS for SQL Server

- DB2 Linwe/Unge Windows

- ImterSystems Caché

- MySQL

- ODBC

-~ Oracle

- PostgreSQL

- SAP HANA

- SAPIQ o) | ‘ | ‘

- SAP SQL Anywhere
SAP Sybase ASE [ Include archive files
SQL Azure
SQL Server Exclude filefs) / Folderis):

Filz Type

Report Lkilities

Crystal Reports

Oracle Reports

SAP Dashboards (¥Xcelsius)

SQL Server Reports

Programming Languages

Ada

C Style (C.C++CH)

-~ COBOL

- Java ‘ ‘

Search Pathis):

Directary Include Sub Directories?

Enter each item on a seperate line.

- Lua Import Clear Use *for wildcards

- Pascal (Delphi)
.. Pard / PHP / Puthon
< >

[[] Do not show this window each time | select a scan source item.

View or Hide Project Settings

At the bottom, left of the Project Settings dialog box, you can click to check the Do not show this window each time | select a
source item check-box.

Apply Project Settings

When you are done making changes to one or more a source items, click on thebutton to apply the changes.

Note: Changes are also automatically applied and saved as you navigate between source items within the Project Settings dia-
log box.

See Also: "Set User Options" on page 63 (in the Tips and Hints section, there is a Show project settings whenever |
select a source item check-box). Click to check or un-check as desired.

Location

This section provides detailed steps required to configure project settings for local or network folders, repositories, and databases.
These are the physical locations of the source files, documents, and data included within a project.

Local or Network Folders

This section describes the procedures required to include the set of selected programming files, reports, and other documents from
local or network folders, add or edit search path(s), include / exclude archive files, exclude files or folders, and to apply file filters to
restrict processing to only a subset of selected files.

To access the active project settings for local or network (source) folders:
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Local or Network Folders

1. Intheframeontheleft,inthe File Systems category, clickto select Local or Network Folders. See below:

| @) Find it EZ - Default Project

| Wizards |

File  Projects Replace Document

[] Databaszes

[ ] Access

T DD 1 i e e ARG Adnue

OR

2. Fromthe menu, select|Projects -> Settings . See below:

@ Find it EZ - My Sample Project
File | Projects | Replace Document Tools Help
| Wizart Manage projects h Expre
! Settings M
Iy
Default
0 R My Other Edit the active project settings. fotatist
My Sarnple
Lok Toroegin, use t
[1 80l Server Benodinn Services (1l gelect 5 A

3. The following dialog box will appear:
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Include Source

®) Default Project Settings x

File Systems Include Local or Network Folders
+ Local or Network Folders
Databases

Access

DB2 Linuwx/Unix/Windows

Google Cloud SQL for MySQL Directory Include Sub Directories?

InterSystems Caché
MySaL C:\Users'ken\Documents'\ Test CasesiUofSask v

Options  Exclusions  File Fiter

Search Path(s)

Oracle
PostgreSaL
+ SOL Server
SQL Server Agent Jobs
Advanced Search Fiters
Crystal Reports Add | ‘ Edit ‘ | Remove

Include Crystal Reports [ Microsoft Excel [ Microsoft Word
[ POF [] SGL(DBAScipts)  [] SSRS Reports
[] Text / ¥ml /CSV [] Website Development

Search within archive fles? (O Yes @ No

Include Source

When a source item is selected from the frame on the left, the Include [Source Name] check-box at the top of the dialog box is
checked by default. To exclude the source from your search, click to un-check the check-box.

' Note: If a source item is excluded, any existing settings for the source are retained. J

Add or Edit Search Path(s)

To add a search path to the Local and Network Folders search:
1. Fromthe Options tab, click on the[Add |button.
2. Inthe Search Path(s) section, clickon thebutton. A Search Path dialog will appear, as below:

@ Search Path h-d

Directaory: | | Ed

Include Sub Directories?:

OK | | Cancel |
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Add or Edit Search Path(s)

3. Clickon the folder icon 'J button to the right of the Directory field. A Select Folder dialog willappear. See example

below:
©) Select Folder X
4 « FinditEZ » Content v 0 Search Content ye
Organize » Mew folder SEENA
I This PC | Name -
[ Desktop A_Introduction Topics
=| Documents B_Links and Lists
; Downloads C_Conditions Motes Tables
. D_Images
J’! Music - .
Print Only Topics
&= Pictures
Resources v
B videos = s
Folder: | |
Select Folder Cancel

a. Navigate to and select the folder you want to add as a search path.

b. Clickon the[Select Folder |button. The folder path will appear in the Directory field.
Tip: You can also copy and paste or type in a fully-qualified path into the Directory text box.

Note that the Include Sub Directories check-boxis checked by default. To exclude sub directories for the selected folder,
click to un-check this check-box.

5. Clickon the[OK]button. The new search path will be added to the Search Path(s) list. See example below:
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Add or Edit Search Path(s)

Include Local or Metwork Felders

Options  Mask Filters  File Filter

Search Pathis):

Directory Include Sub Directories?
ChUsers' see Documents'Bitrix24', v
Ch\Users' v Documents\ GitHub, v
ChUsers’ voo Documents' Test Cases', /
Add | ‘ Edit ‘ ‘ Remove
Include: [1 Cstyle (C,C++,C2) ] Config/ Log Files Crystal Reports
[ Microsoft Excel [ Microsoft Word [] Oracle Reports
1 PDF [1 Perl / PHP / Python  [] SOL (DBA Scripts)
[] S5RS Reports [ Text/ Xml/ CSV 1 website
See more

Search within archive files? (O Yes (@ No

Note: If sub directories have been included for a given search path, a green check mark appears in the corresponding
Include Sub Directories? column.

l Alert: You will be prevented from entering duplicate paths or overlapping sub-folders for a project. J

6. Repeatsteps 2 through 5 to add multiple paths.

To edit a search path:
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Include Archive Files

1. Inthe Search Path(s) list, click to highlight the search path you want to edit. See example below:

@ Default Project Settings X
File Systems Include Local or Network Folders
+ Local or Network Folders .
Databases Options  Exclusions ~ File Fitter
Access
DB2 Linuwe/Unix/Windows Search Path(sk:

Google Cloud SGL for MySQL

; Directory Include Sub Directories?
InterSystems Caché
wySaL v
Oracle C:\Users'ken\Documents' Test Cases'\UofSask™ v
Postgre SGL
+ SQL Server
SQL Server Agert Jobs
Advanced Search Fiters
Crystal Reports | Add ‘ | Edt | Remove
Include Crystal Reports [ Microsoft Excel [ Microsoft Word
[1 PDF [] SQL (DBA Secripts) [] 55RS Reports

[] Text / Xml / C5V [[] Website Development

Search within archive files? (O Yes @ No

[] Do not show this window each time | select a scan source item
2. Clickon the[Edit]button.

3. Repeat steps 3-5above.

Toremove a search path:

1. Inthe Search Path(s) list, click to highlight the search path you want to remove.

2. Clickon the[Remove |button. The selected search path will be removed from the list.
Click on the[ Close |button to apply your changes.

Include Archive Files

Whether or not afile is considered an Archive is determined by the file extension. If it is any of the following support Archive types, it
willbe opened as an archive and Find it EZ will search the contents:

"ARJ" "LZH". "LZMA", "RAR", "RPM", "7Z","XZ" "BZ2", "BZ","GZIP","GZ", "TAR", "ZIP"
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Exclude Files or Folders

Include Local or Metwork Folders

Options  Mask Filters ~ File Filter

Search Path(s):

Directory Include Sub Directories?
ChUsers\ken' Documents\ Test Cases, v
Add ‘ | Edit ‘ | Remove
Include: [] € Style (C,C++,£%) [ Config / Log Files Crystal Reports
[] Microsoft Excel ] Microsoft Word [] Oracle Reports
[ POF [ Perl / PHP / Python [ SOL (DBA Scripts)
[] 55RS Reports [ Text / Xml 7 CSV ] Wehsite
See more

| Search within archive files? @ Yes () Mo I

Toinclude archive files in your Local or Network Folders search, locate and click the Ye s optionto Search within
archive files.

Exclude Files or Folders

There are three ways to add one or more specific files or folders to be excluded from the selected directories (in the Search Path(s)
list) in your Local or Network Folders search:

1.

Right-click a search results item in the Errors tab, chose | Add File to Project Exclusion List from the context menu. See

below:
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Exclude Files or Folders

@ Find it EZ - My Sample Project

| wizards |

File Projects Replace  Document

Tools  Help

Find: user

- o x

- ‘ Expression Builder

Source

<<

-~

[J] File Locations

Local or Network Folders
[ SQL Server Repotting Services

[ Databases

[ Access

[] Amazon RDS for MySQL

[ Amazon RDS for Oracle

[ Amazon RDS for PostgreSQL
[ Amazon RDS for SQL Server
[] DB2 Linwe/Unise/Windaws
[ Google Cloud SQL

[ InterSystems Caché

O MysaL

] obBC

[] Oracle

[ sQL Azure

SQL Server

Report Utilities

Crystal Reports
Oracle Reports
SQL Server Reports

Search Result History: | - Select a search result —
Resul_] Search within selected Documents

>3 Options

Results (displaying 4cf4) | Statistics._Ermors (5)

Location Type Host File Path or Database

Local or Network Folders  N/A iew Error

Local or Network Folders  N/A o 5 = i Documes
Local or Netwark Folders  N/A \%\f 3 g [ e (L ‘I\_Ducume
SQL Server N/A AdvertureWor.

SQL Server NAA

< >

Search Type:
@ Bookean Search
O Wideard Search

Document Scope:
@® Search Entire Document
O Search Line By Line

Content Filters:
[ Word Match
[] Case Sensitive
[ include Comments
[ Comments Orly

CodeSearch

- PRO desktop

4 matches found

2. Toimporta list of files to exclude:

a. IntheExclude files,

folders and archives ... sectionoftheMask Filterstab,
click on the[Import|button. An Open dialog will appear.

©2010-2019Find it EZ Software Corp.
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Include Local or Network Folders

Options| Mask Filters |File Filter

Include files, folders and archive with the following masks:

*

Enter each item on a seperate line.
Import Reset .
P H Use * for wildcards,

Exclude files, folders and archives with the following masks:

Chlsers\ken'\Documents' Test Cases\Some_FinditEZ_Crystal_Tests\Crystal - Upgrade to 9 en
ChlUsersiken\Documents' Test Cases\3128 Incomplete Provider Notes.rpt

ChUsers\ken\Documentsh Test Cases\Some_FindltEZ_Crystal_Tests\Crystal - Formula Errorbr

Import Clear Enter each item on a seperate line.
’ Use * for wildcards

@ Open

4 <« Clients » Find itEZ » GitHub aKe Search GitHub

Organize « New folder

-

I This PC | Name
I Desktop

@ Documents

# Downloads

J‘& Music

=/ Pictures

m Videos

Mo iterns match your search,

File name: | | Text Files (~.o0)

o

bes

=~ [ @

b. Navigate to and select the desired *.txt file.

96

© 1998 - 2019 Find it EZ Software Corp.




Include File Filters

c. Clickonthe[Open |button. The contents of the selected file willbe added tothe inthe Exclude files,
folders and archives ...t

d. Clickon the[Close|button to apply your exclusions.
AND/OR
3. Toenter the path, file name, or wildcard to exclude:

a. ClickinsidetheExclude files, folders and archives ... textboxandenterthedesired
text to exclude.

Note: Enter each item on a separate line. Use * for wildcards. For example, enter the path to exclude a sub-directory,
exclude a specific type of files (e.g. *.cs), etc.

b. Clickonthe|Apply [button to apply your exclusions.
Toclear the Exclude File(s) / Folder(s) list:
+ Click on the[ Clear |button. Allitems in the list will be removed.

Include File Filters

YoumayuseboththeMask FiltersandiortheFile Filter tabstoinclude onlya subset of specificfiles within the
configured path(s). You must first add the desired source path folders. Thisfilter is often used to minimize false positives or expedite
indexing and searching by limiting the number of file contents included in a project. This setting can be quickly changed to include all or
a subset of files as needed.

Toinclude one or more files and/or folders based on a wildcard or pattern that matches part of a file or path name:

1. OpentheLocal or Network Folders projectsettingsdialog box, clickto opentheMask Fil-
ters tab, see below:
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@ My Sample Project Settings PY

File Systems Include Local or Network Folders

+ Local or Network Folders N .
Options] Mask Filters |File Filter
Databases

DB2 Linux/Unix/Windows Include files, folders and archive with the following masks:

InterSystems Caché
MysQL
Oracle
PostgreSOL
SAP HANA
SQL Server
SOL Server Agent Jobs
Advanced Search Filters
Crystal Reports
S5RS Reports Impart ‘ ‘ Reset

wx

Enter each item on a seperate line.
Use * for wildcards.

Exclude files, folders and archives with the following masks:

Ch\Users\ken\Documents\Test Cases\Some_FindiEZ_Crystal_Tests\Crystal - Upgrade to 9 on
Ch\Users'ken\Documents\Test Cases\3128 Incomplete Provider Notes.rpt
Ci\Usersiken\Documents\Test Cases\Some_FindItEZ_Crystal_Tests\Crystal - Fermula Errorbr

Enter each item on a seperate line.

Clear Use *for wildcards

Import

[ Do not show this window each time | select a scan source item. Close

2. Bydefault, all paths and filenames withinthe Options tab Search Path (s)areincluded usingthe wildcard
pattern * _ %

3. Toonlyinclude the subset of files containing the text "order" in either the folder path or filename itself, replace the default
* _ * pattern with the textorder, or *order*  asbelow:

Options Mask Filters  File Filter

Include files, folders and archive with the following masks:

order

Enter each item on a seperate line.

Import Reset Use * for wildcards.

4. Toalsoinclude anyfilesin a subset of paths such as order history sales report stored by date as follows "..\orderhistory\yyyy-
mmigross-sales.rpt", enter the pattern * \orderhistory\*\gross-sales.* ,asbelow:
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Options Mask Filters  File Filter

Include files, folders and archive with the following masks:

order
*orderhistoryy ™ gross-sales.”

Enter each itern on a seperate line,

Import Reset Use * for wildcards.

5. Repeatadding additional patterns on separate lines as needed, or use thebutton below to import a list of patterns.

Note: The list of "included" patterns is cumulative. In other words, each pattern on aline is "OR"-ed together with all
other patterns. As such, leaving the default "*.*" pattern in this box would supersede all individual pattern lines that may
be added.

6. Toclear the list, use the[Resetlbutton to restore the default * . * pattern ( ie, include all ).
To include one or more specific fully qualified files by name:

1. OpentheLocal or Network Folders projectsettingsdialogbox,clicktoopenthe File Filter
tab, see below:
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@ My Sample Project Settings

DB2 Linux/Unix/Windows

File Systems Include Local or Network Folders
+ Local or Network Folders .

Options  Mask Filters| File Filter
Databases

@® Include all Files

InterSystems Caché

MysQL

Oracle

PostgreSQL

SAP HANA

SOL Server

SOL Server Agent Jobs
Advanced Search Filters

(@] Only include this subset of Files

Crystal Reports
SSRS Reports

Add ‘ ‘ Paste | | Remove | ‘ Remove All

Close

2. Toinclude allfiles, click to choose the Include all Files option. This is the default selection.

OR

[[] Do not show this window each time | select a scan source itemn.

Toinclude only a subset of files, click to choose the Only include this subset of Files option.

Toadd a subset:

a. Clickon the[Add |button. An Add Filter dialog will appear.

Add Filter

Awzilable Files

C:\Users'wmooman'.Documents Gt Hub"\ UserGuides' Docs\Find t EZ Docs Outline Ver 2.doc A
C:\Users'wmooman'.Documents My Projects'\Find it EZ\ContentA_Introduction TopicsDrop Downs htm
“wmoomanDocuments My Projects'\Find it EZ\ContentA_Introduction Topics'Headings htm
“wmoomanDocuments My Projects'\Find it EZ\ContentA_Introduction Topics'Welcome htm
“wmooman'Documents My Projects'Find it EZ\ContentWbout Find it EZ htm
“wmooman'Documents'My ProjectsFind it EZ\Cortert\About This Guide htm
“wmooman'.Documents My Projects\Find it EZ\Content \Activate License Manually htm
“wmooman'.Documents My Projects\Find it EZ\Content \Activate License htm
“wmoomanDocuments My Projects'\Find it EZ\Content \Activation htm
“wmoomanDocuments My Projects'\Find it EZ\ContentAdd File to Project Exclusion List htm
Swemnnman Dnenimentes M Praiecte Find # FACnrtert W 8Ad ar Fdit Annntatinne btm

ADOQODDO0O0

>

Filename Fitter: ||

| ‘ Refresh H Select All H Select Mone ‘

Use * a8 a wildcard.

TIP: K you hold down the CTRL Key
you select multiple items ‘ Add ‘ |

Close ‘

TheAvailable Files listwilbe populated with a list of files included in the folders selected previously on the
Options tab, andfiltered to include / exclude specific subsets of files based on any entriesontheMask Filters
tab.
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b. Clickto select the desired file(s).

Note: Select multiple items by holding down the key. Or, click on the[Select All |button or the[ Select None |button, or

the[Refresh |button as desired.

c. Tofilter by file name, use the Filename Filter:

Click inside the Filename Filter text box.

Add Filter

Available Files

Filename Fitter: || | ‘ Refresh H Select All ‘ ‘ Select None ‘
Use ~ as a wildzard.

TIP: i you hold down the CTRL Key
you can select multiple items. ‘ Add ‘ ‘ Gl ‘

Enter the desired file name filter, using wildcards as desired (e.g. *.cs, *.js, “user®, etc.).

Add Filter

Awailable Files

“wmooman“Documents My Projecte'\Find it EZ\Content*Resources’Stylesheets'\FinditEZ Stylesheet cas
“wmooman“Documents'My Projects'\Find it EZ\Content*Resources"Stylesheets'styles css
“wmooman“Documents My Projects'\Find it EZ\Content*Resources' Table Styles'PattemedRows css
“wmooman“Documents My Projecte'\Find it EZ\Content*Resources' Table Styles"PattemedRowsOnDarcBackground .«
“wmooman“Documerts' My Projects'\Find it EZ\Content'Resources' Table StesSimple css

“wmooman Documents My Projects'\Find it EZ\Content*Resources’ Table Styles'SimpleWith Padding .css
“wmooman“Documents' My Projects'\Find it EZ\Content*Resources' Table Styles'Standard cas
“wmooman“Documents' My Projects'\Find it EZ\Content"Resources' Table Stes' StandardOn Diark Backaground .css

aooooonn

< >

Filename Filter: |'.css| | ‘ Refresh H Select All ‘ ‘ Select Mone ‘
Use * as a wildcard.

TIP: If you hold down the CTRL Key
you can select multiple items. ‘ Add ‘ ‘ Gl ‘

l Note: Thisfilter applies to the flename itself, and does not apply to the drive letter, folders or path names.

d. Selectone or more items from the list.

Tip: Use the Select All button or hold the CTRL key then click to select multiple items.

e. Once complete, clickon thebutton. The selected files willbe added to the Only include this subset of Files list.

f. Repeat steps 5a through 5e to add additional files as desired.

AND/OR
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5. To paste a subset from the clipboard:
a. Clickon the[Paste |button. The clipboard contents will be added directly to the Only include this subset of Files list.

b. Optionally repeat Copy then Paste additional fully qualified flenames until completed.

' Alert: The clipboard may contain a single file or list of flenames, but each line must be formatted with a fully qualified path. ]

6. Toremove file(s):

a. Toremove allfiles from the list, click on the| Remove All |button.

b. Toremove only selected file(s) from the list, click to select the files you want to remove, then click on the[ Remove |button.
7. Clickon the[Close |button to apply your changes.

Databases

This section describes the procedures required to include the databases source in a project, enter database connection information,
test a database connection, reset search defaults, open results with the desired viewer / editor, and apply various database search fil-
ters.

To access project settings for databases:

1. Editthe active project using the | Projects -> Settings menu.

@ Find it EZ - My Sample Project
File | Projects | Replace Document Tools  Help
| Wizard Manage projects n Expre
! Settings I
Default
My Other Edit the active project settings. LStatim
[ F 4
My Sample
Lot TODETin, use i
[1 50| Server Benodinn Services (1l select 5 A

2. Intheframe onthe left, in the Location category, locate the Databases sub category.

Note: You may access the same dialog box with a simple right-click on the desired database in the expanded Source
panel on the left of the main application screen.

[ ] Databases *
[] Acc

L .Pu'naznl Right click to change settings.
[ ] Amazon or Uracle

[ Amzzan BOS far Protare S0l

3. Clickon the desired database name. In the first example below, we have selected the Oracle database:
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@ My Sample Project Settings ®

- Location
Local or Network Folders
Repositories Connection  Data  Tables Procedures Java Procedures Triggers Funclions Views Packages
~ SQL Server Reporting Service
... Databases Authorization Type Database Login
- Access
- Amazen RDS for MySQL Hostnams or P \ |
§ ﬂ:zg ;gg:z; ggf'gewer Port Number. [ 7] teave blank for default of 1521)
- DB2 Linwe/Unge Windows SID or Service ‘ ‘
- ImterSystems Caché
- MySQL Usemame: ‘ ‘
- ODBC

[ Include Oracle

>

Password ‘

Reriie (Lres: Comeetion |
- SAP HANA

- SAPIQ

- SAP SQL Anywhere
SAP Sybase ASE Search: [ Table Data Normal View Materilizad View
SQL Az
saL Se;ir Table Defintions
File Type

Report Lilties

Crystal Reports Triggers [ Synoryms [ Sequences
Oracle Reports

Functions [ Type Spec [ Type Body
SAP Dashboards (¥Xcelsius)

Frogramming Langusges
Ada Open Results With
C Style (C.C++.CH)
-~ COBOL

- Java

o lua

... Pascal (Delphi)

.. Parl / PHP / Puthan
< >

[[] Do not show this window each time | select a scan source item.

In the second example below, we have selected the SQL Server database:

| [ Remember

Schema =

Package Spec Package Body

Procedures Java Stored Procedures

@ My Sample Project Settings ®
- Location a | O Include SQL Server
Local or Network Folders
Repositories Connection  Data  Tables Stored Procedures  Triggers  User Defined Functions ~ Views

P SQL Server Reporting Service

- Dalabasss Authorization Type Database Login ~
- Access
- Amazen RDS for MySQL Hostnams or P \ |
- Amazon RDS for Oracle .
. Amazon RS for SL Server { leave blank for default of 1433 )
- DB2 Linwe/Unge Windows Usemame: ‘ ‘
- ImterSystems Caché
- MySaL Password ‘ ‘ [ Remember
- QDBC
- Orede (Lres: Comeetion |
- PostgreSQL
- SAP HANA Database &=
- SAPIQ Owner: =
-+ SAP SQL Anywhere

SAP Sybase ASE Search: [ Table Data Triggers [ Sequences
SQL Az
o Table Definttions Functions [ Synonyms
Filz Type Procedures Views [ Types

Report Lkilities

Oracle Reports
SAP Dashboards (Xcelsius) Open Resuks Wih
SaL Server Reports
Frogramming Languages
Ada

C Style [C.C++.CH)

- COBOL

- Java

- lua

- Pascal (Delphi)

.. Parl / PHP / Puthan
< >

[[] Do not show this window each time | select a scan source item.
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Connection Information - Databases

1. Forthe selected database, select and/or enter the required connection information. Depending upon the database selec-
ted, these settings could include:

» File Extensions Searched
» Password

» Search [Options]

* Hostnameor IP

* PortNumber

* Username

» Database

* Authorization Type
» SID or Service

+ Schema

* Owner

+ Classes

+ DSN

* Instance Number

2. Tohave Find it EZ remember your password between sessions, click to check the Remember check-box. The default set-
tingsis enabled (i.e. checked).

Note: If not saved, each time you start the Find it EZ program, you would be required to re-enter active project database
connection passwords. Otherwise, the attempt to authenticate your secure connections would fail for any index, search,
compare, replace or document process.

Alert: Passwords are not saved in plain-text; however, if you chose to save passwords, itisrecommended that you make
an effort to secure access to the configuration database.

3. Clickon the[Close|button to apply your changes.

Test Database Connection

To test your connection, click on the| Test Connection |button.

AT

Flease wait, contacting the server

1. Ifthe testis unsuccessful, you will receive an "Connection failed!" message, along with a Reason. Check your settings and
try again.

' Note: The error handling system will provide up to two messages/ alerts: J
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» Findit EZ willindicate, in general, what happened (e.g. "Unable to connect.").

» The called program may, at times, return a more detailed message that is proprietary to that target system and
often provides you with more details to help you resolve the "why" we were unable to connect. We are not in con-
trol of the content of that message or when / if it comes back, but we will always display and log the extra details
whenever possible.

Unable to connect, please check your settings and try again.

Provider Message:
Unable to log on: Could not connect to server . Please check
that the server name is correct, and that the server is running.

2. Ifthe testis successful, you will receive a "A connection was made successfully!" message.

ot

Connection made succesfully!

0K

Reset Search Defaults

On the database Connection tab or Bl Reports Options tab (see links below), the Search section contains a number of items for
which you can search. To include a set of database objects, select an item and click to check the preceding check-box.

For each database type, there is a set of default database objects normally used for code change impact analysis. To restore the
selections to the default settings that came with your Find it EZ install, click on the| Reset search defaults |button. This will also reset all
individual database object filters to “include allitems”.

Note: If any one of the default items are not selected, or if a subset of objects are filtered, the corresponding Source item in the
main application left panel will indicate this by including a Filter next to the Source item. This allows you to quickly identify when
the source database objects are filtered and may not include all documents as configured.

Open Results With

To specify the viewer / editor with which you want to open search results for the selected database, locate the Open Results With
field and click on the corresponding| Select Viewer / Editor |button.
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@ My Sample Project Settings

- Location Include Access
Local or Network Folders
Repositories
H L. 50 Server Reporting Services
*-- Databases
- ACcess
- Amazon RDS for MySQL
- Amazon RDS for Oracle
- Amazon RDS for PostgreSQL
- Amazon RDS for SQL Server

DB2 Linuwe/Unbe Windows

Google Cloud SQL
- InterSystems Caché
- MySQL
--QDBC
- Oracle
- SQL Azure
- SQL Server
File Type
Report Utilities
- Crystal Reports
-Oracle Reports

+- SQL Server Reports
-~ Programming Languages
i Ada
- C Style CC++CH)
i--Oracle Forms
- Ruby
- SGL (DBA Scripts)
i Visual Basic
. Websits Development

- Documents
- Microsoft Excel
- Microsoft Word
L. PDF

Connection  Data

File:

Password

Search

[ Do not show this window each time | select a scan source item

Open Results With:

Tables

Quenes

=]

‘ Remember

{ will be used for all password protected files in search list )

[] Table Data

Include Linked Tables

Table Definitions

[ Include Linked Tables

Select Viewer/Editor

@ Configure Viewer/Editor Settings

Category Default

Find it EZ Viewer

Windows Default Editor

Selected Application

| Databases

®

O

O

Report Lilties
Programming Languages

Documents

By Source ltem Category Default

®
®
@

Find it EZ Viewer

O
O
O

Windows Default Editor

@]
@]
O

Selected Application

R (RS R

Access

Ada

Amazon RDS for MySQL
Amazon RDS for Oracle
Amazon RDS for Postgre SGL
Amazon RDS for SAL Server
C Style (C.C++CH)

Crystal Reports

DB2 Linwe Unpe Windows
Google Cloud SGL
InterSystems Caché
Microsoft Excel

Microsoft Word

MySQL

OCO0O00O®0O0O0C0C®O0O0 0|0

000000000000

®®®®0@eee0@@ @@

000000000000

B R (RF R (RF| R RF (R ORE (R R (R Y

Use default settings H

oK ||
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Apply Database Item Filters

Depending upon the database selected, you may be presented with a number of filter options from which to choose, including:
+ Data
« Tables
» Stored Procedures
« Triggers
» User Defined Functions
* Views

» JavaProcedures

* Functions
» Packages
* Events

Each of these tabs allow you to select between including all corresponding database object items, or only specific subset of items.
This allows you to expedite the subsequent (re)indexing process as well as reduce false-positive matches in your search results.

Click on the desired filter tab (see examples below).

You may use the File Filter tab to include only a subset of specific files within the configured path(s). You must first add the desired
source path folders. Thisfilter is often used to minimize false positives or expedite indexing and searching by limiting the number of file
contentsincluded in a project. This setting can be quickly changed to include all or a subset of files as needed.

To apply a Datafilter:
1. Open the desired Database dialog box.

@ My Sample Project Settings X

- Location Include SQL Server
- Local or Network Folders
- Repostones Connectidy
P SQL Server Reporting Services
+- Databases Authorization Type:
- Access

- Amazon RDS for MySQL

¥ ﬂ:zﬁ ;gg:z; ?f;;esm_ Port Number [ ] tleave blankfor defouk of 1433)

- Amazon RDS for SQL Server Usemame ‘ ‘
DB2 Linwe/Unze/Windows
Google Cloud SQL Password ‘ ‘ Remember
IrterSystems Caché =
e
ODEBC
Oracle
SQL Azure
SQL Server

File Type Search: [] Table Data Triggers [ Sequences

REP;;;,;::"::PD“ Table Definitions Functions [ Synomyms

Oracle Reports Procedures Wiews [ Types
- 5L Server Reports

- Programming Languages Use defaultsettings

- Ada
--C Style (C.C+=CH) Open Results With
- Oracle Forms

- Ruby

- SQL {DBA Scripts)

- Visual Basic

~ Website Development
- Documents

- Microsoft Excel

- Microsoft Word
--PDF

ables  Stored Procedures  Triggers  User Defined Functions  Views

Database Login i

Hostname or IP ‘ ‘

Database &38| AdventureWorks

Cwner: | dbo
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a.

2. Clickto select the desired Data tab.

Q My Sample Project Settings

Location Include SQL Server
t- Local or Network Folders
i-- Repositories Connection Data  Tables Stored Procedures  Triggers  User Defined Functions  Views
H SQL Server Reporting Services
i Databases
Access (® Onlyinclude this subset of Tables

Amazon RDS for MySQL

Amazon ROS for Oracle
Amazon ROS for Postgre SQL
Amazon ROS for SAL Server
- DB2Z Linw/UnbeWindows
- Google Cloud SQL
- InterSystems Caché
- MySQL
- ODBC
- Qracle
-~ SQL Azure
- SQL Server
- File Type
- Report Utilties
- Crystal Reports
- Oracle Reports
~ SQL Server Reports
- Programming Languages
- Ada
- C Style (C.C++.CH)
- Oracle Forms

- Ruby
- SQL {DBA Scripts)
- Visual Basic
Website Development
Documents
Microsoft Excel
Microsoft Word
PDF

[] Do not show this window each time | select a scan source item.

3. Toaddasubset:
Click on the[Add |button. An Add Filter dialog will appear.

Add Filter

Available Tables

dbo AWBuildVersion
dbo.Databaselog
dba.EmorLog

Filename Filter: ||

Use * as a wildcard.

|‘ Refresh H Select All HSB.IectNm-ue‘

TIP: i you hold down the CTRL Key

you select multiple items . ‘

Close

The Available Tables list will be populated with a list of tables included in the folders selected previously on the Options tab.

Click to select the desired table(s).

Note: Select multiple items by holding down the key. Or, click on the[ Select All |button or the[ Select None |button, or

the[Refresh |button as desired.
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c. Tofilter by table name, use the Filename Filter:
i. Clickinside the Filename Filter text box.

ii. Enter the desired file name filter, using wildcards as desired (e.g. *.cs, *.js, *user®, etc.).

l Note: Thisfilter applies to the table name itself, and does not apply to the drive letter, folders or path names. ]

d. Selectone or more items from the list.

Tip: Use the[Select All |button or hold the(Ctrl)key then click to select multiple items.
e. Once complete, clickon thebutton. The selected tables will be added to the Only include this subset of Tables list.
f. Repeat steps 3a through 3e to add additional tables as desired.

AND/OR

4. To paste a subset from the clipboard:
a. Clickon the[Paste |button. The clipboard contents will be added directly to the Only include this subset of Tables list.

b. Optionally repeat Copy then Paste additional fully qualified flenames until completed.

' Alert: The clipboard may contain a single file or list of flenames, but each line must be formatted with a fully qualified path. J

5. Toremovefile(s):

a. Toremove allfiles from the list, click on the[Remove All |button.
b. Toremove only selected table(s) from the list, click to select the table(s) you want to remove, then click on the[ Remove |button.

6. Clickon the[Close |button to apply your changes.

Note: Normally, including database table data is disabled by default. However, in some systems it may be necessary to include
searching the contents of some system tables that either contain dynamic programming logic/ code, or that may contain type
codes or other application related content you wish to include in your change impact analysis. Because this can drastically affect
indexing size and search performance, you must select the subset of specific system tables. Searching all database tables is not
recommended.

To apply a Stored Proceduresfilter:
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1.

Open the desired Database dialog box.

Q My Sample Project Settings

Location

Local or Network Folders

Repostories

H SQL Server Reporting Services
Databases

Access

Include SQL Server

Corneclion Data  Tal Stored Procedures

Autharization Type: Database Login

Triggers  User Defined Functions

Amazon RDS for MySQL Hostriame or IF ‘

Amazon RDS for Oracle

Port Number
Amazon RDS for Postgre SGL

L I

leave blank for default of 1433 )

Amazon RDS for SQL Server

Usemams: ‘
- DB2Z Linw/UnbeWindows

- Google Cloud SQL Password ‘

- InterSystems Caché
- MySQL
- ODBC
- Qracle
-~ SQL Azure
- SQL Server
- File Type
- Report Utilties

- Crystal Reports

- Oracle Reports

~ SQL Server Reports
- Programming Languages
Ada
C Style [CC++CH)
- Oracle Forms

8| | AdventureWorks
8| doo

[ Table Data
Table Definitions

Databass

Ohwner:

Search

Procedures

Use defaultsettings

Open Results With

- Ruby
- SQL {DBA Scripts)
- Visual Basic
Website Development
Documents
Microsoft Excel
Microsoft Word
PDF

[] Do not show this window each time | select a scan source item.

Triggers
Functions

Views

Select Viewer/Editor

‘ Remember

[ Sequences
[ Synonyms
[ Types

Views

Click to select the Stored Procedures tab.

Q My Sample Project Settings

Location
Local or Network Folders
Repostories

SQL Server Reporting Services
* Databases
Access
Amazon ROS for MySQL

Include SQL Server

Cornection  Data  Tables Stored Procedures

(@ Include all Stored Procedures
(O Onlyinclude this subset of Stored Procedures

Triggers  User Defined Functions

Views

Amazon ROS for Oracle
Amazon ROS for Postgre SQL
Amazon ROS for SAL Server
- DB2Z Linw/UnbeWindows
- Google Cloud SQL
- InterSystems Caché
- MySQL
- ODBC
- Qracle
-~ SQL Azure
- SQL Server
- File Type
- Report Utilties
- Crystal Reports
- Oracle Reports
~ SQL Server Reports
- Programming Languages
- Ada
- C Style (C.C++.CH)
- Oracle Forms

- Ruby
- 50L (DBA Scripts) | ‘

- Visual Basic
Website Development
Documents
Microsoft Excel
Microsoft Word
PDF

[] Do not show this window each time | select a scan source item.
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3. Toinclude all stored procedures, click to choose the Include all Stored Procedures option. This is the default selection.
OR
Toinclude only a subset of files, click to choose the Only include this subset of Stored Procedures option.
To add a subset:

a. Clickon the[Add |button. An Add Filter dialog will appear.

Add Filter

Available Stored

dba uspGet BillOf Materials

dbo uspGetEmployee Managers
dbo uspGetManagerEmployees
dbo uspGetWhere UsedProduct 1D
dba.usp LogEmor

dba.usp Print Emor

dba usp SearchCandidate Resumes

Fiename Fiter. | | ‘ Refresh H Select All H Select None ‘
Use * 3z a wildcard.

TIP: If you hold down the CTRL Key
you can select multiple items ‘ Add ‘ | Close ‘

The Available Stored Procedures list will be populated with a list of stored procedures included in the folders selected pre-
viously on the Options tab.

b. Clickto select the desired stored procedure(s).

l Note: Select multiple items by holding down the key. Or, click on the[Select All |button or the[ Select None |button, or ]

the[Refresh |button as desired.

c. Tofilter by file name, use the Filename Filter:

i. Clickinside the Filename Filter text box.

ii. Enter the desired file name filter, using wildcards as desired (e.g. *.cs, *.js, *user®, etc.).

l Note: Thisfilter applies to the stored procedure name itself, and does not apply to the drive letter, folders or path names. ]

d. Selectone or more items from the list.

Tip: Use the[Select All |button or hold the(Ctrl)key then click to select multiple items.

e. Once complete, click on the[Add |button. The selected stored procedures wil be added to the Only include this subset of
Stored Procedures list.

f. Repeat steps 5a through 5e to add additional stored procedures as desired.
AND/OR

6. To paste a subsetfrom the clipboard:

a. Clickon the[Paste|button. The clipboard contents will be added directly to the Only include this subset of Stored Pro-
cedures list.

b. Optionally repeat Copy then Paste additional fully qualified flenames until completed.

' Alert: The clipboard may contain a single file or list of flenames, but each line must be formatted with a fully qualified path. ]
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7. Toremove file(s):

a. Toremove allfiles from the list, click on the[Remove All |button.
b. Toremove only selected stored procedure(s) from the list, click to select the stored procedures you want to remove, then click
on the[Remove |button.
8. Clickon the[Close|button to apply your changes.
Tip: Each of the database item filters, other than “table data”, workin the same way as a file filter. However, when using wildcards

to select database objects some include the object schema or owner in the format: owner.objectname . You may filter the selec-
tion list to include all objects belonging to a specific owner as follows: owner.*

See Also:

» "Localor Network Folders" on page 88
* "Viewer / Editor Settings" on page 69
* "Bl Reports" below

» "Search an Oracle Database" on page 213

» "Search aSQL Server Database" on page 217

File Type

This section provides detailed steps required to configure project settings for Programs, Documents, and Bl Reports.

Bl Reports

This section describes the procedures required to include the Bl Reports source files, reset defaults, download optional connectors,
and open search results with the desired viewer / editor.

Report files can be physically stored in one of three Locations:

» Localor networkfolders.

» Report Scheduling database repositories, such as SAP BusinessObjects Enterprise Server or a SQL Server Reporting Ser-
vices database.

» Version control system repositories, such as git, TF S, etc.

Toinclude selected report type files in a Project, you must also select and configure one or more of the possible locations these cor-
responding files can be stored within.

To access project settings for Bl Reports:
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Bl Reports

1. Editthe active project using the | Projects -> Settings menu.

@ Find it EZ - My Sample Project
File | Projects | Replace Document Tools Help
| Wizart Manage projects h Expre
! Settings N
by
Default
0 A My Other Edit the active project settings, potatist
My Sample
Lot TOOETIn, use i
[1 50l Server Benotinn Services 1l select 5 A

2. Intheframe onthe left, in the File Type category, locate the Bl Reports sub category.

Note: You may access the same dialog box with a simple right-click on the desired report utility in the expanded Source

panel on the left of the main application screen.

[] Databases *
[] fcc

L .Pu'naznl Right click to change settings.
[ ] Amazon or Uracle

I_I Arn=znn BOS for Pretans SOl

3. Clickon the desired report utility. In the example below, we have selected the Crystal Reports report utility:
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@ My Sample Project Settings

- Location
- Local or Network Folders
- Repositories
~ SQL Server Reporting Service
- Databases
- Access
- Amazon RDS for MySQL
- Amazon RDS for Oracle
- Amazon RDS for SQL Server
- DB2 Linwe/Unge Windows
- ImterSystems Caché
- MySQL
- ODBC
-~ Oracle
- PostgreSQL
- SAP HANA
- SAPIQ
- SAP SQL Anywhere
SAP Sybase ASE
SQL Azure
SQL Server
Filz Type
Report Lkilities
Oracle Reports
SAP Dashboards (¥Xcelsius)
SQL Server Reports
Programming Languages
Ada
C Style (C.C++CH)
-~ COBOL
- Java
-~ Lua
- Pascal (Delphi)

.. Parl / PHP / Puthan
< >

>

[ Include Crystal Reports

Options

Search:

Search In:

Sections:

Open results with:

[[] Do not show this window each time | select a scan source item.

Data Source and Connections
Formulas
Pictures
Record Sorting
Report Fields
Text Field Content

Report Parameters
Main Body

Report Header
Page Header

Group Header
Details

Select Viewer/Editor

|

Report Summary (Version/Author)
Funning Totals

Saved Report Data

SQL Expressions

Subreport Links

Subreport Names

Subreports

Report Footer
Page Footer

Group Footer

‘ Note: The[ Use default settings |button resets the sections and search items to the most common used program settings. J

The stepsrequired to configure individual settings for each report utility are similar to other file type source items. Each report utility
uses a unique document model to organize and manage code and content design. For Bl report designers familiar with each tool,
these report sections and page layout areas will be familiar. You may include all or a subset of these items to limit the scope of doc-
ument contents indexed and/or searched.

' Note: The|Use default settings |button resets the sections and search items to the most common used program settings. J

To specify the viewer / editor with which you want to open search results for the selected report utility, locate the Open Results With
field and click on the corresponding|[ Select Viewer / Editor |button.
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@ Configure Viewer/Editor Settings >
Category Default Find it EZ Viewer Windows Default Editor Selected Application
Databases ® O O
| Report Utilties ® @] @]
Programming Languages ® @] @]
Documents ® O O

[ SR S ) S N

By Source ltem Category Default Find it EZ Viewer Windows Default Editor Selected Application

Access

Ada

Amazon RDS for MySQL
Amazon RDS for Oracle
Amazon RDS for Postgre SQL
Amazon RDS for SQL Server
C Style (C.C++CH)

Crystal Reports

DB2 Linwe/Urice/ Windows

(gl [ SSi A “ainl Sgin] Sgu S %

|

Google Cloud SQL
InterSystems Caché
Microsoft Excel

Microsoft Word

CO0OO0O0®O|0oJCO® OO0 O0
OO0O000O00|oO0 00000
@ ®®®0@e@ee®0@@@®
[oNeoNoNeoNeNe] Io] (oMo ONONe!

MySaL

Use defzult settings | ‘ oK | ‘ Cancel

See Also:

* "Viewer / Editor Settings" on page 69

» "File Locations and Source Settings" on page 86

» "Download Connectors" on page 264

» "Reporting Tools" on page 221

» "Create a Database Cross-Reference List" on page 221

» "ldentify reports using a specified connection" on page 239

» "Findtextin atext boxin a Crystal Report" on page 243

Programs

This section describes the procedures required to include various programming language source code files in a project, add or
remove file extensions searched, and open results with the desired viewer / editor.

Programming language source code files can be physically stored in one of two Locations:
* Localor networkfolders.
» Version control system repositories, such as git, TFS, etc.

Toinclude selected programming language source code files in a Project, you must select and configure one or more of the possible
locations these corresponding files can be stored within. You must also include the programming languages in the Customization
Wizard.
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Toinclude the programming languages used in your development environment:

1. Select ( enable ) the applicable vendor technology stacks, web & bundled software appsonthe Software Plat-

forms Used tab viathe main menu Tools -> Customize -> Source :

@ Customizing - Code Search Pro Desktop - 18.041

Software Platfomns Used  Individual Components

~
Vendor Technology Stacks (4) Summary

> SQL Server Agert: Jobs
> Epic Software

> Individual Components

O m]
Microsoft [sod SAP Analytics

Manage application changes using SAP analyics
technologies indluding Crystal Reports, SAP Deshboards
SAP Hana, Sybase IQ. Sybese ASE and SQL Anywhere

Manage applcation changes using Microselt technologies
include NET. SGL Server, Azure, Acess and MS Cffice

Oracle O % 1BM ]

Manage application changes using IBM technologies
including COBOL and DB2 database.

Manage appication changes using Oracle technologies
including Java, MySQL and Oracle databases.

Web & Bundled Software Apps (4)

ASP.NET and web development O Open source development m]

Manage changes using web development languages
including C#, VB, ASP, JavaScript. HTML, XML, Peri
PHP. Python, SQL Soripts etc.

Manage changes in fies using open source languages and
databases including MySGL, PostoreSQL. Java, Lua, Per
PHP. Python, HTML. XML, Text, PDF etc.

] Manage and implement Epic heatthcare release upgrades Manage changes to software componerts and databases
with ease, including support for all underlying technalogies, used by iMIS, including SQL Server, Crystal Reports.

the whole analytice kit 4 caboodle!

|_H Epic Software s MIS software bundle m}

Business Intelligence & Report Scheduling Services (1)

> SOLServerAgentJobs

Connect to a SGL Server to extract agert job SQL
statements cortained within each job-step.

Select options and programming languages and teols used in your envirenment to custemize your Find it EZinstall. Nete that additional vender
connectors may be requred based on your selections. You wil be prompted to download and instal additional companents f needes Aoply

Cancel ‘

-
Note: You may access the same dialog box with a simple right-click on the desired programming language in the expan-
ded Source panel on the left of the main application screen.
i L]
] Programming Languages ]
[ ] Ada %
C Style {C,C+t§ﬁj w
] coeoL - - .
| Right click to change settings. I
[] Java -
[1lua D
J

2. Orclickonthe Individual Components tab, locate the Programming Languages sub category.
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Add or Remove File Extensions Searched

@ Customizing - Codle Search Pro Desktop - 13.0.41

Software Platforms Used  Individual Components

T Programming Languages
[lada

C Syle (CCosCH)
coBOL

Java

Lua

Oracle Foms
Pascal (Delphi)

Per / PHP / Python

~ | Summary

> SQL Server Agent Jobs
> Epic Software

> iMIS software bundie
> Individual Components

T Documerts

]

]

]

[ATex / sl 7 C5V
Report Utiities

[ACrystal Repotts

[Joracte Repatts

[ASSRS Repors
[ Databases
A Access

[ Corfiguration / Log Files
=

[] SAP Dashboards (Xcelsius)

[ Amazen RDS for MySQL
[)Amazon RDS for Oracle

[ Amazon RDS for PostgreSGL
[ Amazon RDS for SQL Server
[ DB2 Linux/LnixWindows

[ Google Cloud SQLfor MySQL

Select options and programming languages and toois sed in your environment to customize your Find it EZ install. Note that addifional vendor —
connectors may be required based on your selections. You will be prompted to download and install addtional components if neede Apoly ancel

3. Clickon the desired programming language(s), then click on thebutton to show / hide these available source doc-
ument types within the Include sections of the corresponding source location Options tabsin the Project Settings

configuration dialog. See below for example:

Includes

[] Cstyle (C,C++,C%) [ ] Config/ Log Files Cryctal Reports
[ ] Microsoft Excel [] Microsoft Werd [ ] Oracle Reports

[ ] PDF [ ] Perl / PHP / Python [ ] S0L (DBA Scripts)
[] S5RS Reports [] Text/ ¥ml / C5Y [] Website
See more

Note: The See more linklocated at the end of the Include lists, when clicked, auto refreshes the list of available
items to include the "hidden" but available source items. When a "hidden" item is checked, it willbecome visible going for-
ward on the Source panel on the main screen and automatically be included in your custom program settings.

4. Referto links below for more info on managing project settings.

Add or Remove File Extensions Searched

Within many organizations, corporate file-naming standards are often used for common programming language functions. You may
apply the same syntax-aware parsing of content for a given programming language by adding these file extensions to the cor-

responding source item.
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Add or Remove File Extensions Searched

1. Toadd anew custom file type, from the main menu| Tools -> Customize -> Association File Types

@ Association File Types X

Associate afie type with a specific Find i EZ Search syntax

You can also use this feature to change which application Find it EZ willuse to open search resuks

Add New
File Type Extension Search Syntax Opens Wih Application ~

W ASCX Webste Development Find t EZ Code Viewer
o Asp Webste Development Find it EZ Code Viewer
W ASPX Website Development Find it EZ Code Viewer
W CFM Webste Development Find t EZ Code Viewer
i CONFIG Webste Development Find it EZ Code Viewer
W Css Website Development Find it EZ Code Viewer
& csv Text / Xl / CSV Find t EZ Code Viewer
4 DOL SQL (DBA Scrits) Find it EZ Code Viewer
4 Doc Microsoft Word Find t EZ Code Viewer
4 Docx Microsoft Word Find it EZ Code Viewer
W Day SQL (DBA Scrits) Find it EZ Code Viewer
4 DTD Text / Xl / CSV Find t EZ Code Viewer
& HTM Webste Development Find it EZ Code Viewer
W HTML Website Development Find it EZ Code Viewer
W ey SOL (DBA Serpts) Find t EZ Code Viewer
s Webste Development Find it EZ Code Viewer
W ISP Website Development Find it EZ Code Viewer
4 MASTER Webste Development Find t EZ Code Viewer
4 ooc SQL (DBA Scipts) Find it EZ Code Viewer
W POF FOF Find it EZ Code Viewer
W PRC SQL (DBA Serpts) Find t EZ Code Viewer
4 ROL SSRS Repots Defauit Windows Appiication Microsoft SQL Server Report Buider .

) denotes a but in extension which cannot be removed

a. Clickonthe[Add New |button. A dialog will appear (as below).

&) Add/Edit Association X
Extension:
Search Syntax: Crystal Reports -
Open With: (®) Find it EZ Code Viewer

() Default Windows Application (Windows Open With {Pick an app))
() Custom Spplication

| 0K | | Cancel

b. Enter the name of the new file extension (without the leading ".").

c. Selectthe desired programming language Search Syntax tobe applied to contents of documents using this file
type extension.

Alert: You may only associate (add) unique custom filename extensions to one or more programming language. So, for
example, if you wanted to associate the file extensions “sam” to be parsed as a Java file, and / or a C#file, you can add the
same file type "sam" selecting each search syntax you would like it parsed with. However, this may produce duplicate
search results for each search syntax with the same file and is not recommended.

d. ChoseanOpens Wi th viewer/editor.
e. Clickon the[OK]button. The new file extension will be added to the File Type Extension list.
2. Toremove afile extension:

a. IntheFile Type Extension list, click to select the file extension you want to remove.

b. Clickon the[Remove |button. The selected file extension will be removed from the list.
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l Alert: You will not be able to remove any of the standard default file extensions associated with each Programming Lan- ]
guage.

3. Toapplyyour changes, click on the[ OK |button.

See Also:
» "Search Wizard" on page 129
» "Projects" on page 82

» "Viewer/ Editor Settings" on page 69

» "File Locations and Source Settings" on page 86

Documents

This section describes the procedures required to include the documents source in a project, add or remove file extensions
searched, open results with the desired viewer / editor, and select Microsoft Excel search scope options (where applicable).

Application logs, data files and office documents can be physically stored in one of two Locations:

* Localor network folders.

» Version control system repositories, such as git, TFS, etc.

Toinclude selected documents in a Project, you must also select and configure one or more of the possible locations within which
these corresponding files can be stored.

To access project settings for documents:

1. Editthe active project using the | Projects -> Settings menu.

@ Find it EZ - My Sample Project
File | Projects | Replace Document Tools  Help
| Wizar Manage projects h Expre
! Settings I
b
Default
0 R My Other Edit the active project settings. LStE‘t'm
My Sarmnple
Lokerer T ToTEgin, use t
[1 80l Server Benodinn Services (1l gelect A

2. AProject Settings dialog window willappear as below.
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@ Default Project Settings >

File Systems Include Local or Network Folders
o Local or Network Folders
Databases Options | Exclusions  File Filter
Access
DB2 Linue/Unix/Windows
Google Cloud SQL for MySQL

InterSystems Caché
MysaL C:\Users"ws Documents\ Test Cases\UofSask's v

Search Path(s):

Directory Include Sub Directories?

Oracle
PostgreSQL
+ SQL Server
SQL Server Agent Jobs
Advanced Search Fiters
Crystal Reports Add ‘ | Edit | ‘ Remove
Microscft Excel
S5RS Reports

Include: Crystal Reports Microsoft Excel Microsoft Word
[ POF [] SQL (DBA Scripts) SSRS Reports
[] Text / ¥ml / CSV [[] Website Development

Search within archivefles? (O Yes @ MNo

Note: You may access the same dialog box with a simple right-click on the desired document type in the expanded
Source panel on the left of the main application screen.

Advanced Search Flters

Crystal Reports
Microsoft Excel

Cracle F-leport5| Ri

ght click to change settings.

4. Inthetreeliston the left, locate the Advanced Search Filters sub category.

3. Clickon the desired document type. In the example below, we have selected the Microsoft Excel document type:
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Microsoft Excel Search Options

®) Default Project Settings x
File Systems Microsoft Excel
o Local or Network Folders
Databases Options
Access
DB2 Linue/Unix/Windows nclude: Formulas
Google Cloud SaL for MySGL Data
InterSystems Caché ) )
MySQL Connection Properties

Oracle
PostgreSQL
o SQL Server
SQL Server Agent Jobs
Advanced Search Fitters
Crystal Reports

Microsoft Excel

55RS Reports

Microsoft Excel Search Options

Note that when the Microsoft Excel source is selected, you are able to select from the following Search options to optimize search
performance and reduce false-positive matches:

« Formulas - include cell formula content
+ Data -include visible cell data content

+ Connection Properties -include Excelworkbook datasource connection information

Toinclude content from these items, click to check the preceding check-box (un-check to exclude).

Add or Remove File Extensions Searched

You may add custom file type extensions to be searched using the Tools -> Customize -> Associate File Types menu, which will
launch the Associate File Types dialog as below:

©2010-2019Find it EZ Software Corp. 121



Add or Remove File Extensions Searched

@) Association File Types x
Assaciate afile type with a specific Find it EZ Search syntax
You can also use this feature to change which application Find it EZ wil use to open search resuks
Add New

Fie Type Extension Search Syntax Opens With Application ~
A ASCX Websie Development Defauit Windows Application Microsoft Visual Studio 2017
(a1 ASP ‘Website Development Find it EZ Code Viewer
4 ASPX Website Development Defauit Windows Application Microsct Visual Studio 2017
& C Style (C.C++C#) Find 1t EZ Code Viewer
4 CFG Configuration / Log Fles Find it EZ Code Viewer
(4 CFM ‘Website Development Find it EZ Code Viewer
4 CONF Corfiguration / Log Fles Find it EZ Code Viewer
4 CONFIG Webste Development Find 1t EZ Code Viewer
i CPP C Style (C.C++C#) Find it EZ Code Viewer
& cs C Style (C.C++C# Find it EZ Code Viewer
& css Website Development Find it EZ Code Viewer
& csv Text / Xml / CSV Find it EZ Code Viewer

CusTOM S5RS Reports Find it EZ Code Viewer
4 oL SGL (DBA Scripts) Find it EZ Code Viewer
4 DOC Microsoft Word Find it EZ Code Viewer
4 DOCK Microsoft Word Find it EZ Code Viewer
& par SQL (DBA Seripts) Find it EZ Code Viewer
4 DTD Text / Xml /CSV Find it EZ Code Viewer
A H C Style (C.C++C#) Find 1t EZ Code Viewer
i HPP C Style (C.C++C#) Find it EZ Code Viewer
(4 HTM ‘Website Development Find it EZ Code Viewer
) HTML Website Development Find it EZ Code Viewer v
{4 denotes a buit in extension which cannot be removed

1. Toadd afile extension (where applicable):
a. Clickon the[Add Newlbutton. A dialog willappear (see below).

Extension:
Search Syrtax:
Cpen With:

@ Add/Edit Association

EXAMPL
Website Development
(@ Find it EZ Code Viewer

() Default Windows Spplication (Windows Open With (Pick an app))

() Custom Application

oK

Cancel

b. Enter the name of the new file extension (without the leading ".").

c. Selectthe Search Syntax applicable to the contents of files saved with this extension.

d. ChoseanOpen Wi th option to associate your preferred file viewer / editor with this new extension. The defaultis the
built-in Find it EZ Code Viewer.

e. Clickon the[OK]button. The new file extension will be added to the Associate File Types list.

2. Toremove afile extension:

a. Inthe Associate File Types list, click to select the custom file extension you want to remove.

b. Clickon the[Remove |button. The selected file extension will be removed from the list.

Alert: You will not be able to remove any of the standard default file extensions associated with each Document type.

These built-in file types are indicated with a lock = icon.
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Add or Remove File Extensions Searched

3. Toapplyyour changes, click on the[OK|button.

See Also:

» "Viewer/ Editor Settings" on page 69

» "File Locations and Source Settings" on page 86
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Get Started with Wizards

Get Started with Wizards

This section provides step-by-step procedures required to use the various Find it EZ ‘'wizards' to walk you through common tasks, to
perform a regular search, to use the expression builder, and to understand the features of the Searching status window (including
multitasking while searching, errors, and stopping a search).

A'wizard'is a sequence of dialog boxes that lead you through a series of well-defined steps. This section willintroduce you to the fol-
lowing four basic types of Find it EZ wizards:

* Search Wizard

* Document Wizards

* Replace Wizards

Wizards Overview

This section describes how to launch the various available Wizards, understand the purpose of each unique option, and to set the
main Wizards dialog to show (or not) on application start-up.

Launch the Wizards

The Wizards walk you through the steps required to set up and run a search, generate documentation, and perform other common
tasks. If the Show on Start-up option is selected, the Wizards dialog will open automatically when you start up Find it EZ.

‘ Note: The Show on Start-up option is selected by default when Find it EZ is run for the first time. J

If the Wizards dialog does not open automatically, follow these steps:
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Launch the Wizards

1. Click on the[Wizards |button. The Wizards dialog box will appear.

@ Wizards s

lwant to ...
SEARCH

® Search for a specific database object, code snippet, or a varizble to find any
references throughout all of my source code { including within reports and databases )

DOCUMENT
(O Bxtract database ohjects (tables, stored procedures, views, etc. ) used in my reports
(O) Generate detailed content documentation for my reports
(O Bdract all SQL code used in my reports
(O Create a database column crossTeference for my reports
() List all my reports, including printer, and update irformation
() List the schedule for my reports inside a SQL Server Reporting Services (SSRS) database

REPLACE
(O Replace Crystal Report data source connections, or qualfied table names

Show on Statup | | Next == | | Cancel

a. Clickto choose the desired search option.
b. Click on the[Next]button to continue.

2. Create or select a new project:

a. Clicktochoose the Use an existing project option, then select the desired project from the drop-down list,
OR

b. Clickto choose the Create a new project option and enter the desired project name into the corresponding text box.
c. Clickon the[Next]|button to continue.

3. Select the file types to include in your search:
a. Clickto check each item you want to include.
b. Clickon the[Next|button to continue.

4. Selectthe desired file locations:
a. ClicktocheckanyDatabases you wantto search.

b. Clickon the[Next|button to continue.

5. Enter connection information for each database.

‘ Note: If more than one source location is selected, connection information will be requested for each source. J

a. Clickon the[Test Connection |button to verify your connection.
b. Click on the[Next|button to continue.
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Wizards Options

a.

6. Enter your search criteria:

Enter a search term into the Find text box.

b. Click on the[Start Search |button. A search dialog box will appear showing the status of the search.

Searching ..
Search Tems: rebase
Search Options Boolean Search, Search Entire Document
e I 5
Scanned ] 95/97
Matches: 14
Emors\Wamings: 0
Duration: 00:00:04 - Hide Details

Scan Source Type Document

C Style (C.C++CH) Searching [master]:Praxy.cs

C Style (CC++.CH) Searching [master]:GitDiff cs

C Style CC+CH) Searching [master]:Git EmorCode.cs

C Style C.C++CH) Searching [master]:Ensure cs

Tip:  Onthe Results list Double click to view or edit source in your selected editor
~or- Flight click on any result for more options

7. Once the search is complete, results will appear in the Results window.

Wizards Options

Refer to the image and table below for a description of each option:
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Wizards Options

@ Search Assistant

|wantto ...

SEARCH

REPLACE
7

Welcome to the Search Assistant

Search for a specific database object. code snippet, or a variable to find a
® P j pp ry
references throughout all of my source code (including within reports and databases )

"~ DOCUMENT
\ (O) Bdract database objects (tables, stored procedures, views, etc. ) used in my reports
xa“o Generate detailed content documentation for my reports
=) Extract all SQL code used in my reports
— () Create a database cross-eference for my reports
/7 () List all my reports, including printer, and update information

(O) Replace Crystal Report data source connections, or qualfied table names

Show on Startup

|| Nea» ||  cancal

# Wizard sl Use Case / Document Produced S0
Shortcut Documents

Search for a specific  Seelinksat  Use Boolean or Wildcard search expressions to find allreferencesto  List XLSX
database object, end of topic. any text throughout your entire code stack, data files or office doc- List HTML
code snippet, or a uments. Search results are displayed in the main application window —_—
variable to find any with highlighted match details for each document containing a "hit." Detail
references through- Interactive to-do list results can then be used to launch an editor of XLSX
out all of my source your choice to work with the original source document, or lists can be

) . . . ) Detail
code (including updated, saved, printed or exported to various file formats such as HTML
within reports and HTML, text, CSV or Excel spreadsheets as needed.
databases)
Extract database Document -  Create a list of data source connections, server host names, data- XLSX
objects (tables, > Business  pase names, tables, procedures, views, table links (joins), call state-
stored procedures, Igtte’llltgznce ments, parameters and includes both embedded SQL SELECT
views, etc.) used in -Cro:s-aR::ei- statements from within your reports or the underlying database SQL
my reports ence code content. Results are exported to Excel with customizable column

selections.
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Show Wizards on Start-up

# Wizard Menu Use Case / Document Produced SO
Shortcut Documents
Generate detailed Document - Automatically generate detailed report documentation for your entire  HTML
content doc- > Business  rgport library in a consistent layout and format. Complete report spe-
umentation for my Igt;ll:ger:ce cifications in a standard format are exported in your choice of HTML Xt
reports beﬁ;?t;:)rn or TXT format. Create a single file for each report processed, or

export all results into file with page-breaks for each report.

Extract all SQL code Docu{nen! = Extractall SQL statements embedded within your reports, including HTML
usedin myreports > Business  rn_time derived SQL commands and table joins from a visual drag-

i ) . . TXT
f:'g’/'f:"ce and-drop designer. Export documentation to your choice of HTMLor ——
saL TXT format. Create a single file for each report processed, or export
Queries allresults into file with page-breaks for each report.

Create a database Docul_nen! = Create a complete database cross-reference for all of your reports. XLSX
cross-reference for I> B‘I’IS_’"ess List tables and database fields used within your reports by location
my reports _gtzo'ﬁ:::e (where used/ referenced). Results are exported to Excel with cus-
Cross- tomizable column selections.
Reference
List allmy reports, Document - Create a real-time list of all of your reports, including author inform- XLSX

including printerand > BUSINess  ation Jast updated, where located, etc. Results are exported to Excel

update information (S EErE with customizable column selections.

-> Report

Listing
Replace Crystal Replace -> Mass change the data source connections for a set of Crystal
Report data source Crystal Reports. Thisis useful whenever you are migrating reports between
connections or qual- g:f:;:,su';e development->test->production host environments, a database is
ified table names connections Moved to anew server, a database name has changed, the database

or qualified type has changed or you want to change the data source connection

table names type (for example you want to switch from ODBC to OLE DB con-
nection or vice-versa). Output can over-write the original source files
or be written to a new target folder (recommended).

Show Wizards on Start-up

At the bottom, left corner of the Wizards dialog box there isa Show on Startup check-box. Click to un-check this item to prevent the
Search Wizard from launching automatically each time you start the program.

See Also:

» "Perform a Regular Search" on page 150

» "Localor Network Folders" on page 88

» "Use the Expression Builder" on page 156

» "Work With Search Results" on page 166

» "Search Within Result Documents" on page 176

* "Projects" on page 82
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https://www.finditez.com/solutions/report_examples/reportdef/Combination Balance Sheet and Income Statement.html
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https://www.finditez.com/solutions/report_examples/sqlquery/Combination Balance Sheet and Income Statement.html
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https://www.finditez.com/solutions/report_examples/DatabaseCrossRef.xlsx
https://www.finditez.com/solutions/report_examples/ReportListing.xlsx

Search Wizard

Search Wizard

This section takes you through each step required to use the Search Wizard: launch the wizard (two ways), create or select a pro-
ject, selectfile types to include, select file location(s), enter connection information, enter search criteria and start the search, and
enter connection information and update reports.

Launch the Search Wizard

@ Find it EZ - My Sample Project

File  Projects Replace Document Tools  Help

|Wizard5 | #ee—-  Find: Enter Boolean E

Source S

A

[ ] File Locations

Local or Network Folders To begin, u

The Search Wizard is launched only via the[ Wizards |button (i.e. this wizard cannot be accessed via the menu), as follows:
Click to choose the Search Wizard option:

» Option 1: Search for a specific database object, code snippet, or variable to find any reference throughout all
of my source code (including within reports and databases)
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Create or Select a Project

@ Wizards X

lwantto ...

SEARCH

® Search for a specific database object. code snippet. or a variable to find any
references throughout all of my source code (including within reports and databases )

DOCUMENT
(O) Extract database objects (tables, stored procedures, views, etc. ) used in my reports

(O Generate detailed content documentation for my reports
(O) Extract all SQL code used in my reports

(O) Create a database cross-reference for my reports

() List all my reports, including printer, and update information

REPLACE
(O Replace Crystal Report data source connections, or qualfied table names

Show on Startup | | [ext == | | Cancel

Click on the[Next >> |button to continue.

The Search Wizard will open.

Create or Select a Project

Projects are used to group and save search settings, filters, and directories between sessions.
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Select File Location(s)

1. After you "Launch the Search Wizard" on page 129., the following dialog will appear:

@ Search Assistant
New Search Wizard
Create or Select a Project

Projects are used to group and save settings, filters and directories between sessions.

(® Use an existing Project
My Sample ~

(O) Create a new Project

[ Use predndexed documents

Show on Statup <z Previous | | Next == | | Cancel

2. Touse an existing project for your search:
a. Clicktochoose the Use an existing Project option (selected by default).

b. From the project drop-down list, click to select the name of the existing project (i.e. settings) you would like to use for your
search.

3. Tocreate anew project for your search:
a. Clickto choose the Create a new Project option.

b. Inthe project text box, enter the name of the new project.

4. Touse pre-indexed documents for this search, click to check the Use pre-indexed documents check-box.

Tip: Whenever possible, using pre-indexed documents will drastically improve search performance.

5. Clickon the[Next >> |button to continue.

Select File Location(s)

A number of Search Wizard options include this dialog box. See example below:

Note: The Show More linklocated to the right of the lists below, when clicked, auto refreshes the list of available items to
include the "hidden" but available source items. When a "hidden" item is checked, it will become visible going forward on the
Source panel on the main screen and automatically be included in your project and custom program settings.
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Enter Connection Information

@ Search Wizard

Select search location(s)

File Systems

Local or Network Folders

Databases

[] Access

[[] DB2 Linue/UnixWindows

[] Google Cloud SGL for MySQL
[] InterSystems Caché

] MysaL

[] Oracle

[] PostgreSQL

[] SQL Server

[] SGL Server Agent Jobs

Show More

[] Show on Startup

<< Previous

Next >

| | Cancel

1. IntheFile Systemsists, clickto selectthe storage areas within which you want to search.

2. Inthe Databases list, click to select the source database(s) within which you want to search.

3. Clickon the[Next >> |button to continue.

' Note: To go back to the previous step, click on the[<< Previous |button.

Enter Connection Information

The following example is for SQL Server Reporting Services (SSRS) connection information.

132

© 1998 - 2019 Find it EZ Software Corp.



Enter Connection Information

@) Search Wizard X

Enter the Microsoft Reporting Services connection information

Options  Report Filter

Authorization

Database Login ~
Hostname or IP: |bnbdatabase1 |
Port: |:| { leave blank for default of 1433)
Username: |sa |
Password: P | Remember
Database : 8| AdventureWorks55RS
Include: [] M5 Data Source [ M5 Shared Datasets

SSRS Reports See more

<< Previous | | Mext > = | | Cancel

[] Show on Startup

The following examples are for SQL Server database connections and local or network folders:
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Enter Connection Information

@ Search Wizard

Authorization

Hostname or IP:

Connection  Data Tables

Enter the S0L Server connection information

Stored Procedures  Triggers

Database Login

User Defined Functions

Views

[b

[] Show on Startup

Port Number: |:| (leave blank for default of 1433 )
Username: |sa |
Password: r— | Rernember
Databasze: 8| Adventurewo
Owner: §2 |"All User Schemas™ |
Include: [] Table Data Triggers [ Sequences

Table Definitions Functicns [1 Synonyms

Procedures Views [ Types

Use default settings
<< Previous | | Mext > | | Cancel
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Enter Search Criteria and Start Search

@) Search Wizard X

Enter the Local or Network Folders connection infermation

Options  Mask Filters ~ File Filter

Search Path(s):

Directory Include Sub Directories?
ChUsers\ken\Documents\Test Casesh, v
Add | | Edit | | Remove
Include: [] CStyle (C,C++,C#)  [] Config / Log Files Crystal Reports
[ Microsoft Excel [ Microsoft Word [] Oracle Reports
[ pDF [] Perl / PHP / Pythen [] SCL (DBA Scripts)
[] S5RS Reports [ Text 7 ¥ml / CSV [] Website
See more

Search within archive files? @ Yes () Mo

[] Show on Startup | << Previous | | Mext = | | Cancel

1. Onthe Options tab (selected by default), enter the connection information for the selected source.

To test the connection, click on the button where applicable.

Inthe Include section, select all document types you wish to search. Clickthe S@ee@ moxe hyperlink for additional
hidden but available document types.

l Alert: You must select at least one document type to be included from each source location. J

Note: The See more linklocated at the end of the Include lists, when clicked, auto refreshes the list of available
items to include the "hidden" but available source items. When a "hidden" item is checked, it willbecome visible going for-
ward on the Source panel on the main screen and automatically be included in your custom program settings.

4. Toapplyafiltersin order to limit the subset of documents to be included, click on any of the object Filter tabs to right of the
Options tab and see links below for more detail.

5. To continue, click on the[Next >> |button.

Enter Search Criteria and Start Search

This dialog is the final step in the Search Wizard. See below:
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Enter Search Criteria and Start Search

@) Search Wizard X

Enter search criteria

Find: |Ente|' Boolean Expression ... ~ | | Expression Builder
Example: {Order} AND {By} More Information
Filters: [ Exact Match

[] Case Sensitive
[ Include Comments
[ Comments Only

[] Show on Startup << Previous | | Start Search | | Cancel

1. Fromthe Search Type drop-down list, click to select one of the following options:
» Boolean (caninclude wildcards)
2. Inthe Find text box, enter the desired search expression.

Tip: Click on the More Information link for search expression hints, or click on the|Expression Builder putton for assist-
ance building complex boolean queries.

» Toview or select from a list of recent search expressions, click on the field to view a drop-down list and click to select
the desired search expression.

« Toperform a search using the Boolean Search Builder, click on the| Expression Builder |button. Refer to the
See Also links below.

3. Inthe Content Filters section, click to select the desired filters:

» Exact Match - exact word match for Boolean search. When enabled, matching will be attempted within each indi-
vidualword, not across words, and is case-insensitive. If disabled (default), for Boolean, this would essentially
behave like a wildcard (partial word) match.

+ Case Sensitive - match case of expression.

* Include Comments - default is disabled to reduce false-positive matches. When enabled, comments are
searched.
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Document Wizards

+ Comments Only - —defaultis disabled. When enabled, “include comments” is automatically enabled and ONLY
comments are searched.

4. Tolaunch the search, click on the[Start Search |button. A Searching ... dialog will appear. See example below:

Searching ..

Search Terms
Search Options

Indexed

rebase

Boolean Search, Search Entire Document

I /02

C Style (C.C++.CH)
C Style (C.C++.CH)
C Style (C.C++.CH)
C Style (C.C++.CH)

Searching
Searching
Searching
Searching

Scanned || 178/301
Matches: 140
Emors\Wamings: 0
Duration: 00:00:05 - Hide Details
Scan Source Type Document

[master]:UnbomBranchException.cs
[master]:Identity.cs

[master]: TreeEntryDefinition cs
[master]: TreeEntryChanges.cs

Tip:  Onthe Resutts ist Double cick to view or edit source in your selected editor
or- Right click on any result for more options

5. Tostop the search, click on the[Stop |button.

6. Once the search is complete, any results matching your search criteria willappear in the Results window.

See Also:

» "Show or Hide Source Items" on page 66

» "Perform a Regular Search" on page 150

» "Use the Expression Builder" on page 156

» "Localor Network Folders" on page 88

« "Databases" on page 102

» "Localor Network Folders" on page 88

* "Projects" on page 82

* "Use Pre-Indexed Documents" on page 153

Document Wizards

This section takes you through each step required to use the Document Wizards: launch the wizards (two ways), create or selecta
project, select file types to include, select file location(s), enter connection information, select recurrence and what to include, and
choose report options and export report.

Launch a Document Wizard

The DOCUMENT Wizards can be launched via the[Wizards |button or via the main menu. See below:
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Select Recurrence and What to Include

1. Launcha DOCUMENT wizard via the[Wizards |button:
a. Clickon the[Wizards |button in the search bar. See below:

@ Find it EZ - My Sample Project
File  Projects Compare Replace  Document  Tools  Help

|Wizards | #bee Find: Enter Boolean Expression ...

Source 44

0 Statistics | Errors (00
Rle Locations

[ BusinessObjects Bl platform 4.1 To begin, use the wizard or;

b. Clickto choose one of the following DOCUMENT Wizard options:
+ Extract database objects (tables, stored procedures, views, etc.) used in my reports
» Generate detailed content documentation for my reports
» Extractall SQL code used in my reports
» Create a database cross-reference for my reports
+ Createalist of all myreports, including printer and update information
OR
2. Launcha DOCUMENT Wizard via the Find it EZ menu:

@ Find it EZ - My Sample Project

File  Projects Replace | Document | Tools Help

| Wizards | Business Intelligence P fon L
Source €L
FY ..
i | Statistics | Errors (0]
| [ 1 File Locations

+ SelectReports -> Business Intelligence -> [Any Option]

3. Clickon the[Next >> |button to continue.
4. The selected DOCUMENT Wizard will open.

Note: The following example is the DOCUMENT Wizard for an SAP Bl Platform schedule listing, which is only available
in our Dev Surge 365 product edition. However, most of the steps and dialog boxes presented in this example are vir-
tually identical for the other Document Wizard options.

Select Recurrence and What to Include

Note: The recurrence dialog is only selected for the SAP Bl Platforms schedule listing option of the DOCUMENT Wizards; (
which can also be accessed from the menu via | Document -> SAF BOE / Crystal Server -> Report Schedules ).
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Select Recurrence and What to Include

) 54P InfoView Report Schedules X

What do you want to include?

Recumence: | All Recuming b

[] Base Reports only {Default Settings)

<« Previous | | Mext == | | Cancel

©2010-2019Find it EZ Software Corp. 139



Choose Report Options and Export Report

1. Clickon the Recurrence drop-down. A list of options will appear, as below:

@ SAP InfoView Report Schedules s

What do you want to include?

Recumence: | All Recuming

| << Previous | | Next == | | Cancel |

These are items that match up to selections in the SAP Bl Platform repository schedule frequency options.
2. Clickto select the desired recurrence.

3. Ifyouwantto show the default settings, click to check the Base Reports only check-box.

Note: Crystalreports has "Default Settings" and "Per Instance Settings." Default settings belong to the report itself (the
base report) and then each time you schedule a report you can give the report its own schedule / settings. This allows you
to just return the defaults as you may have a large number of one-time scheduled reports that will never be run again.

4. Tocontinue, click on the[Next >> |button.

Choose Report Options and Export Report

The following dialog is used with the Export Wizard. See example below:
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Replace Wizards

@ SOL Code Extract X

Choose your Report Options, then click on the Export button below to generate and save your report.

Columns:

®) Include all columns

(O) Select from the following

ocation

Host

File Path
Filename
Report Section
Data 5 e
Data Source Name
Database

Lwner

LOOH

Available Included

<< Previous | | Export | | Cancel

1. Inthe Columns section, choose to Include all columns or to Select from the following.
2. |IF the second option is chosen:

a. Inthe Available list, click to select the report column you want to include, then click on the[-> |button to move the selected
column to the Included list.

b. Tomove allcolumns from the Available list to the Included list, click on the[->->]button.
c. Toremove all columns from the Included list, click on the[<<]button.

d. Toremove asingle column from the Included list, click to select the report column you want to remove, then click on thebut-
ton.

3. Once complete, click on the[Export|button to generate and save your report. The Searching dialog will appear.

See Also:

» "Reporting Tools" on page 221
» "Create a Database Cross-Reference List" on page 221

Replace Wizards

This section takes you through each step required to use the REPLACE Wizards: launch the wizard (two ways), select where to look
for reports, enter connection information, select report destination folder, select report tables to change, choose new connection
type, and confirm information and convert.
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Launch the Replace Wizards

Launch the Replace Wizards

The REPLACE Wizards can be launched via the[Wizards |button or via the menu. See below:
1. Launch a REPLACE Wizard via the[Wizards |button:
a. Clickon the[Wizards |button in the main application window.

@ Find it EZ - My Sample Project

File  Projects Replace Document Toocls Help

Wizardsl <: Find: E
Source

<

Results  Statistics  Erors (0)
||] File Systems |

b. Clickto choose the following REPLACE wizard option:

REPLACE

() Replace Crystal Report data source connections, or qualified table names

() Set my Crystal Reports to "No Printer”

OR

Replace | Document Tools Help

| Crystal Reports ~ » Data source connections or qualified table names

Set Reports to "Mo Printer” —
Jurce = =

2.

3. The selected REPLACE Wizard willopen.

Select Where to Look for Reports

Below is an example of the "change Crystal Reports Datasource connections" replace wizard.
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Select Where to Look for Reports

@ Replace Crystal Reports Connection Information

Welcome to the Conversion Wizard

Select where you want to look for reports

(® Use an existing Project

My Sample ~

| | Mext == | | Cancel

1. Clickon the corresponding project drop-down list and select the desired project.

2. Ifyou have one or more search results selected, click to choose the Use selected documents option. This is a way of run-
ning the report with only a subset of items based on your last search.

3. Tocontinue, click on the[Next >> |button.
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Select Report Destination Folder

Select Report Destination Folder

@ Replace Crystal Reports Connection Information

X
Where would you like the updated reports placed?
(@) New Folder
|C:"-.Users"-.\rmoorrnan"-.Documents"—-.Gients"-.Flnd it EZ|
(O Ovenwrite original files
Waming: Only valid connections will be replaced. it is strongly recommended that
you save to a seperate folder and verify the results.
<< Previous | | et == | | Cancel
1. Toplace the updated reportsin a new folder, click to choose the New Folder option.
a. Clickon the folder icon to the right of the text field. A Select Folder dialog willappear.
@ Sselect Folder X
A <« Clients » Find tEZ » Test Folder v D Search Test Folder P
Organize * MNew folder =z - 9
" ~
[ This PC Name
[ Desktop Mo items match your search.
|5 Documents
# Downloads
J’! Music
&= | Pictures
B Videos vl o
Folder: | |
Select Folder Cancel
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Select Report Tables to Change

b. Create or navigate to and select the desired folder.
c. Clickon the[Select Folder |button. The selected folder path will now appear in the text field.
OR

2. Tooverwrite the originalfiles, click to choose the Overwrite original files option.

Alert: Allconverted files are written to a single pre-existing target folder. The sub-folder structure from the selected
source documents are not created in the target destination output path selected. If duplicate filenames exist in sub-
folders, the files will be over-written with the last copy converted. This is a known limitation with an enhancement planned
to auto re-create the source folder paths. As a temporary work-around, it is recommended that you convert only a single

folder of documents at a time.

3. Tocontinue, click on the[Next >> |button.
Select Report Tables to Change

FinditEZ allows replacement of multiple or a subset of database connections that may exist within each report file. You may choose to
replace only a subset of database connections, or all of them at once.

@

Select which report tables you wish to change

Table Type Connection
Financials ODEBC (RDO) ¥ireme Sample Database 11.5
Customer QDEBC (RDO) Xireme Sample Database 11.5
Employes QDBC (RDO) Yireme Sample Database 11.5
Employee Addresses ODEBC (RDO) ¥ireme Sample Database 11.5

Getting list of Report Tables

Processing file 5/18: Form Letter? mt

‘ Select All ‘ ‘ Select Mone

<< Previous | | Mext == | | Cancel

1. Alistof report tables from the selected location will load. See example above:

To stop Find it EZ from loading report tables, click on the[Stop |button.
3. Foreachreporttable to want to change, click to check the preceding check-box. Note that all report tables in the selected loc-
ation are selected by default.
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Choose New Connection Type

a. Todeselectallavailable report tables, click on the button, then click to check only those you wish to include.
b. Toselectallavailable report tables, click on the[Select All |button, then click to uncheck only those you wish to exclude.
4. Tocontinue, click on the[Next >> |button.

Choose New Connection Type

@ Replace Crystal Reports Connection Information X

Choose your new connection type

Type:

Cracle Server
xBase

| want to:
(®) Clearthe DSN qualfied table name (Recommended: Let Crystal update to match data source)
(O) Set the DSN qualfied table name to match the table name
(O) Leave the DSN qualffied table name as it is cumently set

<« Previous | | Mext == | | Cancel

1. Selectthe new connection type:
a. Clickonthe Type field to view a list of connection types.
b. Click to select the desired connection type.
2. Enter and/or select connection parameters:
a. ForAccess / Excel (DAO) and xBase, click on the folder icon and navigate to and open the desired folder.
b. For ODBC, selectthe ODBC DSN and enter the Username and Password.
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Choose New Connection Type

c. For OLEDB, Configure OLE (via Data Link Properties) and enter the Username and Password.

i. Clickon the| Configure OLE |button. The Data Link Properties dialog willappear. This dialog is opened by default.

£F| Data Link Properties X

Provider Connection Advanced Al

Select the data you wart to connect to:

(OLE DB Provider(s) 2

IEM OLE DB Provider for DEZ - IBMDECL
Microsoft Jet 4.0 OLE DB Provider

Microsoft Cffice 12.0 Access Database Engine OLE DB Pro
Microsoft OLE DB Provider for Oracle

Microsoft OLE DB Provider for Search

Microsoft OLE DB Provider for SQL Server
Microsoft OLE DB Simple Provider

M5Diata Shape

QOLE DB Provider for Microsaft Directony Services
SAP HANA MD¥ Pravider

S0L Mative Client

SQL Server Mative Cliert 11.0 v
£ >

Mext ==

Cancel Help

i. Selectthe Providerand click on the[Next button.
i. Enter Connection parameters and click on the[Test Connection |button.
iv. Enter any further required details (depending upon the selected Provider).
v. Clickonthe[OK]button.
d. For Oracle Server, enter the Service, Username, and Password.
3. TellFindit EZ what you want to do:

a. Inthel want to section, click to choose the desired option.

4. To continue, click on the[Next >> |button.
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Confirm Information and Replace

Confirm Information and Replace

Save Reports To:

New Connection Type:

Connection Parameters:

@ Replace Crystal Reports Connection Information

Please confirm the information below, then click on "Convert” below.

|C:\Users\\rmoon'nan\Documents\Clients\Flnd it EZ\Te

Access / Bxcel (DAD)

Database Name : My Database Name|
Database Type : Access|

<< Previous

1.

2.
3.

Review the following inform
+ Save Reports To

* New Connection

ation:

Type

* Connection Parameters

If changes are required, click on the[<< Previous |button. Click the button again to return to previous steps.

If the information is correct, click on the[ Convert |button. A Conversion Status notification willappear. See example below:

Conversion Status

Processing file 14/18: Record Sorting new3 mt

4. Tostop the conversion, click on the[Stop |button.

5.

Once the conversion is complete, Microsoft Excel willlaunch and open a Conversion Results spreadsheet containing a

detailed Conversion Log.
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Enter New Connection Information and Update Reports

Enter New Connection Information and Update Reports

This dialog appears only when option 10 is selected from the Wizards. See example below:

@ BOE Bl - Change Database logon information X

Enter your new connection information then click "Update Reports” below to start the update

| want to change:

(®) The existing database configuration ( original or custom)
(O To "Use original database logon information™
(O To "Use custom database logon irformation”

Update the following:
[ Server

[] Database:

[ User:
[] Password:

Note: Only checked items will be updated

Additional Options:

When viewing and scheduling report: | Cumrent Value {do not chanae)

ange
Prompt the user for database logon {viewing only)
Use 550 context for database logon (viewing only)
Use same database logon as when report is run
Use user database credentials for database logon

<< Previous | | Update Reports | | Cancel

1. Inthel want to change section, click to choose the desired option.

2. Inthe Update the following section:

a. Clickto select (i.e. check) each item that you want to update.

b. For each selected item, enter the new connection information in the corresponding text box.

' Note: Only checked items will be updated. ]

3. Inthe Additional Options section:
a. Click onthe down arrow to view the drop-down list.

b. Selectthe desired option from the list.

4. Tostartthe update, click on the| Update Reports |button.
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Perform a Regular Search

Perform a Regular Search

Aregular search is performed without the use of the Search Wizard. Search settings are applied 'manually’ and the search is ini-
tiated from the Search Bar.

|‘ Wizards. | Find: Enter Boolean Expression ... - | Options | [GREIIE | Expression Builder \I

In addition to using the Search Wizard, you can run a regular search as follows:

Select a Project

1. Fromthe Find it EZ menu, select Projects . The currently active project appears preceded by a check mark, as in the
example below:

@) Find it EZ - My Other Project

File m Compare  Replace  Document  Tools  Help
| Wizarg SETET 2 TIHEEE n Expression ..
Settings
Default
0 H My Other tatistics Errars (0)
] My Sample

o Tooeqma search, use the wiza

(M1 zelect and configure settings

[] Local or Network Folders —— _ :
| Click to set as the active project. Larc:h options on th

[] Git / GitHub

[]saLs ting Servi (3) enter your search tems or cli
erver Reporting Services

1 SWN (Suhversinn

2. Selectthe name of the project for which you want to perform a search. The selected project name will appear in the Find it
EZ window title bar (as above).
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Configure Source Location(s)

Configure Source Location(s)

1. Fromthe Source panelon the left, select the source locations containing documents you want to search:

@ Find it EZ - Default Project - o X
File Projects Replace Document Tools Help
| wizaras | Find: Enter Boolean Expression . - | options | (S | Expression Builder
Source < Results
Resuts | Statistics  Erors (0)
[ File Systems
LocalorNetwark Folders W, To begin, use the wizardor
| (1) select a Project
[ Databases 2) Gonfigure ane or more locations and tems you wish to scan
@ set Options ta optimize search results
[ Access ter your target keywordis) in the Find box, or
[ DB2 Linu/Unix/Windows s Expression Builder to help create complex Boolean queries
[] Googe Cloud SQL for MySGL CEEEE
[ interSystems Cache:
[ MysaL -~
(] Oracle \\_
[ PostareSQL
SQL Server
(] SQL Server Agent Jabs [
Advanced Search Filters
Crystal Reports

a. Clickonasourceitem. A[Project Name] Project Settings dialog willappear, showing advanced configuration settings for

the selected source location. See example to follow.

b. Configure settings, as required.

2. Example - search Local or Network Folders:

@ Default Project Settings

Google Cloud SQL for MySQL

InterSystems Cache

MySQL

Oracle

PostgreSQL
o SQL Server

SQL Server Agent Jobs
Advanced Search Fitters

Crystal Reparts

File Systems Include Local or Network Folders
+ Local or Network Folders
Databases Options  Exclusions  File Fiter
Access .
DB2 Linux/Unix/Windows Search Peths}

Include:

[ PDF

Search within archive files?

[] Do not show this windaw each time | select 2 scan source item.

[ Text / Xml /CSV

Directory Include Sub Directories?
€:\Userstken’\Documents'\ Test Cases\Uof Sask v
Add | ‘ Edit ‘ | Remove
Crystal Reparts [] Microsoft Excel [ Microsoft Word

[] SGL (DBA Scripts)
[] Website Development

O Yes @ No

[] SSRS Repotts

©2010-2019Find it EZ Software Corp.
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Set Search Options

Set Search Options

Click the[Options|button on the search bar, select the desired Content Filters to minimize false-positive search results.

E | Expression Builder |

Boost Performance:

[] Use pre-indexed documents

Content Filters:
[] Exact Match
[] Case Sensitive
[] Include Comments

[] Comments Only

Note: Default search Options are: Use Pre-Indexed documents =off/unchecked, Content Filters =
None. Your preferred search and indexing options can be changed 'on program start-up' or during 'new wizard tasks' to use this
default or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documents. This will use the last indexed document con-
tent and therefore will not refresh content with latest updates. Use thisfilter if it is known that the source documents are changed
infrequently or have not changed since the last Find it EZ project indexing.

Boolean with Wildcards Search Expressions

Search expressions syntax is boolean with wildcards. This allows you to search for field {A} OR {B} , {{A} AND {B}} OR {C}, etc. Note
that curly brackets are delimiters for words and strings between boolean operators. The wildcard character is an asterisk ( * ). For
example, if you search for "User*," the system will only find matches on items that start with the text "User."

Because of the way the search expression engine is setup, there are a few limitations:

» Wildcard is "stopped" on a white space boundary (i.e. If the text in the document is "UserName likes seafood" and you use
the search expression string "User*food" it will not find a match on this set of words separated by spaces. However search-
ing for "{User*} AND {*food}" will match on the first word and third word on in the same document. If it was "User-
Name.likes_seafood" then "User*food" will match on the single concatenated word ( individual terms joined by special
characters to form a single word ).

Exact Match Filter

When the Exact Match setting is turned on in Content Filters, the result must be found between a white space boundary (these
include spaces, tabs, periods, special characters and line feeds for strings). This is normally used to find a single, exact word match.

‘ Note: Exact match is case insensitive. J

152 © 1998 - 2019 Find it EZ Software Corp.



Use Pre-Indexed Documents

Use Pre-Indexed Documents

Thisfilter is located on the[Options|buton menu; inthe Boost Performance section. Click to check the check-box to apply
thisfilter.

For better search performance, this filter will use the last indexed document content and therefore will not refresh content with latest
updates. Thisis not an issue if it is known that the source documents are changed infrequently or have not changed since the last
Find it EZ project indexing.

Enter Target Keyword(s)

On the search bar (see image below), enter the desired search text into the Find text box.

|‘ wizards | Find: Enter Boolean Expression .. - | options “ Expression Builder ‘I
Example:
[ v | Find: [ [1] optors | BN | epression s | |

Start Your Search

1. Toinitiate the search, click on the[Search |button. A Searching window will appear, showing the status of the search.

2. Once complete, the Search Complete dialog box willappear, as in the example below:

Search Complete
Search Terms product
Search Options Boolean Search, Search Entire Document
- I /13
Scanned: I, 15/ 18 Search Complete
Matches 163
Ermors\Wamings: 0
Duration: 00:00:00
Tip:  Onthe Results list Double click to view or edit source in your selected editor _ Show Results
-or- Right click on any resutt for more options

3. Clickon the[Show Results |button. A list of results matching your search criteria will appear in the Results frame.
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View Search History

@ Find it EZ - Default Project

File Projects Replace Document Tools Help

| wizards | Find: product - | options ‘E | Expression Builder | ‘
Source < Results
Search Resul History: | 20181115 20:41:05 - “UNSAVED". Project: Defaut Boolean Search, prodt. v [ search within selected Documents
[ Fie Systems
Resuts (displaying 142cf 142)  Statitics  Erore (3)
Ll i El~  Location Type Host Fi Path or Database Document Matches 4
O bat 0 Localor Network Folders  Crystal Repot  FINDITEZT460P  Ci\Users ken\Dacuments\Test .. invaice.mt ]
[m} Local or Network Folders  Crystal Report FINDITEZT460P  C:\Us Test C 27
[ Local or Network Folders  Crystal Repot_ FINDITEZ-TAG0P__ C:\Users en\Documents\Test .._pricelist ot 15
)
] DB Lo/ Ui Windows [} Local or Network Folders__ Ciystal Repot___ FINDITEZ T460P_C:\Users en\Dacuments\Test . Interactive Sot Detal.pt
ST [m} Local or Network Folders  Crystal Report FINDITEZT460P  C:\U Test .. AACOfiicerl 2
W o = 3k O Loeal or Network Folders Crystal Report FINDITEZT460P  C:\Users\ken\Documents\Test .. Order Processing fficiency Dashboard rpt 17
[ InterSystems Cache [} Localor Network Folders  Crystal Repot  FINDITEZT460P  C:Users en\Documents\Test ... Interactive Parameters Chart ot &
O mysaL 0 SQL Senver Stored Procedure 10.8.0. Ttest finditez dhospActvateProduct 55
[ oracke O SQL Server Stored Procedure 10.80. Ttest finditez dbo spCheckForRevakedlicense 6
1 Posgesal O SQL Server Stored Procedure 10.8.0. st findtez dbo spGeiCustomerBudgetEmai 2
o%a O SGL Server Stored Procedure  10.8.0.T'test finditez dbo spSendOrderSerial Numbers 4
5L Server O SQL Server Stored Procedure 10,80, T'test findtez dbo.spCheckForlpdates 7 v
[ 5L Server Agent Jabs Details L] Show matches only
Advanced Search Fiters First | Next | Previous | Last | Match2of 51 Find in File:
-n
Crysal Reports "
omer_db/product.xml http://resources.businessobjects.com/support/downloads/samples/cr/customer_db/aaemey . xsd
/samples/cz/customex_db/product .xsd
mples/cr/customer_db/product.xml .
< >
Cystal Report
2554 matches found.
l Note: After performing a search, settings can be saved to a Project for later use again. ]

View Search History

Search history can be viewed from the search bar. To view search history:

1. Clickon the down arrow button located on the right of the Find field. A drop-down list of previous search expressions will

appear.
My Sample Project —
| Compare Replace Document Tools Help
I rebase | 5 i| B
oo
Source << || Sduser Options
- productid
s * st Performance:
ions See more T product
Use pre-ndexed do
Jects Bl platform 4.1 estate L=
menth
pork Folders year ent Filters:
jub summary
Reporting Services technical Exact Match
g bus Case Sensttive
Irsion) wehicle
marqin Include Comments

Note: This history s limited to 26 items and is preserved between program sessions. New search terms are added 'top
down.' When the list exceeds 26 items, the bottom item drops off. )
2. Clickto select the desired search expression.
N
See Also:
» "Local or Network Folders" on page 88
« "Databases" on page 102
* "Programs"onpage 115
» "Documents" on page 119
* "Bl Reports" on page 112 )
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View Search History

» "Wizards Overview" on page 124

* "Projects" on page 82

» "SetUser Options" on page 63

» "Use the Expression Builder" on the next page
« "Work With Search Results" on page 166

» "Clear Expressions History" on page 74

* "View Search Result History" on page 166
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Use the Expression Builder

Use the Expression Builder

This section provides instructions to perform a search using the Boolean Search Builder, building a search query, reviewing
example Boolean expressions, and creating a valid Boolean expression using Find it EZ custom Boolean syntax.

Open Boolean Search Builder

To launch the Boolean Search Builder, click on the| Expression Builder |button located on the right side of the search bar. See
below:

@ Boolean Search Builder X

Add ltem H Remove liem || Paste from clipboard || Import listfrom file

Search Query

oK || Cancel

Build Search Query

Click on the| Expression Builder |button to launch the Boolean Search Builder. A blank search query item is added.
To apply NOT to the current search query, click to check the corresponding NOT check-box.

Select the required number of curly brackets from the left curly bracket drop-down list.

Enter the desired search text into the Search Text text box.

Select the required number of curly brackets from the right curly bracket drop-down list.

@ g w b~

Select the desired Boolean operator (AND or OR) from the Operator drop-down list.

Find it EZ Custom Boolean Syntax

Find it EZ uses custom syntax so thatitems are recognized as Boolean operators rather than search text.

For example, to have the Boolean operator "AND" be recognized, you must enclose the search termsin curly brackets, e.g. {this}
AND {that}. The use of curly brackets is special syntax to our software. The Boolean Search Builder wizard helps with this for build-
ing / managing complex expressions, especially for first time users.
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Example Boolean Expressions

Example Boolean Expressions

For Search Syntax Examples including Boolean and Wildcard, visit: https://www.finditez.com/support/#syntax.

Add New Search Query Item

To add a new search query item, click on the| Add Item |button. A new, blank search query item line will be added.

Q Boolean Expression Builder

Search Text
| Product

Search Query
NOT{Product} OR

Remove Search Query ltem

1. Toremove a search query item, click on the right arrow button preceding the row to select the item.

' Note: You must click on the right arrow, and delete individual rows, one at a time. J
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Paste Search Query Item From Clipboard

@ Boolean Expression Builder X

[ noT { Search Text

Search Query
NOT{Product} OR

2. Clickon the[Remove Item |button. The selected item will be removed from the search query.

Paste Search Query Iltem From Clipboard

To copy a search query item to the clipboard:

1. Locate the desired search h query item text within any file or window on your system.
2. Highlight the desired text.
3. Pressthe +keys on your keyboard. The selected text will be copied to the clipboard.

To paste the copied search query item into a search query:

1. Clickon the[Paste from clipboard |button. A search query item line will be created for each instance of search text and the
correct curly brackets and operators will be applied. See example below:

Example:
Copied search query item: {insert} and {{into} AND {{Order} OR {Customer}}}
Resulting search query in Boolean Search Builder:
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Import Search Query Values From File

@ Boolean Search Builder ®
NOT { Search Text } Operator
3 {l ~ |insert } ~ |AND ~
O i ~ |into } ~ | AND v
] i ~ | Order " 1 ~|oR ~
O { ~ | Customer ] ~ v

[ oo ][ ronmeren ][] s romctisons ([ mpotiotrone |

{finsert} AND {{into} AND {{Order} OR {Customer}H

[ o« [ oma |

Import Search Query Values From File

1. Clickon the[Import list from file |button. An Open dialog box will appear.

@ Boolean Expression Builder ®

| ssen [ removoten || paetomaipions |

Search Query [ Click to import a list of line seperated values to use in the
NOT{Product} OR

Lo J[ cms |

2. Navigate to and select the file containing the list of line separated values to use in the query.

' Note: Accepted file typesinclude *.txt and *.csv. ]

3. Clickon the[Open |button. A search query item line will be created for each instance of search text.
4. Apply NOT, curly brackets to control order of expression evaluation, and operators (AND / OR) as required.
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View Search Query Details

View Search Query Details

As you are building your search query using the Boolean Search Builder, note that the entire search expression is shown in the
Search Query box at the bottom of the dialog box.

Apply Boolean Expression to Search

1. Toapply the Boolean expression to your search, click on thebutton. The search query will be entered into the Find text
box located on the search bar.

2. Tolaunch the search, click on the[Search |button.
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Searching Window

Searching Window

During a search, the Searching ... status dialog appears. See example below:

Searching ...
Search Temms: rebase
Search Options: Boolean Search, Search Ertire Document
Indexed: I
Scanned: | ] 85/97
Matches: 14
Emors\Wamings o
Duration: 00:00:04 - Hide Details

Scan Source Type Document

C Style ({C.C++CH) Searching [master]:Proxy.cs

C Style {C.C++CH) Searching [master].Git Diff cs

C Style (C.C++CH) Searching [master]GitEmorCode cs

C Style ({C.C++CH) Searching [master]:Ensure cs

Tip:  Onthe Results list Double click to view or edit source in your selected editor
-or- Right click on any result for more options

Refer to the table below for a description of each data element:

Searching

Data Ele- Description

ment

Search Thisis the search expression entered into the Find text box located on the Search Bar.

Terms

Search Thisis a summary of the current Search Type and Content Filters settings on the Options panel.

Options

Indexed This shows a visual progress display and current count of the total number of documents indexed vs the total num-

ber of documents available in the selected sources on the Source panel.

Scanned This shows a visual progress display and current count of the total number of indexed documents (above) that
have been scanned for the current search criteria (i.e. Search Terms).

Matches Thisis the total number of instances where the current search expression has been found in the source doc-
uments.
Errors / Thisis the total number of errors or warnings that have been generated while connecting and/or scanning the

Warnings source documents for search criteria matches. Once the search is complete, these can be viewed in the Results
window by clicking on the Errors tab (click on an error row to view details).

Duration Thisis the elapsed time used to index and scan the selected source documents
Status Thisisthe current Source, (Document) Type or Processing Status, and Document (Name) being scanned
Table for matches.
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Multitask While Searching

Multitask While Searching

Once a search is launched, you can continue working on other programs while Find it EZ runs unattended in the back-ground. While
a search is running, you can not minimize the Find it EZ program or use any other window in Find it EZ as the search dialog box keeps
focus until completed or cancelled. However, Find it EZ will go to the background on your desktop if you launch another program

(e.g. Word, a browser, Visual Studio, etc.).

Hide or Show Searching Details

While a search is taking place, you can view or hide search details. See examples below:

Searching ...
Search Temms: rebase
Search Options: Boolean Search, Search Ertire Document
Indered: 7 A
Scanned: 0/0
Matches: 0
Emors\Wamings 2
Duration: 00:00:40 + Show Details

Tip:  Onthe Results list Double click to view or edit source in your selected editor
-or- Right click on any result for more options

Click on the + Show Details link to expand the table showing Source, (Document) Type or Processing Status, and Document

(Name). See example below:

Searching ..
Search Tems: rehase
Search Options: Boolean Search, Search Entire Document
Indexced: - |wB
Scanned: 0/0
Matches: 0
Emors\Wamings 0
Duration: 00:00:02 - Hide Details

Scan Source Type Document

Git / GitHub Connecting

Tip:  Onthe Results list Double click to view or edit source in your selected editor
-or- Right click on any result for more options

To hide details, click on the - Hide Details link.

Show Search Results

Once a search is complete, the progress bars will stop advancing and a "Search Complete" notification will appear (see example

below).

To view results, click on the[Show Results |button.

162

© 1998 - 2019 Find it EZ Software Corp.



Stop Searching

Search Complete

Search Tems: rebase

Search Options: Boolean Search, Search Entire Document
Indexed: - |m&
Scanned: I o
Matches: 118

Emors\Wamings (1]

Duration: 00:00:04

Tip:  Onthe Results list Double click to view or edit source in your selected editor
-or- Right click on any result for more options

Search Complete

The results willappear listed in the Results window. See example below:

@ Find it EZ - Default Project

File Projects Compare Replace Reports Tools Help

- [m]

X

| Search Assistant Find: rebase - B | Advenced ||
Source << || Search Result History: | 2016-08-08 16:15:26 - Unsaved. Projsct: Defaut, Boolean Search, re | > Options
~ ~
Resu[ ] Search within selected Documents || geo .
[ Fie Locations Trpe:
" Results ( displaying 7 of 7) | Siatistics | Errers (0) @ Boolean Search
[] BusinessObiects Bl platfom 4.1
- [F]=  Location Type Host File Path () Wildcard Search
Lo o Network Fold ] Git / GitHub C Style (C/C++/.. Https://githubc..  [master]
L] Local or Network Folders O Git / GitHub C Style (C/C++/..  htps://gthubc...  [master]
[[] SQL Server Reporting Services O Git / GitHub C Style (C/C++/... https://github.c...  [master]\
[] SVM (Subversion) O Git / GitHub C Style (CAC++/... Hips://gthubc.. [master | | SOOP&S
O O Git / GitHub C Style (C/C++/.. hitps://gthubc..  [master] @ Search Entire Document
O Git / GitHub C Style (C/C++/...  hitpsi//github.c...  [master]:\
. Search Line By Li
e O Git / GitHub C Style (C/C++/..  htps://gthubc...  [master]\ ® Sk
[] Databases Fiters:
[] Access [ Word Maich
[ Amazon RDS for MySQL [ Case Sensiive
[] Amazon RDS for Oracle [] Include Comments
[] Amazon RDS for SQL Server [ Gommerts Oy
W B e et ( N [ Use preindexed documents
[ InterSystems Caché
] mysaL Details
[] obeC
[] Oracle
[ PostgreSQL
[] SAP HANA
[]saria
[] SAP 5GL Anywhers
[] SAP Sybase ASE . A
=P Finditez
v DEV SURGE v
118 matches found

Stop Searching

To cancela search in progress, clickon thebutton. A notification will appear at the bottom of the dialog. See example below:
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View Search Errors

Stopping the search

- Hide Details
Scan Source Type Document
Crystal Reports Updating Index Consolidated Income Statement

‘ Stopping the search. This may take a few moments ... O Tasks remaining ‘

View Search Errors

If a search is complete and the error countis > 0, you can view error details as follows:

1. Note the error count on the Search Completed with Errors dialog. See example below:

Search Completed with Errors
Search Terms rebase
Search Options Boolean Search, Search Entire Documert
e 11515
Scanned: S L Search Complete
Matches: 118
Emos\Wamings: 2 -iie—
Duration: 00:00:54
Tip:  Onthe Results list Double click to view or edit source in your selected editor
D T R T e R el feeuls
Click on the button.

In the Results window, click on the Errors tab.

4. Locate the error for which you want to view details and double-click on the row. Or, right-click and select  View Error from
the context menu. An error details dialog willappear. See example below:
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View Search Errors

File Projects Compare Replace Reports Tools Help
| search Assistant Find: rebase - | Advanced
Source << | | Search Result History: | 2016-18-08 16:25:42 - Linsaved. Project: Defauit, Boolean Search, rek | >> Options
~ ~
Results Search .
[ File Locations Type:
Results | Stafistics, Frrors U] (®) Boolean Search
BusnessObjects Bl platform 4.1
Location Type Host Fie Path or Database O Widcard Search
[ Local or Network Folders
| BusinessObjects Biplat... N/A ) |
Git / GitHub
[ SGL Server Reparting Services | @ BusinessObjects Bl pletform 4.1 - Error x|
[ SVN (Subversior) F
[ Team Foundation Server Location: BusinessOtjects Bl piatfom 4.1 of ] | Search Entire Document
[ Visual Source Safe T [va 4 | | search Line By Line
Host
[ Databases | |
Path/Datzbase: [ |
[ Access Word Match
Document ‘ |
[ Amazon RDS for MySQL Case Sensiive
[ Amazon RDS for Oradle Error. Enmor whie proessing /More Report: Samples/Reports/Financial/Consolidated Income A
| Statement:
[ Amazon RDS for SL Server ey
[0 DE2 Linue/ Ui/ Windows Use pre-indexed documents
[ InterSystems Caché
[ mysaL Details Failed to find an avaiable Repott Application Server.
[ opeC
[ Orece
[ PostaresaL
[ SAP HANA
O i Check Setings | | AeportABug || Clese |
[ SAP SQL Anywhere
[] SAP Sybase ASE . .
.- Finditez
hIAS > DEV SURGE hd
0 matches found

Review details of the error.

To check your project settings, click on the| Check Settings |button.
Toreporta bug, click on the[Report A Bug |button.
To close the error details dialog, click on the[ Close |button.

© N o o

See Also:

» "Work With Search Results" on the next page
» "File Locations and Source Settings" on page 86
» "Find it EZ Support" on page 245
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Work With Search Results

Work With Search Results

This section describes the procedures required to view search results, statistics, and errors; to search within documents, to view
search result details; and to save, open, copy, modify, export, and print search results.

View Search Results

1. Performasearch.

2. Results matching your search criteria will be shown in the Results window. Use the horizontal scroll bar located below the
window to view all result data columns.

[J] File Locations

Local or Network Folders
[ SGL Server Reporting Services

[ Databases

[ Access

[ Amazon RDS for MySQL

[ Amazon RDS for Oracle

[] Amazon RDS for PostareSQL
[] Amazon RDS for SQL Server
[ DB2 Linuwe/Unice/Windows
[ Goagle Cloud 5QL

[ InterSystems Caché

[ MysaL

[] obeC

[ Oracle

[ QL Azure

QL Server

[ Report Lhilities

SQL Server Repotts

“_Results ( displaying 21 of 21) | Statistics | Errors (2)

@ Find it EZ - My Sample Project — m] *
File Projects Replace Document Tools  Help
‘ Wizards | Find: product B ‘ Expression Builder
Source << | | Search Result History: |~ Select a search resuk - = Options
- Resul_] Search within selected Documents Search Type:

@® Boolean Search
O Widcard Search

Document Scope:

@® Search Entire Document
O Search Line By Line

(] Word Match

[] Case Sensitive
[ incude Comments
[ Comments Only

[C]~  Location Type Host File Pat ~
O Local or Network Folders Crystal Report Cillse
O Local or Network Folders Crystal Report C:\Use,
O Local or Network Folders Crystal Report Cllse
O Local or Network Folders Crystal Report Cillse
O Local or Network Folders Crystal Report Clse,
[m} Local or Network Folders . Crystal Report B Cisq
] Local or Network Folders ictal Banad = Cillea
O Local or Network Foiders | D0uble-click ta view/edit source or Right -click far more optians’ =
[} Local or Network Folders SRS Report Cilse
[} Local or Network Folders ~ SSRS Report Cillse
[} Local or Network Folders ~ SSRS Report Cillss
[} Local or Network Folders SRS Report Cillse
[} Local or Network Folders ~ SSRS Report Cilse v
< >

Details [] Show matches only

First | Next | Previous | Last | -n

Version 11.0 ~
Author ® 2002 Crystal Decisions, Inc.
Comments Report showing employee sales by
Drill down on product type to vit
Title Emplovee Sales (Ouarterlv Report) ¥
<
Ciystal Report

Code

Search

PRO desktop

384 matches found

See Also:

* "Wizards Overview" on page 124

» "Perform a Regular Search" on page 150

View Search Result History

After running several consecutive searches, to view previous (unsaved) search results prior to closing the program:

Note: In order for the Search Result History field to appear, you must have completed more than one search since the last
time you opened the Find it EZ program. This list of historical results is unlimited, but is automatically cleared when you exit the pro-

gram.
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View Result Source

1. Atthe top of the Results window, click on the Search Result History field. A drop-down list willappear, showing a list of
unsaved search result records tagged by date and time.

Find: user - | Ef

< Search Result History: | 2017-01-16 11:47:17 - *UNSAVED". Project: My Sample, Boolean 534 | 2> Optiol
A - Select a search result —
2017-01-16 11:32:19 - "UNSAVED". Project: My Sample, Boolean Search, produlehl Type:
B 2017-01-16 11:47:17 - "UNSAVED". Project: ample, Boolean Search.
Results ( displayin 2017-01-16 11:47-34 - *UNSAVED". Project: My Sample, Boolean Search, year ) poolean Search
T~ Tocation Type Host File Path o ) Wildcard Search
|| [l Local or Network Folders SSRS Report Chillzersts
| [l Local or Network Folders S5RS Report C:hllsersh
Document Scope:
[l Local or Network Folders SSRS Report Chllsersts
[l Local or Network Folders S5RS Report Chlsers'ys (@ Search Entire D
| SQL Server Stored Procedure Adverture () Search Line By
] SOL Server Table Definition Adventure

2. Locate and click on the desired search result record. The corresponding search results will appear in the Results window
and willinclude any annotations or items marked complete.

View Result Source

Open Result

1. Toopen the details of a matching search result with either the built-in code viewer or selected default file type editor:

a. Inthe Results window, locate and double-click on the result for which you want to open the source.

@ Find it £2 - My Sample Project - O

File Projects Replace Document Tools  Help
- | Expression Builder

Source << || Search Result History: | — Select a search resul - 22 E3E05
~

| wizards | Find: user

Resu[_] Search within selected Documents Content Filters-

. Results ( displaying 7cf7) | Statistics | Errors (3) [ Bract Match

[] File Locations See mors

Local or Network Folders

[ saL s Reporting S [[]»  Location Type Host File Path o [] Case Sensitive
erver Repoting Services
O Local or Network Folders SRS Report Clsers! 7 include Comments
O Local or Network Folders SRS Report Clsers
Databases s Comments O
t = O Local o Network Folders SRS Report CAUsers! W= siEny
[ Access O Local or Network Folders | SSRS Report CAUsersl
[ Amazan RDS for MySQL E ggt gewar Stored Procedure Adverturs
over [ =

[] Amazon RS for Cracle a e 1] Sales With OnDemand Sub.rdl - Notepad

[] Amazon RDS for PostareSGL
[ Amazan RDS for SQL Server

File Edit Format View Help

k2xml version="1.8" encoding="utf-8"2>

[ DB2 Linue/Urnix/Windows
[ Google Cloud SQL.
[ InterSystems Caché

<Report xmlns:rd="http://schemas.microsoft.com/SQLServer/reporting/rep
<Description>Report Title: Employee Sales (Quarterly Report)Report A

Drill down on product type to view sales rep's individual product sale
<DataSources>

[ wysar N <DataSource Name="DataSourcel">
[ ooec <ConnectionProperties>
[ Oracle TR e <DataProvider>SQL</DataProviders
[ sqL Azure <ConnectString»>Data Source=CRMIGRATION\SQLExpress;Initial Cata
SQL Server <IntegratedSecurity>true</IntegratedSecurity>

Data Source </ConnectionProperties>
[] Report Utilities See more DataSoul <rd:DataSourceID>FFA9A4784A7EB779E71DAFBB650B29ED< /rd :DataSource:

Nam| </DataSource>
CWSiE| Reports 1 Cenl ¢ /DataSources>
Oracle Reports <DataSets>
QL Server Reports 5SR5 Repott <DataSet Mame="DataSetl">»
Y <Fields>

<Field Name="Unit_Price">

OR
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Find it EZ Result Viewer

b. Right-click on the result and select' Open Result from the context menu.

@ Find it EZ - My Sample Project - ] X
File Projects Replace Document Tools Help
| wizards | Find: user - E | Expression Buitder
Source << || Search Result History: | Select a search resuk - > Options
~
R‘:sd Search within selected Documents Conts -
[] File Locations See more i R
Results ( displaying 7of7) | Statistics | Errors (3) [ Bract Match
Local or Network Folders =
[[]»  Location Type Host File Path o [] Case Sensitive
[ SGL Server Repotting Services X
g Local or Network Folders  SSRS Report Clkers' (e
Local or Network Folders  SSRS Report C\lsers)
Databases s Commerts O
O e O Local o Network Folders SRS Report CAUsers W= siEny
Ao O Local or Network Folders T w—,
o 0 SQL Server Open Result |, ure
[ Amazen ADS for MySQL I
O SGL Server Remove |nmra
[] Amazon RDS for Cracle O ol =
enver Settings [ Open result with the editor specified in the selected source items settings.
[] Amazon RDS for PostareSGL . !
= —————— Add File to p| Click on "Settings" to specify a new editor
rzon RDS for SOL Server
[] DB2 Linuoe/Uix/Windows Annotations
[] Google Cloud SQL Mark Completed
[ InterSystems Caché Mark Incomplete
[ wysaL < Copy Object Name >
QDBC
O Add to Boolean Term (OR) E
[ oradle
First | Mext | Previous | Last | Add to Boolean Term (AND) »
[ QL Azure
Replace Search Term
SQL Server ~
Data Souzces
[ Report Wtilities See more DataSourcel
Name DataSourcel
[ al orts Connection String Data Source=CRMIGRA
Crystal Rep v
< >
Orace Reports
SSRS Report CodeSearch
M saL s i
TAVEE o y PRO desktop

8 matches found

2. Theresultwillopenin the preselected viewer / editor depending upon the file type.

See Also:

» "Viewer/ Editor Settings" on page 69

Find it EZ Result Viewer

The Find it EZ Result Viewer allows you to view the source code for a search result document. This section describes the steps
required to open the viewer, change a location or group, navigate search results, find a file, and view or edit the source code in
another program.

Open Find it EZ Result Viewer

If" Find it EZ Viewer" is selected for the Opens wi thprogram in "Viewer / Editor Settings" on page 69, then when you "View
Result Source" on the previous page, it will appear in the built-in Find it EZ Viewer (see examples to follow). Text matching your
search criteria (i.e. matches) is highlighted in yellow within the Find it EZ viewers.

Note: The built-in Find it EZviewer is the default "Opens with" app for all file types. Contents in the viewer are searchable and
match the Details panel contents in the main Find it EZ dialog. There are three different built-in viewers:

1. Textviewer - for all source code files, displays highlighted matches content.

2. Data viewer - for database table data, displays a grid with data in cells ( columns and rows ). Column headings are the
database table fieldnames.

3. Spreadsheet viewer - for Excel documents, displays a grid with cell data, and includes display of cell formula contents.
Column headings and row numbers are like Excel (A,B,C ...)and ( 1, 2, 3 ... ) respectively.
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Navigate Search Results

Navigate Search Results

Local or Network Folders

Resu[_] Search within selected Documents

- GEEEN | Exoression Builder

>> Options

File Projects Replace Document Tools Help
| Wizards | Find: user
Source << | | Search Result Hitory: | - Select a search resut -
~
[ Fie Locations See more

Results ( displaying 7of 7) | Statistics | Errors (3)

Content Filters:
[ Exact Match

~  Location Type Host File Path o Case Sensitive
[ 5L Server Reperiing Services = ” U
O Local or Network Folders ~ SSRS Report CA\Users [ Include Comments
O Local or Network Folders SRS Report C\sers'
Databases 5 Comments O
o SRS O Local or Network Folders SRS Repott Ca\Users' [ Comments Oriy
[ Access O Local or Network Folders  SSRS Report C\Users
[ Amazon RDS for MySQL | SQL Server [ Stored Procedure Adverture]
07 Amazon RDS for Orack O SQL Server Table Definition Adverture]
szan Rbs ferbrace O SQL Server Table Definition Adverture
[] Amazon RDS for PostarsSQL
[ Amazon RDS for SQ
e —— @ Find it EZ Result Viewer - dbo.uspLogError — O
[] Goagle Cloud SQL | | First | Next | Previous | Lest | Match1of2 Find in File: -

[ InterSystems Caché

] mysaL
] obeC
[] Oracle
[] saL Azre
SQL Server

[] Report Utilities
Crystal Reports
Oracle Reports
50L Server Reports

INSERT [dbo].[ErrorLlog]

(
(a1,
[ErrorNumber],
[ErrorSevericy],
[ErrorState],
[ErrorProcedure],
[ErrorLine],
[ErrorMessage]
)

VALUES
(

CONVERT (sysname, CURRENT_USER),

ch

ktop

thes found.

To navigate through the matches found in your document, click on the First, Next, Previous, or- buttons located at the top left
of the viewer. Note that a counter to the right of the buttons keeps track of which match you are viewing; e.g. "Match 7 of 9."

©2010-2019Find it EZ Software Corp.

169



Findin File

Find in File

To search within the result document:

1. Enter the desired search text into the Find in File text box.

@ Find it EZ Result Viewer - dbo.usplogError

First | Next | Previous | Last |Match 1of2 Find in File: state

-- Data insertion/modification is not allowed
-- & transaction is in an uncommittable stat
IF XACT_STATE() = -1
BEGIN
PRINT 'Cannot log error sSince the
+ 'Rollback the transactior
RETURN:;
END

INSERT [dbo]. [ErrorLog]
(
[UserName],
[ExrrorNumber],
[ExrorSeveri
[Errnr] .
[ErrorProcedure],
[Errorline],
[ErrorMess=sage]
)

VALUES
(

CONVERT (sysname, JCURRENT_USER),

ZRROR_STATE (),
ERROR_PROCEDURE () ,

EDDAD T TME 1

Tt transaction is in an uncommittak
executing usplLogError in order to &

2. Clickonthe leftarrow (find previous) or right arrow (find next) button. OR, pressthekey on your keyboard to 'find

next.'

3. Items matching your search criteria will be highlighted in blue. Click on the right arrow button or press Enter to navigate

through the matches found.

Documents with Multiple Tabs

The Find it EZResult Viewer for some documents will contain multiple tabs. For an Excel workbook, there is one tab per worksheet
(e.g- Sheet 1) plus a tab for workbook details (Workbook Info; including database connections, etc.). For other documents, you
normally only have a single tab with highlighted code. For SAP Dashboards, this will contain a minimum of 3 tabs: Code viewer (Dash-
board code definition) + Excel worksheet + Excel workbook info (connection / author). See example below.

Search, Results, and Details panel:
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Documents with Multiple Tabs

@ Find it EZ - My Sample Project - O X

Find: Software - [GEEED | Advanced

2016-03-30 10:57:56 - Project: My Sample. Boolean Search. Software:
Search Type:

Results (. fing 10f1) | Statistics | Errors (0) | @® Boolean Search
[] BusinessObiects Bl platfom 4.1 e P ®
] - e Path or Wildcard Search
= o O [ ]
[ Git / GitHub
[] 5QL Server Reporting Services "Double-click to view/edit source or Right -click for more options” |
] SwN (Subversion) =
[ Team Foundation Server (®) Search Ertire Document
[ Visual Source Safe () Search Line By Line
Filters:
[ Word Maich
[ Case Sensitive
[ Include Comments
[] Commerts Onty
< S [ Use preindexed documents
First | Next | Previous | Last | -
[ B28 | B [Software
A B [ ~
3 Eng London Crtr |12
10 Eng london NE |12 .
Sheet1 Warkbook Info . B
Finditez
e DEV SURGE hd
3 matches found

To open the Find it EZResult Viewer, right-click on the workbook in the Details panel and select Open| from the context menu. Or,
double-click on the workbook.

Result Viewer Tabs:

@ Find it EZ Result Viewer - ExcelWithConnection.xls - O *
First | Next | Previous | Last | Match10f3 Find in File: -
| B28 | Fx |[Software
A B C ol

1

b GroupMame HoursOperation

3 Accourt Manager |16

2 Audt 16

1 Client SM 0

G Eng Cablers 12

7 Eng Contractors 12 v

Sheet1 Workbook Info

Workbook Info tab:
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Select AllResults or None

@ Find it EZ Result Viewer - ExcelWithConnection.xlsx

First | Next | Previous | Last | Match10f3 Find in File:

Zuthor : Find it EZ Software
Title : Connection Test
Last Modified By : Michael Cooper

Connections

HName : MyConnection

Command : "demo"."dbo"."data"
Command Type @ Table

£
Sheet!  Workbook Info

ODC File : C:\Documents and Settings\CADD\My Documents\My Data Sources\My
Connection : Provider=35QLCLEDB.1l;Integrated Security=535PI;Persist Securit

See Also:

* "Viewer / Editor Settings" on page 69

» "View Search Result Details" on page 181

Select All Results or None

1. Inthe header of the check-box column, click on the down arrow button. A context menu willappear. See below:

Find: product

=

<< Search Result History:  2017-01-16 12:25:08 - "UNSAVED". Project: My Sample. Boolean Search
=12 Result] | Search within selected Documents

>

&

Resulis ( displaying 21 of 21) ‘ Statistics | Errors (2)

I Location Type

-

L Local or Network Folders Crystal Report
O Local or Network Folders S5RS Report
O

]

[l

Local or Network Folders SSRS Report
Local or Metwork Folders SSRS Report
| aral ar Metwnre Frlders S5RS Renart

Host

File Path ¢ ™
Chlsers'y
Mlsers'
AUsers'y
“sersy

2000

il lmera’

Boost Perf
[ Use

Content R
[] Ea
[ Cas{
7 inciy
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Select AllResults or None

Find: product

>3

<L Search Result History: | 2017-01-16 12:25:08 - "UNSAVED". Project: My Sample, Boolean Search
o Result] | Search within selected Documents
pre
Results ( displaying 21 of 21) | Statistics | Errors (2)
B | nnaion Tim Hagt File Path¢
Ol Select Chllsersh
O all C\Users's
O none Chllzersy
O . ChlUsersy
0O itemns marked completed C\lsers's
O items with annotations CAUsersh
|| O Mark all selected as complete Chlsersy
= g Mark all selected as incomplete C\sers'y
- O C\Users
O Add selected files to project exclusion list Adventure
O Remove all selected Adventurs
0 Search for all selected Documents P 1y SN
D ST T o Adventurs
O SQL Server User Defined Fu... Adventure

Boost Pey
[ us

Content H
[ Bg
[lca
7 Ing|
[ Co

2. Toselectallresults:

* Fromthe menu, choose  Select -> All . All results will be selected (checked).

3. Todeselectallresults:

* Fromthe menu, choose | Select -> None . All check-boxes will be cleared.
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Search for All Selected Objects

Search for All Selected Objects

1.

In the check-box column, click to select (check) the result objects for which you want to search your project for references.

Search Result History: | 2017-01-16 12:25:08 - “UNSAVED®. Project: My Sample, Boolean Search
Result] | Search within selected Documents

Resulis ( displaying 21 of 21) ] Statistics | Errors (2)

[T+  Location Type File Path ¢ *
] Local or Network Folders Crystal Report ChUsers’:
[l Local or Metwork Folders S55RS Report - CHlzers’y
[l Local ar Metwork Folders S55RS Report ChlUsers'y
[l Local or Network Folders 55RS Report ChUsers’:
[l Local or Metwor Folders 55RS Report ChUzers'y
] Local or Network Folders S5RS Report ChUsers’:
[l Local or Metwor Folders 55RS Report Chzers’y
[l Local ar Metwork Folders S55RS Report ChlUsers'y
[] | geal ar Metwords Folders SSES Bepord C lsmrs™ys
S0L Server Stored Procedure Adventure
SGL Server Stored Procedurs Adverture
D SCL Server Iger Defined Fu... Adventure
[l S0L Server Uger Defined Fu... Adventure
] SGL Server User Defined Fu... Adverture
[l SCL Server Iger Defined Fu... Adverture w
£ >

In the header of the check-box column, click on the down arrow button. A context menu willappear.
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Open Viewer and Editor Settings

Search Result History: | 2017-01-16 12:25:08 - “UNSAVED". Project: My Sample, Boolean Search
Result] | Search within selected Documents

Reszults [ dizplaying 21 of 21) | Stetistics | Errors (2)

I:l - | neatine Tume Het File Path ¢ G
O Select Chsers's
| all
% none [ - “Users':
. ChUsers'y
H iterns marked completed CAlsers\y
[l iterns with annotations 5 Usarg'y
] Mark all selected as complete Crillsershy
O Mark all selected as incomplete C:.'-.Users.'-.'
ChUzers'y
Add selected files to project exclusion list Adventure
Femove all selected Adventure
| Search for all selected Documents M Adventure
] N Adverture
[l SQL Server Uger Defined Fu... Adventure
] SQL Server User Defined Fu... Adverture »
< >

3. Fromthe menu, select|Search for all selected Documents . A Continue notification message will appear.

Continue o

This will search your project for references to the selected objects

QK Cancel

4. Tolaunch the search, clickon thebutton. The search will proceed, and any results willappear in the Results window.

OR
5. Tocancel, click on the[Cancel |button.

Open Viewer and Editor Settings

To access project settings from the Results window:
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Search Within Result Documents

1.

In the Results window, right-click on any result. A context menu willappear.

@ Find it EZ - Default Project - o X
File Projects Replace Document Tools Help
| Wizards | Finds tr - | options Expression Builder
Source < Results
‘Search Result History: |~ Select a search result — v [ search within selected Documents.
[] File Systems
Resuls (displaying 245 of 245)  Statisics  Erors (1)
Ll i Elv  Locaton Tioe Host i Path or Database Document Matches &
jm} Localor Network Folders  Cystal Repot  FINDITEZTA60P  C:\Users\ken\Documents\Test .. 10519 - Research Revenue Reportfor Cash Fow .. 51
L] Databases O SQL Server Stored Procedure  10.8.0.Test findtez dbo spGetReselerSalesLead 7
[ Access O SQL Server Stored Procedure 10.8.0T\est findtez dbo spGetReselerSales eadsList 11
] DB2 Lo/ UrisWindows ] SQL Server Stored Procedure  10.8.0.1\est findite: dbo spGeteselerTier 1
O Srclies
[ Google Cloud SaL for MySaL o Open Result Ty ——Tr 2
[ InterSystems Caché O Remove dbo spGetSAPConnectorMatrixMatch 3
0 MysaL E tor Settings ofie 2
[ Oracle it = z
O Postoresal a Storet Al e P Bl dbo spSendOrderReleasedEmail 5 .
— Storm A oSkt mart Mo il it p
Change the open with editer.
AL Server Annotations. [Change the op [] Show matches onty
[ SQL Server Agent Jobs Mark Completed
First | Next | Previous | Last | Match1of Find in File: a-n
Advanced Search Fiters
+ ERowCouns int Copy ObjectHome ~
Coystal Reports , @Success int
! gError inc Add to Boolean Term (OR)
, @InvalidInpucParam in Add to Boolean Term (AND)
+ @fue bic Replace Search Term
, @False bit
—- ReturnCode constants
SET @Error = -
e - O
< >
Stored Procedure
2. Fromthe menu, clickto select Settings . The Associate File Types dialog will appear.
@ Association File Types X
Associate a file type with a specific Find it EZ Search syrtax.
You can also use this feature to change which application Find t EZ will use to open search results.
Add New
File Type Extension Search Syntax Opens With Application Q
[ ASCX Website Development Find it EZ Code Viewer
(s ASP Website Development Find it EZ Code Viewer
L ASPX Website Development Find it EZ Code Viewer
& crm Websie Development Find it EZ Code Viewer
(s CONFIG Website Development Find it EZ Code Viewer
(s CSS Website Development Find it EZ Code Viewer
s CSV Text / Xml / CSV Find it EZ Code Viewer
& DoL SQL (DBA Scripts) Find it EZ Code Viewer
(s DOC Microsoft Word Find it EZ Code Viewer
(s DOCX Microsoft Word Find it EZ Code Viewer
& oay SQL (DBA Scripts) Find it EZ Code Viewer
s DTD Text / Xml / CSV Find it EZ Code Viewer
s HTM Website Development Find it EZ Code Viewer
g HTML Website Development Find it EZ Code Viewer
ey SQL (DBA Scripts) Find it EZ Code Viewer
s JS Website Development Find it EZ Code Viewer
L JSP Website Development Find it EZ Code Viewer
(s MASTER Website Development Find it EZ Code Viewer
4 ooc SQL (DBA Scripts) Find it EZ Code Viewer
s PDF PDF Find it EZ Code Viewer
& PRC 5aL (DBA Scrpts) Find &t EZ Code Viswer
& ROL SSRS Reports Default Windows Application Microsoft SQL Server Report Bulder .
(44 denotes a buit in extension which cannot be removed.

See Also:

.

"Viewer / Editor Settings" on page 69

Search Within Result Documents

There are times when an initial search expression will yield results with false-positive matches; or, within which a secondary search
for additional terms will pinpoint what you are looking for. To search within only a subset of search result documents:
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Search Within Result Documents

1. Atthe top of the Results window, click to check the Search within Documents check-box.

@ Find it EZ - My Sample Project - m] ®
File Projects Replace Document Tools Help
| Wizards | Find: user - \ Expression Builder
Source << || Search Result History: - Select s sascch.cas ik > Options
~
Search within selected Documents -
[ File Locations See more | o=
Reslts ( displaying 7 of 7) oSty [ Bxact Match
Local or Network Folders =
- cation ype lost il Path o se Sensitive
Lo T H Fie Path [ Case 5

[ SGL Server Reporting Services

[m| Local or N Foldes  SSRS Report C:\Users [

[m| Local offffetwork Folders SRS Report C:sers)
[ Datcbases Ses more O Local or Network Folders SRS Report CAUserss W s ey
[ Access O Local or Network Folders SRS Report C:\Users

Erver tored Procedure venture’

[ Amazon RDS for MySQL 0 SGL 5 Stored Proced Ad

[m} SQL Server Table Definition Adventure]
(W e (e = ] SQL Server Table Definition Adventure]
[ Amazon RDS for PostereSQL
[ Amazon RDS for SQL Server
[ DB2 Linuwe/Unée/Windows
[ Google Cloud SQL
[] InterSystems Caché
O mysaL < >
[ opec Details [] Show matches only
[ Orece

First | Nest | Previous | Last | -n
[ saL Aure
SGL Server Description Converted from Crystal REpPOTT!A

Data Scurces
[ Repert Utilities See more DataSourcel
Name DataSourcel

Crystal Reports Connection String Data Source=CRMIGRA® Y

< >
Oracle Reports
oL Server iers 858 et CodeSearch

w r PRO desktop
Smatches found

On the search bar, enter the desired search text into the Find text box.

| Find: ProductlD

Once complete, the Search Complete dialog box willappear.

Click on the[Search |button to initiate the search. A Searching dialog box will appear, showing the status of the search.

4.
Searching - th
ltems (re)lndexed: 482
Time Elapsed: 00:00:08
Tip:

ltems Searched: 368/ 368 Errors\Warnings:

Matches Found: 7166

Local Files Databases Analyzing Searching
Results

Search Complete

On the Results list Double click to view or edit source in your selected editor
-or- Right click on any result for more options

0
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View Result Statistics

5. Clickon the[Show Results |button. A list of results matching your search criteria willappear in the Results frame.

Search Result History:  2017-01-16 14:20:52 - *UNSAVED™. Project: My Sample. Boolean Search
Result[ | Search within selected Documents

Resultz ( dizplaying 2 of 2) JStatistics Errors (0)

[T+  Location Type Host File Path or D
O SQL Server Stored Procedure . -
[l S0L Server Stored Procedure AdvertureVWo
< >

Details [] show matches only

First | Mext | Previous | Last | " »

~

CREATE PROCEDURE [dbo]. [uspGetWnereUsediqeliieagin]
@StartProductID [int],
ECheckDate [datetime]
S ~
< >

Stored Procedure

View Result Statistics

Inthe Results window, click on the Statistics tab. Use the horizontal scroll bar located at the bottom of the window to view all data
columns; Location, Type, Documents, Matches.

View Result Errors

In the Results window, click on the Errors tab. Use the horizontal scroll bar located at the bottom of the window to view all data
columns; Location, Type, Host, File Path or Database, Document.

Click on an individual error item for more details. These errors and warnings often provide instructions to resolve the issues logged.

Add an Errant File to the Project Exclusion List

. Note: This option is available only for results sourced from Local or Network Folders. ]

178 © 1998 - 2019 Find it EZ Software Corp.



Add an Errant File to the Project Exclusion List

Purpose: If one or more files come up in the Results window Errors tab list, and (for example) the file is corrupt, can't be opened, or
is on the Results list and you know you don't want to include this particular file in future search passes for this project's Local or Net-
work Foldersfiles, you can use this option to add it to the project file exclusion list quickly and easily, as follows:

1. Onthe Errors tab list, locate the file that you want to add to the current project's search exclusion list.

2. Right-click on the file. A context menu will appear.

Search Result History:  — Select a search result — ~

Results [] Search within selected Documents

Results ( displaying 1of 1) | Statistics . Emors (1)
Location Type Host File Path or Database Document Emor

Local or Metwork Folders  N/A ChUsers'ken\Documant='Tact Cazacioar ok i Unable to load the report
View Error

[ AddFile to Project Exclusion List |

3. Fromthe menu, select|Add File to Project Exclusion List . The selected file will be added to the Exclude File(s) / Folder
(s) listin Project SettingsMask Filters tabforLocalor Network Folders.
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Add an Errant File to the Project Exclusion List

Options  Mask Fitters  File Filter

Include files, folders and archive with the following masks:

Enter each item on a seperate line.

Import Reset Use * for wildcards.

[Exclude files, folders and archives with the follawing masks:

Chlsers w0 Documents' Test Cases'Some_FindkEZ_Crystal_Tests'\Crystal - Formula Emortbroken.pt
Chlsers » Documents’ Test Cases' 3128 Incomplete Provider Motes pt

Enter each item on a seperate line.

Import ‘ | Clear Use * for wildcards

4. Anysubsequent search or documentation process will exclude this errand / corrupt file.

See Also:

» "Add File(s) to Project Search Exclusion List" on page 203
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View Search Result Details

View Search Result Details

1. Inthe Results window, click on the result for which you want to view details. See example below:

@ Find it EZ - My Sample Project — m] *
File Projects Replace Document Tools  Help
| wizards | Find: user - ‘ Expression Builder
Source << | | Search Result History: |~ Select a search resuk - = Options
~
Resul] Search within selected Documents Conts -
[ File Locations See more 3 Rl
oot or Nt P " Results ( displaying 7 of 7) | Statistics | Errors (3) [ Exact Match
cal or Network Folders ~
i [[]~  Location Type Host File Path o [ Case Senstive
[ SQL Server Reporting Services
E Local or Network Folders SRS Report Ci\lsers) [ Include Comments
Local or Network Folders ~ SSRS Report C\Users
[ Databases Seemore || Local or Network Folders SRS Report CA\Usersh [ Commeris Only
[ Access [} Local or Network Folders  SSRS Report Ci\lsers)
[ Amazon RDS for MySaL [} SQL Server Stored Procedure
[ ———— O SQL Server Table Definition Adventure!
(W e (e = O SGL Server Table Definttion Adventure]
[ Amazon RDS for PostgreSQL
[ Amazon RDS for SQL Server
[ DB2 Linuwe/Unice/Windows
[ Goagle Cloud 5QL
[ InterSystems Caché
] mysaL < >
[ opec Details [[] Show matches only
[ Oracle
First | Next | Previous | Last - »
[ saL Az
ure
5QL Server END N
D Re Utilities S INSERT [dbo].[ErrorLog]
(
Crystal Reports PN ame . v
Oracle Reports 3 >
P Stored Procedurs CodeSearch
o y PRO desktop
8 matches found

» Details willappear in the Details window located below the Results window (as above).

* Matches are highlighted in each line where they appear, and lines are numbered.

» Toview only those lines with a match, click to check the Show matches only check-box. See below.

‘ Note that the line numbers are hidden when this option is checked.

» Tosearch Details, enter your search text into the text box and click on the First, Next, Previous, Last, or arrow buttons.

First | et | Previous | Last |

- »

» Toopenthe Find it EZ Result Viewer, right-click inside the Details paneland select Open from the context menu. You can

also | Select All and Copy using the same method.

Details [[] show matches only
First | Mext | Previous | Last | " »
Picture BOLogo Py
Size 150=x40
Hyperlink httn: /S  busine,;
Text Fi Open
Tex Busin ¥
£ Select All  CTRL-A >
Crystal Report Copy CTRL-C

* The Show matches only option is auto-synchronized to the Automatically expand details user option (see link below).
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Copy Detail Item to Clipboard

When turned on, you will see the full context of the searched document with line numbers. When turned off, only lines with

matches will appear (without line numbers).

@ Find it EZ - My Sample Project

File Projects Replace Document Tools Help

| wizards | Find: user

- o e

o @‘ Expression Builder

Source <« Search Result History: - Select a search result —

~

[ File Locations

Search within selected Documents

> Options

Content Filters:

See more

. Results (displaying 7 of 7) | Statistics | Errors (3)

Location Type
Local or Network Folders SRS Report
Locdl or Network Folders— SRS Report
Local or Network Folders SSRS Report
Local or Network Folders SRS Report
SGL Server Stored Procedure
SQL Server Table Defintion
SQL Server Table Defintion

Local or Network Folders

Host
[ SGL Server Repotting Senvices "

‘

[0 Databases Ses more

[ Access

[ Amazon RDS for MySQL

[ Amazon RDS for Oracle

[] Amazon RDS for PostareSQL
[[] Amazon RDS for SQL Server
[ DB2 Linuwe/Unie/Windows
[ Google Cloud QL

[ InterSystems Caché

[ MysaL <
[ obBC

0000000

Details

(] Show matches only

[ Exact Match

[ Case Sensttive
[ include Comments
[ Comments Orly

File Path o
C:\Users’
Co\Jsers’
C\Users'
Co\sers
Adventure
Adventure
Adventure

[ Oracle

[ saL Asure First | Next | Previous | Last |

-»

[[Etane],

CONVERT (sysname, CURRENT USER},

SQL Server

[ Report Uhilities

Crystal Reports
Oradle Reports
SQL Server Repotts

See more

<

Stored Procedure

CodeSearch

PRO dasktop

8 matches found

Note: The Show matches only option is auto-synchronized to the automatically expand details user option (see link
below). When turned on, you will see the full context of the searched document with line numbers. When turned off, only

lines with matches will appear (without line numbers).

Copy Detail Item to Clipboard

1. Locate the matching instance line that you want to copy to the clipboard.

2. Right-click on the selected line. A context menu will appear.

Uzed Colum=

Details [] show matches only
First | Mext | Previous | Last | " »
Report Llias Product_Type ~

pEELS Sy, Product Type Namf

Open
< I Select Al CTRL-A
Crystal Report Copy [: CTRL-C

3. Fromthe menu, select/ Copy . The selected line will be copied to the clipboard.

4. Paste the copied text to the desired target location which can be another program or external editor.
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Copy Search Results Document Names

Copy Search Results Document Names

This section describes the steps required to copy a search results match document name to the clipboard, add an document name to
the Boolean search term, or replace the Boolean search term with a selected result document name.

Copy Document Name to Clipboard

1. Inthe Results list, locate the file (line match) you want to copy the corresponding document name from.

2. Right-click on the file (line match). A context menu willappear.

Search Result History: | 2017-01-16 12:25:08 - “UNSAVED™. Project: My Sample, Boolean Search
Result] | Search within selected Documents
Resulis ( displaying 21 of 21) ] Statistics | Errors (2)
[T+  Location Type Host File Path ¢ *
[l Local ar Metwork Folders S5RS Report ChlUsers'y
] Local or Network Folders S5RS Report ChUsers':
[l Local or Metwor Folders S5RS Report Chzers’y
[l Local ar Metwork Folders S5RS Report ChlUsers'y
O Open Result
] SQL Server Adventure
] S0L Server Remove Adventure
Ol SGL Server Settings Adventure
0 SQL Server Add File to Project Exclusion List Adverture
] SQL Server Adventure w
e Annotations >
Mark Completed matches only
Mark Incomplete
First | Mext | Previous - »
i Copy Object Name K o
-
CREATE FROC Add to Boolean Term l[_'@ﬂ] als]
BEStarth Add to Boolean Term (AND)
ECheckD Replace Search Term
as ¥
< >
Stored Procedure

3. Fromthe menu, select Copy Object Name. The name of the selected file (line match) will be added to the clipboard.

Add Object Name to Boolean Search Term

1. Inthe Results list, locate the file (line match) you want to add the corresponding document name as an additional search
term in your existing F1nd expression.

2. Right-click on the file. A context menu will appear.
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Replace Boolean Search Term

Search Result History: | 2017-01-16 12:25:08 - “UNSAVED". Project: My Sample, Boolean Search
Result] | Search within selected Documents
Results ( displaying 21 of 21) ] Statistics | Errors (2)
[T+  Location Type Host File Path ¢ *
[l Local or Metwor Folders S5RS Report Chlzers’y
] Local or Network Folders S5RS Report ChUsers’:
[l Local or Metwor Folders S5RS Report Chzers’y
U Local or Metwork Folders S5RS Report ChUzers'y
0 SQL Server Open Result m
[l SQL Server Adverture
] SQL Server Remove Adventure
[l SGL Server Settings Adverture
0 SQL Server Add File to Project Exclusion List Advertture
] SQL Server Adventure w
< Annotations 3
Mark Completed tches only
Mark Incomplete
First | Mext | Previous | I - »
Copy Object Name
-
ceaTE procern|  Addto Boolean Term (OR) N -1
@StartPro Add to Boolean Term (AMND)
ECheckDat Replace Search Term
a5 ¥
< >
Stored Procedure

3. Fromthe menu, select/Add to Boolean Term (OR) OR Add to Boolean Term (AND) , as desired. The name of the selected
file object will be appended to any existing search term in the Find text box (on the search bar) with the selected boolean
expression AND / OR operand. See example below:

Find: {ProductiD} OR {dbo.uspGetBillOfMaterials}

o | Expression Builder | ‘

Replace Boolean Search Term

1. Inthe Results list, locate the file (line match) with the corresponding document name you want to use as the next Boolean
search term. For example, if you now want to search for all references to the selected document name in your next search.

2. Right-click on the file. A context menu will appear.
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Modify Search Results

Find: {ProductiD} OR {dbo.uspGetBillOfMaterials}

5

L.

Search Result History: | 2017-01-16 12:25:08 - *UNSAVED®. Project: My Sample, Boolean Search

Result{_] Search within selected Documents

Resulis ( displaying 21 of 21) ‘ Statistics | Errors (2)

E- Location Type Host File Path c ™
| Local or Network Folders 55RS Report Chllsers'y
O Local or Metwork Folders S5RS Report Chlsers'y
[l Local or Network Folders 5SRS Report ChlUsers'y
0l Local or Network Folde: Open Result ==
O SGL Server Venture
|:| SGL Server Remove Wenture
[l SQL Server Settings Wenture
Ll SQL Server Add File to Project Exclusion List perture
O SGL Server enture
|:| SGL Server Annotations WEMTLNE
< Mark Completed >
Mark Incomplete only
First | Mext | Previous | Last Copy Object Name - »
Name Add to Boolean Term (OR) ~
Query Add to Boolean Term (AMD)
Data
Replace Search Term .
Commarraresr lag

il

>

2

3. Fromthe menu, select Replace Search Term .The name of the selected line match document name will replace any existing

search term in the Find text box (on the search bar). See example below:

| Find: Sales With OnDemand Sub_sub_subsales.rdl

- | Expression Builder | ‘

4. Click the[Search]button on the search bar to find all references to that document name within your active project.

Modify Search Results

This section provides step-by-step instructions to mark search result items complete or incomplete, add or edit result annotations,
remove an item(s) from search results, and to add a file to a project's search exclusion list. You may want to break up a listinto smaller
sub-lists for redistribution, or remove false-positive matches, etc.

Mark Item(s) Complete or Incomplete

1. Inthe Results window, locate the result you want to mark complete or incomplete.

2. Right-click on the result row. A context menu willappear.
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Mark Item(s) Complete or Incomplete

Search Result History: | 2017-01-16 12:25:08 - “UNSAVED". Project: My Sample, Boolean Search
Result] | Search within selected Documents
Resulis ( displaying 21 of 21) ] Statistics | Errors (2)
[T+  Location Type Host File Path ¢ *
[l Local or Metwor Folders 55RS Report Chlzers’y
] Local or Network Folders S5RS Report ChUsers’:
[l Local or Metwor Folders 55RS Report Chzers’y
[l Local or Metwor Folders 55RS Report ChUzers'y
O Sletene Open Result
[l S0L Server Adverture
] S0L Server Remove Adventure
] S0QL Server Settings Adventure
0 SQL Server Add File to Project Exclusion List Adverture
] S0L Server Adventure w
£ Annotations >
” Mark Completed . only
Mark Incomplete
First | Mext | Previous - »
; Copy Object Mame
1 -
2 CREATE PROCH Add to Boolean Term (OR) b1=)
3 i @5tart Add to Boolean Term (AMD)
e ECheckD Replace Search Term
= i AS ¥
< >
Stored Procedure

3. Clickto select Mark Completed or Mark Incomplete, as desired.

» Ifmarked complete, a green check-mark will appear preceding the result.

+ Ifacompleted resultis then marked incomplete, the green check-mark will be removed.

[+  Location - Type Host File Path ¢ ™
[l Local or Networ: Folders 55RS Report C:sers'
[l Local or Networs Folders 55RS Report Csers'y
[l Local or Networs Folders 55RS Report Csers'y
D Ludl O TNELWUTR, TUIICT a2 Mg TUCHILITL L.'\.M
] B 501 Server qtcred F'mc:edure - Adventurd
[l Set=-Gere Ghe i

] SaL Senrer User Deflned F|.|... Adventure
[l S0L Server User Defined Fu... Adventure
] SQL Server Uzer Defined Fu. . Adventure
] S0L Server Uszer Defined Fu... Adventure w
£ >
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Mark All Complete or Incomplete

Mark All Complete or Incomplete

1. Inthe check-box column, click to select the results you want to mark complete or incomplete.

| Rexzultz  dizplaying 21 of 21) I Statistics | Errors (2)

4

A DOORRORROL H

Location Type

Local or Metwork Faolders S55RS Report
Local or Network Folders 55RS Report
Local or Metwor Folders 55RS Report

Host File Path o *™

Chlsers's
ChUsers':
CMzers’y

Local or Netwark Folders S55RS Report . - Chilsersy

SGL Server Stored Procedurs
SCL Server Stored Procedure

Uger Defined Fu...
SGL Server User Defined Fu...
S0L Server User Defined Fu. ..
S0L Server Uger Defined Fu...

Adverture

Adventure

Adventure

Advenrture

Adverture

Adventure w
>

2. Inthe header of the check-box column, click on the down arrow button. A context menu will appear.

4

Results ( dizplaying 21 of 21) | Ststistics | Errors (2)

| neaticn Tima

File Path ¢ *

Select
all
none
items marked completed

items with annotations

Chzers’y
CMUsersy
Chlsers's
= C:AlUsers'y
Adventure
Adverture

.Emmm -

Mark all selected as complete P

| Adventure

Mark all selected as incomplete

| Adventure
Adverture

~ OOORRORROO F

Add selected files to project exclusion list
Remove all selected

Search for all selected Documents

Adventure
>

[[] show matches only

ranp—

3. Tomarkthe selected results complete, select Mark all checked as completed from the menu. A green check mark will
appear preceding each selected result.

OR

4. Tomarkthe selected resultsincomplete, select Mark all checked as incomplete from the menu. Green check marks will
be removed preceding each selected result.

your results, you will be prompted to save your search results, continue without saving, or keep the program open.

l Note: If any search results have been marked complete and you attempt the exit/close the program without first saving ]
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Select All tems Marked Completed

Select All Items Marked Completed

Tolocate and select all results that have been marked completed:

E - Location Type Host File Path o r
] Local or Metwor Folders S55RS Report ChUsers®
L] Local or Network Folders S5RS Report CAllsers'y
] ' Local or Network Folders S55RS Report ChUsers®
] Local or Metwor Folders S55RS Report ChUsers®
]+ 50LServer Stored Procedure Adventurs
] SQL Server Stored Procedure Adventurs
]+ 50LServer Ilzer Defined Fu... Adventurs
] SQL Server Ilzer Defined Fu... Adventurs
]+ 50LServer Ilzer Defined Fu... Adventurs
] SQL Server Ilzer Defined Fu... Adventure
£ >

1. Inthe header of the check-box column, click on the down arrow button. A context menu will appear.

Resulis [ displaying 21 of 21) | Sististics | Errors (2)

R =i T LL File Path ¢ ™
Select

[l |: - Chlsers'
] all 1 Chlsers'y
] none CiUsers'y
O | iterns marked completed M CA\Users'y
U - - - Adverture
N iterns with annotations Adventure
[l Mark all selected as complete Adverture
E Mark all selected as incomplete Adventure

i i - Adventure
H Add selected files to project exclusion list Adventure v
< Remove all selected 3

Search for all selected Documents

[] show matches only

| . .1 o

2. Fromthe menu, choose Select -> items marked completed . All results previously marked completed will be selected
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Add or Edit Annotations

(checked).

[]+  Location Type Host File Path ¢ ™
] Local or Network Folders S5RS Report Clsers'
i Local or Network Folders 55R5 Report Csers'
" Local or Network Folders 55R5 Report Csers'
[l Local or Networ: Folders S5RS Report C:sers'
" S0L Server Stored Procedure Adwventure
] SQL Server Stored Procedure Adventure
" 50L Server User Defined Fu... Adventure
] SQL Server User Defined Fu... Adventure
" 50L Server User Defined Fu... Adventure
T SQL Server User Defined Fu... Adventure w
< >

See Also:

» "Select AllResults or None" on page 172

Add or Edit Annotations

This section outlines the procedures required to add, view, edit, or delete an annotation or to locate and select all items with annota-
tions. Annotations are task assignment or instructions to others or reminders to self for action required on a given search result item.
These annotations can then be exported directly to MS Project or distributed via search result lists as a column of information that is
included.

Add Annotation

1. Inthe Results window, locate the result to which you want to add an annotation.

2. Right-click on the result row. A context menu willappear.
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Add Annotation

Results ( displayang 21 of 21) | Statistics | Errors (2)
Fa
[[]=  Location Type Host File Path ¢ *
U Local or Metwork Folders S5RS Report ChUzers'y
] Local or Network Folders S5RS Report ChUsers’:
TV Loca o oo Flders
g Local or L3 Open Result -
[l Local or Networ Folders Lisers'y:
" S0L Server Remove renture
] SQL Server Settings yerture
v SQL Server Add File to Project Exclusion List yerture
[l SQL Server enture
" S0L Server Annotations rerture
I,
[l SQL Server Mark Completed Loy enture s
< Mark Incomplete *
: only
Copy Object Mame

First | Mext | Previous Last Add to Boolean Term (OR:I . ‘

Con Add to Boolean Term (&MNDY s

Texts7 Replace Search Term

Hame Ea=ro—- o

Type Text Box

Content [rEnindive Cough ~

3. Fromthe menu, select Annotations . An Add/Edit Annotations dialog willappear.
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Add Annotation

@) Add/Edit Annotations X
Date Entered By
Add New | | Delete
Date:
Entered By:
Comments:
Close

4. Clickonthe[Add New]button. A new entry will be added, including the current date, time (in the Date field), and username
(inthe Entered by field).
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Add Annotation

@) Add/Edit Annotations *
Date Entered By
Add New [ Delete
Date: 20170117 10:15:09
Entered By: vmoorman
Comments: |

Close

5. Inthe Comments text box, enter the desired annotation.

6. Clickon thebutton to save your note and close the Add/Edit Annotations dialog. A clipboard icon will appear in the

Results window preceding each result with an annotation. See example below:

e

[]=  Location Type Host File Path ¢ ™
[l Local or Networke Folders 55RS Report Csers'
[l Local or Networ: Folders 55RS Report C:sers'
|:|-/' Local or Networs Folders 55RS Report Csers'y
[l Local or Networs Folders 55RS Report Csers'y
" S0L Server Stored Procedure Adventure
[l I:I SCL Server Stored Procedure Adverture
vEIEE User Defined Fu..
] SQL Server User Defined Fu... Adventure
" 50L Server User Defined Fu. . Adventure
] SQL Server Uzer Defined Fu. . Adventure w
£ >

Note: If any search results have annotations and you attempt the exit/close the program without first saving your results,
you will be prompted to save your search results, continue without saving, or keep the program open.

|

7. Todiscard any changes, click on the[Cancel |button.

192

© 1998 - 2019 Find it EZ Software Corp.



View Annotations

View Annotations

1. Inthe Results window, locate the result for which you want to view annotations.

‘ Note: Results with annotations are preceded by a clipboard icon.

2. Right-click on the result row. A context menu willappear.

Results ( displaying 21 of 21) ] Statistics | Errors (2)
[T+  Location Type Host File Path ¢ *
[l Local ar Metwork Folders S5RS Report ChlUsers'y
] Local or Network Folders S5RS Report ChUsers':
T o ot Foers
W | ocal or Netwark Folders Open Result Users
] Local or Network Folders |sers'
" S0L Server Remove yenture
] S0L Server Settings yerture
v/ SQL Server Add File to Project Exclusion List yerture
[l SQL Server enture
" 50L Server Annotations . |.rerrture
[l SQL Server Mark Completed bz’ YEMTUNE w
< Mark Incomplete *
: only
Copy Object Mame

First | Mext | Previous Last Add to Boolean Term (OR:I . ‘

Con Add to Boolean Term (&MNDY s

Texts7 Replace Search Term

Hame Ea=ro—- o

Type Text Box

Content [rEnindive Cough ~

3. Fromthe menu, select|Annotations . An Add/Edit Annotations dialog will appear. Details for the most recent annotation
will be shown by default in the lower section of the dialog. To view another annotation, click to select the desired row (e.g. by

©2010-2019Find it EZ Software Corp.

193
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Date or Entered by) from the listin the upper section. See example below:

@ Add/Edit Annotations X
Date Ertered By
20070117 10:2505  vmooman And one more.
2070117 10:2458  vmooman This is another note.
200717101703 vmooman This is a note.
AddNew ||  Delete
Date: 20170117 10:25:09
Entered By: VMooman
Comments: And one mare.
Save | | Ca |
Clese
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Edit Annotation

Edit Annotation

1. For the selected annotation, make the desired changes in the Comments text box.

@ Add/Edit Annotations X
Date Entered By
2007017 10:2509  vmooman And one mare.
20170117 10:2458  vmooman This ig another note.
200717101703 vmooman This is a note.
Add New | | Delete
Date: 20170117 10:25:09
Entered By: Vmooman
Comments: | am changing this note.. |

smor | [ o]

Clese

2. Clickon the[Save|button to save. A new, dated entry will be generated to include the changes. See example below:
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Edit Annotation

@) Add/Edit Annotations

Date

Ertered By

20070117 10:2%:18  vmoorman
20070117 10:2509  vmooman
2070117 10:2458  vmooman
200717101703 vmooman

| am changing this note
And one mare.
This iz another note.
This is a note.

Date:
Entered By:

Comments:

20170117 10:29:18

Ymooman

| am changing this note. ..

Close

3. Todiscard your changes, click on the[Cancel |button.
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Delete Annotation

Delete Annotation

1. Inthelist of annotations, click to select the entry you want to delete.

@ Add/Edit Annotations X
Date Entered By
200170117 10:2%:18  vmooman | am chanaging this note.....
20070117 10:2508  vmooman And one more.
20070117 10:24:58  vmooman This iz anather nate.
2070117101703 vmooman This is a note.

addNew || Detser |

Date: 20170117 10:24:58
Entered By: Vmooman

Comments: This is ancther nate.

Clese

2. Clickon the[Delete |button. The selected annotation will be removed from the list. See below:

©2010-2019 Find it EZ Software Corp. 197



Delete Annotation

@) Add/Edit Annotations *
Date Entered By
20170117 10:2%:18  vmooman | am changing this note
20070117 10:2509  vmooman And one mare.
270117101703 vmooman This iz a note.
Add New | | Delete

Date: 20170117 10:259:18

Entered By: vmoorman

Comments: | am changing this note. ..

Close

3. Toclose the Add/Edit Annotations dialog, click on the[X]button.
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Select All tems with Annotations

Select All Items with Annotations

1. Inthe header of the check-box column, click on the down arrow button. A context menu will appear.

Reszults ( dizplaying 21 of 21) | Stetistics | Errors (2)

1

Select

all

c
i

none

iterns marked completed

items with annotations

c
Y

Mark all selected as complete

4

Mark all selected as incomplete

F

Add selected files to project exclusion list

Remove all selected

~ ORORORORNOO

Search for all selected Documents

[] show matches only

File Path ¢ ™
ChUszers'y
CiUsers'y
ChUsers':
CAlUzers
Adverture
Adventure
Adventure
Adverture
Adventure
Adventure w
>

First | [Wext | Previous | | ast |

- W]

2. Fromthe menu, choose Select -> items with annotations . All results with annotations will be selected (checked).

Remove Item from Search Results

1. Inthe Results window, locate the result you want to remove from the list.

2. Right-click on the result row. A context menu willappear.
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Remove Item from Search Results

Results ( displaying 21 of 21) ] Statistics | Errors (2)

[+  Location Type Host File Path ¢ *
] Local or Network Folders S5RS Report ChUsers’:
[l Local or Metwor Folders S5RS Report Chzers’y
[l I:I + Local or Network Folders S5RS Report ChlUsers'y
[ Sl i Open Result @
(1 " SQL Server riture
10 SQL Server | Remove ‘errture
L]+ S0L Server Settings P erture
0 SQL Server Add File to Project Exclusion List enture
[ " 50L Server lenture
] S0L Server Annotations lenture w
< Mark Completed B
Mark Incomplete only
First | Mext | Previous | Last | Copy Object Name - »
Hame i Add to Boolean Term (OR) o
Query Add to Boolean Term (AMND)
Dara Replace Search Term
Cormma

SELECT Emnlnves

[Firar 1Y

3. Fromthe menu, select| Remove . An Are you sure? confirmation message will appear.

@ Are you Sure?

[] Do nat ask again.

Are you sure you want to remove this item from the search results?

x

Yes ||

Mo

Tip: To prevent this dialog from appearing the next time you remove a result, click to check the Do not ask again

check-box.

4. Toremove the selected item from the search results, click on the[ Yes |button. See example below:
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Remove All Checked Results

[]+  Location Type Host File Path ¢ ™
[l Local or Networs Folders S5RS Report Csers'y
[l Local or Network Folders S5RS Report ChUsersy
[l Local or Netwaork Folders S5RS Report Clsers'
] !jvf Local or Network Folders S5RS Report Clsers'
(1« 56L Server Stored Procedure Adventure
[l !j SQL Server Stored Procedure Adventure
1+ 5QL Server Uzer Defined Fu... Adventure
] SQAL Server Uszer Defined Fu... Adwventure
1+ 5QL Server Uszer Defined Fu... Adventure
] SQL Server Uszer Defined Fu... Adwventure
£ >

OR

5. Tocancel, click on the[No |button.

Alert: If you inadvertently delete an item, you can recover by using the “search results history” drop down box to return to
the full search list. However, this will reset and roll back all changes since the search was run/loaded.

Remove All Checked Results

1. Inthe check-box column, click to select (check) the results you want to remove.

Location

Local or Networs Folders
Local or Networs Folders
Local or Networs Folders

Dv

SQL Server
" 50L Server
SQL Server
" 50L Server
SQL Server

Type

S5RS Report
S5RS Report
S5RS Report
S5RS Report
Stored Procedure
Stored Procedure

User Defined Fu...
Uzer Defined Fu...
Uszer Defined Fu...
Uszer Defined Fu...

Host

CLEARTECHNIL...
CLEARTECHNIL...
CLEARTECHNIL...
CLEARTECHNI...

152.168.5.209
152.168.5.209
152.168.5.205
152.168.5.209
192.168.5.209
192.168.5.209

File Path ¢ ™
CiUzers'y
CilUzersh
Chlsers™
C:hlUsers's
Adventure
Adventure
Adventure
Adventure
Adwventure
Adventure
>

2. Inthe header of the check-box column, click on the down arrow button. A context menu will appear.
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Remove All Checked Results

Results ( displaying 20 of 20) | Statistics | Errors (2)

hd Select

all

none
1 items marked completed
. iterns with annotations

Mark all selected as complete

Mark all selected as incomplete

Add selected files to project exclusion list

| Remove all selected P

~ ORORORROOO H

Search for all selected Ducuﬁents

First | Mext | Previous | Last |

—ile Pathc ™
MUzers'y
LRTECHNI..  Chlsers®
BRTECHMI..  Chlgers'
LRTECHMI..  Chlsers'
68.5209 Adverture
68.5.209 Adventure
68.5.209 Advenrture
68.5.209 Adventure
68.5.209 Adventure

| 68.5209 Adverture w

>
[] show matches only
" »

3. Fromthe menu, select|Remove all checked . An Are you sure? confirmation message willappear.

@ Are you Sure?

Are you sure you wart to remaove this tem from the search results?

ot

[ ] Do not 2=k again.

fes

Mo

Tip: To prevent this dialog from appearing the next time you remove a result, click to check the Do not ask again

check-box.

4. Toremove the selected items from the search results, click on the[ Yes|button. See example below:

- Location Type -
] Local or Network Folders Crystal Report
[l Local or Networ: Folders Crystal Report
[l Local or Networs Folders Crystal Report
[l Local or Networs Folders Crystal Report
[l Local or Networs Folders S5RS Report
[l Local or Netwaork Folders S5RS Report
] Local or Network Folders S5RS Report
] Local or Network Folders S5R5 Report
[l Local or Network Folders 55R5 Report
[l Local or Networke Folders 55R5 Report
£

Host

CLEARTECHNI...

CLEARTECHNIL...
CLEARTECHNIL...
CLEARTECHNIL...
CLEARTECHNIL...
CLEARTECHNI...
CLEARTECHNI...
CLEARTECHNI...
CLEARTECHNIL...
CLEARTECHNIL...

File Path ¢ *

Clsers
C:y
Mllsers'y

Mllsersy
Msers'
Ssers'y
SUsers'
Slsers's
Mlsers'
Mllsersy w

00000000

Lzers';

>

OR
5. Tocancel, click on the[No |button.
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Add File(s) to Project Search Exclusion List

Alert: If you inadvertently delete an item, you can recover by using the “search results history” drop-down box to return
to the full search list. However, this will reset and roll back all changes since the search was run/loaded.

Add File(s) to Project Search Exclusion List

Add a Single File to the Project Exclusion List

' Note: This option is available only for results sourced from Local or Network Folders. J

Purpose: If one or more files come up in the SearchResults tab list, and (for example) the file can't be opened, or is on the Results
list and you know you don't want to include this particular file in future search passes for this project, you can use this option to add it to
the project file exclusion list quickly and easily, as follows:

1. Inthe Results list, locate the file that you want to add to the current project's search exclusion list.

2. Right-click on the file. A context menu will appear.

Reszulis [ dizplaying 16 of 16) | Statistics | Errors (2)
[T+  Location Type Host File Path ¢ *
| Local or Network Folders Crystal Report CLEARTECHNI.. ChUsers®:
] Local or Network Folders Crystal Report CLEARTECHML... CMUsers'
| Local or Network Folders Crystal Report CLEARTECHNI.. ChUsers®:
] Local or Network Folders Crystal Report CLEARTECHMI... CMUsers'
[l Local or Network Folders Open Result Isers\]
] Local or Netwark Folders sers'y
(] Local or Network Folders HELI sers'y
] Local or Network Folders Settings sers'
0 Local or Network Folders Ad File to Project Exclusion List [Psers
] Local or Network Folders e SEMSY W
| Annotations 3
Mark Completed anly
Mark Incomplete
First | Mesxt | Previous | Last | - »
Copy Object Name
G Lne; A
Textl3 Add to Boolean Term (OR)
Mame Add to Boolean Term (AND)
Tvpe Replace Search Term
Conterres coovrromc—rvoT ousTmess—Uhd ) Y
< »
cope 0 o

3. Fromthemenu,selectAdd file to project exclusion list. The selected file willbe addedto
the Exclude File(s) / Folder(s) listin Project SettingsMask Filters tabforLocalor Network Folders.

4. Aview request notification willappear, as below:
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Add Multiple Files to Project Exclusion List

Add Multiple Files to Project Exclusion List

the cument

@ Exclude File(s)

Selected Local or Network File(s) have been added
to the project exclusion list. Would you like to view

exclusion list?

Yes

Mo

[ ] Dont ask again

5. Toview the current exclusion list, click on the[Yes |button. To cancel, click on the[No |button. See example below:

1.
2.
3.

Options  Mask Fitters  File Filter

Include files, folders and archive with the following masks:

Import Reset

Enter each item on a seperate line.
Use * for wildcards.

[Exclude files, folders and archives with the following masks:

Clsers w Documents' Test Cases'Some_FindtEZ_Crystal_Tests'\Crystal - Formula Erortbroken rpt
ChlUsers s Documents'Test Cases' 3128 Incomplete Provider Notes rpt

Impaort ‘ | Clear

Enter each item on a seperate line.
Use * for wildcards

In the Results list, locate the files that you want to add to the current project's search exclusion list.

In the check-box column, click to select (check) the desired results.

In the header of the check-box column, click on the down arrow button. A context menu will appear.
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Results ( displayaing 16 of 16 ) | Statistics | Errors (2)
s

- o = = File Path ¢ *
E E all e u:pic:ns
[l none ARTECHMI... ChlUsers™

iterns marked completed \RTECHNI.. - C\Users'

" h annotati \RTECHNI...  Ci\Users\:
rEms with annetatens IRTECHNI..  C\Users':
Mark all selected as complete ARTECHNL.. C\Users':
Mark all selected as incomplete 68.5.205 Adverture
O | Add selected files to project exclusion list | 58.5.209 Adventure
] IS 685208  Adverture v
Remove all selected
< >
Search for all selected Documents [ st matck I
First | Mext | Previous | Last | " B

4. Fromthemenu,select Add selected files to project exclusion list .The
selected files will be added to the Exclude File(s) / Folder(s) listin Project SettingsMask Filters tabforLocal
or Network Folders.

5. Aview request notification willappear, as below:

@ Exclude File(s) ®

Selected Local or Network File(s) have been added
to the project exclusion list. Would you like to view
the cument exclusion list?

Yes Mo

[ ] Dont ask again

6. Toview the current exclusion list, click on the[Yes |button (see example below). To cancel, click on the[No |button.
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Options  Mask Fitters  File Filter

Include files, folders and archive with the following masks:

Enter each item on a seperate line.

Import Reset Use * for wildcards.

[Exclude files, folders and archives with the follawing masks:

Chlsers w0 Documents' Test Cases'Some_FindkEZ_Crystal_Tests'\Crystal - Formula Emortbroken.pt
Chlsers » Documents’ Test Cases' 3128 Incomplete Provider Motes pt

Enter each item on a seperate line.

Import ‘ | Clear Use * for wildcards

See Also:

.

"Add an Errant File to the Project Exclusion List" on page 178
"Save Search Results" on page 46

"Export Search Results" on page 49
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Example Workflow Scenarios

This section provides a number of example scenarios, procedures, and resulting screen shots for searching and reporting in source
file locations, databases, and accessing reporting tools.

Source File Locations

Examples provided in this section include searching local or network folders.

Search Local or Network Folders

1. Fromthe Source frame on the left, locate the File Locations category.
2. Clickto checkthe Local or Network Folders source. The Project Settings dialog willappear.

3. Configure settings.
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@ My Sample Project Settings

- Location
Local or Network Folders
.. Databases
- B2 Linwe UnocWindows
- MySQIL
- Oracle
- PostgreSQIL
- SAF Sybase ASE
- 50L Server
- File Type
- Report Liilties
- Crystal Reports
- Oracle Reports
- 501 Server Reports
- Programming Languages
- SQL (DBA Scripts)
- Website Development
- Documents
- Microsoft Excel
- Microsoft Word
- POF

Options  File Filter

Search Pathis):

Include Local or Metwors Folders

Directony

Include 2

ChUsers w Documents My Projects’My Project Test“San ...

Add

[] Include archive files

BExclude file(s) / Folderis):

Enter each tem on a seperate line

Clear Use *for wildzards

[] Do not show this window each time | select a scan source item.

4. Fromthe Source frame on the left, click to check one or more supported file type(s). For example, select a file type from the

Documents category.

5. Configure settings. See example below:
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@ My Sample Project Settings ®

Include Text / Dat Files

>

- MySQL
-~ QDBC
- Oracle Options
- PostgreSQL
- SAP HANA File Extensions Searched: |CSy
58P 10 ot
- SAP 5QL Anywhere XML
- SAP Sybase ASE XSL
- SQL Azure
- 5QL Server
.- File Type
- Report Ltilties ‘ Add | |

- Crystal Reports
- Oracle Reports
- SAP Dashboards (¥celsius) .
3L Server Reports Open Results With
- Programming Languages
- Ada

C Style [CC++CH)

COBOL

Java

Lua

Pascal (Delphi}

Per / PHP / Python

Ruby

SQL (DBA Scripts)

Visual Basic

Websie Development
Documents
Configuration / Log Filles
- Microsoft Excel
- Microsoft Word
- PDF
- Text / Data Files

< >
[[] Do not show this window each time | select a scan source item.

6. Fromthe Options frame on the right, select the desired Content Filters.

Note: Default search Options are: Search Type =Boolean with Wildcards Expressions, Content Filters = None.
Search options can be set 'on program start-up' or changed during 'new project or wizard task' creation to either use the
program defaults or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documentsin Content Filters. This will use the
last indexed document content and therefore will not refresh content with latest updates. Use thisfilter if it is known that
the source documents are changed infrequently or have not changed since the last Find it EZ project indexing.

7. Onthe search bar (see image below), enter the desired search text into the Find text box.

| search assistant | Fing: |Enter Boolesn Expression .. H“ﬁ carch | | Advanced ‘I
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@ Find it EZ - My Sample Project
File  Projects Compare  Replace

| Search Assistant

Reports  Tools  Help

Find: san diego

SQL Server Reports

[] Programming Langua_ . See more

[] SGL (DBA Scripts)
[] Website Development

Details

0 Decuments See more

] Microsoft Excel
[] Microsoft Ward
[ roF

Source w2 Results 3
.. Results | Statistics | Errors (0)

[] File Locations Content

Local or Network Folders To beain a search, use the search assistant or: LlE
(1) select and configure settings for one or more source items on the left Jc

[] Databases See more (2) set your search options on the right O
(3) enter your search terms or use the Advanced wizard to build an expression above. ...

[] DB2 Linwe/Unie/Windows Oc

] mysaL

[] Oracle

[] PostagreSaL

[] 5AP Sybase ASE

[] saL Server

[] Report Lkilities See more

Crystal Reports

[ Oracle Reports

8. Clickon the[Search |button to initiate the search. A Searching dialog box will appear, showing the status of the search.
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Searching ...
Search Terms san diego
Search Options Boolean Search, Search Entire Documert
Indexed ] 10/10
Scanned 0/0
Matches: 0
Emors\Wamings: 0
Duration: 00:00:00 - Hide Details

Scan Source Type Document

Tip:  Onthe Results list Double click to view or edit source in your selected editor
~or- Right click on any result for more options

9. Once complete, the Search Complete dialog box willappear.

Search Complete

Search Tems san diego

Search Options Boolean Search, Search Entire Documert

e 10/ 10

Scanned: . 00 Search Complete
Matches: 7

Emors\WWamings: 1]

Duration: 00:00:00

Tip:  Onthe Results list Double click to view or edit source in your selected editor
or- Right click on any result for more optionss o

10. Clickon the[Show Results |button. A list of results matching your search criteria will appear in the Results frame.
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@ Find it EZ - My Sample Project

| Search Assistant

File  Projects Compare Replace Document Tools  Help

Find: san diego

Source L ‘

] Fle Locations

Local or Metwark Folders

[] Databases See more

] DB2 Linee/Unie/ \Windows
(] MysaL

] Oracle

[] PostgreSaL

(] SAP Sybase ASE

[] SGL Server

] Report Lkilities See mare

Crystal Reports
(] Cracle Reports
S0L Server Reports

] Programming Langua... Seemore #

(] 5GL (DBA Scripts)
(] Website Development

] Documents See more

] Microsoft Bxcel
] Microsoft Waord
] PDF

Search Result History:  2016-09-27 12:07:56 - . Project: My Sample. Boolean Search, san dieg

Resu[_| Search within selected Documents

Results ( dizplaying 5 of 5) ]Statistic:s Errars ()

[[]+  Location Type
| Local or Metwork Folders Xml
] Local or Metwark Folders *ml
] Local or Metwark Folders ¥ml
] Local or MNetwork Folders Xl
| Local or Metwork Folders k‘ Xl
£

Details

Host File Path o

CAllsers'y
Callsers'y
Calsers'y
-, - C:hlsers'y
Cohlsers®y

>

[] Show matches only

First | Mext | Previous | Last |

“ »

<Url Source="file:///C:/Users/ =

*ml

s Document: &

' Note: After performing a search, settings can be saved to a Project for later use again.

212

© 1998 - 2019 Find it EZ Software Corp.



Database Examples

11. Toview details for a result, click on a row in the Results window. Details will appear in the Details window.

12. Toview the source file, right-click on a detail line and select Open from the context menu. See example below:

@) Find It EZ Source Code Viewer - C:\Users\vmoorman\Documents\My Projects\My Project Test\San Diego\OutputivmoormantTempor...  —
Location/Group:  Code ~
First | Next | Previous | Last | Match 1of 1 Find in File:

O

P

-»

<?xml version="1.0" encoding="utf-3"?2>
<CatapultGlobalSkinCache

<Map>
<Tag
Name="Header" />
<Tag
Name="Menu Item">
<Class
Name="2nd Level" />
<Class
Name="3rd Level" />
<Class
Name="4th Level" />
<Class
Name="1st Level" />
</Tag>
<Tag
Name="Search Input” />
<Tag
Name="Menu" />
<Tag

<

If you wish to view or edit this document in another program, change the "Open With" optien found in the settings window for the selected scan source

SavedSource="file:///C:/Users/vmoorman/Documents /My Prodects/ s/ Output/ vmoorman/ Temporary/ Glok

<
See Also:
» "Search Wizard" on page 129
* "Localor Network Folders" on page 88
» "Configure Source Location(s)" on page 151
» "Localor Network Folders" on page 88
* "File Type" on page 112
J
Database Examples
Search an Oracle Database
1. Fromthe Source frame on the left, click to check Oracle in the Databases category.
2. Configure settings. See example below:
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@ My Sample Project Settings ®

- MySQL
- ODBC

Include Oracle

>

- Oracle Connection  Data  Tables Procedures Java Procedures Triggers Funclions Views Packages
- PostgreSQL

- SAP HANA Authorization Type: Torrrolier
- SAPIQ
- SAP 5QL Anywhere Haostname or IP ‘ ‘
- 5QL Azure 1522 (leave blank for default of 1521)
- SQL Server 51D or Service ‘ORCL ‘
« File Type )

- Report Utilties Usemame: ‘

| 4 Remember

~

- Crystal Reports
- Oracle Reports
- SAP Dashboards (¥celsius)
« QL Server Reports

- Programming Languages Schema 0
- Ada
C Style (C.C+=.CH) Search: [] Table Data Narmal View Materialized View
COBOL
Jva Table Defintions Package Spec Package Body
Lua Procedures Java Stored Procedurss

Pascal (Delphi)
Per / PHP / Python Triggers Synoryms Sequences

Ruby Functions Type Spec Type Body
SQL (DBA Scripts)

Visual Basic Use default settings

Websie Development

Documents Open Results With
Configuration / Log Filles

- Microsoft Excel

- Microsoft Word

- PDF

- Text / Data Files

Password ‘----

< >

[[] Do not show this window each time | select a scan source item.

3. Clickthe[Options|button on the search bar, choose the desired Optimization and Content Filters.

Note: Default search Options are: Optimization =DO NOT use pre-indexed documents (unchecked), Content Fil-
ters =None. Search options can be set 'on program start-up' or changed during 'new project' or 'new wizard task' con-
figuration to use this default or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documents. This will use the last indexed doc-
ument content and therefore will not refresh content with latest updates. Use this filter if it is known that the source doc-
uments are changed infrequently or have not changed since the last Find it EZ project indexing.

4. Onthe search bar (see image below), enter the desired search text into the Find text box.

| search assistant | Fing: |Enter Boolesn Expression .. HM| Advanced \I
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@ Find it EZ - My Sample Project Project
File Projects Compare Replace

| wizares |

Document  Backup Tools  Help

Find:

[7| opions

Expression Builder

Source <

[ Folders & Version Control *

[ Local or Network Folders
[ Git /GiHub
[ Team Foundation Server

[ Business Intelligence *
[ Crystal Reports Server 2011

[ Microsoft Reporting Services

[ rePORTAL

[J Databases

[ DB2 Linus/Unix/Windows
[ InterSystems Caché

[ mysaL

Oracle

[ PostgresaL

[ SAP HANA

[ SaL Server

[ SQL Server Agert Jobs

Resuts | Siafistics  Ermors (0)

To begin, use the wizard or:
(1) select a Project
(2) configure one or mere locations and items you wish to scan
(3)set Gptions to optimize search results
{4y enter yourtarget keywordis) in the Find box. or
use the Expression Buiderto help create complex Boolean queries
5) cick Search

5. Clickon the[Search |button to initiate the search. A Searching dialog box will appear, showing the status of the search. See

6.

example below:
Searching ...
Search Terms user
Search Options Boolean Search, Search Entire Documert
i I 53/
Scanned P 12561463
Matches: 4573
Emors\Wamings: 0
Duration: 00:15:37 - Hide Details
Scan Source Type Document
Oracle Searching WWV_FLOW_GEN_API2
Oracle Searching WW_FLOW_CALENDAR
Oracle Searching WY_FLOW_SECURITY
Oracle Searching WWV_FLOW_ITEM

Tip:  Onthe Resutts ist Double cick to view or edit source in your selected editor
or- Right click on any result for more options

Once complete, the Search Complete dialog box willappear.
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Search Complete

Search Terms user

Search Options Boolean Search, Search Entire Documert
i I 53/
Scanned: D 146371483
Matches: 8151

Ermors\Wamings: 0

Duration: 00:15:45

Tip:  Onthe Resutts ist Double cick to view or edit source in your selected editor
or- Right click on any result for more options

Search Complete

7. Clickon the[Show Results |button. A list of results matching your search criteria will appear in the Results frame. See

example below:

@ Find it EZ - My Sample Project Project

File Projects Compare Replace Document Backup Tools Help

|W\zavd; ‘ Find: {OrderlD} OR {Customer}

- a X

- | options ‘W‘ Expression Builder

Source < Results

Search Resut History: | 2018-11-05 15:04:45 - “UNSAVED". Project: My Sample Project. Boolean Se

[ Folders & Version Control L "
Resuls (displaying 150f 15) | Statisics  Emors (0)

(] Local or Network Folders Fl~  Locaon Type Host

[ Gt /GiHub

Fie Path or Database

[ search within selected Documents

Documert Matches A

] SQL Server Agent Jobs

(

[ORDER ID]) NUMBER NOT NULL

, (BEEREYSR ID] NUMBER NOT NULL
, [ORDER_TOTAL] NUMBER (8,2) NULL
, [ORDER_TIMESTAMP] DATE  NULL
,[USER_ID] NUMBER NULL

FOREIGN KEY [DEMO_ORDERS_CUSTOMER ID FK]
FORRTON ¥RV (MRMA AROFRS SRR TH TRI
<

Table Defirition

] Oracle Package Body bribdatabase XE APEX_04D000MW/V_FLOW_PRO.. 1
[ Team Foundation Server [m} Oracle PackageBody ~ bnbdatabasel  XE APEX_040000WWYV_FLOW_TEA.. 18
O Oracle PackageBody  brbdatabase]  XE APEX_04D000WWV_FLOW TEA.. 6
[ Business Intelligence * O Oracle Package Body  brbdatebasel  XE APEX_04D000 WWV_FLOW_SAM... 101+
O Oracle Package Spec  brbdatabasel  XE APEX_04D000 WWV_FLOW_TEA.. 6
L Costal Feports Server 2011 O Oracle Table Definiion  brbdatabasel  XE FINDITEZ DEMO_CUSTOMERS 5
[ Microsot Reporting Senvices O Oracle Table Defintion _ brbdatabasel  XE APEX_040000WWV_FLOW_TASKS 1
[ =PORTAL O Table Definiion __bribdatabase 1 8
O Oracle Table Defintion ~ brbdatabasel  XE OF ORDERS 4
[] Databases O Oracle Table Definion  brbdatabasel  XE APEX_04D000 WWV_FLOW_BUGS 2
[} Oracle Table Definition bnbdatabase1 XE OE TEST 2
[ DB2 Linux/Unix/Windows O Oracle Trigger bnbdatabase XE FINDITEZINSERT_DEMO_CUST 2
(1 inkerSysioms Caché O Oracle View brbdatabase]  XE APEX_D4D000APEX_TEAM_BUGS 4
1 wysaL O Oracle View brbdatebase  XE OETEST 3
Oracle r Oracle View brbdatebase1  XE OF ORDERS VIEW 1 ©
[ PestareSQL L L)
[ sAP HANA First | Next | Previous | Last | Match1of8 Find in File: an
[ sat sewer CREATE TABLE [FINDITEZ].[DEMO_ORDERS] "

(DEMO_ORDERS_CUSTOMER ID_FK)

iMEMA ARTERS MTSFR Th FRL

REFERENCES DEMO_CUSTOM
REFFRENCRS MRMA MSERSG TIRRE TN

164 maiches found,

' Note: After performing a search, settings can be saved to a Project for later use again. J

8. Toview details for a result, click on a row in the Results window. Details will appear in the Details window. See example

above.

9. Toview the source file, right-click on a detail line and select Open from the context menu. See example below:
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© Find It EZ Source Code Viewer - ORCL.APEX_D40200.WWV_FLOW_FEEDBACK

- a X

Location/Group:  Table Defintion v
First | Next | Previous | Last | Match2 of 4 Find in File: an

, [PAGE_LAST_UPDATED BY] VARCHAR? (255)  NULL ~

, [FAGE_LAST UPDATED ON] DATE  NULL

,[SESSION_ID]  VARCHARZ (255)  NULL

, [AFEX_USER] VARCHRR? (255)  NULL

. [@E3] EMATL]  VARCHARZ (255)  NULL

, [APPLICATION VERSION] VARCHAR? (255)  NULL

, [SESSION_INFO] VARCHARZ (4000) NULL

, [SESSION_STATE] VARCHRR? (4000) NULL

, [PARSING_SCHEMA]  VARCHARZ (255)  NULL

, [SCREEN_WIDTH] VARCHARZ (30) NULL

, [SCREEN_HEIGHT] VARCHAR? (30) NULL

, [HTTP_USER AGENT] VARCHARZ (4000) NULL

, [REMOTE_ADDR] VARCHARZ (4000) NULL

, [REMOTE_USER] VARCHARZ (4000) NULL

, [HTTP_HOST] VARCHAR? (4000) NULL

, [SERVER_NRME] VARCHARZ (4000) NULL

, [SERVER_FORT] VARCHARZ (4000) NULL

, [TAGS] VARCHARZ (4000) NULL

, [LABEL 01] VARCHARZ? (4000) NULL

, [LABEL_02] VARCHARZ (4000) NULL

, [LABEL_03] VARCHAR? (4000) NULL

, [LABEL_D4] VARCHARZ (4000) NULL v
< >

If you wish to view or edit this document in another program, change the "Open With" optien found in the settings window for the selected scan source

Search a SQL Server Database

1.

From the Source frame on the left, click to check SQL Serverin the Databases category.

2. Configure settings. See example below:

@ My Sample Project Settings

- MySQL ~

-~ QDBC

- Qracle

- PostgreSQL

- SAP HANA

- SAPIQ

- SAP 5QL Anywhere

- SAP Sybase ASE

- SQL Azure

- SQL Server

« File Type
- Report Utilties

- Crystal Reports

- Oracle Reports

- SAP Dashboards (¥celsius)

« QL Server Reports

- Programming Languages

- Ada

C Style [CC++CH)

COBOL

Java

Lua

Pascal (Delphi}

Per / PHP / Python

Ruby

SQL (DBA Scripts)

Visual Basic

Websie Development

Documents

Configuration / Log Filles

- Microsoft Excel

- Microsoft Word

- PDF

- Text / Data Files

Connection  Data
Authorization Type
Hostriame or IP

Port Number:

Usemame:

Password

Database
Owner:

Search:

Open Results With

< >

[[] Do not show this window each time | select a scan source item.

Include SQL Server

Tables Stored Procedures  Triggers  User Defined Functi

Database Login

fions  Views

[ 7] tleave blank for defaul of 1433)

‘ Remember

82|  AdventureWorks
8| cbo

[] Table Data
W Table Definitions
Procedures

Select Viewer/Editor

Triggers

Functions

Views

[ Sequences

Synonyms
Types

3. Clickthe[Options|button on the search bar, choose the desired Optimization and Content Filters.
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Note: Default search Options are: Optimization =DO NOT use pre-indexed documents (unchecked), Content Fil-
ters = None. Search options can be set'on program start-up' or changed during 'new project' or 'new wizard task' con-
figuration to use this default or to remember your last used settings.

Tip: For better search performance, click to check the Use pre-indexed documents. This will use the last indexed doc-
ument content and therefore will not refresh content with latest updates. Use this filter if it is known that the source doc-
uments are changed infrequently or have not changed since the last Find it EZ project indexing.

4. Onthe search bar (see image below), enter the desired search text into the Find text box.

| search assistant | Fing: |Enter Boolesn Expression .. HM| Advanced \I
@ Find it EZ - My Sample Project Project - o X

File Projects Compare Replace Document Backup Tools Help
| Wizards | Find ]| options \M\ Expression Builder

Source < Results
Fesuts  Siatistios  Erors (0)

[ Folders & Version Control ®

[ Local or Network Folders To begin, use the wizard or:

[ Gt /Gt (1) select a Project

(2) confiqure one or more locations and tems you wish to scan
(3) set Options to optimize search resuts
{4) enter yourtarget keyword(s)in the Find box. or

L] Team Foundation Server

L Hfhosises btoleoonce L Use the Expression Bulderto help create complex Boolean queries
L] Crystal Reports Server 2011 8)ciick Search

[ Microsot Reporting Seniices
L] rePORTAL

[ Databases

[ DB2 Linux/Unix/Windows
[ InterSystems Caché

[ mysaL

[ Oracle ——
[ PostreSQL

L] SAP HANA

SQL Server

[ SQL Server Agert Jobs

5. Clickon the[Search |button to initiate the search. A Searching dialog box will appear, showing the status of the search. See
example below:
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Searching ...
Search Terms Product|D
Search Options Boolean Search, Search Entire Documert
ncnet I 0/ 103
Scanned ] 52/108
Matches: 9
Emors\Wamings: 0
Duration: 00:00:02 - Hide Details

Scan Source Type Document

Website Development Searching stemmer-english amd.min js

Website Development Searching require min js

Website Development Searching plugins min js

Tip:  Onthe Resutts ist Double cick to view or edit source in your selected editor
or- Right click on any result for more options

6. Once complete, the Search Complete dialog box willappear.

Search Complete

Search Terms
Search Options
Indexed
Scanned:
Matches:
Emors\WWamings:
Duration:

Product|D

Boolean Search, Search Entire Document
I 0/ 103
I 0/ 103
27

0

00:00:03

Tip:  Onthe Results list Double click to view or edit source in your selected editor
~or- Right click on any result for more options

Search Complete

7. Clickon the[Show Results |button. A list of results matching your search criteria willappear in the Results frame. See

example below:
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@ Find it EZ - My Sample Project Project - [u] X

File Projects Compare Replace Document Backup Tools Help

| wizards | Find: ProductiD - | options |@

Expression Builder

Source < Results
Search Result History: | - Select  search resuit — v [ search within selected Documents
[ Folders & Version Control L]
Resuts (isplaying 28 of 23)  Statitics  Emors (0)
[ Local or Network Folders Elw  Location Tpe Host File Path or Database Document Matches A
Wi ] SaL Server Table Defron brbdatabased  Advertursflorks2017 Production ProcuctProductPhoto 6
L] Team Foundaion Server 0O 0L Server Table Definition  bribdatabased AdventureWorks2017 Production WorkOrder 3
O SQL Server Table Definition bnbdatabased. AdventureWorks2017 Production WorkOrderRouting 5
[0 Business intelligence * O SQL Server Table Defintion  brbdatabase4  AdventureWorks2017 Procuction ProductReview 6
O SQL Server Trigger brbdetabased  AdveniurcWerks2017 Production iWorkOrder 2
(W) RS [} Tigger brbdta AdveniurcWorks2017 al ] 3
[ Wicrosct Reporting Senvices O Sal Sewer Trigger brbdetabased  AdveniureWorks2017 Production uWorkOrder 3
[ rePORTAL O 5L Server Tiigger 7 a. OrderDetail 2
O 5L Server Tiigger 7 a OrderDetail 3
[ Databases [m] SQL Sever User Defined Fu...  bribdatabased  AdventureWorks2017 dbo uinGetStack 3
[m] SQL Server User Defined Fu 7 dbo. DealerPrice 5
[ DB Linue/Unix Windows O SQL Server User Defined Fu. 7 doo ListPrice 5
[ nterSystems Caché O 5QL Server User Defined Fu 7 dbo st 5
1 wysaL [} Sal Sewer View brbdetabased  AdveniurcWorks2017 Production vProductAndDescription 1 -
[ Oracle
[ PostgresaL petaits W/CECminaey
[ saP Hana First | Next | Previous | Last | Match10f3 Find in File: an
SET NOCOUNT ON; "
[ 50L Server Agent Jobs
BEGIN TRY

-- If inserting or updating these columns
IF UPDATE ( ([EJERISSER]) OR UPDATE ([OrderQuy]) OR UPDATE ([UnitBrice]) OR UPDATE ( [UnitPriceDi.
—- Insert record into TransactionHistory

BEGIN
INSERT INTO [Production].[TransactionHistory]
([ProductID]
FReferanceOrAsrTIY ©
< >

Trigger

134 matches found,
]

. Note: After performing a search, settings can be saved to a Project for later use again.

8. Toview details for aresult, clickon a row in the Results window. Details will appear in the Details window. See example
above.

9. Toview the source file, right-click on a detail line and select Open from the context menu. See example below:

e Find It EZ Source Code Viewer - AdventureWorks.dbo.ufnGetProductListPrice - a *

Location/Group:  Function ~

First | Next | Previous | Last | Match 105 Find in File: -wn

CREATE FUNCTION [dbo].[ufnGetProductlistPrice] (GEEELIagat [int], @OrderDate [datetime])
RETURNS [money]
FX]
BEGIN
DECLARE @ListPrice money:

SELECT @ListPrice = plph.[ListPrice]
FROM [Production].[Product] p
INNER JOIN [Production].[ProductListPriceHistory] plph
ON p.[ProductID] = plph.[ProductID]
AND p. [ProductID] = @ProductID
LND @OrderDate BETWEEN plph.[StartDate] AND COALESCE (plph.[EndDate], CONVERT (datecime, '99¢

RETURN @ListPrice;
END:

< >

If you wish to view or edit this document in another program, change the "Open With" optien found in the settings window for the selected scan source

See Also:

» "Databases" on page 102
* "Apply Database Item Filters" on page 107

» "Test Database Connection" on page 104
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Reporting Tools

Examples in this section include creating a SQL statements detail extract and creating a database cross-reference list.

Create a Database Cross-Reference List

1. Launch the Export Wizard for a Database Cross-Reference Extract:

a. Using the main Wizard:

i. Atthe top, left of the main window, in the search bar, click on the[ Wizards |button. The Wizards dialog will appear.

@ Wizards X

I want to ...
SEARCH

O Search for a specific database object, code snippet, or a variable to find any
references throughout all of my source code {including within reports and databases )

DOCUMENT
(®) Extract database objects (tables, stored procedures, views, etc. ) used in my reports
(O) Generate detailed content documentation for my reports
() Etract all SQL code used in my reports
() Create a database column cross-eference for my reports
() Create a list of all my reports, including printer, and update information
REPLACE
(O) Replace Crystal Repont data source connections. or gualfied table names

[ Show on Startup | | | Nesxt > | | Cancel |

i. ClicktochoosetheExtract database objects (tables, stored procedures,
views, etc.) used in my reportsoption.

b. Using the menu:

i. Fromthe Find it EZ menu, select| Document -> Business Intelligence -> Database Cross-Reference .

The Database Cross-Reference Document Wizard willappear. See below:
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@ Database Cross-Reference Docurnent Wizard >
Create or Select a Project
Projects are used to group and save settings, filters and directories between sessions.

(®) Use an existing Project [] Use pre-indexed documents

My Sample ~

() Create a new Project

(0 Use selected documents
O Al results (4)
(O Currently displayed results (4)
() Checked results only (0)

‘ | Mext = > | | Cancel

2. Clickon the[Next >> |button to continue.
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@ Database Cross-Reference Document Wizard x

Select search location(s)

Folders & Version Control
Local or Network Folders Show More

Business Intelligence
Microsoft Reporting Services
[] rePORTAL

Databases
[] DB2 Linux/Unix/Windows Show More
[] InterSystems Caché
] MysaL

[] Oracle

[] PostgreSQL

] SAP HANA

[] SOL Server

[] SOL Server Agent Jobs

[] Show on Startup << Previous | | est = | | Cancel

3. Click to select the report file locations and optionally select the underlying source databases if you would like to include the
SQL Select code from procedures, views or functions used by your reports.

4. Clickon the[Next >> |button to continue. Each of the selected source report location and underlying database configuration
panels willappear as in the examples below.
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e Database Cross-Reference Document Wizard
Enter the Local or Network Folders connection information
Options  Mask Filters  File Filter

Search Path(s):

Directory
C\Userst\ken\Documentsi Test Cases',

Include Sub Directories?

v

Add | | Edit | ‘ Remove

Include: Crystal Reports [ Oracle Reports

Search within archive files? () Yes (® Mo

[1 S5RS Reports

<< Previous || Next > > ||

Cancel
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G‘ Database Cross-Reference Document Wizard

*
Enterthe SGL Server connection information
Connection Data  Tables Stored Procedures  Triggers  User Defined Functions  Views
Authorization Type Database Login ~
Hostname or IP: |bnbda1&base3 ‘
Port Number: [ ] tleave blank for default of 1433)
Usemame: |su\sa ‘
Password | ‘ [] Remember
Database B8 AdventureWorks2014
Owner: = |'AII User Schemas™ |
Include [ Table Data [ Triggers [] Sequences
[ Table Definitions Functions [ Synonyms
Procedures Views [ Types
‘ << Previous | | Next > | | Cancel |

5. Enter or confirm the pre-configured the file location and underlying database(s) connection information, click the check-
boxesto include desired report types and known database objects used by your reports.

Click on the[Next >> |button to continue after each configuration panelis completed. Use the[Test Connection|button to con-
firm valid settings where applicable. After the last location is configured, the Export Confirmation dialog willappear.
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E‘ Database Cross-Reference Document Wizard

Columns:

@® Include all columns

(O Select from the following

Location

Type

Host

File Path

Filename

Sub Report

Data Source Type
Data Source Name
Database
Scherna/COwner
Report Table

Call Staternent
Table Links

50L Command
S0L Expressions
Underlying Database Code

HAvailable Included

Choese your Repert Options, then click on the Export button below to generate and save your report.

<< Previous | | Export | |

Cancel ‘

7. Choose what columns you would like to export. The defaultisto include all columns available.

8. Clickon the[Export]button. Find it EZ will begin gathering the required data.

Searching .

Search Terms

Search Options Wildcard, Search Line By Line + Include Comments

Indexed | 2/42
Scanned: 0/0
Matches: 0
Emors\WWamings: 1]
Duration: 00:00:00 - Hide Details

Scan Source Type Document

SQL Server Indesing Types

Tip:  Onthe Results list Double click to view or edit source in your selected editor
-or- Right click on any resutt for more options

Stop

9. Once complete, a Save As dialog will appear. See example below:
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@ savers X
4 > ThisPC » Deskiop v|® | SesrchDesktop »
Organize v New folder - @
Oracle Example A Name Date modified Type Size @
Reports Examples 2016-03-052:32 PM  File folder
SQL Server Bample Eile folder
& Onedrie File folder
File folder
[ This PC File folder
B Desktop File folder
Documents File folder
3 Downloads File folder
File folder
D Music }
< Y Shorteut 2k8
=] Pictures N Internet Shortcut 1KB
[ videos LB Microsoft Excel W... 16KB
i Gateway (C) [ 08-091:15PM  Microsoft Excel W... 5KB
2 = AL15PM  Shortout 2KR 2
File name:
Save as type: | XLSX Files (*xlsx) -
~ Hide Folders Cancel

10. Save the report:
a. Modify the File name as desired.
b. Navigate to the desired folder location.

c. Clickonthe button.

A Save Complete notification willappear, as below:

@ Save Complete

Save complete

Would you like to view the saved file?

[] Aways view, do not show again. | View Maow

Cloze

11. To view the saved report, click on the[ View Now |button. The file will open in the specified viewer / editor. See example

below:

SQLCodeExtract xlsx - Excel

Insert  Pagelayout  Formulas  Data Review  View  Q Tell me what you want to do 5 share
o B B
& o T A& N = |[cenera . By [P Bt - Z-89 O
o T Sort & Find &
aste BT u- 5. dea- § -0 » <38 Condtional Formatas Cell =, ot & Fin
- £ ® > | Fommatting~ Tabler Styles~ B2 Format~ | & v Fier - Selact+
Clipboard 1 Font T Alignment T Number k] Styles Cells Editing A
AL - £ | Location v
A 8 c D E 3 s H =
1 [Location Trype Host File Path  Filename Report Section Data Source Type Data Source Name Databa
2
3 |Local or Netwark Folders Crystal Report CLEA C:\Users\vm Summary Group.rpt Main Body ODBC(RDO)  Xtreme Sample Database 11.5
4 |Local or Netwark Folders Crystal Report CLEA C:\Users\vm Sales With OnDemand Sub.rpt Main Body OLEDB(ADO]  CRMIGRATION\SQLExpress  Xtrem
5 |Local or Network Folders Crystal Report CLEA C:\Users\vm Sales With OnDemand Sub.rpt Main Body OLEDB(ADO}  CRMIGRATION\SQLExpress  Xtrem
6 |Local or Netwark Folders Crystal Report CLEA C:\Users\vm Sales With OnDemand Sub.rpt Main Body OLEDB(ADO)  CRMIGRATION\SQLExpress  Xtrem
7 |Local or Netwark Folders Crystal Report CLEA C:\Users\vm Sales With OnDemand Sub.rpt Main Bady OLEDB(ADO)  CRMIGRATION\SQLEXpress  Xtrem
8 |Local or Network Folders Crystal Report CLEA C:\Users\vm Sales With OnDemand Sub.rpt Main Body OLEDB(ADO)  CRMIGRATION\SQLExpress  Xtrem
3 |Local or Network Folders Crystal Report CLEA C:\Users\vm Sales With OnDemand Sub.rpt Main Body
10 |Local or Netwerk Folders Crystal Report CLEA C:\Users\vm Sales With OnDemand Sub.rpt Subreport subsales.rpt  OLEDB(ADO)  CRMIGRATION\SQLEXpress  Xtrem
11 |Local or Network Folders Crystal Report CLEA C:\Userskvm Sales With OnDemand Sub.rpt Subreportsubsales.rpt ~ OLEDB(ADO)  CRMIGRATION\SQLExpress  Xtrem
12 |Local or Network Folders Crustal Report CLEA C:\Users\vm Sales With OnDemand Sub.rpt Subreport subsales.rpt _ OLEDB(ADO)__ CRMIGRATION\SQLExpress _ Xtreme -
Find it EZ SQL Code Extract ® El v
Ready BB m = I + 100%

Report data will include the following:
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Location

Type

Host

File Path
Filename

Report Section
Data Source Type
Data Source Name
Database

Owner

Report Table

Call Statement
Table Links

SQL Command
SQL Expressions

Underlying Database Code - SQL SELECT statement content based on procedures, views or functions referenced

when source database configuration included
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Extract all embedded SQL queries from within my reports

1. Launch the Export Wizard for an embedded report SQL Queries extract:

a. Usingthe main Wizard:

i. Atthe top, left of the main window, in the search bar, click on the[Wizards |button. The Wizards dialog will appear.

@ Wizards X

I want to ...
SEARCH

O Search for a specffic database object. code snippet. or a variable to find any
references throughout all of my source code {including within reports and databases )

DOCUMENT
(C) Bxract database objects (tables, stored procedures, views, etc. ) used in my reports
() Generate detalled content documentation for my reports
(®) Extract all SQL code used in my reports
() Create a database column cross-reference for my reports
() Create a list of all my reports, including printer, and update information
REPLACE

(O) Replace Crystal Report data source connections, or gqualfied table names

[J Show on Startup | | | Next »> | | Cancel

ii. Clicktochoose the Extract all SQL code used in my reports option.

b. Usingthe menu:

i. Fromthe Find it EZ menu, select| Document -> Business Intelligence -> Show SQL Queries .
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The Show SQL Queries Document Wizard dialog will appear.

@ Show SOL Queries Document Wizard *
Create or Select a Project
Projects are used to group and save settings, filters and directories between sessions,

(® Use an existing Project [] Use pre-indexed documents

My Sample ~

(O Create a new Project

(O Use selected documents
O All results (4)
() Currently displayed results (4)
(O Checked results only (0)

‘ | Mext > | | Cancel

2. Clickon the[Next >> |button to continue.
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e‘ Show S0L Queries Document Wizard *

Select search location(s)

Folders & Version Control
Local or Network Folders Show More

Business Intelligence
[] Microsoft Reporting Services
[] rePORTAL

<< Previous | | Mext = > | | Cancel

3. Clickto select all of the report file locations to include.

4. Clickon the[Next >> |button to continue. Each of the selected source report location configuration panels will appear as in
the examples below.
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@ Show SOL Queries Document Wizard

Enter the Local or Network Folders connection information

Options  Exclusions ~ File Fitter

Search Pathis):

CiUsers‘ken\Documents' Test Cases'\Uof Sask™

Directory Include Sub Directories?

v

Add ‘ ‘ Edit ‘ ‘ Remove

Include: Crystal Reports S5RS Reports

Search within archive files? (O Yes (@) Mo

<< Previous | | Next =

Cancel
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@ Show SOL Queries Document Wizard X

Enter the Microsoft Reporting Services connection information

Options  Report Filter

Autherization

Database Login ~
Hostname or IP: |bnbdatabasE1 |
Port: |:| (leave blank for default of 1433 )
Username: |Sa |
Password: prove—. | Remember
Database : B AdventureWorksSSRS
Include: [] M5 Shared Datasets SSRS Reports

<< Previous | | Mext »= | | Cancel

5. Enter or confirm the pre-configured the file location and other connection information, click the check-boxesto include
the desired report types to extract embedded SQL queries from.

6. Clickon the[Next >> |button to continue after each configuration panelis completed. Use the[Test Connection|button to con-

firm valid settings where applicable. After the last location is configured, the Export Confirmation dialog willappear.
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@ Show SOL Queries Document Wizard X
Choose your Report Options, then click on the Export button below to generate and save your report.

‘What Format?: Plain Text (td) w
Create a single File? O

Prefix all generated filename(s) with: I:I ( optional, leave blank to use source RPT filenames )

<< Previous | | Export | | Cancel

7. Enter the export options:
a. Selectexported content file type.
b. Alldata exported to a single file, or individual files created for each report?

c. Optionally add a prefix to the file(s) created. Can be useful for separating data from each wizard run stored in the same des-
tination output folder.

8. Clickon the[Export|button. Find it EZ will begin gathering the required data.
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Searching ...
Search Terms :
Search Options Wildcard, Search Line By Line + Include Commerts
i I 13
Scanned: 0/0
Matches: 0
Emors\Wamings: 0
Duration: 00:00:00 - Hide Details

Scan Source Type Document

Find it EZ Performing Wildcard search

Tip:  Onthe Results list Double click to view or edit source in your selected editor
~or- Right click on any result for more options

9. Once complete, a Save As dialog willappear when the "single file" option was checked in step 7(b). See example below:

© savers X
4 B> ThisPC > Desktop v|®  SearchDesktop p
Organize »  New folder = [2]
Reports Example DB CrossRef ~ » Name Date modified Type Size -
Reports Example Extract File folder
SQL Server Bxample File folder
& Onedrive File folder
File folder
& ThispC File folder
I Desktop File folder
[ Documents File folder
& Downloads File folder
File folder
B Music .
. as Microsoft Excel W... 26 KB
=] Pictures oy Shortcut 2kB
H videos | Internet Shortcut 1k8
i Gateway (C) a: Microsoft Excel W 16 KB
M 3 Micrasaft Fxcel W. 5KR e
I IDctabaseCrossRetulsy -
Save as type: | XLSX Files ("xlsx) v

~ Hide Folders Cancel

10. Savethereport:
a. Modify the File name as desired.
b. Navigate to the desired folder location.

c. Clickon the[Save|button.

A Save Complete notification willappear, as below:
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@ Save Complete
Save complete

Would you like to view the saved file?

[ Aways view, do not show again. View Maow | | Close

11.  Or once complete, if individual files are to be created, a Select Folder dialog will appear as below:

@) select Folder

4 5 ThisPC » Desktop v @ | Search Desktop o
Organize *  New folder
Images A Name

Date modified Type Size
Partners

Ne items match your search.
Retail
7@ OneDrive

[ This PC

1 30 Objects
[ Desktop

%] Documents
4 Downloads
D Music

=] Pictures

B Videos
i Windows (C:)

= Finditez Website (\\192.162.5.237\Output) (Z)
v €

Folder [|

Select Folder Cancel

12. Savethereport:
a. Navigate to the desired folder location.
b. Clickon the[Select Folder |button.

The file creation process will begin.

Note: Each generated file will use the same filename as the source document, along with the target selected file type
extension. Sub-folders will be created based on the source file location. A Replace File confirmation alert dialog may
appear if a duplicate filename in the target output path already exists, as below:

e Replace?

File C\Temp\\chart.tet already exists, would you like to replace it?

Replace | | Replace All ‘ | Skip ‘ | Skip All ‘ ‘ Cancel

Chose the desired action to continue processing.
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13. Upon completion, the target output folder will appear, displaying all generated files as below:

M = | CA\Temp - O x
Home Share View 2]
x LTz |ﬂ HH setect an
il- Edit Select none
Pin to Quick Copy Copy Delete Rename New Properties )
access o to - folder - £ History DD Invert selection
Clipboard Organize New Open Select
™ » ThisPC » Windows (C:) » Temp v O Search Temp »
*  Name Date modified Type o
s Quick access
Dragen Naturally Spezkin File folder
JB Desktop "9 ¥ Speaking :
Universes File folder
; Downloads |=] 2 connections.bd Text Docume
=] Documents [£] 3128 Incomplete Provider Notes - no sub... Text Docume
=] Pictures 3128 Incomplete Provider Notes SUBREP... Text Docume
P
Data |=| 10435 - Income Statement - Sched 3 - Co... Text Docume
Images |=| 10435 - Income Statement - Sched 3 - Co... Text Docume
Partners |=] 10519 - Research Revenue Report for Cas... Text Docume
Retail |=] 10519 - Research Revenue Report for Cas... Text Docume
ail
|=| AACChairmenMemberAdvisers.tt Text Docume
e Creative Cloud Files |=| AACChairmenMemberAdvisers-O.txt Text Docume
|=| AACDistributionList.txt Text Docume
7@ OneDrive
|=| AACDistributionList-0.tet Text Docume
[ ThisPC |=| AACDistributionListSingle.tdt Text Docume
B 3D Objects |=] AACDistributionListSingle-0.bxt Text Docume
[ Desktop |=| AACInstructions.txt Text Docume
|=| AACInstructions-0.tet Text Docume
| Documents
|=| AACInstructionsSingle.txt Text Docume
& Downloads [5] AACInstructionsSingle-D.txt Text Docume
J Music [ AACOfficerLabels.bxt Text Docume
=] Pictures wlewl 3
206 items =

<
See Also:

» "Create or Select a Project" on page 130

» "Search Wizard" on page 129

» "SelectFile Location(s)" on page 131

» "Add or Edit Search Path(s)" on page 90

* "Localor Network Folders" on page 88

* "Include Archive Files" on page 93

» "Connection Information - Databases" on page 104

» "Choose Report Options and Export Report" on page 140 )
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Troubleshooting and Tips

This section will provide solutions to some workstation, custom network, or programming environment issues. Also included are
some suggestions for frequently asked questions and common product use hints and tips.

Reduce False Positive Matches

Problem:

When dealing with a small number of documents, it is possible for a full-text-search engine to directly scan the contents of the doc-
uments with each query, a strategy called 'serial scanning.' This is what some tools, such as grep, do when searching.

However, when the number of documents to search is potentially large, or the quantity of search queries to perform is substantial,
the problem of full-text search is often divided into two tasks: indexing and searching. All Find it EZ editions use this enhanced per-
formance and more scalable approach.

The indexing stage will scan the text of all the documents and build a list of search terms (often called an index, but more correctly
named a concordance). A concordance is an alphabetical list of the principal words used in a book or electronic document, listing
every instance of each word with its context, including token type (e.g. comment, language keyword, etc.) and programming lan-
guage specific scope (e.g. report page section, etc.). In the search stage, when performing a specific query, only the index is ref-
erenced, rather than the text of the original documents.

The indexer willmake an entry in the index for each term or word found in a document, and note its relative position within the doc-
ument.

Free text searching is likely to retrieve many documents that are not relevant to the intended search question. Such documents are
called false positives.

Solution:
Within Find it EZ, false positive matches can be significantly reduced using the following methods:
Local or Network Folders:

» "Add or Edit Search Path(s)" on page 90

' Note: You can exclude sub-folders and / search specific individual or multiple paths. J

* "Include Archive Files" on page 93

Note: Archive files are excluded by default; including them will extract and search the contents of all files within the
archive (e.g. “zip”) file.

* "Exclude Files or Folders" on page 94

» "Local or Network Folders" on page 88
Databases:

» "Connection Information - Databases" on page 104

‘ Note: You can search a subset of database objects. J

» "Apply Database Item Filters" on page 107

l Note: You can include afiltered set of database items, selected by name (tables, views, stored procedures, triggers, ]
etc.).

» "Reset Search Defaults" on page 105
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Reporting Utilities:
» "Bl Reports" on page 112

l Note: You can include specificreport “(page) sections,” “(search in) areas,” and “search (elements)” unique to each
report type.

* Youcan Use default settings (see link above) to reset the type of data searched to the most common code areas only by
report type.

Documents:
» "Microsoft Excel Search Options" on page 121
Programs:

» "Add or Remove File Extensions Searched" on page 117

‘ Note: You can add or remove custom file extensions to be searched for text-based files. J

See Also:

See Also:

» "Search Within Result Documents" on page 176

» "Set User Options" on page 63; note setting for “Limit the number of matches per object to” can be reduced from
the default of 1000.

» "Perform a Regular Search" on page 150; note the settings available in the Options section - Content Filters cat-
egory.

» "Use the Expression Builder" on page 156; for assistance building complex Boolean queries.

Identify reports using a specified connection

Problem:

You need to determine if there are Crystal Reports using a specific ODBC connection to an underlying data source.
Solution:

There are a couple of ways you can do this using Find it EZ.

Ensure that searching connection information is enabled in the Crystal Report settings:
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* Inthe Source Panelinthe File Systems,cickto Include:

@ Default Project Settings

File Systems
o Local or Network Folders
Databases
Access
DB2 Linux/Unix/Windows
Google Cloud SQL for MySQL
InterSystems Caché
MySQL
Oracle
Postgre SQL
o SQL Server
SQL Server Agent Jobs
Advanced Search Fiters
Crystal Reports

Include Local or Network Folders

Options  Fxclusions ~ File Fiter

X

Search Path(s):
Directory Include Sub Directories?
C:\Users'ken'\Documents\ Test Cases'\UofSask\ v
‘ Add | ‘ Edit | ‘ Remove
Includs Crystal Reports [] Microsoft Excel [ Microsoft Word

1]
[ Text / Xl /CSV

[] SGL (DBA Scripts)
[] Website Development

[] SSRS Reports

Crystal Reports source, as below:

Search within archive files?

O Yes @ No

[] Do nat show this windaw each time | select a scan source tem

+ Open the Crystal Reports project settings: right-clickon Crystal ReportsintheAdvanced Search
Filters sectionofthe Source panelon the left
| | SCL Server Agent Jobs

Advanced Search Filters

I Crystal Reports
Microsoft Excel
Oracle Reports
55RS Reports

L]
Right click to change settings.

- OR - from the menu, select Projects -> Settings -> Crystal Reports

240 © 1998 - 2019 Find it EZ Software Corp.



Program freezes when attempting to index Crystal Reports on a local or network file system

@ Default Project Settings *
File Systems Crystal Reports
o Local or Network Folders
Databases Options
Access
DB2 Linux/Unix/Windows Include: Data Source and Cannections Report Summary (Version/Author)
Google Cloud SQL for MySQL
InterSystems Caché Formulas Running Totals & Summary Fields
MySQL [ Unused Formulas [] Saved Report Data
Oracle
Postgre5aL Pictures SQL Expressions
o SQL Server Record Sorting Subreport Links
SQL Server Agent Jobs
Advanced Search Filters Report Fields Subreport Names
Crystal Reports [] Text Field Contert Report Parameters
[] Field Formatting Alerts (Saved Data Orly)

Section Properties

Report Areas: Main Body Subreports

Sections/Bands: Report Header Report Footer
Page Header Page Footer
Group Header Group Footer
Details

* Inthe Search section, click to check the Data Source and Connections option

Then,
1. Good - Run a Boolean search for {ODBC} AND {DSN}; where DSN is your DSN. That should find all of the reports with that
connection.
OR

2. Best- Generate the "SQL Code Extract" Report which will list all of the connections used in your reports. You can then filter
and sort the spreadsheet to those using ODBC and a certain connection.

Note: We cannot "follow the link" so to speak. Where a report is using an ODBC connection called PRODUCTION and thatis
pointing to dblive01, we will not be able to show you dblive01.

See Also:

» "Perform a Regular Search" on page 150

» "Reporting Tools" on page 221

Program freezes when attemﬁti_ng to index Crystal
Reports on a local or network file system

Problem:

When attempting to index a number of Crystal Reports files, the search panel animated gears appear to freeze and the index
counter stops incrementing after a long period of time has elapsed.

Solution:
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1. Fromthe menu, select Tools -> Customize -> User Options .

@ User Options *

On Startup
(® Use application default search settings | Boolean, Entire Document )

() Use last search settings
Show Wizards
Show me when updates are available

Performance

] RFunin reduced performance mode {Used for troubleshooting)
[] Enable Crystal Report locked file pre-checks {Local or network files only)

Wam me ff files are larger than : MEB

Results

] Automatically expand details
] Aways view my exported report after saving

Limit the number of matches per object to :
Tips and Hints
Show project settings whenever | select a source item
Show an alert when | try to remove one or more search results
Show an alert before | attempt to search database or saved report data
Show an alert whenever | add an item to the project exclusions list
[] Enable detailed emor logging

oK Cancel

2. Inthe Performance section, click to check the Enable Crystal Report locked file pre-checks (Local or network
folders only) option.

This allows the Crystal Reports scanner to detect locked files during indexing and, if a file is currently open or locked, to make a tem-
porary copy of the file before allowing Crystal Reports to open it. Note that this feature is disabled by default as it can affect per-
formance.

Note: Thisfeature is disabled by default as it can affect performance. It is recommended that you disable this performance
troubleshooting option once the documents are successfully indexed.

Use of 7-Zip has been denied by your Administrator

Problem:

While indexing a project, you receive a Windows 10 message, which reads: Use of "7-Zip" has been denied by your Administrator...

Note: This message would be generated by security software and would appear in the lower right corner of the monitor, similar to
other windows alerts.

Thisis a dependency/ prerequisite built-in open source program that our application bundles and uses for processing the following
document/ source file types:
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» Excel (xslx)
* MS Word (docx)
* SAP Dashboards ( aka Xcelsius )

Aswell as if you have "Include Archives" checked off under the Local File System location and you have one or more archives in your
search folders.

9 My Sample Project Settings X

Include Local or Network Folders

i Local or Network Folders

>

BusinessObijects Bl platform 4 Options  File Fifter
- Git / GitHub
- SQL Server Reporting Service Search Pathis):
- SWN (Subversion)
- Team Foundation Server
... Vigual Source Safe C:\Users'wmooman'.Documents'Clients\Find it EZ\Excel Example v
i Databases
Access
- Amazon RDS for MySQL
- Amazon RDS for Oracle
- Amazon RDS for PostgreSQL
- Amazon RDS for SQL Server
- DB2 Linwe/Unic Windows
- Google Cloud SQL
InterSystems Caché ol ‘ |
MySQL
- ODBC O Include archive files
- Oracle
- Postgre SQL Exclude filels) / Folderis):
-- SAP HANA
- SAP IQ
SAP SQL Anywhere
SAP Sybase ASE
- SQL Azure
- SQL Server
- File Type
: - Report Utilities
- Crystal Reports
Qracle Reports
SAP Dashboards (Xcelsius)
- SQL Server Reports Import | ‘
rogramming Languages
L A= v
£ >

[T] Do not show this window each time | selsct a scan source item

Solution:

Directory Include Sub Directories?

Erter each item on a seperate line.
Use *for wildcards

Clear

If a system administrator enforces a rule disallowing use of the 7-zip program, then either this restriction has to be removed by the sys
admin OR the end-user unfortunately cannot search the above particular document types with Find it EZ.

Note: You may even get this message when attempting to install Find it EZ while logged onto a computer without Administrative
rights. You will still be able to install the program, but use of the features requiring 7-zip will record an error and may cause the pro-
gram to crash.

Find text in a text box in a Crystal Report

Searching of text field content is not enabled by default but can be enabled by doing the following:

1. Onthe Source panel (on the left), right-clickon"Crystal Reports"undertheAdvanced Search
F'il ters section. This wil bring up the Project Settings configuration dialog for Crystal Reports.
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Find text in a text box in a Crystal Report

@ Find it EZ - My Sample Project - o X

File Projects Compare Replace Document Backup Tools Help.

| wars | Fincs ot - | optors: |(EXERER | xpression s

Source < Results
Search yi |-~ Select a search result -- ~ [ Search within selected Documents
[ Folders & Version Control
Results (displaying 177 f 177)  Statistics Errors (3)
4 IS
LI"‘;‘ ‘;'GNT:W:”‘ Folders [lv  Location Type Host File Path or Database Document Matches 4
1 Git/ Gt
m ‘F ‘d“ . [m] Local or Network Folders  Crystal Report  FINDITEZ-T460P  C:\Users\uwDocuments\Te...  Group Selection.rpt 3
e m] Local or Network Folders  Crystal Report  FINDITEZ-T460P  C:\Users\ewe\Documents\Te.., 3128 Incomplete Provider Notes SUB.. 2
e et ol 2 Local or Network Folders  Crystal Report  FINDITEZ-T460P  CAUsers\vw\Documents\Te... 3128 Incomplete Provider Notes - no... 1
B = ] Local or Network Folders  Crystal Report  FINDITEZ-T460P  C:\Users\wweDocuments\Te... Record Selection.rpt 1
[] Crystal Reports Server 2011 [} Local or Network Folders  Crystal Report  FINDITEZ-T460P  C:\Users\ww\Documents\Te... ~ pricelist.rpt 3
[ Microsoft Reporting Services m} Local or Network Folders  CrystalReport  FINDITEZ-T460P  C:\Users\ww\Document:iTe...  Summary Grouprpt 1
o Local or Network Folders  Crystal Report  FINDITEZ-T60P  CAUsers\wwDocuments\Te...  Order Processing Efficiency Dashboa... 101+
[ rePORTAL rystal Rep 9 Y
[} Local or Network Folders  Crystal Report  FINDITEZ-T460P  C:\Users\wwe\Documents\Te...  Group.ipt H
[ Databases #|O0 Local or Network Folders  CrystalReport  FINDITEZ-T460P  Ci\Users\w\Dacumentsi\Te..  Record Sarting newd.rpt H
a Local or Network Folders  CrystalReport  FINDITEZ-T460P  CAUsers\vwDocuments\Te... 10435 - Income Statement - Sched 3... 101+
[] DB2 Linux/Unix/Windows =l B e e i - - - &
[1 InterSystems Caché Details
O mysaL
[ Oracle
[] PostgreSQL
[ SAP HANA
[ sat Server
[] SOL Server Agent Jobs
Advanced Search Filters
Crystal Reports [t cick to change setfings
Microsoft Excel
Oracle Reports
SSRS Reports

3806 matches found.

Alternatively, you can get to this window from the menu as follows: | Projects -> Settings , then clickon"Crystal
Reports."

e My Sample Project Settings x
Folders & Version Control Crystal Reports
+ Local or Metwork Folders -
Git / GitHub Options

Team Foundation Server
Business Intelligence Include: Data Source and [] Report Summary
Crystal Reports Server 2011

Microsoft Reparting Services

Formulas Running Totals & Summary

1ePORTAL [] Unused Formulas [] Saved Report Data
Databases Pictures SOL Expressicns

DB2 Linux/Unix/Windows Record Sorting Subreport Links

InterSyst Caché

’\;;Srq)f ems Lache Report Fields Subreport Names

Report Parameters

Oracle Text Field Content

PostgresQl - -
Field Formattin Alerts (Saved Data Onl
SAP HANA U 9 ¢ ¥
SOL Server Section Properties Custom Functions (Main Body)
SQL Server Agent Jobs
Advanced Search Filters Report Aress: ] Main Body Subreports
Crystal Reports
Microsoft Excel Sections/Bands: Report Header Report Footer
Oracle Reports Page Header Page Footer
SSRS Reports

Group Header
Details

Use default settings

Group Footer

[ Do not show this window each time | select a scan source item.

2. Clicktocheckthe Text Field Content option.
3. Clickonthe

4. The nexttime a Crystal Reports document search is done it will include content within text boxes.
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Find it EZ Support

Find it EZ Support

This section describes the many support options available with Find it EZ, how to report a bug, or a request a feature to Find it EZ
Software Corp.., and how to view or send your session log.

Support Options

Support Option Navigation

Contact Find it EZ Software Corp. https://lwww.finditez.com/support/#contact

Frequently Asked Questions https://www.finditez.com/support/#faq

Search Knowledge Base https://lwww.finditez.com/support/#kb

Syntax and Examples https://www.finditez.com/support/#syntax

Requesta Demo https://www.finditez.com/support/#demo

Watch Instructional Videos https://www.finditez.com/resources/#by video

View Session Log From the program menu, select Tools -> View Session Log . The session log will
open in Notepad. Each event line will start with the event date and time, followed
by details.

Send Logs to Support From the program menu, select Help -> Send Logs to Support

Checkfor Updates From the program menu, select Help -> Check for Updates .
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My Find it EZ Account

My Find it EZ Account

This section describes how to register for and manage your Find it EZ account, access software downloads, managing serial num-
bers, quotes, orders, and creating or reviewing support tickets status.

My Account

The My Account tab on the member website allows you to manage your contact information, update alerts, subscriptions, and
change your password. This section will describe how to register for and log in to manage your Find it EZ account.

Once registered, you can log in to the secure member area of Find it EZ, where you can change your password, download product

updates, update your email subscriptions, retrieve product activation keys, view order history, process payments, check on the status
of or submit new support tickets.

Register for a free Find it EZ member account:

Note: You must use a valid corporate e-maildomain address. Free or blacklisted emaildomains (e.g. gmail, hotmail, etc.) are not
accepted. Thisincludes your primary e-mail address associated with a social account ( LinkedIn, Twitter, Google Plus, or Face-
book.

There are three ways to register for a Find it EZ member account.
Option 1:

1. Visit https://www.finditez.com/register.

2. Fillinthe New User Registration form.
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Register for a free Find it EZ member account:

New User Registration

Email Address: .
Confirm Email: .
Password: °
Confirm Password: °
First Name: .

Last Name: .

Company Name:

How did you hear about A friend or colleague told me v
us?:

Are you Human? oy
I'm not a robot

. Note: Items with dots are required. The Are you Human? option must also be checked. ]

3. Clickon the[Register |button. A verification email will be sent to the provided email address.

4. Tocomplete your registration, click on the link in the email . The website willopen and you will be logged in automatically.
Option 2:
1. Register for a free trial following these steps:

2. \Visithttps://lwww.finditez.comand click on any one of the trial download links or buttons.
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Register for a free Find it EZ member account:

3. Fillinthe Start your tree trial form.

Start your free tria
L]
L] L]
L]
Select a product edition T e
o

I'm not a robot

u Find it EZ - You have
us WEEKS if not MONTHS

of work !! Love the software.

I
za

John Flemming, Director,
Information Technology

compare editions

Download Trial Now

help me decide

4. Click onthe[Download Trial Now |button. A separate welcome and trial key emails will be sent to the provided email address.

Option 3:

Use one of your social media accounts to sign-in following these steps:

1. Visit https://www.finditez.com/login.

2. Click on any one of the available social account sign-in buttons located on the right. See below:

Login

Email Address:
Password:

Remember my Login

Not a member yet? Register now for free!
Forgot your password?

Resend Login account activation email { Note: whitelist donotreply@finditez.com )

Orsigninusing

s
S f_ Sanmvilh Facebook
.

& Signinwith Twitter

I Sian in with Linkedin
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Log In to Your Find it EZ Member Account

3. When prompted, accept the social account access. The secure member site will open with the My Account tab selected
and a welcome email will be sent to your associated email address with a random password assigned.

' Alert: We highly recommend that you change the temporary password as soon as possible.

Note: New login accounts are automatically associated with and linked to a pre-existing company account based on matching cor-
porate email domain. This provides instant shared access to internal support tickets and serial numbers for a given entity.

Log Into Your Find it EZ Member Account

There are two ways to log into the secure member area:
Option 1:
Tolog in to your Find it EZ member e-mail account, follow these steps:

1. Visit https://www.finditez.com/login.

2. Enter your account Email Address and Password.
3. Clickonthe button. The secure member site will open with the My Account tab selected.

Option 2:
To sign-in with one of your social accounts linked to your email address, follow these steps:

1. Visit https://www.finditez.com/login.

2. Click on any one of the available social account sign-in buttons. See below:

Log in or Sign Up for a new account

For access to free trials, webinar replays, software downloads, your private serial numbers, quotes, orders and suppaort tickets.

Or sign in using

W Sign in with Twitter

Log In Sign Up

Welcome Back!

in Signinwith Linkedin

S

3. Ifprompted, accept the social account access. The secure member site will open with the My Account tab selected.

Update Account Details and Preferences

1. Logintoyour Find it EZ Member Account.

2. Onthe My Account tab, make changes as desired.
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Change Account Password

My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets Feedback
~
Email Address: -
First Name: .
Last Name: .
Phone Number;
Company MName:
Undate alerts on ¥ Alert all users when a newer release is available
program start-up?
Subscribe to mT."”tnf ¥ New Release Announcements
ists?
¥ Quarterly Newsletter
) Special Offers
3. Clickon the[Update |button to save.
1. Loginto your Find it EZ Member Account.
My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets Feedback
Email Address: [~
First Name: .
Last Name: .
Phone Number:
Company Name:

Update alerts on
program start-up?

Subscribe to mailing

S ¥ New Release An
ists?

uncements
# Quarterly News|ftter

) Special Offers

¥/ Alert all users wherfla newer release is available

2. Onthe My Account tab, click on the[Change Password |button. A Change Password dialog box will appear.
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Manage Linked User Accounts

Change Password
Email Address:

Password:

Confirm Password:

3. Inthe Password and Confirm Password fields, enter and confirm the new password.

4. Clickon the[Update |button to save your changes.
5. Clickon the|X|button to close the Change Password dialog box.

Manage Linked User Accounts

Add New Account Contacts

To add additional end-users associated with your company, so that they may have direct access to download software updates, self-

serve license key management and support, simply follow the steps below:

‘ Note: Only the primary company account contact can make these changes.

1. Logintoyour Find it EZ Member Account.

2. Onthe My Account tab, scrolldown to locate the Linked User Administration section.

Linked User Administration

User Prime Contact

O

Add more Change Prime Contact

Accts Payable
v

Remove

3. Inthe User column, clickon the Add more link. The Add New Contact dialog box will appear.
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Change Prime Account Contact

Add New Contact

Email Address (Login):

Password:

First Mame:
Last Name:

Phone Number:

Accounts Payable Contact?:

"If a password is not entered, one will be randomly generated
and sent to the new user email above”

T

4. Enter information for the new contact.

<
Note: You must use a valid corporate email domain address. Free or blacklisted email domains (e.g. gmail, hotmail, etc.)

l are not accepted.

J

<
Note: Accounts payable contacts have access to view and remit secure online payment for orders and/or quotes, regard-

l less of which company contact created the order.

J

5. Clickon the[Add |button to save. If a password was not entered, a temporary one will be sent to the new contact.

l Alert: We highly recommend that the new contact logs in and changes his/ her temporary password as soon as pos-
sible.

J

6. Toadd another contact, click on the| Add Another |button and repeat steps 4 and 5 above. Or, click on the Cancel orbut-

ton to exit.

Change Prime Account Contact

Note: Only the primary company account contact can make this change. Once changed, all notifications, renewal alerts, etc. are ]

l sent to the new contact automatically.

1. Loginto your Find it EZ Member Account.

2. Onthe My Account tab, scrolldown to locate the Linked User Administration section.
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Remove an Account Contact

Linked User Administration

User Prime Contact Accts Payable

® v

Add more

Change Prime Contact

Remove

3. Inthe Prime Contact column, click to choose the new prime/admin contact.

4. Clickonthe[Change Prime Contact |button to save your change. See example below:

Linked User Administration

User Prime Contact Accts Payable
v

Change Prime Contact

Add more

Remove

Remove an Account Contact

If a staff member is no longer with your organization or department, you can remove access to your Find it EZ company licenses and

product order information (applicable to accounts payable contacts only) as follows:

‘ Note: Only the primary company account contact can make these changes.

1. Logintoyour Find it EZ Member Account.

2. Onthe My Account tab, scrolldown to locate the Linked User Administration section.

Linked User Administration

User Prime Contact Accts Payable

o v

Remove

Change Prime Contact

Add more

3. Locate the name of the contact you want to remove from your account.

4. Inthe far right column, click on the corresponding Remove link. A confirmation message will appear.

Are you sure you want to remove the alternate login

[ o]

5. Toremove the selected contact, click on the[ Yes |button. The contact will be removed from the list.

Linked User Administration

User Prime Contact

O v

Change Prime Contact

Add more

Accts Payable

6. Tocancel, click on the[No |button.
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Manage Company Address Records

Manage Company Address Records

Your company address records are automatically added and/or updated during the order check-out process.

Finditez

SOFTWARE

Home » Checkout » Step 1 Welcome

2]

SUPPORT

Q2
CHAT

My Account | Log out

Checkout

Step 1- Account details == Step 2 - Confirm order == Step 3 - Select Payment Method

Select Billing Address Select Shipping Address

HTML and PDF formats now available for review

s Releases -
I on the resources learning page

Knowledge Base

@ Frar::

: ©1998-2016 Find it EZ Software Corp.
change made simple

My Business 1234 Happy Street SE Calgary, AB T2C 3J9 CA Delete My Business 1234 Happy Street SE Calgary, ABT2C 3J9 CA
Add New Address Add New Address
COMPANY SUPPORT LATEST NEWS PARTNERS & AWARDS
About Us FAQ Oct 4 2016 - “NEW* draft user guides in online ft Platfor

Awards Syntax and Examples ’{'."\!
Partners My Tickets Status Senz3 2018 N WippeinrL fof‘ogdedlggi)(} - Sgh

y P - orms, schedules an oogle Clous
Become a Partner Contact Us with 10x faster performance in new 2017 17.0.5 Microsoft Partner
Legal Notices Site Map release, now available ORACLE' Silver
Security & Privacy Partner

Same as Billing

Delete

Save and Continue

G v )& |ofin

In addition to being able to select, add, or update address records using our secure cart check-out process, any active contact may
also add, update, or remove address records that are linked to the company profile. These changes are immediately reflected and

available for subsequent online orders placed.

Add Company Address

1. Loginto your Find it EZ Member Account.

2. Onthe My Account tab, scrolldown to locate the Address List section.
Address List
Company Address Contact
My Business 1234 Happy Street SE Calgary, AB T2C 3J9 CA My Business =&
AddMOre o —
3.

below:

Inthe Company Address column, clickon the Add more link. The Address Information dialog box willappear, as
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Add Company Address

Address Information

Contact Mame:

Email:

Phone:
Company:
Address Line 1:
Address Line 2:
City:

Country:

Please Select T e

Prov / State:

Postal / Zip Code:

I

4. Enter or select company location information.

l Note: Items with a dot are required. J

5. Clickon the[Save|button. The new address will be added to the list.

Address List

Company Address Contact
My Business 1234 Happy Street SE Calgary, ABT2C 3J9 CA My Business =@
My Other Business 5678 Somewhere St NW Calgary, ABT1X 0L6 CA My Other Business Edhi}

Add more
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Update Company Address

Update Company Address

1. Loginto your Find it EZ Member Account.

2. Onthe My Account tab, scrolldown to locate the Address List section.

Address List

Company Address Contact
My Business 1234 Happy Street SE Calgary, AB T2C 3J9CA My Business edho}
My Other Business 5678 Somewhere St NW Calgary, AB T1X 0OL6 CA My Other Business =W
Add more

3. Locate the address you want to edit.

4. Inthe far right column, click on the corresponding editicon. The Address Information dialog box will appear.

Address Information

Contact Name:

Iy Other Business ™

Email:

DOO-I0I-ID0D

Company:

My Other Business

Address Line 1:

5678 Somewhere St NW L]

Address Line 2:

City

Calgary ™
Country:

Canada " e
Province:

Alberta " e
Postal Code:

TiX0L6 ™

I
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Remove Company Address

5. Change company location information as desired.

' Note: Items with a dot are required. ]
6. Clickon the[Save|button.

Remove Company Address

1. Logintoyour Find it EZ Member Account.

2. Onthe My Account tab, scrolldown to locate the Address List section.

Address List
Company Address Contact
My Business 1234 Happy Street SE Calgary, ABT2C 3J9 CA My Business
My Other Business 5678 Somewhere St NW Calgary, AB T1X OL6 CA My Other Business
Add more

3. Locate the address you want to delete.

4. Inthe far right column, click on the corresponding delete icon. A confirmation message willappear.

Are you sure you want to remove the address for: 5678 Somewhere St NW Calgary TIX0L6 7

=1 =]

5. Todelete the selected company address, click on the[ Yes|button. The address will be removed from the list. See below:

Address List

Company Address Contact
My Business 1234 Happy Street SE Calgary, AB T2C 3J9 CA My Business =@

Add more

6. Tocancel, click on the[No |button.

Software Downloads

The Software Downloads tab on the member website allows you to download new releases and connectors and to view release
notes and system requirements.

Download Release Version

From the Program:

1. See"From the Find it EZ menu, select Help -> Check for Updates." on page 39
From the Website:

1. Logintoyour Find it EZ Member Account.

2. Clickto select the Software Downloads tab. A list of product releases and optional connectors will appear.
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Download Release Version

a.

My Account Software Downloads Serial Numbers

‘Quotes

Download Release

Orders

Product Version
Code Search Pro - Desktop 2017 17.1.2
Code Search Pro - Server 2017 17.1.2
Dev Surge 365 - Enterprise 2017 1712
Code Search Community 17.0.5
Eclipse Plugin 116

Date
2016-12-20
2016-12-20
2016-12-20
2016-09-28
2011-07-19

W | [

®

i)

[

£
&
&
S

Notes | Specs |.net

My Support Tickets Feedback

HANA
1.00.097
1.00.097
1.00.097

Download Connectors

Crystal Reports DB2 Access Bl4.1 XI31 Git
13.017 105 2007
105 2007

105 2007 | 1417 | 127 271

3. Locate the product and release version that you want to download.

4. Download the product as follows:

In the Version column, click on the product release number for the corresponding product row. The release setup file will

begin to download.

OR

In the Specs column, click on the download icon for the corresponding product row. The system requirements will be
provided. Click on the[ Download Now |button and the corresponding release setup file will begin to download. See example

below:

Dev Surge 365 Enterprise
SYSTEM REQUIREMENTS

» Certified Microsoft Platform Ready for Windows Desktop Vista/7/8/10 ( 32 or 64 bit editions
» Certified Microsoft Platform Ready for Windows Server 2008/2012 ( 32 or 64 bit editions |
» Runs as a 32 bit .net executable, requires Microsoft. NET Framework 4.5

30 days.

Download Now m

» Download setup file for Windows (58 MB)

This setup package includes the latest stable release for both registered
user upgrades as well as fully functional trial installs. Trials will expire after

5. Locate and launch the downloaded *.exe setup file from your target system. AFind it EZ InstallShield Wizard dialog box

willappear.
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View Release Notes

ﬁ Find it EZ - Code Search Pro Desktop - InstallShield Wizard X

Welcome to the InstallShield Wizard for Find it
EZ - Code Search Pro Desktop

The Installshield(R) Wizard will allow you to modify, repair, or
remove Find it EZ - Code Search Pro Desktop. To continue, dick
MNext.

Click on the[Next|button.

Read and follow the installation instructions.

When complete, click on the[Finish |button.

' Note: The same product setup files are used for both trials as well as full release or upgrade installs.

See Also:

» "Download Connectors" on page 264
* "View Release Notes" below

* "View System Requirements" on page 262

» "Installation, Activation, and Updates" on page 3

View Release Notes

From the Program:
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View Release Notes

ment Tools | Help

ductlD Support Options
Uszer Guide

n Ais el Request a Demo pject: My Sa
Report A Bug within sel

esulis { displayin Send Logs To Support
Send Feedback

Location ost
SGL Server Check For Updates
SQL Server | View Release Motes [

About Find it E£

1. Fromthe Find it EZ menu, select Help -> View Release Notes . Release Notes willopen in a new browser window showing
the most recent information first.

17.0.18 - Nov 30,2016

It is recommended that all users upgrade to this release.

Due to fixes in this release, your index will be reset.

APPLICATION

¥ Fixed a bug that was preventing the “Section” column from being displayed properly in the File -> Export -> Search Result Details report
» Fixed a bug where sorting of columns was not warking correctly if one or more columns were hidden
¥ Fixed a bug where PDF documents where not being indexed but not searched.

DETAILS

Number Summary

2293 Saved search results details "section” column is blank

2303 Performance Improvement - Split Index

2310 Cosmetic issues

2317 PDF - not finding matches unless "Use Pre-indexed Documents” is checked off.

2321 Connection Change Wizard - Clicking on the first table list column caused Find it EZ to crash
2325 ‘When a result column is hidden sorting is not working correctly

2326 Index files are removed but the mapping is not, causes errors during search.

2. Scrolldown to view historical notes.
3. Toclose Release Notes, close the browser tab or window.

On the Public Website:
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View Release Notes

1. Visit https://lwww.finditez.com/products/#release.

Overview Pricing Release info Screenshots What can it search?

@ Code Search Pro Desktop
@ Code Search Pro Server
@ Dev Surge 365 Enterprise
@ Dev Surge 365 Ultimate

@ Community Edition

2. Clickthe + (expand) button to view details for the desired product edition.

Overview Pricing Release info Screenshots What can it search?

@ Code Search Pro Desktop

@ Code Search Pro Server

© Dev Surge 365 Enterprise
Release 17.1.2 ( Dec 20, 2016)

What's new in the latest release:

¥ *NEW?* integrated wildcard "word" search within Boolean expressions.
» Removed separate wildcard search type, now included in default (Boolean) search type.
» *NEW?* Exact match (word or string) filter to reduce faise-positives when applicable.

-

Performance Enhancements:

Application startup times have been reduced by 95 %
Initial full index times have dropped by 60%

v v w

Re-fresh index (update changed source documents only) times have dropped by 99%

-

Search step times have dropped by 95%

-

Improved index stability and program scalability.

-

Renamed buttons “Search Assistant™ to "Wizards" and "Advanced” to "Expression Builder” on main app search bar.
Fixed a bug in Compare that prevented differences from being listed in versions 17.0.0 through 17.0.17 inclusive.

-

g Full Release Notes

Starting @ $468 per user ( includes 1 year software assurance & unlimited free support plan)

Under Development

¥ Scan projects, branches, files within additional Source Control Management repository including Perforce P4, Surround SCM, Mecurial and CVS.
» Add support for data dictionaries and ETLs such as 5515, SSAS, SAP BOE Universes.

» Add support for generic OLE DB databases, Informix and SQLite databases.

¥ Add support for MS Access ACCDB ( 2007 + ) databases.

» Add support for Tableau, Qlikview, Logi Analytics, SAP Lumera, Webi { Web Intelligence ), IBM Cognos.

» New "Sequential Words" search patterns ... find the word "this" followed by "that” within "x" words.

Have any other specific needs? Submit your ideas or requests directly to our development team.

3. View asummary of the latest release highlights, and click on the Full Release Notes link for more detail.
On the Member Website:
1. Logintoyour Find it EZ Member Account.

2. Clickto select the Software Downloads tab. A list of product releases and optional connectors will appear.
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View System Requirements

Product

Code Search Pro - Desktop 2017
Code Search Pro - Server 2017
Dev Surge 365 - Enterprise 2017
Code Search Community

Eclipse Plugin

My Account Software Downloads

Version
17.1.2
17.1.2
17.1.2
1705

116

Serial Numbers

‘Quotes

Download Release

Date
2016-12-20
2016-12-20
2016-12-20
2016-09-28
2011-07-19

Notes

W | [

®

i)

Specs

[

L R L

Orders

net
4.5
45
4.5

22

My Support Tickets

HANA
1.00.097

1.00.097

Feedback

Download Connectors

Crystal Reports
13.017

13.0.17

DB2
10.5
10.5
105

Access

2007

Bl41 X131 Git

1417

127 | 271

3. Locate the product release for which you want to view release notes.

4. Inthe Notes column, click on the corresponding note icon. A Release Notes dialog box willappear showing the most

recent information first.

APPLICATION

DETAILS

Number
2293
2303
2310
2317
2321
2325
2326

17.0.18 - Nov 30,2016

Due to fixes in this release, your index will be reset.

Summary

It is recommended that all users upgrade to this release.

» Fixed a bug where PDF documents where not being indexed but not searched.

Saved search results details "section” column is blank

Performance Improvement - Split Index

Cosmetic issues

¥ Fixed a bug that was preventing the “Section” column from being displayed properly in the File -> Export -> Search Result Details report
¥ Fixed a bug where sorting of columns was not working correctly if one or more columns were hidden

PDF - not finding matches unless "Use Pre-indexed Documents” is checked off.

Connection Change Wizard - Clicking on the first table list column caused Find it EZ to crash

‘When a result column is hidden sorting is not working correctly

Index files are removed but the mapping is not, causes errors during search.

5. Scrolldown to view historical notes.

6. Toclosethe Release Notes dialog box, click on thebutton.

View System Requirements

All editions of Find it EZ programs require a Microsoft Windows operating system that can run .net4.5 or newer. For detailed tech-
nical specifications, see https://msdn.microsoft.com/en-CA/library/8z6watww . For individual edition requirements, see below.

On the Website:

1. Loginto your Find it EZ Member Account.

2. Clickto selectthe Software Downloads tab. Alist of product releases and optional connectors willappear.
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Download .NET Framework

My Account Software Downloads Serial Numbers ‘Quotes Orders My Support Tickets Feedback

Download Release Download Connectors
Product Version Date Notes | Specs |.net HANA  CrystalReports DB2 Access Bl4.1 X131 Git
Code Search Pro - Desktop 2017 17.1.2  2016-12-20 B & 4.5  1.00.097 13.017 105 2007
Code Search Pro - Server 2017 1712  2016-12-20 B £ 45 1.00.097 7 105 2007
Dev Surge 365 - Enterprise 2017 17.1.2 | 2016-12-20 Ei] & 4.5  1.00.097 13.017 105 2007 | 1447 | 127 271
Code Search Community 1705 2016-09-28 B & 22
Eclipse Plugin 116 2011-07-19 3

3. Locate the product release for which you want to view system requirements.

4. Inthe Specs column, click on the corresponding download icon. A System Requirements dialog box will appear.

Dev Surge 365 Enterprise
SYSTEM REQUIREMENTS

» Certified Microsoft Platform Ready for Windows Desktop Vista/7/8/10 ( 32 or 64 bit editions )
» Certified Microsoft Platform Ready for Windows Server 2008/2012 ( 32 or 64 bit editions )
» Runs as a 32 bit .net executable, requires Microsoft. NET Framework 4.5

This setup package includes the latest stable release for both registered
user upgrades as well as fully functional trial installs. Trials will expire after
30 days.

» Downlead setup file for Windows (58 MB)

Download Now m
5. Todownload the selected product release, click on the| Download Now |button.

6. Toclose the System Requirements dialog box, click on thebutton.

Download .NET Framework

Alert: The .NET framework connector is required. If you do not have the required .NET 4.7.2 pre-installed, you will be prompted
to download this prerequisite from Microsoft. We provide an alert and link to the appropriate download page depending on the
Windows operating system you are running. The program will not launch until .NET 4.7.2 is installed.

On the Website:
1. Loginto your Find it EZ Member Account.

2. Clickto select the Software Downloads tab. Alist of product releases and optional connectors willappear.
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Serial Numbers

My Products

Download Release

Product Version Date Notes

Code Search Pro - Desktop 2018 18.0.41 | 2018-09-11

Code Search Pro - Server 2018 180.42 | 2018-10-26

Dev Surge 365 - Enterprise 2018 18.0.41 | 2018-09-11

Older Versions

Download Release

Product Version Date

Code Search Pro - Desktop 2013 4412

2013-04-17

17.1.18

Code Search Pro - Desktop 2017 2017-04-27

Other Trials/Downloads

Download Release

Product Version Date

Code Search Community 2018 18.0.41 2018-09-11

Quotes

Notes

Notes

Orders My

Crystal Reports
Help me decide
Help me decide

Help me decide

Crystal Reports
13.06

13019

.net HANA

B a7

Support Tickets

Optional Connectors

DB2 Access

Help me decide = 2016

Optional Connectors

DBz  Oracle

Optional Connectors

Crystal Reports DB2

Feedback

Access

SAP BI Git

Help me decide | 2.12.0

Bl41 XI31 Git

Access SAP BI Git

3. Locate the product release for which you want to download the .NET framework.

4.

In the .net column, click on the corresponding .NET version number. A Microsoft.NET Framework dialog box will appear.

Microsoft NET Framework 4.7.2
REQUIRED

Download a compatible 86 version from our server (1mb)

Download a compatible version for your system dire

Download Now

y from Microsoft

5. Todownload the selected version from the Find it EZ server, click on the[ Download Now |button. OR

6. Todownload the selected version directly from Microsoft, click on the directly from Microsoft link.

7. Toclose the Microsoft.NET Framework dialog box, click on the Close or|z|button.

Download Connectors

Source items that require a connector will appear with a small warning icon preceding the name. See example below:

Note: Some connectors are required (e.g. ".net') but others are optional (depending on whether or not you want to search a par-
ticular document type that then needs a corresponding vendor supplied connector). After product install on first run configuration
wizard for setting up your environment, if you select one or more source items that require connectors, the wizard will prompt you
to auto-download and install them. If you do not do so, or later add a source item, you will note that it has a yellow alert triangle icon
nextto it in the left (Source) panel. If you attempt to include such a source item in a project, you will be prompted to auto download

and install the required connector.
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@ Find it EZ - My Sample Project
File  Projects Compare Replace Reports  Tools  Help
| Search Assistant Find: Enter Boolean Expression ...
Source = Results
Statistics | Errars (0)
[ Databases See more
[] DBE2 Linwc/Unibe Windows To begin a seanch, use the search assistant or:
[] mysaL (1) select and configure settings for one or more source ite
[] Orack (2) set your search options on the right
[] PostgreSaL {3) enter your search terms or use the Advanced wizard to
[ & SAP HANA
[] 5GL Server

Click on the source item / warning to download the associated connector.

If you try to initiate a search that includes a selected source lacking a required connector, an error message willbe generated. See

example below:

Q) %

The connectar for SAP HAMA is not installed.

You can download a compatible version from our website using the button below.

You will not be able to use this search module urtil the connector is installed.

Download | | Cancel

From the Program:

' Note: Downloading and installing a connector will require local administrative rights on your system.

1. Fromthe Find it EZ menu, select Tools -> Connector Manager .

©2010-2019Find it EZ Software Corp.
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&) Find it EZ - My Sample Project
File  Projects Replace Document | Tools | Help
| Wizards | Customize »
View Session Log -
Source = . .
Clear Expression History
Prowy Settings
] File Systems y 9
Connector Manager |
Local or Metwork Folders -
License Management »
[] Databases Index & Search Management
[T (3} sef Uptions 1o optimize search res
A Connector Manager dialog willappear.
@) Connector Manager X
Show Al ~
Name Installed 32-bit Version Other Available 32-bit Versions Release Date
‘T‘._‘; Find it EZ Git Runtime 21201 Feb 25, 2017
@ SAP HANA Database Client 1.00.102.06.1461042750 1.00.097.00.1434028111 Jul 02, 2015
‘D |IBM Data Server Driver Package 11.1.0.1527 Help me decide
'D SAP Business Objects Bl platform .MET Runtime (32-bit} 1424 2464 Help me decide
‘ ‘ | Open Downloads Folder ‘

2. Optionally select one of the Show drop down options to filter the list. For example, selecting the optonMi s sing will dis-

play a list of required connectors that have not yet been installed based on the source items you have configured using the
Configuration Wizard.

Note: Items with a check-markicon o next to them indicate you have the minimum or newer connector version detec-
ted as already installed on your system.

e

=
3. Click on any one of the items with an install icon g then click the| Install / Update |button. The connector will begin down-
loading.

Downloading SAP Crystal Reports runtime engine for MNET (32-bit)

Progress:  18.8 MiB/74 1 MiB (25% complete)

==
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Once downloaded, a Find it EZInstallShield Wizard willappear.
Click on the[Next|button.

Read and follow the instructions provided.

When complete, click on the[Finish |button.

& o T D

4. OR, clickon any one of the items with a download compatible version icon i , then click the[Help me decide |button or
hyperlink for that item. T his will launch your browser and open a page on the Find it EZ Software Corp. website to help you
select the correct version of the connector based on other related software installed on your workstation. For example, click-
ing on the "IBM Data Server Driver Package" for the required DB2 connector will take you to this page, see below:

Q Finditez Products Solutions Customers Quotes Shop Support Resources Blog Q LogIn

home / support / connectors / DB2

DB2 Integration

Find it EZ ires the IBM Server Driver Package client installed in order to connect to and search DB2 databases.

Plea he appropriat it connector below.

Download Free Trial

Code Search Pro Desktop, Pro Server or Dev Surge 365 Enterprise
Find it EZ v18 or later

DB2 runtime 9, 10 and 11 are certified compatible. Choose the one that most closely matches your DB2 database server or your workstation
DB2 client tools version installed. NOTE: All versions are backwards compatible.

» IBM Data Server Driver v11.1 - Download Here (52mib), Alternatively this is available directly from IBM Here
» IBM Data Server Driver v10.5 - Download Here (75mb)
» IBM Data Server Driver v9.7 - Download Here (26mb)

5. Follow the instructions on the website page to select, then download and chose to either save or run the corresponding
setup package depending on your browser and network security permissions.

Note: If you chose to save the setup package to your local system, you will then need to locate and run it with admin-
istrative rights once the download completes successfully.

Tip: The[Open Downloads Folder|button will contain all downloaded Find it EZ setup packages within this default path:
C:\ProgramData\Bits n Bytes Software Inc\Installers . To keep all related downloads organized for re-use, it is recom-
mended that you save these "version compatible" connector setup packages to this specific folder location as well.

On the Website:
1. Logintoyour Find it EZ Member Account.

2. Clickto selectthe Software Downloads tab. Alist of product releases and optional connectors willappear.
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Q Finditez Products  Solutions  Customers  Quotes  Shop  Support  Resources Blog Q
home / members
My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets Feedback
My Products :
Download Release Optional Connectors
Product Version Date Notes .net| HANA  Crystal Reports DB2 Access SAP BI Git
Code Search Pro - Desktop 2018 18041 20180911 B 45 |1 Helpme decide |~ Helpme decide |~ 2016
Code Search Pra - Server 2018 18.042 20181026 B 45 |1 Help me decide
Dev Surge 365 - Enterprise 2018 18041 20180911 B 45 Helpme decide  Helpmedecide 2016 | Help me decide = 2.12.0

3. Locate the product release for which you want to download a connector.

4. Inthe Optional Connectors section of the table, click on the corresponding hyperlink in the desired connector column. For
allhyperlinks that do not contain the text Help me decide,aConnector Details dialog box willappear. See
example below:

SAP Crystal Reports runtime engine for NET (32-bit)
CONNECTOR DETAILS

¥ Installs the SAP Crystal Reports runtime engine for NET Framework (32-bit) version 13.0.17

REQUIRED FOR SCANNING or UPDATING CRYSTAL REPORTS
(RPT files)

¥ Download a compatible 32-bit version from our server (75MB)

¥ Alternatively download the 32-bit edition direci

T

To download the selected version from the Find it EZ server, click on the[ Download Now |button. OR,

Where applicable, to download the selected version directly from Microsoft (i.e. Access) or directly from SAP (i.e. Crystal
Reports), click on the directly from Microsoft or directly from SAP link, respectively. See example above.

from SAP. Click on the "32bit.msi" link beside support pack 17 or later

7. The connector will begin downloading.
Once downloaded, a Find it EZ InstallShield Wizard will appear.

Click on the[Next|button.

Read and follow the instructions provided.

When complete, click on the[Finish [button.

8. Toclose the Connector Details dialog box, click on the Close or[X]button.

e o T 9

9. OR,inthe Optional Connectors section of the table, if you chose any connector with the hyperlinktext Help me
decide, awebsite page will display with instructions to guide you through selecting a compatible version depending on
related software that may be installed on your workstation or network environment. See example below:
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Q Finditez Products  Solutions ~ Customers  Quotes  Shop  Support  Resources Blog Q

SAP Business Objects and Crystal Reports Integration
Find it EZ requires a compatible .NET runtime installed in order to al Reports and/or to connect and search SAP Bl platforms.

connector below.

Dev Surge 365

Dev surge supports three types of connectors depending on the repository you have enabled. None (Loca

Files Only), BOE BI XI 3.1 or earlier. or SAP Bl 4.X.

s Intelligence server version (if applicable).

elect which version of the Crystal Reports designer you have installed (if applicable) and your SAP Busi

Crystal Reports SAP Repository
None / Not installed || None / Local or Network files only v <:|

Find it EZ v18 or later

Allversions above service pack 2 (13.0.2 ) of the connector are supported. We recommend always using the latest version from SAP.

» SAP Crystal Reports runtime engine for .NET (32-bit) SP23 - Download Here (98mb). Alternatively the latest version can be downloaded directly from SAP Here

10. Follow the instructions on the web page to filter the recommended compatible version of the connector to be installed.

11. Once the recommended connector download link is displayed, click to download and chose to either save or run the cor-
responding setup package depending on your browser and network security permissions.

<
Note: If you chose to save the setup package to your local system, you will then need to locate and run it with admin-
istrative rights once the download completes successfully.
J
N\
See Also:
» "Checkfor Updates" on page 38
* "Download Release Version" on page 257
* "Download .NET Framework" on page 263
J

Serial Numbers

The Serial Numbers tab on the member website allows you to manage or transfer your current Find it EZ product license, obtain a
new trial license, activate or manually activate a product, review software assurance plans and license type options.

Follow the steps below to view your current Find it EZ product serial numbers.

View or Transfer Current License

Alert: You must have an active maintenance plan in order to request a license transfer. License transfers require review and
approval. Reviews are completed within one business day, upon which you will receive a confirmation email either approving or
declining the request. Once transferred, the Find it EZ program must be uninstalled from the old workstation.

From the Program:
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View or Transfer Current License

ument | Tools | Help
baductD Customize 3 - e
Configuration Wizard
ich Resulf View Session Log Project: My Sample, Boolean Search{ | >*
Clear Expression History within selected Documents Boost Perfo
Resulis Proxy Settings [ Useq
- Lod Download Connectors k| Host File Path or D
- Filt
5Q License Management + Transfer to ancther machine {
5Q Index & Search Management Enter senial numkber —
|| | Case

1. Fromthe Find it EZ menu, select Tools -> License Management -> Transfer to a new machine . A confirmation message will
appear, as below:

email for more information.

Find it EZ will now shutdown.

Your license transfer request has been received successfully. Please check your

ot

2. Clickon the[OK]button to shut down Find it EZ on the current machine. A request will be automatically sent to Find it EZ
product support, and you will receive a confirmation email once the transfer request has been reviewed and processed
within one business day.

3. Open your e-mail and follow the instructions to transfer the license to a new machine.

On the Website:

1. Loginto your Find it EZ Member Account.

2. Clickto select the Serial Numbers tab. Locate the product for which you want to view or transfer a license.

My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets Feedback

Get a New Trial License
License T Serial Numb Uperade Protecti # #
icense Type erial Number perade Protection ;oo ced
Code Search Pro - Desktop 2016 - Single Named Active until 2017-07- P 1
User
Dev Surge 365 - Enterprise 2016 - Single Named Active until 2017-01- P 1
User 25
Dev Surge 365 - Enterprise 2016 - 30 day trial Expired 2016-08-19 4 1
Code Search Pro - Server 2016 - 30 day trial Expired 2016-08-17 1 0
Code Search Pro - Server 2016 - 30 day trial Expired 2016-06-23 1 0

Buy
More

Details

Details

Details

Details

Details

o BE! BE |

|

|
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Enter New Serial Number

3. Locate your active license in the list and click on the corresponding Details link. A View / Transfer License dialog box will

appear.

View/Transfer License

Order:  N/A
Serial Number:
Expiry Date: 2017-07-01
#Llicenses: 2

Activated: 1time(s)outof

Machine Name
5/24/2016

Product: Code Search Pro - Desktop - 2 Licenses

License Type: Single Named User

a maximum of 2 time(s).

Max Upgrade Version: 17.1.2 - Download

Activation Date
2:38:39PM

Submit a Support Request
Transfer to new Machine

4. Todownload the mostrecent upgrade available for the selected license, click on the Max Upgrade Version: [Version #]

Download link. The corresponding setup file will begin to download. See example below:

https://www.finditez.com/ftp_download?FC=ARCHIVE,17.1.2

M Find_it_EZ_17.1.2 (1).

4.7/297 MB, 37 secs left

BNE

B rindit

5. Totransfer the license to a new machine, click on the Transfer to new Machine link. A confirmation message will appear,

as below:

www.finditez.com says:

Thank you, your request has

besn received.

0K

To close this message, click on the[OK |button.

6. Toclose the View / Transfer License dialog box, click on thebutton. You will receive a confirmation email once the trans-
fer request has been reviewed and processed within one business day.

Enter New Serial Num

From the Program:

ber
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Tools | Help

Customize *

View Session Log

Clear Expression History

Proxy Settings

Connector Manager

License Management * | Transfer to another machine

= Index & Search Management | Enter serial number <:|
lnnetr Artimize search reel e

1. Fromthe Find it EZ menu, select Tools -> License Management -> Enter serial number . The Activate dialog box will
appear.

@ Activate *

Email Address: || | *

First Mame: | | *

Last Name: | | *

Serial Number: |

| Activate | | Manual activation |

Praxy Settings ‘ ‘ Lockup Serial Number H Buy Now H Contact Us ‘ | Cancel ‘

2. Fillinthe required information.

Note: If access to the Internet s protected by a proxy firewall within your network, click on the[ Proxy Settings|button and
enter the required credentials before clicking the|Activate|button. For more information, see "View or Edit Proxy Settings"
onpage 8

‘ Note: Input fields with an "*" are required.

3. Clickon the[Activate |button.

See Also:

« "Activate License" on page 32

Get a New Trial License

On the Public Website:

Visit https://www.finditez.com/ and click on any of the "download trial" links:
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Geta New Trial License

Find it easy. - with "epic” clarity Q » New Software Release?

Ever experience something like this after
implementing a software upgrade?

Whenever changes are planned or made to the
underlying database in any enterprise software
application, things can, and unfortunately
sometimes do, go wrong.

Find it easy to do it right and avoid this angry mob
scenein your office!

& Start your free trial
Download Now!

The following trial download form is available in the footer area of allweb pages:

Try it
Start your trial today | Email Addre ® | Name

The following slide-out menu is available on the right-hand side of all but the home page:

Search. Compare. Document.
Analyze, Get a full 3607 view to
better manage any software change.

& Start your free trial

:
.
§
:
(@]

Download Now!

OR

Visit https://lwww.finditez.com/freetrial for direct access to the Start your free trial download form.
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Geta New Trial License

@ Start your free trial

L]
. .
John Flemming, Director, Information Technology
L
help me le
Select a product edition ve

I'm not a robot
eCAPTCHA Download Trial Now

1. Complete the form and click to select the desired product edition.

2. Clickon the[Download Trial Now! |button. If eligible, your trial setup file will begin to download and a confirmation email with

your trial key will be sent to the email address provided.
On the Member Website:
1. Logintoyour Find it EZ Member Account.

2. Clickto select the Serial Numbers tab.

My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets Feedback

Geta New Trial License
License Type Serial Number Upgrade Protection b U
2 = Licenses  Used

Code Search Pro - Desktop 2016 - Single Named Active until 2017-07- P 1
User

Dev Surge 365 - Enterprise 2016 - Single Named Active until 2017-01- 2 1
User 25

Dev Surge 365 - Enterprise 2016 - 30 day trial Expired 2016-08-19 4 1
Code Search Pro - Server 2016 - 30 day trial Expired 2016-08-17 1 0
Code Search Pro - Server 2016 - 30 day trial Expired 2016-06-23 1 0

Details

Details

Details

Details

Details

Buy
More

 BE BE BF |

|

3. Clickonthe[Get a New Trial License |button. ARequest License dialog box willappear.

Request License

trial license.

Product:| Code Search Pro - Desktop ¥

Thank you for your interest in evaluating Find it EZ. Click on the Request license button below and we will email you a

4. From the drop-down list, select the product for which you want to request a trial.

5. Clickonthe button. The trial license information will be sent to your account e-mail address.
6. Open your e-mail. Note the trial license serial number and click on the[Download Now |button.
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See Also:

« "Activate License" on page 32

» "Activate License Manually" on page 33

Purchase Licenses

On the Public Website:
See "Create a New Order" on page 292
On the Member Website:

1. Logintoyour Find it EZ Member Account.

2. Clickto select the Serial Numbers tab.

3. IntheLicense Type column on the left, locate the product edition for which you want to purchase additional licenses.

Get a New Trial License Manual Activation

License Type Serial Number

Code Search Pro - Desktop 2016 - Single Named
User

Dev Surge 365 - Enterprise 2016 - Single Named
User
Dev Surge 365 - Enterprise 2016 - 30 day trial

Code Search Pro - Server 2016 - 30 day trial

Code Search Pro - Server 2016 - 30 day trial

Upgrade Protection

Active until 2017-07-

Active until 2017-01-
25

Expired 2016-08-19

Expired 2016-08-17

Expired 2016-06-23

MyAccount | Software Downloads [CIILGCICI| Quotes | Orders | MySupport Tickets | Feedback

#

Licenses

2

2

#
Used

1

Details

Details

Details

Details

Details

Buy
More

R BE BF |

|

4. Inthe Buy More column, click on the corresponding shopping carticon. The Select Enterprise options form willappear.

See example below:
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Finditez

SOFTWARE

Q

PRODUCTS

home » cart » add Enterprise licenses

Select Enterprise options

Dev Surge 365 - Enterprise 2017 - Single Named User

Search Crystal & Oracle

Quantity 1 Reports
Search SSRS Reports
Price: $468 Search all major databases

Search dB schema & SQL code
Search database table data

Search Office documents

Prices in USD, annual subscription

Select Installation Package

(&) E] = ] = <
CUSTOMERS QUQTES SHOP SUPPORT RESOURCES CHAT
Welcome | My Account | Log out
Item Summary
$468 usD

® 1 year support & upgrades included

Save 5% - 2 years support & upgrades for 3444

Save 10% - 3 years support & upgrades for $842

@ Reasons to Buy

@ Software Assurance ( Support & Upgrades )

From $39/user/month (billed annually)

» Dev Surge 365 - Enterprise 2017 - Single
Named User

¥ 1subscription user license
» 1year support & upgrades included

Got a Question?

| We are here to help!

. 1.844.634.6348 ext 1
& sales@finditez.com

Enter the desired Quantity.

Inthe Select Installation Package section, click to choose the desired package / software assurance option.

Click on the[Add to Cart|button. You will be directed to the Shopping Cart Summary page. See example below:

Finditez

SOFTWARE

Q

PRODUCTS

home » cart » summary

O B - © = <
CUSTOMERS QUOTES CART SUPPORT RESOURCES  CHAT
Welcome | My Account | Log out

Shopping Cart Summary
Your shopping cart contains: 1 items
Product

Dev Surge 365 - Enterprise - Single Named User

» 1year support & upgrades included

DISCOUNT CODES

Enter your coupon code if you have one.

+ Apply coupon

*conversion rate from USD @ 1.3044

Unit Price (CAD)  Quantity
561046 1
FREE
Sub Total:

Taxes based on

*Ship to Province:
Select for estimated taxes v

Grand Total:

Search Website

Currency: [ CAD |

+Add more items

Total

$610.46 Zla
$610.46
$610.46

8. Toadd more items, clickon the button.

9. Toeditor delete anitem, click on the corresponding icon located to the right of each item. The Installation Package (drop-
down) and Quantity (text box) will become editable. See example below:
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Software Assurance Plans

Finditez Q O Ei = ] = 2
SOFTWARE PRODUCTS CUSTOMERS QUOTES CART SUPPORT RESOURCES CHAT
home » cart » summary Welcome | My Account | Log out
Search Website
Shopping Cart Summary Currency: | CAD]
*conversion rate from USD @ 1.3044
Your shopping cart contains: 1 items
Product Unit Price (CAD)  Quantity Total
Dev Surge 365 - Enterprise - Single Named User $610.46 $610.46 x| @
update
1 year support & upgrades included v FREE .
Sub Total: $610.46
DISCOUNT CODES
N Taxes based on
Enter your coupon code if you have one.
Ship to Province:
Select for estimated taxes ¥
Grand Total: $610.46

Make changes, as desired, and click on the Update link to save.

10. Where applicable, enter a discount code and click on the| Apply coupon |button.
11. Tosave the item(s) as a quote, click on the[ Save as quote |button.
12. Tobuythe selected product(s) now, click on the button.

Software Assurance Plans

There are two types of licenses and corresponding maintenance (software assurance) plans:
Code Search Pro (Desktop and Server)
» Perpetuallicenses. First year software assurance included.

+ After year 1, software assurance is optional. However, if you do not renew and want access to an upgrade (newer release
than the last one available when your software assurance lapsed), you must buy a new license. Upgrade discounts may be
considered at our discretion on a case by case basis.

Dev Surge 365

+ SaaSlicenses. Software assurance included.

» Renewalis mandatory for use of the software. Otherwise, once your subscription expires, the software stops working.
What Software Assurance includes:

» Unlimited support incidents. Direct access to our support (development) team via phone, WebEx, remote desktop, email,
etc.

» Ability to request a license transfer (approval only possible if on an active software assurance plan). This can be required if
on change of employee or reconfiguration / major upgrade of the workstation (e.g. newer operating system, change of work-
station name on the company domain, major hardware upgrade such as hard drive, etc.).

» Accessto new software release upgrades.

Software assurance is typically quoted / invoiced for a one year period. During payment remittance, you can choose to take advant-
age of extending your software assurance period to:

» Save 5% for 2 year; 10% for 3 year plans.

» Enjoy the convenience of only have to renew every 2 or 3 years instead of annually.
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» Coordinate with a PO process to reduce overhead and approval requirements.
» Take advantage of available surplus budget when possible.
For more information about our software assurance plans:

* Visithttps://www.finditez.com/cart/ and click on the Support and Upgrades or the License Information links at the
top of the Product Catalog page for more detail and definitions.

+  Click on any[Select Options |button for a product line item. Note that you can get a discount on extending your pre-paid sup-
port plan. Click to expand the Software Assurance tab.

Annual Renewals

Annual renewal notices are sent as follows for existing customers:

If, on the final payments remittance page, you chose to "auto-renew," then you will be invoiced and will receive this invoice 45 days
prior to your software assurance plan expiry date. If payment is not remitted, reminders are auto-sent 3 weeks ( 21 days ) and again
3 days prior to support expiry. If payment is still not received, an overdue notice is sent 5 days after support expiry and collection
action may commence.

If you do not check the "auto-renew" setting, then you will simply receive a renewal quote 3 months ( 90 days ) prior to your software
assurance plan expiry date. Reminders are sent 21 days and 3 days prior to support expiry.

If payment is not received after your software assurance plan expiry date, this lapse effect does the following:

» Code Search Pro: Keeps working, but no support responses and can no longer transfer the licenses. The member down-
loads panel changes to add a section for "older versions" so that you have access to download the max version you are eli-
gible to use.

+ Dev Surge 365: Stops working.

License Type Options

For further information about licensing, please contact support@finditez.com.

License types for Find it EZ products
Find it EZ products are either sold or leased under two distinct license plans:

» Perpetual - Permanent right to use license is purchased. First year software assurance is included with access to all minor
and major upgrades for free. Optional software assurance.

+ Software As A Service (SaaS) - Annualrenewable contract lease plan. If your contract is not renewed, the product can
no longer be used and all licenses are automatically disabled upon expiry of the contract term.

Under either plan, there are also two available end-user license types to chose from:

+ Name User Licenses (NULs) - Each license is associated with a single, unique windows user login and host machine com-
bination. NULs are transferable between machines and/or users but must go through an automated transfer request,
vendor review and approval process at the sole discretion of Find it EZ.

+ Concurrent Access Licenses (CALs) - Each license is associated with a Windows host machine, but floating amongst all
domain users. Also commonly known as floating licenses. Only limited in use to the maximum number of concurrent con-
nection (licenses) purchased.

' Alert: For further information about licensing, please contact support@finditez.com. ]

' Note: Dev Surge 365 Enterprise is only available in on-premise Software As A Service - Named User Licenses. J
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Quotes

See Also:

» "License Agreements and Statements" on page 304

Quotes

A quote is a 15 day price guarantee with no obligation to pay by the customer. The Quotes tab on the member website allows you to
compare products, create and view quotes, and pay for a quote.

Create a New Quote

1. Visit https://www.finditez.com/.

Finditez Q b6

SOFTWARE

PRODUCTS  CUSTOMERS

E] - 2] = =N
QUOTES SHOP SUPPORT RESOURCES CHAT
[t

home » members

10te
or a Quote
d Quotes

My s.
ELEIRILEEE Help convince my boss

My Account

Software Downloads

Welcome Vicky Moorman | My unt | Log out

Search Website

Feedback

2. Fromthe menu at the top of the page, select’ Quotes -> New Quote . The Products Catalog

willappear.

Products Catalog

BuyingFAQ Supportandupgrades License inf

Code Search Pro - Desktop 2017

License Type Description

Single Named User Productivity software designed for individual developers who
perpetual need to document and analyze the full impact of any software
«change throughout your entire code-stack with just one tool.

Search and document source code stored on physical file
systems or using native connections te all major databases.

5Named User Pack  Save up to $250, almost 15% off with the purchase of a 5-user
perpetual pack

nation Download pricelist Find a Reseller

+ Compare items

Learn More

Highlights Pricing Compare
» Runs on Windews Client $369 USD
¥ Designed for Individual Priced per NUL
Users Annual $99
» Number of users: 1
¥ FREE Software Assurance
first year

Annualized cost per user "™Add To Quote
$153

¥ Runson Windows Client $1599 USD
¥ Designed for Smali Priced per 5 NULs
Workgroups Annual $399

Number of users: 5

3. Usingthe vertical scroll bar, locate the product that you want to add to a quote.

4. Clickon the corresponding green[Add to Quote |button. A Quote Summary page will appear.
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Create a New Quote

Quote Summary
Your Quote contains: 1 items
Product

Code Search Pro - Desktop - Single Named User

» 1 year support & upgrades inciuded

DISCOUNT CODES

Enter your coupon code if you have one.

+ Apply coupon

Currency:[ CAD]

*conversion rate from USD @ 1.3044

Unit Price (CAD)  Quantity Total
$481.32 1 $481.32 = B
FREE
Sub Total: $481.32

Taxes based on

*Ship to Province:
Select for estimated taxes ¥

Grand Total: $481.32

To add more items, click on the green| + Add More Items |button. The Products Catalog willappear (see above).

To edit or delete an item, click on the corresponding blue edit or delete icon located to the right of each item. See example

below:

Quote Summary
Your Quote contains: 1 items

Product

Code Search Pro - Desktop - Single Named User

1 year support & upgrades included v

DISCOUNT CODES

Enter your coupon code if you have ane.

+ Apply coupon

Currency: [CAD]

“conversion rate from USD @ 1.3044

+Add more items

Unit Price (CAD) ~ Quantity Total
$481.32 | $481.32 x| @
update
FREE

Sub Total: $481.32
Taxes based on

“Ship to Province:

Select for estimated taxes ¥

Grand Total: $481.32

b. Clickonthe Update link to save your changes.

Change the Quantity or Software Assurance selection, as desired.

Where applicable, enter a Discount Code and click on the[ Apply Coupon |button.
To send the quote to Find it EZ Software Corp., click on the button.

If you are not already logged into the Find it EZ website, you will be prompted to login in order to save a copy of the quote.

See below:
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Help Convince My Boss

Secure Checkout

Email Address:
Password:

Remember my Login

Not a member yet? Register now for free!
Forgot your password?

Resend Login account activation email ( Note: whitelist donotreply@finditez.com )

Or signinusing

k& Signin with Twitter

N Sion inwii Linkedin

10. Aconfirmation screen willappear with your quote information along with product trial download links. See example below:

g Your quotation expires on 2017-02-14.

A copy of your quotation have been sent to: vicky@cleartechnical.ca

Your Quotation # 3001170532

Qur software is free to download at any time. Serial numbers are needed to activate a trial for our software.
You may request and then use trial serial numbers to activate your software evaluation

Quantity Product

1 New License for Code Search Pro - Desktop ( DNO1SA1)
Single Named User

1year support & upgrades included upon receipt of payment.

Serial Numbers for activation

Code Search Pra - Desktop 2017

Download this product

request a trial key

Thank you for your quotation request from FinditEZ

Need to download your software?

You can do this at any time from our
download page:

Software download page

Want a copy of your Quote?

If you are a US based customer, you may also
download a copy of our W-8BEN-E for
withholding tax exemption

Download PDF document

Got a Question?

We are here to help!

t.1.844.634.6348 ext 1
Esales@finditez.com

Help Convince My Boss

One or more quotes can be created and forwarded directly to the manager or department head responsible for budget approval.
This wizard walks through a few questions to create a template email with one or more saved quotes automatically attached to it. This
can simplify the budget approval process by comparing your industry and adjacent technologies to our existing client base, providing
a list of benefits along with examples of competitors or similar companies that use Find it EZ.
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Help Convince My Boss

1. Visit https://lwww.finditez.com/.
Finditez Q 16} & ™= o
SOFTWARE

= =)
PRODUCTS CUSTOMERS

SUPPORT  RESOURCES
home » members

QUOTES  SHOP

CHAT

New Quote
Pay for a Quate
My saved Quotes

Help convince my boss

Welcome Vicky Moorman | My Account | Log out

Search Website

My Account

Software Downloads

Serial Numbers

Create New Quote Help convince my boss

Quote # Expiry Date Amount Status Edit
3001170532 2017-02-14 $505.39

Quote 4

Create a new Quote

Select one or more existing quotes

3. Clickto chose “Create a new Quote” or “Select one or more existing quotes”.

N
Note: If you have previously saved quotes, you are not logged in, and you select the latter option, you will be prompted to
login, as below:

Login

Or signinusing
Email Address:

. f Sign in with Facebook
Connect with Google
Password: .

! Remember my Login

E Sign in with Twitter

N Signin with Linkedin

Not a member yet? Register now for free!

Forgot your password?

Resend Login account activation email { Note: whitelist donotreply@finditez.com )

J
4. Once you have created a new quote or logged in to your Find it EZ account, you will be prompted to select one or more
quotes to attach to the e-mail. See example below:
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Help Convince My Boss

Select quote(s) to include:

Quote # Expiry Date Quote Total
3001170532 2017-02-14 $505.39

Select the desired quote(s) and then click on thebutton. ABudget Approval Request form willappear, as below:

Budget Approval Request

Decision Maker Name:

L]
Decision Maker Email: .
Ourindustry vertical: Please Select A
Technologies we use,supported by FinditEZ:
Business Intelligence Reporting Tools: [ All
Active Reports Crystal Reports Oracle Reports
SAP Business Objects Enterprise Server SAP Crystal Reports Server SAP Dashboards.
SSRS
Source Control Repositories: [/ All
Git Hub SVN (Subversion) Team Foundation Server
Visual Source Safe
Databases: L/ All
Access 1BM DB2 MySQL
ODBC Oracle SQL Azure
SQL Server Caché
Programming Languages: || All
Ada Ci#.net CCH+
COBOL Delphi Pascal JAVA
Lua Perl/Php/Python Ruby
Visual Basic Web({HTML XML,ASP)
Documents: [ All
Logs,Text and Data files Excel(Spreasheet formulas,connections) Word(Office Docs)

PDF

My products/evaluation notes and recommendations:

4»| Source | & [ A C I
B 7 U & X x |@|Es = =y W= = 4[| e BIE O6E=& Q=
Styles - Format - Font - Size ~ || - -

4

[3 Preview Now

5. Fillinthe Budget Approval Request form. ltems with a dot are mandatory. You willhave an opportunity to review and
change the contents of the generated email prior to sending. The more data provided in the form, the more complete the
generated email template will be. Once complete, click on the[ Preview Now |button.
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View or Change Saved Quotes

Preview Approval Request Email

To: Jane Doe<jane.doe@myemail.com>
=
Subject: Productivity software budget approval request
Body: Jane Doe,

Attached, please find a quote for asoftware programming aid that | have recently evaluated and am recommending we
purchase. Based on my trial assessment, | believe it will help reduce the time it takes ta implement our software project
changes by impraving the estimating process, code quality, global impact analysis across our entire codestack, expedite
production support troubleshooting and providing an effective and efficient way to make the most cost effective design
choices by quickly analysing "what if | change this vs that" scenarios whenever we plan to add new features throughout our
code stack.

This product has great features for excellent value! Please check it out.
Regards,

John Smith

Bottom line, Find it EZ will benefit us by reducing the time to complete ongoing changes and cost of supporting and

our software i we will see a return on this investment within our next project use.
Attachment(s): Order # Expiry Date Amount
3001170532 2017-02-14 $505.39

Lo o | o |

6. Tomake changes to the email body produced, click on thebutton and repeat step 5. If the contents are approved,
click the[Send [button. To abort, click the[ Cancel |button.

Note: If you cancel the process, but had created a new quote in step 3, the quote will still be saved to your Find it EZ
account.

www.finditez.com says:

Message successfully sent

View or Change Saved Quotes

You may change the contents of a pending, open quote, including adding or removing items, increasing or decreasing item quantity,
or changing the support length for individual items in the quote.

Finditez Q 6] B = 2] = =

SOFTWARE PRODUCTS CUSTOMERS QUOTES SHOP SUPPORT RESOURCES CHAT
[brr

home » members Welcome Vicky Moorman | My Account | Log out

w
New I-U_Dte Search Website

a0

(PYY? M| Software Downloads | Serial Numbers [iassmpyasem rrearmm i i Feedback

284 © 1998 - 2019 Find it EZ Software Corp.



View or Change Saved Quotes

1. Visit https://finditez.com/. From the menu at the top of the page, select | Quotes -> My Saved Quotes . If you are not logged
in, you willbe prompted to do so for access to your saved quotes.

Login

Or signin using

Connect with Google

& Signin with Twitter

) Remember my Login
Sign in with Linkedin
LogIn

Not a member yet? Register now for free!

Forgot your password?

Resend Login account activation email { Note: whitelist donotreply@finditez.com)

2. Loginto your Find it EZ member account. A table willappear showing the quote Quote #, Expiry Date, Amount, and
Status.

My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets

Create New Quote Help convince my boss

Quote # Expiry Date Amount Status Edit PDF Pay Now

o |

2301170531 2017-02-07 $505.39 Quote # '}'\

3. Toeditthe quote, click on the corresponding Edit icon.

Quote 3001170532 Currency:[CAD]

“conversion rate from USD @ 1.3044

Your Quote contains: 1 items

Product Unit Price (CAD}  Quantity Total
Code Search Pro - Desktop - Single Named User $481.32 1 $481.32 Ela
¥ 1year support & upgrades included FREE
Sub Total: $481.32
DISCOUNT CODES

q Taxes based on
Enter your coupon code if you have one.

“Ship to Province:
Alberta v
GST @ 5% on $481.32 $24.07

Grand Total: $505.39

Note: Only pending, unexpired quotes can be modified. If a quote is in a status that does not allow updating, you may cre-
ate a new quote or contact Find it EZ sales support for assistance.
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Pay for a Quote

a. Make changesasdesired.

b. Clickon the[Update Quote |button to save and re-send the revised quote.

Thank you for your quotation request from FinditEZ

>
g Your quotation expires on 2017-02-14. NesdlimatnleelEm e e

‘You can do this at any time from our
download page:

Software download page

A copy of your quotation have been sent to: vicky@cleartechnical.ca
Your Quotation # 3001170532

Qur software is free to download at any time. Serial numbers are needed to activate a trial for our software.

. . Want a copy of your Quote?
You may request and then use trial serial numbers to activate your software evaluation. EYCeL

Quantity Product If you are a US based customer, you may also
download a copy of our W-8BEN-E for
1 New License for Code Search Pro - Desktop ( DNO15A2) withholding tax exemption.

Single Named User

Save 5% - 2 years support & upgrades upon receipt of payment. (B AP et e

Serial Numbers for activation
Got a Question?

Code Search Pro - Desktop 2017 request a trial key

We are here to help!
Download this product

%.1.844.634.6348 ext 1
Esales@finditez.com

®CHAT

4. Todownload the quote in PDF file format, click on the corresponding PDF icon.

a. Thequote willopen as a PDF in a new browser window.

b. Download or Printthe document as desired.

Pay for a Quote

Finditez Q (6] B " ] = (=}

SOFTWARE PRODUCTS CUSTOMERS QUOTES SHOP SUPPORT RESOURCES CHAT
N

home » members Welcome Vicky Moorman | My Account | Log out

New C
e d Quote Search Website
I P roraQuoteI

My saved Quotes
My Account Software Downloads BEGEI IR Help convince my boss i Feedback

1. Visit https://www.finditez.com/. From the menu at the top of the page, select Quotes -> Pay for a Quote . If you are not
logged in, you willbe prompted to do so for access to your saved quotes.
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Pay for a Quote

Login

Or sign in using

O £ swan vl Facebook

Email Address:

Connect wilh Google
Password: 7

= Signin with Twitter
") Remember my Login e

i Son inwit Linkedin
LogIn

Not a member yet? Register now for free!

Forgot your password?

Resend Login account activation email { Note: whitelist donotreply@finditez.com )

2. Logintoyour Find it EZ member account. A table will appear showing the quote Quote #, Expiry Date, Amount, and
Status.
My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets
Quote # Expiry Date Amount Status Edit PDF Pay Now
2301170531 2017-02-07 $505.39  Quote rd n =
3.

In the Pay Now column, click on the corresponding shopping carticon. The Checkout dialog

Checkout

box willappear.

Step 1- Account details => Step 2 - Confirm order => Step 3 - Select Payment Method

Select Billing Address Select Shipping Address () SameasBilling

My Business 1234 Happy Street SE Calgary, ABT2C 3J9CA Delete

My Business 1234 Happy Street SE Calgary, ABT2C 39 CA Delete
Add New Address

Add New Address

Save and Continue

4. Selectthe Billing and Shipping Address, then click on the[ Save and Continue|button.
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Pay for a Quote

Checkout

Step 1- Account details => Step 2 - Confirm order => Step 3 - Select Payment Method

Select Billing Address

® My Business 1234 Happy Street SE Calgary, ABT2C 3J9 CA

Add New Address

Bill To Details (Confirm/Edit Selected)

Contact Name:
Contact Phone:
Contact Email:
Contact Company:
Address Line 1:
Address Line 2:
City:

Country:
Province:

Postal Code:

My Business

1234 Happy Street SE

Calgary
Canada
Alberta

T2C 3J9

Select Shipping Address

® My Business 1234 Happy Street SE Calgary, AB T2C 3)9 CA

Add New Address

Ship To Details (Confirm/Edit Selected)

Contact Name: My Business
Contact Phone:
Contact Email:

Contact Company:

Address Line 1: 1234 Happy Street SE

Address Line 2:

City: Calgary
Country: Canada
Province: Alberta

Postal Code: T2C 349

Select Currency:| CAD ¥

Same as Billing

e

Save and Continue
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Pay for a Quote

Checkout

Bill To Address

Your Quote contains: 1items

Product

Code Search Pro - Desktop - Single Named User
¥ Save 5% - 2 years support & upgrades

® Send the invoice or receipt just to me

Send a copy of the invoice or receipt to this person too:

Accounts Payable Contact

Add New Contact

Step 1- Account details => Step 2 - Confirm order => Step 3 - Select Payment Method

My Business 1234 Happy Street SE Calgary, ABT2C 39 CA

Who should we send the invoice or reciept to?

Ship To Address

My Business 1234 Happy Street SE Calgary, AB T2C 3J9 CA

Currency:[CAD ]

“conversion rate from USD @ 1.3044

Unit Price (CAD)  Quantity Total
$481.32 1 $481.32
$122.61 1 $122.61

Sub Total: $603.93

Taxes based on

“Ship to Province:

Alberta v
GST @ 5% on $603.93 $30.20
Grand Total: $634.13

Who should we send the activation serial numbers to?

® Send them just tome

Send them to these people(s) too:

End User Contacts

.

Add New Cor

5. Review and confirm the order, then click on the button.
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Orders

Step 1- Account details => Step 2 - Confirm order => Step 3 - Select Payment Method
- o —
e =4 i) =
Paypal Purchase Order Wire Transfer Invoice Me Check

Credit Card Payment

Please enter your credit card as a continuous string of numbers without spaces or dashes.

The security of your credit card information isimportant to us. We use Secure Socket Layer (SSL) and do not store your Information

S visa =y

Card Type: Visa v
Credit Card Number:

Card Security Code EB

Expiration Date: 01 v 2017 v

Notes:™

* Enter notes and/or reference numbers you would like to include on your order invoice/receipt.

e.g. VAT number, cost center, etc.
¥ Yes, please auto-renew our software assurance plan annually Process Payment

6. Selectand enter the method of payment.

Note: Payment by secure Credit Card or Paypal willimmediately release full activation keys. Selecting payment by
Check, Invoice Me, Wire Transfer, or Purchase Order willissue a net 30 day terms invoice.

Note: When paying by Purchase Order, you may upload an electronic copy of the purchase order document or email a
copy to billing@finditez.comreferencing your order # in the email subject or body.

7. Clickonthe button.

Orders

An order generates a net 30 day invoice. Or, if the customer proceeds through secure check-out and remits payment online (via pur-
chase order, credit card, or Paypal account), a receipt is issued along with immediately releasing activation keys. The Orders tab on
the member website allows you to create and view orders.

View or Change My Orders
You may change the contents of an order; including adding or removing cart items, increasing or decreasing item quantity, or chan-
ging the support length for individual items in the cart.

1. Loginto your Find it EZ Member Account.

2. Clickonthe Orders tab. Allcurrent orders on file will be listed.

My Account Software Downloads Serial Numbers Orders My Support Tickets Feedback
Create New Order
Order # Order Date Amount Status Edit PDF Pay Now PO
3001170532 2017-01-30 $50539  Invoiced . 0 —§
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View or Change My Orders

3. Toeditthe order, click on the corresponding Edit icon.

Order 3001170532 Currency: [CAD

“conversion rate from USD @ 1.3044

Your shopping cart contains: 1items

Product Unit Price (CAD) Quantity Total
Code Search Pro - Desktop - Single Named User $481.32 1 $481.32 @
» 1 year support & upgrades included FREE
Sub Total: $481.32
DISCOUNT CODES

) Taxes based on
Enter your coupon code if you have one.

Ship to Province:

Alberta v
GST @ 5% on $481.32 $24.07
Grand Total: $505.39

Note: Only pending, active, unpaid orders can be modified. If an order is in a status that does not allow updating, you
may create a new order or contact Find it EZ sales support for assistance.

a. Make changes, as desired.

b. Clickon the[Update order |button to save your changes.
Thank you for your order from FinditEZ

g Your payment is due by 2017-03-01. Click to pay now. =2 matrslie s ey

‘You can do this at any time from our
download page:

Software download page

A copy of your invoice have been sent to: vicky@cleartechnical.ca

Your Invoice # 3001170532

Serial numbers are needed to remove time and limit restrictions on our software. Your payment is due by Want : | -5
ant a copy of your Invoice?
2017-03-01. Upon receipt of payment, your serial numbers will be automatically generated and sent. Py oTy

Quantity Product If you are a US based customer, you may also
download a copy of our W-8BEN-E for

1 New License for Code Search Pro - Desktop (DNO15A2 ) withholding tax exemption.

Single Named User
Save 5% - 2 years support & upgrades upon receipt of payment.

Got a Question?
Serial Numbers for activation

We are here to help!
Code Search Pro - Desktop 2017 issued upon receipt of payment !
1.844.634.6348 ext 1

Download this product Esales@finditez.com
®CHAT

4. Todownload the order in PDF format, click on the PDF icon.
a. Theorder willopen asa PDF in a new browser window.

b. Download or print the document as desired.

5. Toupload an electronic copy for an order where the payment method selected was by Purchase Order, clickon the
button under the PO column.
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Create a New Order

Add New PO# Attachment

Upload Attachment:
Choose file | No file chosen
If more then one file to upload, must be in an archive...

a. Use the[Choose file |button to select the Purchase Order document from your system.
b. Clickon the[Upload |button to save a copy of the file.

Create a New Order

Finditez Q b6 B - 2y = o

SOFTWARE PRODUCTS CUSTOMERS QUOTES | SHOP | SUPPORT RESOURCES — CHAT

home » members Welcome | My Account | Log out
Search Website

My Account Software Downloads Serial Numbers Quotes Orders My Support Tickets Feedback

1. Visit https://www.finditez.com/. From the menu at the top, select Shop.
OR

2. LogintoyourFind it EZ Member Account.
a. Selectthe Orders tab.

My Account Software Downloads Serial Numbers Orders My Support Tickets Feedback

Create New Order

You have no orders on file.
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Create a New Order

b. Clickon the[Create New Order |button. The Products Catalog wil appear.

License Type

Single Named User
perpetual

5 Named User Pack
perpetual

Products Catalog
Buying FAQ Support and upgrades License information Download pricelist  Find a Reseller

Code Search Pro - Desktop 2017

Description

Productivity software designed for individual developers who
need to document and analyze the full impact of any software
«change throughout your entire code-stack with just one tool.

Search and document source code stored on physical file
systems or using native connections to all major databases.

Save upto $250, almast 15% off with the purchase of a 5-user
pack.

Highlights Pricing

Runs on Windows Client $369 USD
Designed for Individual Priced per NUL
Users Annual $99
Number of users: 1

FREE Software Assurance
first year

Annualized cost per user dd To Cart
$153

¥ Runs on Windows Client $1599USD
» Designed for Small Priced per 5 NULs
Workgroups Annual $399

Number of users: 5
EBEE Software

+ Compare items

Learn More

Compare

3. Locate the product(s) you want to add to your order.

4. Toselecta product, click on the corresponding| Add to Cart |button. Go to step 6.

Product

Shopping Cart Summary

Your shopping cart contains: 1items

Code Search Pro - Desktop - Single Named User

¥ 1 year support & upgrades included

DISCOUNT CODES

Enter your coupon code if you have ane.

Curi

rency: [ CAD ]

“conversion rate from USD @ 1.3044

+Add more items

Unit Price (CAD) Quantity Total
$481.32 1 $481.32
FREE
Sub Total:
Taxes based on

“Ship to Province:
Select for estimated taxes v
Grand Total: $

EN

$481.32

481.32

OR
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Create a New Order

5. Toselect product options, click on the corresponding| Select Options [button.

Select Pro Desktop options

Code Search Pro - Desktop 2017 - Single Named User Item Summary

$369 UsD

Total (befere discounts and taxes)

Search Crystal & Oracle
Quantity 1 Reports

» Search SSRS Reports » Code Search Pro - Desktop 2017 - Single
Price: $369  » searchallmajor databases paedl
All prices listed are in USD ¥ SearchdB schema & SQL code D =g

+ Search database table data ¥ 1 year support & upgrades included

¥ Search Office documents

Got tion?
Add Software Assurance ot a Question

We are here to help!
® 1 year support & upgrades included ‘

. 1.844.634.6348 ext 1
Save 5% - 2 years support & upgrades for 394 = sales@finditez.com
Save 10% - 3 years support & upgrades for $178 ®CHAT

® Reasons to Buy
@ Savings Calculator
@ License Types

@® Software Assurance ( Support & Upgrades)

Review product information (bottom left) by clicking on the desired "+" to expand.
Enter the desired Quantity.

Choose the desired Software Assurance plan.
Clickon the| Add to Cart |button.

Shopping Cart Summary Currency:[ CAD]

“conversion rate from USD @ 1.3044

Your shopping cart contains: 1items +Add more items

e o T O

Product UnitPrice (CAD)  Quantity Total
Code Search Pro - Desktop - Single Named User $481.32 1 $481.32 Zla
» 1 year support & upgrades included FREE
Sub Total: $481.32
DISCOUNT CODES

) Taxes based on
Enter your coupon code if you have one.

“Ship to Province:
Select for estimated taxes ¥

Grand Total: $481.32

6. Toadd more items, click on the[+ Add More Items |button. The Products Catalog will appear (see above).

7. Toeditor delete anitem, click on the corresponding icon located to the right of each item.
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Pay for an Order
Shopping Cart Summary

Currency: [CAD]
“conversion rate from USD @ 1.3044
Your shopping cart contains: 1items

Product

4Add more items
Unit Price (CAD)  Quantity Total
Code Search Pro - Desktop - Single Named User $481.32 $481.32 x| @
update
| 1 year support & upgrades included - FREE
Sub Total: $481.32
DISCOUNT CODES
Enter your coupon code if you have one.

Taxes based on

*Ship to Province:

Select for estimated taxes ¥

Grand Total: $481.32

a.

Make changes to the Quantity or Software Assurance selection, as desired.
b. To save your changes, click on the blue Update link.

8. Where applicable, enter a Discount Code and click on the[Apply Coupon |button.
9. Tosave the order asa quote, click on the[Save as quote |button.
10. To pay for the order, click on the[Checkout |button.

Pay for an Order

1. Logintoyour Find it EZ Member Account.

Log in or Sign Up for a new account

For access to free trials, webinar replays, software downloads, your private serial numbers, quotes, orders and support tickets.

Log In

Or sign in using
Welcome Back!
= —

S

2. Clickonthe Orders tab. A table willappear showing the Order #, Expiry Date, Amount, and Status. Locate the order for
which you want to pay.
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Payfor an Order

My Account Software Downloads Serial Numbers. Quotes Orders My Support Tickets Feedback

Create New Order

Order # Order Date Amount Status Edit PDF Pay Now PO
3001170534 2017-01-30 $135.60 Approved (Payment Pending) -}-\’\ -} Add
3001170532 2017-01-30 $634.14 Invoiced L @

3. Inthe Pay Now column, click on the corresponding shopping carticon. The Checkout dialog box will appear.

Checkout

Step 1- Account details == Step 2 - Confirm order => Step 3 - Select Payment Method

Select Billing Address Select Shipping Address Same a5 Billing

® My Business 1234 Happy Street SE Calgary, AB T2C 3J9 CA ® My Business 1234 Happy Street SE Calgary, AB T2C 3J9 CA
Add New Address Add New Address

Bill To Details (Confirm/Edit Selected) Ship To Details (Confirm/Edit Selected)

Contact Name: My Business [ Contact Name: My Business °

Contact Phone: Contact Phone:

Contact Email: Contact Email: L]

Contact Company: Contact Company:

AddressLine 1: 1234 Happy Street SE [ ] Address Line 1: 1234 Happy Street SE [ ]

Address Line 2: Address Line 2:

City: Calgary [ ] City: Calgary [ ]

Country: Canada e Country: Canada AL J

Province: Alberta e Province: Alberta ve

Postal Code: T2C 3J9 [ ] Postal Code: T2C 3J9 [ ]

Select Currency:| CAD v

4. Selectthe Billing Address and Shipping Address, then click on the[Save and Continue |button.
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Pay for an Order

Checkout

Bill To Address

Your Quote contains: 1items

Product

Code Search Pro - Desktop - Single Named User
¥ Save 5% - 2 years support & upgrades

® Send the invoice or receipt just to me

Send a copy of the invoice or receipt to this person too:

Accounts Payable Contact

Add New Contact

Step 1- Account details => Step 2 - Confirm order => Step 3 - Select Payment Method

My Business 1234 Happy Street SE Calgary, ABT2C 39 CA

Who should we send the invoice or reciept to?

Ship To Address

My Business 1234 Happy Street SE Calgary, AB T2C 3J9 CA

Currency:[CAD ]

“conversion rate from USD @ 1.3044

Unit Price (CAD)  Quantity Total
$481.32 1 $481.32
$122.61 1 $122.61

Sub Total: $603.93

Taxes based on

“Ship to Province:

Alberta v
GST @ 5% on $603.93 $30.20
Grand Total: $634.13

Who should we send the activation serial numbers to?

® Send them just tome

Send them to these people(s) too:

End User Contacts

.

Add New Cor

5. Review and confirm the order, then click on the button.
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My Support Tickets

Step 1- Account details => Step 2 - Confirm order => Step 3 - Select Payment Method
. = O s =)
Credit Card Paypal Purchase Orde: Wire Transfer Invoice Me Check

Credit Card Payment

Please enter your credit card as a continuous string of numbers without spaces or dashes.

The security of your credit card information isimportant to us. We use Secure Socket Layer (SSL) and do not store your Information

ﬂ VISA Pasy

Card Type: Visa v
Credit Card Number:

Card Security Code E

Expiration Date: 01 v 2017 v

Notes:™

* Enter notes and/or reference numbers you would like to include on your order invoice/receipt.

e.g. VAT number, cost center, etc.
¥ Yes, please auto-renew our software assurance plan annually Process Payment

6. Selectand enter the method of payment.

Note: Payment by secure credit card or Paypal willimmediately release full activation keys. Selecting payment by Check,
Invoice Me, Wire Transfer or Purchase Order willissue a net 30 day terms invoice.

Note: When paying by Purchase Order, you may upload an electronic copy of the purchase order document or email a
copy to billing@finditez.comreferencing your order # in the email subject or body.

7. Clickonthe button.

My Support Tickets

The My Support Tickets tab on the member website allows you to create, attach a file to, send, and view your support tickets.

Create a Support Ticket

A support ticket is used to report a program bug or to request a new product feature. Submitted crash reports or on-start-up of the
program after a crash also create support tickets automatically. Support tickets status along with fix notes are visible to all linked
accounts that are registered with the same e-mail domain.

From the program:
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Create a Support Ticket

1. Fromthe Find it EZ menu, select Help -> Report a Bug .

Document  Tools | Help
ind: ProductlD Support Opticns
User Guide
Search Result History: Request a Demo pject: My Sample, Boolean 5
Report ABug . within selected Docume
Lag”
Resulis ( displayin Send Logs To Support
B~ | Location eepl s Host File Path
] S0l Server Check For Updates Adveriul
U SGL Server Yiew Release Motes Adventu
About Find it EZ
The Report a Bug dialog willappear. See example below:
@ Report a Bug b
Name: |Ynur MName |
Email Address: |name@duma\n.cum |
Summary: |
Description:
Note: The Name and Email Address fields will be filled out for you according to the current user. These can be
changed, as desired.

2. Fillinthe form:

a.

b.

In the Summary text box, enter a brief but descriptive summary of the issue.

In the Description text box, enter a detailed description of the issue or request. For bugs, include detailed steps required to

reproduce the issue.
Tip: Tosend logsto Find it EZ Support, See"Find it EZ Support" on page 245.

3. Clickon the| Submit Bug |button. Once submitted, the following notification will appear:
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Create a Support Ticket

Your bug was subritted successfully!

oK

On the website:
1. Logintoyour Find it EZ Member Account.
2. Clickonthe My Support Tickets tab.

My Accous Software Downloads I Numbers Quotes rders My Support Tickets Feedback
Create a Support Ticket
Note: It may take up to 24 hours for new issues to appear in this list.
Isj;m Reported Status Last Updated Summary
1606 5"26/2%%12:00100 Fixed 5"31'20',1& G T D | NS N R SN (el el X e N
1607 5"26‘/205;1112:00:00 Fixed 5/31"20'3&3:25:23 Search Assistant / Menu / Window Labels Feedback
126/ 00
1508 HA0OAZOC0 gy 6/2/2016 4:52:01 PM  Incorrect Settings Warning via Search Assistant - Connection Information
127/ -0
1609 | 2T2016 120000 6/2/20164:52:02PM _ Project Settings - Navigation Re: Git / GitHub
127/ -0 51317 98-
1610 AL EATRD Fixed SRV Ll Detail Delete does not work.
AM PM
1611 5;25/20‘13\6"1‘12:00:00 Fixed 6/1/2016 1:43:56 PM  Add Boolean Search Builder to Search Assistant
Gy | DEDEEERTY ey 7"28'2'3;& LS il ey s T e e s il
1678 L0 IS Closed 7’,28"20;& 2= Punctuation Issues on "Manual Activation” Form
120/ 00 128/ .41+
1679 e 20?;412.00.00 Closed 7’28‘20'3512'41'30 Add "Restore Defaults” to Source ltems (7)
120/ 00 271 .35+
1687 7/20/2016 12:00:00 Re\elasedln /2712016 4:35:01 Export Search Results List - Save Complete - Continue Button (label)
AM Testing PM
[22/201412:0000  PReleaced i [27/2014 4:35:01
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Create a Support Ticket

3. Clickonthe[Create a Support Ticket |button. A Ticket System dialog box will appear.

Ticket System

Please use this form to report a bug or request a new Find it EZ feature.
Be sure to complete each field. We will respond directly to each request in as timely a manner as possible.

Thank you, in advance, for your valued feedback. We look forward to exceeding your expectations!

Product Information

Product:

Find it EZ Code Search v

Version Found:

17.1.2 - Code Search Pro - Desktop v

Problem Description

Severity:

Select One T e

Summary:

Description:

Steps to Reproduce:

File Attachment:

Choose file | No file chosen

Note: Please zip multiple files into a single archive file prior to uploading.

©2010-2019Find it EZ Software Corp. 301



View My Support Tickets

4. Inthe Product Information section:
a. Selectthe affected product name from the Product drop-down list.
b. Selectthe affected version from the Version Found drop-down list.

5. Inthe Problem Description section:

a. Selectthe appropriate issue severity from the Severity drop-down list. Refer to the image below:

Critical: The software crashes, hangs or causes you to loose data

Setup: A data conversion. personal computer configuration or installation issue

Support: Request for technical assistance or 'how do 1?' training request

Normal: It's a bug that should be fixed

Minor: Loss of function, but there is an easy workaround

Trivial: A cosmetic problem, such as a misspelled word or misaligned text

Enhancement or Change: Request for a new feature, better performance, or functional changes
Feedback: Product reviews or contest entries

b. Inthe Summary text box, enter a brief and descriptive summary of the issue or problem.

c. Inthe Description text box, enter a detailed description of the issue or problem.

d. Inthe Steps to Reproduce text box, thoroughly describe the steps required to reproduce the issue or problem. Include as
much detail as possible.

l Note: This (d. above) is optional, but very useful information for expediting problem resolution. J

6. To attach afile to the support ticket:
a. Clickon the[Choose File |button.

b. Navigate to the file you want to attach.
c. Clickon the[Open |button. The file name will appear in the File Attachment section to the right of the[Choose File |button.

7. Tosend the support ticket to Find it EZ support, click on the[Send Report |button.

View My Support Tickets

1. Loginto your Find it EZ Member Account.

2. Clickonthe My Support Tickets tab. Alist of your submitted support tickets willappear showing the Issue #, Reported
datetime, Status, Last Updated datetime, and Summary.

302 © 1998 - 2019 Find it EZ Software Corp.



View My Support Tickets

Software Download: | Numbers Quotes Orders My Support Tickets Feedback
Note: It may take up to 24 hours for new issues to appear in this list.
(e Reported Status Last Updated Summary
1606 5/26/2016 12:00:00 Fixed 5/31/2016 3:24:46 Inconsistent Label Naming Re: DSN Qualified Table Names
1607 5"26‘/20}\1‘12:00:00 Fixed 5”31"20;&3:25:23 Search Assistant / Menu / Window Labels Feedback
1608 /262016120000 g 6/2/2016 452:01PM _ Incorrect Settings Warning via Search Assistant - Connaction Information
1609 | 2f27/20161200:000 | 6/2/2016 4:52:02 PM  Project Settings - Navigation Re: Git / GitHub
1610 JENES L LD Fixed SRS TEE ZEE Detail Delete does not work.
1611 HBAOOLZOC00 gy 6/1/2016 1:43:56 PM  Add Boolean Search Builder to Search Assistant
1670 7/6/2016 12:00:00 Closed /26/2016 2:39:44 Mandatory Fields for New User Registration Form
1675 W06 120000 | ¢y 7126/2006 237:42  pyjnctyation Issues on "Manual Activation” Form
g | VEVEBOTEITNY | 6oy I128/20162:41:80 | o 14 =gt Defaults™ to Source ltems (7)
1687 TROOGIE0000 Rewsedto FHAI/ACE #3501 Eyport Search Results List - Save Complete - Continue Button (label)
[22/201412-00-00  Releaserin (2712014 4:35:01

' Note: It may take up to 24 hours for new issues to appear in this list.

3. Clickon aticket number to view more details for an individual item. See example below:

Date
Found

Last
Updat

Summ

Issue
Detail

Notes

2016-12-06

Status: Open

=5 2016-12-06 12:33:22

ary Local or Network Folders: Clear File Filter when Directory is Removed or Changed

5 While setting up to perform a compare, I had created a File Filter to limit items.
When I later removed the Directory altogether, the File Filter remained, causing no
items to index for my subsequent compare.
You may want to consider clearing any File Filters that relate to a Directory if
they no longer apply. Or, alternatively, throw a message that says, "You have File
Filters applied. Do you still want to use them?” or similar.

Reported Issues
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License Agreements and Statements

License Agreements and Statements

Visit https://www.finditez.com/support/documents/eula.pdf to view the Find it EZ Software Corp. Software License Agree-
ment.
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